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Chapter 1: Introduction

The SoftMax® Pro Data Acquisition and Analysis Software controls Molecular Devices®
spectrophotometers and absorbance, luminescence, and fluorescence microplate readers
and detection platforms.

% Note: For the rest of this document, all references to the SoftMax Pro Software -
Standard edition are also applicable to the SoftMax Pro Software - MiniMax Imaging
edition and references to the SoftMax Pro Software are applicable to all editions of the
SoftMax Pro Software unless otherwise specified.

The software provides extensive data calculation and analysis capabilities under a Good
Manufacturing Practices (GMP), Good Laboratory Practices (GLP) work environment for
pharmaceutical, biotechnology, academic, hospital, and government customers.

The Protocol Library contains over 160 protocols that contain instrument settings and formulas.
You can customize the protocols in the Protocol Library to facilitate the data analysis and
report creation.

SoftMax Pro Software is widely integrated with industry-leading robotics systems.

For a complete list of the instruments this release of the SoftMax Pro Software supports, see
Supported Instruments on page 305.

Documentation

5049092 F

The SoftMax Pro Software installation places a copy of the microplate reader user guides (.pdf
files) in the following location on the computer:

C:\ProgramData\Molecular Devices\User Guides

The most up-to-date microplate reader user guides are available on the Molecular Devices
Knowledge Base at:

support.moleculardevices.com.
To access the Knowledge Base from the software:
e Selectthe Home tab, click Contact Us, and then select Knowledge Base.


http://www.moleculardevices.com/service-support
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Important Installation Information

You should install the SoftMax Pro Software on the computer before you set up the microplate
reader. Please be aware that some updates to the SoftMax Pro Software require a purchase.
To download the latest version of the software, visit:
www.MolecularDevices.com/SMPdownloadsite.

% Note: Microsoft no longer supports the Windows XP, Windows 7, and Windows 8
operating systems. Molecular Devices no longer tests or validates the SoftMax Pro
Software on these operating systems.

See the following documents for computer system requirements and installation instructions:
e SoftMax Pro Data Acquisition and Analysis Software Standard Edition and MiniMax Imaging
Edition Installation Guide
e SoftMax Pro Data Acquisition and Analysis Software - GxP Edition - Installation Guide for
the Multi Computer Setup
e SoftMax Pro Data Acquisition and Analysis Software - GxP Edition - Installation Guide for
the Single Computer Setup

Uninstalling the SoftMax Pro Software - Standard Edition

% Note: To uninstall the SoftMax Pro Software - GxP edition, contact Technical Support.
See Obtaining Support on page 19.

Before you uninstall the SoftMax Pro Software - Standard edition, back up your data and
documents to a folder outside of the SoftMax Pro Software folder. This method removes
related Windows registry information.

To uninstall the software:

Click Start > Control Panel.

Click Programs and Features.

In the program list, select SoftMax Pro <n.n.n>.
Click Uninstall or Remove.

Follow the prompts to uninstall the program.

o s> W N =
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Starting the Software
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You can choose to run the software in Offline mode and/or Simulator mode with the computer
not connected to an instrument. You must connect the computer to an instrument for plate
reads and data collection. See Selecting an Instrument on page 63.

Power on the instrument and wait for the instrument to complete its start-up sequence before
you start the software.

To start the software:

e For the SoftMax Pro Software - Standard edition: Double-click the la SoftMax Pro icon on
the desktop or from the Windows Start menu, click Start > All Programs >
Molecular Devices > SoftMax Pro <n.n.n>> SoftMax Pro <n.n.n>.exe.

e Forthe SoftMax Pro Software - GxP edition: Double-click the [l SoftMax Pro GxP icon on
the desktop or from the Windows Start menu, click Start > All Programs >
Molecular Devices > SoftMax Pro <n.n.n> GxP > SoftMax Pro <n.n.n> GxP.exe

e Enteryour user name, password, and select a Project. Then click Log On. See Logging

In to the SoftMax Pro Software - GxP Edition on page 246.

% Note: When you use the FilterMax™ F3 Multi-Mode Microplate Reader, FilterMax F5™
Multi-Mode Microplate Reader, SpectraMax® i3 Multi-Mode Platform, SpectraMax® i3x
Multi-Mode Detection Platform, and SpectraMax® Paradigm® Multi-Mode Microplate
Reader for the first time, the installation process installs the latest instrument firmware
updates.

The SoftMax Pro Software saves instrument firmware updates on the computer hard drive. If
you put a new image on the computer or you replace the computer, this information is lost.
However, the software installation and updates automatically install the latest instrument
firmware.

Instrument firmware information saves in the following file on the computer:
C:\ProgramData\Multimode\Detection Software\Templates\Updatelnfo.xml
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Activating the Software License

The Software License Activation dialog displays when your SoftMax Pro Software license is
inactive oris ready to expire. The SoftMax Pro Software package includes your software
product key. For information about the features of your license or to obtain a new license key,
contact Molecular Devices.

To activate your software license:

1. Inthe Ribbon, select the Help tab, and then click @v"" Software License to display the
Software License Activation dialog.

&4 Software License Activation

License Summary

Name Status Source
ﬁ SoftMax Pro  Standard

e\( SoftMax Pro GxP

u Import - Plate Format

u Import XML Format

Notify on warnings
. . . Activate | | Close
To obtain new keys, contact your Molecular Devices sales representative or om@moldev.com

2. Click Activate to display the Activate Online dialog.

Activate Online

Product Key: I | Activate Online |

If you do not have access to the Internet, click Activate Cffline. To
activate offline, you need your product key, a computer that has

access to the internet, and a USE drive for transferring files

between the computers.

3. Inthe Product Key field, enter the product key.

4. If the computer has access to the Internet, click Activate Online.
If the computer does not have access to the Internet, see Activating the Software License
Offline on page 11.

5. Wait for the Activation Success message and click Finish.
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Activating the Software License Offline
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When the computer onto which you install the SoftMax Pro Software cannot connect to the
Internet, you need a USB drive and access to a computer that is connected to the Internet.

To license the SoftMax Pro Software on a computer that cannot connect to the Internet:

1. Inthe Activate Online dialog:

Activate Online

Product Key:

If you do not have access to the Internet, click Activate Cffline. To
activate offline, you need your product key, a computer that has
access to the internet, and a USE drive for transferring files
between the computers.

Activate Online

Click Activate Offline.
2. Inthe Activate Offline Wizard dialog:

Activate Offline Wizard

Click Save to name and save a CuJ%mfr To Vendo
(.C2V) information file. This file uniquely identifies
this computer.

r

Lave

< Back

Mext > ||

Finish

Click Save.

il
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3.

4,

In the Save As dialog:

&l Save As X
= o i « Desktop » SMP Activation w Search SMP Activation B
Organize « New folder =~ @
S
2! Mame Date modified Type Size
*
a No items match your search.
-
=

[

» Hide Folders Cancel

a. Inthe File Name field, enter a name for the customer to vendor file (.c2v).
b. Navigate to the folderin which to save the .c2v file.

c. Click Save.

In the Activate Offline Wizard dialog:

Activate Offline Wizard

Click Save to name and save a Customer To Vendor
(.C2V) information file. This file uniquely identifies
this computer.

s Your file has been saved.

o el e ]

Note the path to the file and click Next.
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In the Activate Offline Wizard dialog:

Activate Offline Wizard

Locate the .C2V file on your computer and copy it to an external
USE drive. Connect the USE drive to a computer with |nternet
access and then visit the website listed below, Follow the
instructions to upload the .C2V file you created inlagep 1, along
with your product key.

https:/fsmplicensing.moleculardevices.com

Save Link to Disk | | Copy Link to Clipboard

You will receive a Vendor To Customer (W2C) file. Copy the V2T file

onto your USE drive. Connect the USB drive to this computer.

<Back | | Next> || Finish

a. Copy the .c2v file to a USB drive.
b. Click Save Link to Disk, Copy Link to Clipboard or make note of the link. You need this

link for step 8.

6. Take the USB drive to a computer that has access to the Internet.

7. Open anInternet browser and go to: https://smplicensing.moleculardevices.com.

8. Onthe SoftMax Pro Offline Activation System page:

Pro Offline Activation System

Instructions:

Irgert your externsl USE drvee, contanang the Customer Ta Vendor (CEV) fie from the computer on wheth you want to sctrvate SohMax g
Pro. Uplosd the CIV e from your computer by chicling Browse, Locate the C1V fle and dlick Open, Type your product ey in the entry feld
and cheke Actvate. A successful activation irsbates & dowricad of a WVendor To Customaer (W2C) file. Save thes file to your external USE drive.
Connect the USE drive to the computer on wheth you want te scteate SoftMac® Pro.

C2IV File: Choose File | SMP ActivaSion File c2v I
Product Kay:

Thank You for purchasing SoltMax® Pro soltware, We appreciate your business, If you should have any questions or
would like more information on gur Instruments andfor soltware, please visit our web site
www Molecularevices, com or contact our Technical Support

a. Click Choose File.
b. Navigate to and select the .c2v file on the USB drive.

c. Click Activate.

13
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9. Onthe SoftMax Pro Offline Activation System page:

SoftMeno® Pro Offine Acthvation System

Tnsbrections

whelf i w05 BOvate SoRHEn g
T Pt F gy Sl

2 Fila Chooia Fils | SWP Acshoation File e2v
Brodudt Ky

Atk

Thank You lor purchasing SoftMax® Pro seltware. We appreciate your business, [ you should hawve any questions or
weowld lile meore information on sur instraments and/or soltware, pleass visit our web site
wrw M las iy m of contact owr Technical Suppart

] Molecular
Arnig Dot Hen of 171 Fype dDevices

Cpen
|

| o = oy

LTI ul L] L] Shairer 8l

a. Click Show in Folder to display the location of the Update.v2c file that the activation
system downloads to your computer. Otherwise, locate the Update.v2c.
b. Copy the Update.v2c file to the USB drive.
10. Take the USB drive to the computer running the SoftMax Pro Software. In the Activate
Offline Wizard:

Activate Offline Wizard

Locate the .C2V file on your computer and copy it to an external
USE drive. Connect the USB drive to a computer with Internet
access and then visit the website listed below, Follow the
instructions to upload the .C2V file you created in Step 1, along
with your product key.

https:/fsmplicensing.moleculardevices.com

Save Link to Disk | | Copy Link to Clipboard

You will receive a Vendor To Customer ((W2C) file. Copy the W2C file
onto your USE drive. Connect the USE drive to this computer.

<Back ||| Nex> ||| Finish

Click Next.

14 5049092 F



5049092 F

1.

12.

In the Open dialog:

& Open

Organize » Mew folder

» o Quick access

> [ Box

» % OneDrive - Danaher
» O This PC

» il Network

File npame: | Updaten2e

« w « Desktop » SMP Activation v &

MName

*¥ Updatenvle

LA

Search SMP Actrvation

Date modified

81372019 10:57 AM

% ‘ Vendor To Customer files (*2¢

o
™ @

[_geen || Conce

a. Navigate to and select the Update.v2c file on the USB drive.

b. Click Open.

In the Activate Offline Wizard:

Activate Offline Wizard
Locate the W2C file on the USE drive.
- Desktop\SMP Actiuation‘hUpdate.chi I Browse... J
<Back ||| nea> [|| Finisn

Note the name and location of the Update.v2c file and click Next.

Chapter 1: Introduction
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13. Inthe Activate Offline Wizard:

Activate Offline Wizard

Re-enter your product key and then click Activate.

| Activate

a. Inthe Re-enter Your Product Key and then Click Activate field re-enter the product
key.
. Click Activate.
c. Click Finish.

Barcode Reader

16

The software allows you to use a barcode reader as an input device. When you place the
cursor in a text field and then use the barcode reader to read a barcode, the barcode reader
passes the text embedded in the barcode to the text field.

Before you use a barcode reader with the software, you must install the correct barcode
reader drivers. To test a barcode reader, open a text editor, such as Notepad, and then use the
barcode readerto read a barcode. If the reader functions correctly, the text embedded in the
barcode appears in the text editor.

Barcodes can have several different formats, such as MSI or Pharmacode. The barcode reader
you use must support the type of barcode to read. See the documentation that comes with
your barcode reader.
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Automation Mode
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You can use Application Programming Interface (APl) command scripts to automate the
SoftMax Pro Software. Automation Mode uses port 9000 and this port must be open.

To start Automation mode:
1. Select the Operations tab in the Ribbon.

2. Click #Automation Mode.

Automation mode prevents user interaction and the software displays the following dialog in
front of the main window.

Application i3 in Automation Mode
User input has been disabled

Automation Messages:

Client connection
1P Address: =1 Port: 61518

Terminate| Wil forcefully close client connection

When the software acquires data, the Plate section displays in the main window behind the
automation mode dialog and displays the data.

The Automation Messages area displays relevant information.
To stop the automation process, click Terminate.

The StakMax® Microplate Handling System is an integrated microplate handler for use with
Molecular Devices microplate readers, to provide simple, powerful, walk-away benchtop
automation. The StakMax Microplate Handling System uses the SoftMax Pro Software
Automation mode and the StakMax Software has a scripting tool. See StakMax Microplate
Handling System on page 336.

Automation Scripts

You can script and run the automation commands in the SoftMax Pro Software through the
automation API. For experienced automation programmers, the SoftMax Pro Data Acquisition
and Analysis Software Automation APl Reference Guide provides information about the
available commands and parameters. The SoftMax Pro Software also supports a Microsoft
Excel Add-In to write and run Excel Workflows.

Legacy scripts must use the Windows message WM_COPYDATA command. The WM_
SETTEXT command is not supported. Legacy scripts might not work correctly with the current
automation interface. If your legacy script does not work properly, you should use the most
recent version of the automation commands to rewrite the script.

To let the software accept legacy commands from scripts written for the SoftMax Pro Software
automation interface version 5.x:

1. Select the Operations tab.
2. Click Automation Mode.

17
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SoftMax Pro Software Excel Workflows

The SoftMax Pro Automation SDK is the underlying mechanism SoftMax Pro Excel workflows
uses to access SoftMax Pro Software functionality.
The SoftMax Pro Excel workflows expand the industry-leading handling of plate format data by
the SoftMax Pro Software with Excel-based handling of list format data. Use the SoftMax Pro
Excel workflows to run discontinuous kinetic reads, multiplexed reads, kinetic well scan reads,
and temperature-triggered reads.
Afteryouinstall the custom Add-Inin Excel, you can run and edit the Excel workflows oryou
can create your own workflows. The installation places the workflows in the same folder as the
Excel Add-Infiles:

e C:\Program Files (x86)\Molecular Devices\SoftMax Pro <n.n.n> Automation

SDK\ExcelAddIn

The Excel workflow files have a .xlsm extension.

Before you run or edit an Excel workflow, save a copy of the workflow on your computer.
Getting Help

Help is available for dialogs that have a @ help icon or a More Information link.

The Help tab in the Ribbon provides access to the help library.

e Click g SoftMax Pro Help to view the Application Help.

e
o Click Efl Formula Reference to view the SoftMax Pro Data Acquisition and Analysis
Software Formula Reference Guide.

e Click Release Notes to view the SoftMax Pro Data Acquisition and Analysis Software
Release Notes.

e Click 8“ Contact Us to access the following pages on Molecular Devices web site: What's
New in the SoftMax Pro Software, the Molecular Devices Home page, the Molecular
Devices Knowledge Base, or the Molecular Devices Support page.

e Click '3-7“ Software License to manage the software license. See Activating the Software
License on page 10.

e Click Iﬂ Diagnostics to turn on Diagnostics mode in order to record a read that generates
an instrument diagnostics log file. The log file contains information from the connected
instrument to help solve technical issues. (Available for the SpectraMax i3 Multi-Mode
Platform, SpectraMax i3x Multi-Mode Detection Platform, SpectraMax® iD3 Multi-Mode
Microplate Reader, SpectraMax® iD5 Multi-Mode Microplate Reader, and SpectraMax
Paradigm Multi-Mode Microplate Reader.) See Instrument Diagnostics Mode on page 65.

e Click i_“ Export to export the instrument diagnostics log file after you record a read in
Diagnostics mode. This exports the log file to the computer hard drive or a USB drive so
that you can send the file to Molecular Devices Support.

e Click G SoftMax Pro to view the software version number and release information.

18 5049092 F
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Obtaining Support

Molecular Devices is a leading worldwide manufacturer and distributor of analytical
instrumentation, software, and reagents. We are committed to the quality of our products and
to fully supporting our customers with the highest level of technical service.

Our Support website, support.moleculardevices.com, has a link to the Knowledge Base, which
contains technical notes, software upgrades, safety data sheets, and other resources. If you
still need assistance after consulting the Knowledge Base, you can submit a request to
Molecular Devices Technical Support.

You can contact your local representative or Molecular Devices Technical Support at
800-635-5577 X 1815 (North America only) or +1 408-747-1700. In Europe call +44
(0) 118 944 8000.

To find regional support contact information, visit www.moleculardevices.com/contact.

19
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Chapter 2: User Interface

Use the SoftMax Pro Software to perform state-of-the-art analysis. Use the software to control
most Molecular Devices microplate reader instrument functions including the ability to define
the settings to have the instrument run complete experiments and to define the formulas for
result analysis.

When you start the software, the Untitled1 document tab displays in the Document Tabs area
(number 4 in the following image) and the Workspace (number 7) displays the contents of the
default protocol.

% Note: For the SoftMax Pro Software - GxP edition, no document tabs display and the
Workspace area is empty. Your permissions determine which actions you can perform.
See SoftMax Pro Software - GxP Edition on page 243.

Settings Information | .
Endpoint @
4 Absorbance

T o mm o A o >

The numbers in the following table correspond to the image above.

ltem  Description

1 Quick Access Toolbar: Use to create, open, and save protocols and data documents that
contain the settings to run the instrument for data collection. You can customize this toolbar
and you can change its location. See Quick Access Toolbar on page 53.

2 Application Menu: Use to manage protocols and data documents and to define options for
the SoftMax Pro Software. See Application Menu on page 23.

3 Ribbon: Use to select protocols from the Protocol Manager and to define the settings for
each document. The Ribbon also provides the ability to change how you view the
Workspace, manage read workflows, and define instrument settings. See Ribbon on page
54.

Note: One of the first things you will do is to select an instrument on the Home tab in the
Ribbon. See Selecting an Instrument on page 63.

5049092 F 21



SoftMax Pro Software User Guide

Iltem Description

22

4

Document Tabs: Use to select the document to work with. The Document tabs display one
tab for each protocol and data document you open. In the Ribbon, use the View tab to
change the appearance and location of the Document tabs. See Document Tabs on page 66.

Workspace View Selectors: Use the three buttons to change how you work with the
information in the Workspace. See Workspace on page 70.

Navigation Tree: Use to manage and navigate the sections that make up the experiments in
a document. See Navigation Tree on page 67.

Workspace: Use to define and manage the protocols and data documents. Each document
contains one or more experiments and each experiment contains multiple sections for
notes, instrument settings, results, and graphs. See Workspace on page 70.

Acquisition Settings: Provides access to the Settings dialog where you define the settings
for the instrument to use to read a Plate section or a Cuvette Set section in an experiment.
See Acquisition Settings on page 110.

Read: Use to run the experiment. The software collects and stores all raw data from the
instrument. As information is read, the software uses the formulas you define to analyze the
data and the Workspace display updates to the results. See Collecting Data on page 109.

10

Workspace Zoom Slider: Use to zoom the focus of the Workspace in or out to view details of
the experiment section content.

If the computer has access to the Internet, a browser window appears to display the Molecular
Devices SoftMax Pro Insider page. To stop the appearance of the web page, see SoftMax Pro
Options on page 51.
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The ﬁ Application menuicon in the upper-left corner of the window provides access to
the Application menu. Use the Application menu to create, open, save, rename, print, export,
and import documents. Use the Recent Documents section to access the documents you most
recently used.

The Application menu also provides access to the SoftMax Pro Options dialog where you set
options for Data Recovery, Web Browser, Plate Setup Helper, Plate Height Warning, Plate

Eject After Read, Remote Control, Calculation, and SpectraMax iDx Control. See SoftMax Pro
Options on page 51.

iii! UeHMN )~

PN BEREREZCLLO

Recent Documents

Mew

1. Untitled1

QOpen

Save

Save As

Auto Export

Auto Save

Print »

Save as PDF

Export >

Import >

Close Document

19 Exit SoftMax Pro
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Click

to open the Application menu.

o Select | New to create a new document. See Creating Protocols and Data Documents
on page 29.

(= )

Select “+ Opento openadocument or select a document from the Recent Documents
list on the right. See Opening Protocols and Data Documents on page 30.

Select k J Save to save updates to a document.

Select E\l Save As to rename a document, to save a protocol as a data document, to save
a data document as a protocol, to move a document to a different location, orto give a
new document a name. See Saving Protocols and Data Documents on page 31.

Select EAuto Export to define settings to export documents to a new location, in a
format that is compatible with other software applications. See Auto Export on page 32.

ut
Select EJ Auto Save to define settings to save documents. See Auto Save on page 35.

Click "‘e Print and select one of the following:

Select .,,.49 Print All to print the information, settings, and results in a document.

Select “g Print Preview to create a preview of the information, settings, and results
before you choose to print. See Previewing Print Jobs on page 37.

]
Select ""ﬁ Print Selected to select the experiment sections to print and to exclude
experiment sections from the printout. See Printing Select Sections on page 38.

Select ""*" Printing Options to define the header and footer area for the printout, to
add a logo image, and to set the print quality. See Printing Options on page 39.

e Select ﬁ Save As PDF to save the printed output of a document to a portable document
format (.pdf). See Saving Data as a PDF on page 40.

e Click Ll‘ Export and select one of the following. See Exporting Data on page 42:

Select I,_.T Export As Data File (sdax) to export a SoftMax Pro Software - GxP edition
version 7.1.x document to the data document format for use in older versions of the
SoftMax Pro Software.

Select E Export As Protocol File (sprx) to export a SoftMax Pro Software - GxP
edition version 7.1.x document to the protocol format for use in older versions of the
SoftMax Pro Software.

Select I’—-r Export to XML XLS TXT to export the data in a data document to a .xml, .xls,
or .txt file format for use in other applications.
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¥
e Click e Import and select one of the following:

¥
e Select s Plate Format to import data into a Plate section in plate format. This
requires a separate license, contact Molecular Devices. See Importing Data in Plate
Format on page 45.

'
e Select kel XML Format to import data into a Plate section in .xml format. This requires
a separate license, contact Molecular Devices. See Importing Data in XML Format on
page 47.

¥
e Select b Import Legacy Files to import legacy SoftMax Pro Software protocols and
data documents into the SoftMax Pro Software - GxP edition version 7.1.x database.
See Importing Legacy Documents on page 48.

e Select@! Close Document to close the document that is open in the Workspace.

e Click Options at the bottom of the menu to set application options. See SoftMax Pro
Options on page 51.

e Click Exit SoftMax Pro at the bottom of the menu to exit the SoftMax Pro Software.

Managing Documents

The SoftMax Pro Software uses two basic document types: protocols and data documents.
You save both protocols and data documents just like any other file you save to a computer.

[
Use the (w2 Folder Locations icon on the Protocols tab to add or remove the folders that
display in the Protocol Library. See Protocol Library Folder Locations on page 62.

e Protocols contain the settings that the instrument uses to collect data and the formulas to
analyze data. Protocols are useful when you repeat experiments and when you create new
documents.

e Data documents contain the data the software collects when you run the experiment. Data
documents allow you to create reports and graphs from the data you collect.

SoftMax Pro Software - Standard edition version 7.1.x can open documents from version 4.0 or
later.

SoftMax Pro Software - GxP edition version 7.1.x requires that you to import legacy documents
into the SoftMax Pro Software - GxP edition database. See Importing Legacy Documents on
page 48.

Note: Before you open a document, make sure the instrument you select uses the same
settings or compatible settings as the instrument used to create the document.
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Protocols

You can use predefined protocols and you can create your own protocols. Protocols contain
plate well layout assignments, reduction parameters, and instrument settings, but no data.
Protocols are useful when you want to repeat experiments because protocols save instrument
experiment settings and formulas for reuse. See Creating Protocols and Data Documents on
page 29.

When you open a new document, the settings from the default protocol appearin the
Workspace. The default protocol settings help you get started when you create a new
document. When you install the software, the Basic Endpoint protocol is set as the default
protocol with the file name default.spr.

Use the B Save As Default icon on the Protocols tab to change the default protocol settings
to the settings you define in the document that displays in the Workspace. See Protocols Tab
on page 56.

Use the @ Protocol Managericon on the Home tab and on the Protocols tab to access the

Protocol Library. The Protocol Library contains over 160 protocols that contain instrument
settings and formulas. You can customize the protocols in the Protocol Library to facilitate the
data analysis and report creation.

]
Use the a_ﬁ” Folder Locations icon on the Protocols tab to add or remove the folders that

display in the Protocol Library. This helps you find the protocols you use most often. See
Protocol Library Folder Locations on page 62.

Use the '@ Protocol Home Page icon on the Protocols tab to access the SoftMax Pro
Software user community where you can share protocols, exchange tips and tricks, and
network with other users.

% Note: When you save a data document as a protocol, the software creates a new
protocol file that contains the experiment settings without the data. Any data you collect
in the current experiment remains unchanged and is saved with the data document file.

Protocol File Extensions

You can open protocols that have the following file extensions. See Opening Protocols and
Data Documents on page 30:

e pprforSoftMax Pro Software - Standard edition version 4 and 5 protocols.

e sprfor SoftMax Pro Software - Standard edition version 6 and 7 protocols.

e _eprforSoftMax Pro Software - GxP edition version 4 and 5 protocols before youimport

them into the version 7.1.x database. See Importing Legacy Documents on page 48.

e sprxfor SoftMax Pro Software - GxP edition version 6 and 7.0.x protocols before you
import them into the version 7.1.x database.
SoftMax Pro Software - GxP edition version 7.1.x does not display file extensions for
protocols.
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Data Documents

Data documents contain the instrument settings, the raw data the instrument collects, and the
completed data analysis.

Data Document File Extensions
You can open data documents that have the following file extensions:

e pda for SoftMax Pro Software - Standard edition version 4 and 5 data documents.
e sda for SoftMax Pro Software - Standard edition version 6 and 7 data documents.
e _eda for SoftMax Pro Software - GxP edition version 4 and 5 data documents before you
import them into the version 7.1.x database.
e sdaxfor SoftMax Pro Software - GxP edition version 6 and 7.0.x data documents before
you import them into the version 7.1.x database.
e SoftMax Pro Software - GxP edition version 7.1.x does not display file extensions for data
documents.
When you create a data document for an Imaging mode experiment or a Western Blot
experiment, the software creates a folder with the same name as the data document.

Data Export Formats
You can export data to files with the following file extensions: See Exporting Data on page 42.

e xml

e txt (list)
e txt (plate)
e Xls (list)
e xls (plate)

Imaging Read Mode Data Documents

Before you start an image acquisition for an Imaging experiment or a Western Blot experiment,
you must save the data document in a location with enough capacity for the image files. For
best results, save Imaging experiment data documents on the secondary hard drive inside the
computer. Use of an external hard drive can slow the data acquisition and is not
recommended. Use of a USB drive or saving to a network location is not supported.

When you create a data document for an Imaging experiment or a Western Blot experiment,
the software creates a folder with the same name as the data document.

For example, if you save the data document with the name Imaging_ Data, the software creates
a new folder named Imaging_Data in the same folder where you save the data document. This
folder stores the images and results.
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* Imaging Experiments
ﬁig Imaging Data.sda

* Imaging Data

* Exptl
* Platel
* IMAGES
* RESULTS

The software stores the images separately for each plate in the IMAGES folder in .tiff format.
The software stores image analysis data in the RESULTS folder. Western Blot experiments do
not create or use the RESULTS folder.

Note: Do not rename, move, or delete the related folders or files. If you change the
structure of these files and folders, the software may not be able to open the data
document or might display inaccurate results.

i
Use the ﬁApplication menu to copy or delete data documents, image files, and analysis
datafiles.

To delete the images or the analysis data for an Imaging mode experiment:

1. Inthe Navigation Tree right-click the Plate section.
2. Select Delete Images or Delete Cell Data.

If you delete the .tiff file for a Western Blot experiment, the software recreates the .tiff image
from the intensity data stored in the data document.

% Note: When you save an Imaging experiment data document as a protocol, the
software saves only the settings and does not create other folders or files.

Acquisition of images for Imaging experiments requires significant computer memory and
resources. Each image file can be larger than 2 megabytes. When you acquire the image of a
single site in each well of a 96-well plate you can generate 300 megabytes of image data. A
384-well plate can generate 1 gigabyte of image data. When you acquire images of multiple
sites, you increase the data storage requirement.

Before you start an Imaging experiment, turn off all other programs to minimize the demands
on computer memory and resources. When the software has limited access to computer
memory and resources, image acquisition can take a long time. In some cases, images of
some of the wells can be lost. See Optimizing the Computer for Image Acquisition on page
175.

Formaging experiments, save the data to a .txt file format. If you use Auto Export to export
multiple Imaging experiment data documents, the software exports each new data document
without the folders required to save images and results. See Auto Export on page 32.
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Creating Protocols and Data Documents

e

i
Use the Quick Access toolbar and the Application menuto create a new document that

you can save as a protocol or data document. The Protocol Library contains protocols that you
can use to create a new protocol or data document.

To create a document:
D
1. Click in the Quick Access toolbar or click to display the Application menu and
select | New. A new tab displays in the Document tabs and the Workspace displays the

settings from the default protocol.

% Note: You should save and name the protocol before you collect data. For the
SoftMax Pro Software - GxP edition, you must save the document before you can
proceed. See Saving Protocols and Data Documents on page 31.

i

2. Click E in the Quick Access toolbar or click to display the Application menu and

select E\J Save As to display the Save As dialog.
3. Navigate to where you want to save the document.
In the File Name field, enter the document name.
5. Click the Save As Type drop-down:
e Forthe SoftMax Pro Software - Standard edition, select Protocol Files (*.spr) to save
the settings with no data as a protocol.
e Forthe SoftMax Pro Software - Standard edition, select Data Files (*.sda) to save the
settings with no data as a data document.
e Forthe SoftMax Pro Software - GxP edition, select Protocol Documents to save the
settings with no data as a protocol.
e Forthe SoftMax Pro Software - GxP edition, select Data Documents to save the
settings with no data as a data document.
6. Setup the experiments for the document in the Navigation Tree. See Workspace on page
70.
7. Configure the settings for the instrument to use to read the Plate sections and Cuvette Set
sections. See Acquisition Settings on page 110.
Create templates. See Template Editor on page 90.*
9. Set Data Reduction parameters. See Data Reduction on page 191.*
10. Set Display options. See Data Display Options on page 202.*

>

&

i

11. Click E in the Quick Access toolbar or click to display the Application menu and

select E i Save to save your changes.

*Can be done at any point in the process, before or after the initial read.
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Opening Protocols and Data Documents

i3

Use the Quick Access toolbar and the Application menuto open documents. The
Protocol Library contains protocols you can use to create a new protocol or a blank data
document.

The SoftMax Pro Software - Standard edition can open documents created by version 4.0 or
later. When you open a document from a version earlier than version 7.x, the software converts
it to the SoftMax Pro Software version 7.x format. After you save a document, you cannot open
the new document in earlier software versions.

The SoftMax Pro Software - GxP edition version 7.1.x requires a few additional steps if you want
to use documents that are from a version earlier than version 7.1.x. See Importing Legacy
Documents on page 48.

% Note: Each instrument has different settings. Before you open a document, verify that
the instrument used to create the document is the same as the instrument you select on
the Home tab. Some instruments have incompatible settings.

To opendocuments:

}:*‘:
2

1. Click n in the Quick Access toolbar or click to display the Application menu and

=)

Select “+ Opento display the Open dialog.

2. Click the Data Files (*.sda) drop-down (SoftMax Pro Software - Standard edition) or the
Open Type drop-down (SoftMax Pro Software - GxP edition). SoftMax Pro Software - GxP
edition version 7.1.x documents do not display the file extension.

e For SoftMax Pro Software - Standard edition, select Protocol Files (*.spr) to opena
protocol with an .spr file extension.

e For SoftMax Pro Software - Standard edition, select Data Files (*.sda) to open a data
document with an .sda file extension.

e For SoftMax Pro Software - GxP edition, select Protocol Documents to open a version
7.1.x protocol.

e For SoftMax Pro Software - GxP edition, select Data Documents to open a version 7.1.x
data document.

3. Navigate to the document and select it.

4. Click Open. A new Document tab displays above the Workspace with the document
name.

5. Before you use a protocol to collect data, you should save it as a data document.
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Saving Protocols and Data Documents

i3

Use the Quick Access toolbar and the Application menu to save documents. Before you
use a protocol, you should save the protocol as a data document. You can use the Auto Save
feature to automatically save the document. See Auto Save on page 35.

To save documents:

1. Select one of the following:

iz

e Click E in the Quick Access toolbar or click to display the Applications menu

and select EJ Save to save the open document with updated information in the same
location with the same name.

i

e Click E in the Quick Access toolbar or click to display the Applications menu

and select E\J Save As to rename a document, to save a protocol as a data document,
to save a data document as a protocol, to move a document to a different location, or
to give a new document a name. The Save As dialog displays.

s

e Click to display the Applications menu and select ﬁSave As PDF to save the
documentin a .pdf format. See Saving Data as a PDF on page 40.
2. ForSave As, inthe Save As dialog, navigate to where you want to save the document.
3. Inthe File Name field, enter the document name.
4. Click the Save As Type drop-down.
e Forthe SoftMax Pro Software - Standard edition, select Protocol Files (*.spr) to save
the document as a protocol.
e Forthe SoftMax Pro Software - Standard edition, select Data Files (*.sda) to save the
document as a data document.
e Forthe SoftMax Pro Software - GxP edition, select Protocol Documents to save the
document as a protocol.
e Forthe SoftMax Pro Software - GxP edition, select Data Documents to save the
document as a data document.
5. Click Save.
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Auto Export

Use the Auto Export dialog to define how and where the software is to automatically export
data immediately after each plate read completes. Auto export reduces the likelihood of lost
data, particularly when you choose to export documents to corporate network file locations
that are backed up on a regular basis. You can define multiple auto export instances. The
software saves auto export settings with each document.

This feature helps prevent data loss when you do automated reads, such as with the StakMax
Microplate Handling System. See StakMax Microplate Handling System on page 336.

Formaging mode experiments, export the data to a .txt file format. If you use auto export to
export multiple Imaging mode data documents, the software exports each new data document
without the folders required to save images and results.

B Auto Export pd
Enable automatic file saving after every read operation. @
Save Data After Read
[ ada || e || ool |
File Name Location
Data C:\Users\DevTestuser\Documents\SMP
| 0K | | Cancel

To automatically export a document:

1. Openthe protocol or data document to export.

i

2. Click to display the Application menu and select = Auto Export to display the
Auto Export dialog.

3. Selectthe Save Data After Read check box to use auto export.
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4. Click Add or select a document in the list and click Edit to display the Auto Export
Properties dialog.

L'Ej Auto Export Properties X

File Location @
() Protocol's Folder

Browse...

(®) Assigned Folder
File Name

() protocol's Name

(@) Assigned Name

File Format

.sdax n

Save Options
Export Data: ® Raw Reduced Both

(® Create a New File
["] Append Date To File Name

[ ] Append Time To File Name

() Overwrite Existing File

oo [ e |

% Note: Auto export properties settings are specific to the new export location or the
export location you select to edit from the Auto Export dialog. Use this to customize
the settings for each location to which you use auto export.

5. Select a File Location option.

e Select Protocol's Folder to export documents back to the folder that contains the
originating document.

e Select Assigned Folder to export documents to a folder to which the computer has
access. Click Browse to display the Browse For Folder dialog. Navigate to the folder
or click Make New Folder to create a new folder where you want to export the
document.

6. Select a File Name option.

e Select Protocol's Name to name the document with the protocol name.

e Select Assigned Name to assign a name to the document. In the text field, enter the
name for the document. The text in this field is inserted at the start of each document
name.
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7. Click the File Format drop-down and select a file format.

e Select.sda or.sdax to export the file as a data document.

e Select.xmlto export the file in .xml format. Use the .xml format if you plan to import
read data into other data collection and storage applications, specifically, LIMS
(Laboratory Information Management System) or SDMS (Scientific Data Management
System) packages.

e Select .ixt (list) or .txt (plate) to export the document as a tab delimited text file that
most word processor, spreadsheet, or database programs can open.

e Select .xls (list) or .xlIs (plate) to export the document in a format that Microsoft Excel
can open. The Excel output has the same format as a tab delimited file with an .xIs file
extension.

8. Forthe SoftMax Pro Software - GxP edition, if you select .xml, select the Sign check boxto
increase the integrity of the .xml file in order to protect the file from being tampered with.
Clear the Sign check box to not sign the export file.

Note: This feature requires separate license. To obtain a license contact Molecular
Devices.

Save Options: The available save options depend on the file format you select.
9. Select an Export Data option.

e Select Raw to export only the raw data.

e Select Reduced to export only the reduced data.

e Select Bothto export both the raw and the reduced data in the same file.

10. Select one of the following:

e Select Create a New File to create a new document after each read. When you select
this option and do not select either of the following check boxes, the software
numbers documents with the same name sequentially. For example, Data 1, Data 2,
and so on.

e Selectthe Append Date to File Name check box to add the date after the
document name. If you select to append only the date to the document name, the
software indexes the runs for that day starting with 7and increments with each
successive run. For example, the software names the first document named Data
that you export on January 22nd, 2021 Data-01-22-21 1and names the second
document you export Data-01-22-21 2, and so on.

e Selectthe Append Time to File Name check box to add the time after the
document name.

If you select both the date and the time, the time follows the date.

e Select Overwrite Existing File to overwrite an existing document for each read. Use
this carefully because this can cause data loss. A document can overwrite only itself. If
a different document with the same name exists in the save file location, the software
appends a number to the end of the document name.

11. Select Append to File to append the data from multiple plates into one document. Enter
the maximum number of plates to append per document. This option is available when
you select either the .txt or .xIs format.

* Tip: If you use the StakMax Microplate Handling System to read multiple plates (for
example, 10), use this option to export the data from all 10 plates in a single
document.

12. Afteryou define each document name and location, click OK.
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Auto Save

Use the Auto Save Properties dialog to define how and where the software is to automatically
save data after each plate read completes. Auto save reduces the likelihood of lost data,
particularly when you choose to save protocols to corporate network file locations that are
backed up on a regular basis. The software saves auto save settings with each protocol.

CE
[ ] Define Document Folder 9 |
Assigned Folder Browse... |
Define Document Name

Assigned Name

Append Date To File Name Append Time To File Name

0K | | Cancel
To automatically save a document:
1. Openthe protocol or data document to save.
T
2. Click to display the Application menu and select = Auto Save to display the Auto

Save Properties dialog.

3. Select the Define Document Folder check box to use auto save.

Next to the Assigned Folder field, click Browse to display the Assigned Folders dialog.

5. Navigate to the folder where you want to save the protocol and then click OK to return to
the Auto Save Properties dialog.

6. Select the Define Document Name check box to define the document name when the
document saves.

7. Inthe Assigned Name field, enter the name for the document when the document saves.

8. Selectthe Append Date to File Name check boxto add the date after the document
name. If you select to append only the date to the document name, the software indexes
the runs for that day starting with 7and increments with each successive run. For example,
the software saves the first document named Data that you save on January 22nd, 2021
Data-01-22-21 1and names the second document you save Data-01-22-21 2, and so on.

9. Selectthe Append Time to File Name check box to add the time after the document
name.

>

Note: If you select both check boxes, the time follows the date.
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Printing

}:*‘:
2

Use the Application menuto print the contents of the document that is openin the
Workspace. You can print all sections or select the sections to print. You can preview the print
out before you print and you can define the page header, footer, and print quality options.

Print Options

Before you print, you can add a logo image, and define the header, footer, and print quality in
the Printing Options dialog. See Printing Options on page 39.

}:*‘:
2

Click to open the Application menu, click “""'J Print, and then select ""f Printing Options
to display the Printing Options dialog.

Print

The Application menu provides several ways to print the document content. You can click a

{
section in the Navigation Tree and click D to have a section not print oryou can select the
sections to print from the Application menu.

To print a document:

1. Openthe document to print.

}:*‘:
2

2. Click to display the Application menu.
3. Click “""'] Print and select an option:

° Selecti"'.".e Print All to print all the included sections in the document. The Print dialog
displays.

e Select "'g' Print Preview to display the Print Preview dialog where you preview the
print job before you print.

e
e Select ""ﬁ Print Selected to display the Print Selected dialog where you select the
sections to print and the sections to exclude from the printout.

e Select "'"“ Printing Options to display the Printing Options dialog where you define the
header, footer, and logo for the pages and the print quality.
4. Inthe Print dialog, select the printer to use and set the print settings, including the number
of copies to print. To print to a .pdf file, select the Molecular Devices (PDF Writer) or click

e

§HEE

to display the Application menu and select ﬁ Save As PDF.
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Previewing Print Jobs

Use the Print Preview dialog to preview the print job before you print. Use the Print Options
dialog to add a header, footer, and logo image. See Printing Options on page 39.

To preview the printed output:

1.

2.

Openthe document to preview.

iz

Click to display the Application menu, click “"") Print, and then select
Preview to display the Print Preview dialog.
The dialog provides the following tools.

e Scroll through the pages

“Q’ Print

o« B Zoom in

e - -Zoom out

° 3 - Scale to 100%

° :'l - Scale to page width

° G - Scale to the whole page

° :I - Scale to display two pages

Click *# to display the Print dialog.

Select the printer to use and set the print settings, including the number of copies to print.
To print to a .pdf file, select the Molecular Devices (PDF Writer). See Saving Data as a PDF
on page 40.

Click Print.
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Printing Select Sections

Use the Print Selected dialog to select the document sections to print and the document
sections to exclude from the printout. Use the Print Options dialog to add a header, footer, and
logo image.

-

I:Ifj-'i' Print Selected

Select sections to print. @

4[] BasicEndpoint
|:| Intro

,
Motes1
Platel
Standards
Unknowns
Unk_Dilution
Contral
StandardCurve

[ Select All H Deselect.ﬂ.lll

e [ canes

To print select sections of a document:

1. Openthe document to print.

- o - &
. ick to display the Application menu, click *=* Print, and then select *=* Print
Selected to display the Print Selected dialog.
3. Selectthe check box for each section to print.
Clear the check box for each section to not print.
e Click Select All to select all the check boxes.
e Click Deselect All to clear all the check boxes.
e Click Print Preview to preview the print job before you print.
4. Click Print to display the Print dialog.
5. Select the printerto use and set the print settings, including the number of copies to print.
To print to a .pdf file, select the Molecular Devices (PDF Writer).
6. Click Print.
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Printing Options

Use the Printing Options dialog to add a logo to the printout, to define the contents of the
header and footer, and to set the quality of the printed output.

) Printing Options @
Choose options which affect the appearance of the printed document. @
Header and Footer
Left Center
Header
Experiment Name [ Add Image
Footer
File Path and Namea DSoftMaxPrc
Date and Time Page Number
Left Center
Print Quality
Improving the print quality may
U increase the amount of time
Dratt Better Best reguired to print a document.
“an ]
To define printing options:
1. Openthe document to print.
Teapan _
$3i23 e e
2. Click to display the Application menu, click *=* Print, and then select *=F Printing

Options to display the Printing Options dialog.
3. Define the page header:

e Select the Experiment Name check boxto include the experiment name in the
header.

¢ Inthe Left, Center, and Right text fields, enter the text to display in the left, center and
right of the header.

e Selectthe Add Image check box and click the Browse button to locate and select an
image file (jpg format). The software sizes the image to fit in the upper-right area of
the page.

4. Define the page footer:

e Select the File Path and Name check boxto include the document name and pathin
the printout.

e Select the Date and Time check boxto include the date and time.

e Select the SoftMax Pro check boxto include the version of the SoftMax Pro Software.

e Selectthe Page Number check boxto include page numbers.

* Inthe Left, Center, and Right text fields, enter the text to display in the left, center and
right of the footer.

5. Drag the Print Quality slider to adjust the print quality.
6. Click OK.
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Saving Data as a PDF

You can save the contents of a document in .pfd format.

To define .pdf settings:

Click to display the Application menu and select ﬁ Save As PDF. You can also select
the Molecular Devices (PDF Writer) in the Print dialog.

The following tables define the .pdf settings:

General Tab

Option

Description

Option Set Select a set of .pdf settings from this list. To define a new set, select
<Edit>.

Format To create a .pdffile, select .pdf or select from this list to create output in
image file formats.

File Name Enter the file name in the path or click [.. | to browse for a file.

Append if output exists

Select to append this file to an existing file instead of overwriting an
existing file.

Open destination folder
after creation

Select to open the folder where the file is saved after the file saves.

Open the document after
creation

Select to open the file after the file saves.

Document Tab

Option

Description

Author Enter the name of the author to display in the document properties.

Title Enter the title of the document to display in the document properties.

Subject Enter the subject of the document to display in the document
properties.

Keywords Enter keywords for the document to display in the document properties.

Quality Select a quality to define the size of the .pdf file.

Initial zoom level

Select a zoom level to define how the document displays.

Compatibility Level

Select a format to make the .pdf file compatible with older versions of
PDF readers. Some options might not be supported in older version.

PDF/A-1b

Select this check box to use the .pdf/A-1b archiving standard.

Image Tab
Option

Description

DPI

Select the resolution for the image in dots perinch.

Text Alpha Bits

Select the number of bits to use for the alpha channel for text.
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Watermark Tab

Text Enter the text to display in the watermark.

Font Select the typeface for the watermark.

Color Click [_..] to select the color for the text.

Size Enter the size of the text in points.

Outline width Enter the width of the text outline in pixels to have the text display in
outlines. To have the text display as a solid color, leave this field blank.

Layer To have the watermark text display on top of the document text, select
Stamp. To have the watermark text display behind the document text,
select Watermark.

Rotation Select to display the text upward from the lower left corner or downward
from the upper left corner.

Vertical position Select to display the text on the top, center, or bottom of the document.

Vertical adjustment Enter a percentage offset for the vertical watermark position.

Horizontal position Select to display the text on the left, center, or right of the document.

Horizontal adjustment Enter a percentage offset for the horizontal watermark position.

Merge Tab

Option Description

Append PDF Enter the name of the file to which to append this file. To browse for the
file, click [ .
Position To append the new file to the end of the old file, select Bottom. To

append the new file to the start of the old file, select Top.

Background PDF

To print the data on an existing file, enter the file name in this field. Use
this to print on company letterhead. To browse for the file, click [ ... |

Layer

To have the new file display on top of the old file, select Stamp. To have
the new file display behind the old file, select Watermark.

Security Tab

Option Description

Owner password

Enter the password that gives owner permissions for the file.

User password

Enter the password that gives user permissions for the file.

Key Length

Select the length of the key to use for document encryption.

Set Permissions

Select this check box to limit access to the document for the user level.

Print

Select whether to permit printing and the print quality to permit.

Copy to clipboard

Select to permit users to copy text from the file to the clipboard.
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Exporting Data

Use the Export dialog to export data to a .xml, .xls, or .txt format. The software exports data
values with the maximum floating point arithmetic precision, regardless of the display settings
you define.

% Note: For instructions to export membrane data, see Viewing Western Blot Membrane
Data on page 236 and for instructions to export Imaging data to Microsoft Excel or
PowerPoint see Viewing Imaging Data in Wells on page 205.

L Export X
Select sections to export and specify export options. @
All Plates AllGroups [ ] All Notes
4 [ | BasicEndpoint
[] Intro
4 Exptl
Platel
Standards
Unknowns
Unk_Dilution
Contrel

Plate Export Options
Plate Data Options
(@ Raw (_)Reduced () Both
Output Format
() Columns [.txt or xIs) () Plate (.txt or .xls) @ XML [«] Sign

| ok || canca |

To export data:
1. Open the document that contains the data to export.

T
Piifis

2. Click to display the Application menu, click Export, and then selectt-r Exportto
XML XLS TXT to display the Export dialog.
3. Selectthe following:
e Select the All Plates check boxto export all Plate section data.
e Select the All Groups check box to export all Group section data.
e Select the All Notes check boxto export all Note section data.
e Selectthe check box for each section to export.
e (Clearthe check boxfor each section to not export.
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If you select to export Plate section data, select a Plate Data Option:
e Select Raw to export only the raw data.
e Select Reduced to export only the reduced data.
e Select Bothto export both the raw and the reduced data in the same file.

Note: These options apply only to Plate sections.

Select an Output Format option:
e Select Columns to export data in a single column of text for each well.
e Select Plate to export data in a text matrix that corresponds to a plate grid.
e Select XML to export data in an .xml format.

Note: These options apply only to Plate sections.

For the SoftMax Pro Software - GxP edition, if you select XML, select the Sign check box to
increase the integrity of the .xml file in order to protect the file from being tampered with.
Clear the Sign check box to not sign the export file.

% Note: This feature requires separate license. To obtain a license contact Molecular
Devices.

Click OK to display the Save As dialog.
Navigate to the folder where you want to save the data.
In the File Name field, enter the export file name.
Click the Save As Type drop-down and select the file type for the export file.
e Ifyouselect the XML Output Format, the only option is xml. For a copy of the SoftMax
Pro .xml schema, contact Molecular Devices.
e Fordetails about the format and content of the .txt and .xIs format export file, see
Exporting File Details on page 351.
Click Save.

43



SoftMax Pro Software User Guide

44

Importing Data
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Use the Application menuto import data into the software.

T
Paifis

¥
Click to display the Application menu, click = Import:

]
e Select s Plate Format to import tab delimited text data into a Plate section. See
Importing Data in Plate Format on page 45.

¥
e Select ks XML Format to import .xml data into a Plate section. See Importing Data in XML
Format on page 47.

¥
e Select ks Import Legacy Files to import SoftMax Pro Software legacy documents into the
SoftMax Pro Software - GxP edition version 7.1.x database. See Importing Legacy
Documents on page 48.

% Note: The import data in Plate format feature and the import data in the .xml format
feature require separate licenses. To obtain a license for the Plate format data import
feature and the .xml format data import feature, contact Molecular Devices.

The software installation includes templates to import data in the Plate format and a schema to
import data in the .xml format.

When you import plate data, the software creates a new Plate section with the section name
from the import file. If the Plate section name already exists, then the import data overwrites
the existing data in the section. See Plate Sections on page 80.

When you import plate data into an existing Plate section, the software preserves the template
and reduction settings in the existing Plate section if the data you import is compatible with the
settings in the existing section.

To preserve the template and reduction settings, the name of the Plate section in the source
file must match the name of the Plate section in the destination file. If the names do not match,
the software creates a new Plate section.

Another way to preserve template and reduction settings is to copy the import data from the
new Plate section and then paste the data into an existing Plate section. The software uses the
template and reduction settings of the section into which you paste the data.

Note: To maximize the number of data points the software uses for reduction, the end
time reduction parameter changes to match the read time from the import file.
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Importing Data in Plate Format

T
Piifis

Use the Application menu to import data in the Plate format.

Before you canimport plate data that you export in the Plate format from SoftMax Pro Software
version 5.x and 6.x or that you acquire from a different software program, you must first use that
software program to export the data into a format that is compatible with the SoftMax Pro
Software version 7.1.x. The SoftMax Pro Software installation includes templates to import data
in the Plate format.

To import data in the plate format:

1. Open orcreate a new protocol.
2. Define a Plate section into which to import the plate data. Name the Plate section with the
same name as the Plate section in the import file.

T
Piifis

Click to display the Application menu.

4 ¥ : -
Click ke Import and select L Plate Format to import tab delimited text data.
In the Open dialog, navigate to and select the file to import.
Click Opento import the data. The Plate sections display the imported data.
Save the file.

N OO A~ W

Afteryou import the data into the Plate sections, the Read Information area on the right
indicates that the data was imported and shows the time and date of the import. For the
SoftMax Pro Software - GxP edition, the Read Information includes the name of the user who
imported the data.

Import Template Details

Import templates are in a sub-folder of the Program Files folder where you install the SoftMax
Pro Software. The default installation path is:

C:\Program Files (x86)\Molecular Devices\SoftMax Pro
<n.n.n>\Plugins\Import-PlateFormat\Templates

The templates have the xIsx format, but you must save the file in the .txt format with tab-
separated values before you import the data.

The cells in the template are color-coded.

Background Color Description

White Do not alter cell.
Green Cell requires information entry.
Light Yellow Cell information entry optional.

You can paste your data directly into the template or use the template as a model for a script
that converts your data to the acceptable format forimport.
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Plate Data Layout

The first line of an import template defines the number of Plate sections (or "Blocks") that are in
the document.

o ##BLOCKS=1
Each Plate section has the following format:

e Headerlines
The first header line contains the description of the titles for the data in the second header
line. The second header line contains the type of section, Plate, and the title to give to the
Plate section in the document.
The fields in the header lines define the read type, number of wells in the plate,
wavelengths for the read, and other relevant information. The layout and format of the
header lines depend on the read type. For more information, see the template for the read
type of the data.

e Data lines
The data lines follow the header lines with a blank row between the header lines and data
lines. The layout and format of the data lines depend on the read mode and read type.

e The first column displays the time points for a kinetic read, the data pointsin a well
scan read, or the wavelengths in a spectrum read. This column is blank for endpoint
reads.

e The second column displays the temperature for the read, if you use the incubator for
the read. The value is zero if the incubator is off.

e The third column is where the read data starts.

The data displays in a table to indicate the columns and rows of the plate you use for the read.
The data for multiple time points for kinetic reads, multiple data points for well scan reads, or
multiple wavelengths for spectrum reads displays in separate tables below the previous table.
For endpoint, kinetic, or well scan reads with multiple wavelengths, the data for each
wavelength displays in separate tables to the right of the previous table.

wavelength 1 wavelength 2
Temperature 1 2 3 1] 2 3
0:00:00 #it 1.596 2.479 2.95 3.103 1.39 1.97
1.024 0.308 3.925 2.381 1.957, 3.722
0.195 0.287 2.638 0.967] 1.049 1.422
0:01:58 #i 1.564 3.344 2.378 0.113) 3.872] 0.637
0.82 1.797 1.064 3.58 2.603 0.996
0.421 3.066 3.906 0.915 0.57 2.251
#it 1.169 1.092 3.969 1.126 0.004 1.934
1.105 3.022 2.845 1.933 2.834 0.657
3.602 2.033 3.737 0.437] 3.242 1.337

e Endline
The end line follows the data lines with a blank row between the data lines and end line.
The end line of each Plate section is defined by the text: YEnd

To import data from more than one Plate section in a single text file, include the header lines,
the data lines, and the end line for each Plate section after the end line of the previous Plate
section.

The final line of an import file contains a single field with the name of the import file, and the
date and time that the file was saved. This information follows the end line of the last Plate
sectionin the file.
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Importing Data in XML Format

Before you can import data that you acquire from a different software application, you must
first use that application to export the data into a compatible format. The SoftMax Pro Software
installation includes templates to import data in a schema for the .xml format. You must use the
SoftMax Pro .xml schema from software version 6.4.1 or later.

The .xml schema file for data import (XMLImportSchema.xsd) is in a sub-folder of the Program
Files folder where you install the SoftMax Pro Software. The default installation pathis:

C:\Program Files (x86)\Molecular Devices\SoftMax Pro <n.n.n>\Plugins\iImport-XML\Schema

For information about the .xml elements and their usages, see the comments in the schema
file.

To import data from more than one Plate sectionin a single .xml file, make sure that all the
Plate sections are between the <pPlateSections>tags and you define each Plate section
between a set of <PlateSection> tags.

<PlateSections>
<PlateSection>
[Data from the first Plate section]
</PlateSection>
<PlateSection>
[Data from the second Plate section]
</PlateSection>

</PlateSections>

Use the Application menu to import data in the .xml format.
To import data in .xml format:

1. Open orcreate a new protocol.
2. Define a Plate section into which to import the plate data. Name the Plate section with the
same name as the Plate section in the import file.

Teapan
$5iEa3

Click to display the Application menu.

4 ¥ . .
Click ke Import and select Ld XML Format to display the Open dialog.
Navigate to and select the file to import.
Click Opento import the data. The Plate sections display the data you import.
Save the file.

N O A~ W

After the data imports into the Plate sections, the Read Information area on the right indicates
that the data was imported and shows the time and date of the import. For the SoftMax Pro
Software - GxP edition, the Read Information includes the name of the user who imported the
data.
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Importing Legacy Documents

Import SoftMax Pro Software - Standard Edition Version 4 and 5 Documents

The SoftMax Pro Software - Standard edition version 7.1.x can open documents created by
version 4.0 or later. To open documents created in a version earlier than version 4.0, you must
first open the document in the SoftMax Pro Software 4.0 or later, and then save it as a version
4.0 or later document. The document must also meet instrument compatibility requirements.

To use a document from an earlier version of the SoftMax Pro Software, save the document
with a different name or in a different location after you open the document with the current
version.

After you open a document from an earlier version, review the document to make sure the
conversion went well. The document conversion might change instrument settings, curve fits,
or other items that have been updated for version 7.1.x.

Legacy documents have the following file extensions.

e pprfor SoftMax Pro Software - Standard edition version 4 and 5 protocols

e pda for SoftMax Pro Software - Standard edition version 4 and 5 data documents

e _eprforSoftMax Pro Software - GxP edition version 4 and 5 protocols

e _eda for SoftMax Pro Software - GxP edition version 4 and 5 data documents

e sprfor SoftMax Pro Software - Standard edition version 6 and 7 protocols.

e sda for SoftMax Pro Software - Standard edition version 6 and 7 data documents.

e sprx for SoftMax Pro Software - GxP edition version 6 and 7.0.x protocol files.

e sdaxfor SoftMax Pro Software - GxP edition version 6 and 7.0.x data documents.

e SoftMax Pro Software - GxP edition version 7.1.x protocols and data documents do not
display a file extension.

Import Documents Into the SoftMax Pro Software - GxP Edition Database

For SoftMax Pro Software - GxP edition version 7.1.x additional steps are required to import
earlier version documents into the database. Use the Import Legacy Files dialog to import
legacy protocols and data documents into the SoftMax Pro Software - GxP edition version 7.1.x
database. Documents in the SoftMax Pro Software - GxP edition version 7.1.x database do not
display file extensions.

When you log on to the SoftMax Pro Software - GxP edition, you select a Project. The Import
Legacy Files dialog displays only folders for that Project. To import documents into the folders
for a different Project, you must log out and then select the different Project when you log
back on.

% Note: You cannot edit the documents you import into the SoftMax Pro Software - GxP
edition version 7.1.x database. If you choose to do anything with the document after you
import it, you must open the document and use Save As to make a copy of the
document.
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& Import Legacy Files

Import @ Single File O Files in selected folder

File Type | SMP 6 & 7 GxP Data (*.sdax) & @
Selected Folder:
Files to be imported: Remove
0 items
Destination Folder:

[] Create copy if document exists in database

You can import up to 700 files perimport on a computer that meets the recommended
specifications.

To import legacy documents:

}::::
'3

¥ ¥
1. Click to display the Application menu, click e Import, and then select Import
Legacy Files to display the Import Legacy Files dialog.
2. Select anImport option:
e Select Single File to import one document.
e Select Filesin Selected Folder to import all the documents in the folder you select. If
you select this option an additional check box displays.
Select the Include Subfolders and Import Whole Folder Structure check boxto import
all documents in the folder you select plus all documents in any subordinate folders.
This copies the folder structure and all documents to the folder hierarchy for the
Project you selected whenyou logged in.
3. Click the File Type drop-down:
e Select SMP 4 & 5 Data (*.pda) to import SoftMax Pro Software - Standard edition
version 4 and 5 data documents.
e Select SMP 4 & 5 Protocol (*.ppr) to import SoftMax Pro Software - Standard edition
version 4 and 5 protocols.
e Select SMP 4 & 5 Data (*.eda) to import SoftMax Pro Software - GxP edition version 4
and 5 data documents.
e Select SMP 4 & 5 Protocol (*.epr) to import SoftMax Pro Software - GxP edition version
4 and 5 protocols.
e Select SMP 6 & 7 Data (*.sda) to import SoftMax Pro Software - Standard edition
version 6 and 7.0.x data documents.
e Select SMP 6 & 7 Protocol (*.spr) to import SoftMax Pro Software - GxP edition version
6 and 7.0.x protocols.
e Select SMP 6 & 7 Data (*.sdax) to import SoftMax Pro Software - GxP edition version 6
and 7.0.x data documents.
e Select SMP 6 & 7 Protocol Files (*.sprx) to import SoftMax Pro Software - GxP edition
version 6 and 7.0.x protocols.
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Next to the Selected Folder field, click Browse to display either the Open dialog or the
Select Folder dialog. The path displays in the Selected Folder field. The path and the file
name can have a maximum of 256 characters.

Navigate to and select the document or folderto import and click Open or Select Folder
to return to the Import Legacy Files dialog.

In the Files To Be Imported field, select the documents you do not want to import and
click Remove to remove the documents from the list.

Next to the Destination Folder field, click Browse to display the Select Folder for Import
dialog.

Select the folder into which to import the documents and click OK to return to the Import
Legacy Files dialog. The path displays in the Destination Folder field. The path and the file
name can have a maximum of 256 characters.

% Note: The path (including the file name) can have a maximum of 256 characters.
The file name (without the path) can have a maximum of 50 characters. The file
name cannot contain the following characters: . <>1:*?\/

Select the Create Copy if Document Exists in Database check box to create a new
document in the database if a document with the same name exists.

Clear the Create Copy if Document Exists in Database check box to prevent the software
from importing duplicate documents. The import does not overwrite a document.

Click Import to display the List of Files dialog that indicates the status of the import and list
of imported documents.

Click Close to finish the import.
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SoftMax Pro Options

Use the SoftMax Pro Options dialog to define application level preference options that affect
documents holistically.

2] SoftMax Pro Options P

Data Recovery Data Recovery i

Web Browser Save opened files for Data Recovery every 5 minutes

Plate Setup Helper
Plate Height Warning
Plate Eject After Read
Remote Control
Calculation

SpectraMax iDx Control

}:*‘:
2

Click to display the Application menu, and then click the Options button at the bottom of
the menu to display the SoftMax Pro Options dialog.

The SoftMax Pro Options dialog contains the following tabs along the left side:

e Data Recovery - The Save Opened Files For Data Recovery Every 5 Minutes check box is
selected by default. The software saves unsaved documents to a temporary file every five
minutes to assist with data recovery. If the software experiences an unexpected
interruption, when the software restarts, the Document Recovery dialog displays the list of
the documents that you can recover. Recovered documents save to C:\Users\<windows
user>\Documents\SMP<n.n.n>. You cannot turn this option off.

e Web Browser - Select the No Web Browser with 'What’'s New' Page is Opened on Startup
check boxto stop the display of the SoftMax Pro Insider page of the Molecular Devices
web site every time you start the software. This used to be the What's New tab that
appeared in previous versions of the software. When the computer has access to the
Internet, if you select this check box, you can still view the SoftMax Pro Insider page.

Select the Help tab, click 89 and then select What's New. See Help Tab on page 61.
Clear the No Web Browser with 'What’s New' Page is Opened on Startup check box to
display the SoftMax Pro Insider page every time you start the software.
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e Plate Setup Helper - Select the Disable Auto Opening of Helper On New Protocol check
boxto prevent the display of the Plate Setup Helper dialog when you open a new
document. See Plate Setup Helper on page 82.

Clear the Disable Auto Opening of Helper On New Protocol check box to display the
Plate Setup Helper dialog every time you open a new document if the computer has
access to the Internet.

¢ Plate Height Warning - Select the Disable Plate Height Warning on Protocol Run check
boxto prevent the display of the plate height warning when you start a read.

Clear the Disable Plate Height Warning on Protocol Run check box to have the plate
height warning message display as a reminder to correctly set the plate heightin order to
prevent damage to the FilterMax F3, FilterMax F5, SpectraMax i3, SpectraMax i3x,
SpectraMax iD3, SpectraMax iD5, and SpectraMax Paradigm. See Plate Editor on page 117.

e Plate Eject After Read - Select the Plate Remains Inside Instrument After Completion of
Read check box to have the plate drawer remain closed after a read completes.

Clear the Plate Remains Inside Instrument After Completion of Read check box to have
the plate drawer open after a read completes.

e Remote Control - Select the Enable Remote Control check box to enable the use of an
Apple mobile device to control the software. If you select this option, download the
SoftMax Pro Remote app from the Apple App Store. Verify that both the app and the
software use the same Port. Enter the Host Name or IP address of the computer into the
app settings.

Clear the Enable Remote Control check box to prevent the use of an Apple mobile device
from controlling the software.

e Calculation -

e Select the Calculate During Acquisition check box to have the software perform data
calculations of the kinetic data while a kinetic acquisition is in progress. In the
Calculate Every ____ Cyclesfield, enter the number of kinetic reads between
successive calculations. This option allows for the fact that calculations may take any
amount of time, depending on the complexity of the protocol and the speed of the
computer.

Clear the Calculate During Acquisition check box to not use this feature.

e Select the Legacy Rounding check boxto improve consistency with the SoftMax Pro
Software version 5. This introduces a small factor to force rounding upward.

Clear the Legacy Rounding check boxto not use this feature.

e SpectraMax iDx Control - When you use the SpectraMax iD3 and SpectraMaxiD5, select
the Enable Control of SpectraMax iDx Instruments check box to use the software to
connect to a specific IP address. If the Instrument Connection dialog does not detect the
instrument automatically, enter the IP address of the instrument. You can enter up to five
different IP addresses to connect the computer to multiple instruments on your network.
To find the instrument IP address, on the instrument touchscreen touch Maintenance >
System Information. See SpectraMax iD5 Multi-Mode Microplate Reader on page 323 and
SpectraMax iD3 Multi-Mode Microplate Reader on page 320.

Clear the Enable Control of SpectraMax iDx Instruments check box to not use this feature.
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Quick Access Toolbar
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The Quick Access toolbar provides a shortcut to the features in the Ribbon and in the

Application menu. The toolbar displays to the right of the ﬁ iconinthe upper-left corner of
the main window. You can change the content of the Quick Access toolbar and its location.

” "
- TR
M Customize Quick Access Toolbar

Show Below the Ribbon

de ! (=
é Temp: 35 ° Minimize the Ribbon

| SpectraMax ‘ Protocol

MSe (Simulated] Manag
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|:: Open / Close ‘

/" Untitled1 _,
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The Quick Access toolbar has the following icons by default.

° n - Click to create a new document. A new document tab displays above the
Workspace.

° = - Click to open a document. Use the Open dialog to navigate the folder hierarchy and
select a document.

° E - Click to save changes to a document. For a new document, the Save As dialog
displays to save the document.

° . - Click to rename a document, to save a protocol as a data document, to save a data
document as a protocol, to move a document to a different location, or to give a new
document a name.

l*l - Click to change the location of the Quick Access toolbar.
e Select Show Below the Ribbon to move the Quick Access toolbar below the Ribbon
above the Workspace.
e Select Show Above the Ribbon to move the Quick Access toolbar above the Ribbon.
e Select Minimize the Ribbon to not display the icons in the Ribbon. The Ribbon tab
names continue to display and you click the tab name to display the tab icons.
Clear the check box next to this option to display the icons in the Ribbon.

Customizing the Quick Access Toolbar
To add Ribbonicons and Application menu items to the Quick Access toolbar:

1. Inthe Ribbon orthe Application menu, right-click an icon and select Add to Quick Access
Toolbar.

2. Inthe Quick Access toolbar, right-click an icon and select Remove from Quick Access
Toolbar.

3. Whenyouright-click anicon in the Quick Access toolbar, the Application menu, orin the
Ribbon, you can move the location of the Quick Access toolbar and minimize/maximize
the Ribbon.
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The Ribbon contains tabs with icons that vary depending on the instrument you connect to the
computer and your context within the software. You can add the tools from the Ribbon to the
Quick Access Toolbar to expedite your workflows in the software.

Specrattax Poe | ortoco 3 || acqusivon || e d Append || Reduction  Display Tomplate Fipaste. ff Bport
Vie | (Simulated) DRopen/Ciose || tanager P we | TEoror
| | | | |

7 Untitied |

Document |Gomparison | Workilow

m—
@ (e«
l| o Standard
I et New Plate 4% o PP S S S U SN S P N e SV Y

Home Tab

The Home tab displays the following icons:

e Click t'% Instrument to connect the software to the instrument. Displays other instrument
information such as connection status and chambertemperature. See Selecting an
Instrument on page 63.

e Instrument Commands - Icons depend on the instrument you select.

e Click & Temperature to display the Temperature Control dialog where you set the
temperature of the plate chamber or cuvette chamber. See Temperature Control on
page 112.

e Click @ Shake and hold the mouse button to shake the plate. Release the mouse
button to stop the shake. This shake icon is independent of the shake settings in an
experiment. When you create an experiment, a separate workflow allows you to
define how to shake the plate as part of the experiment.

o Click |~15 Open/Close to open and close the instrument plate drawer. The software can
open and close other drawers for some instruments such as the drawers for the

FlexStation® 3 Multi-Mode Microplate Reader. Click =} Tips for the tip rack drawer or

click =+ Reagent for the compound plate drawer.

% Note: The O Info icon on the Operations tab provides access to the
Instrument Information dialog. Use the Instrument Information dialog to open
and close the cartridge drawers for the SpectraMax i3x and SpectraMax
Paradigm. Use this dialog to open and close the filter drawers for the FilterMax
F3 and FilterMax F5. See Instrument Information on page 341.

o Click @ Protocol Manager to display the list of protocols in the Protocol Library. The
Protocol Library contains over 160 protocols that contain instrument settings and formulas.
You can customize the protocols in the Protocol Library to facilitate the data analysis and
report creation.

e Click < Acquisition Settings to display the Settings dialog where you define instrument
settings for the read. See Acquisition Settings on page 110.

e Click I‘ ABS, 3-‘-""' FL, and 4 LUM to do a quick start absorbance, fluorescence, or
luminescence read using default settings. (Available for SpectraMax iD3 and
SpectraMaxiD5.)

e Controls and Status - Icons to start and stop a read.
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Click 'd." Read to read the Plate section or Cuvette Set section you selectin the
Navigation Tree.

]
% Note: Use the 5‘3 Auto Read icon on the Operations tab to read from multiple
Plate sections or Cuvette Set sections. As information is read, the Workspace
display the data.

Click ° Stop to stop the read. The read stops immediately. If you click Stop while the
plate is being read for a kinetic time point, the software completes the data collection
for that time point before the read stops.

% Note: If you stop a kinetic read before it completes, you cannot restart the read

or append data to the read. You must either let the read finish or click
Interrupt to pause the read.

For kinetic reads, click Interrupt to pause the read, and then click lJAppend to
continue the kinetic read from where it left off. When you interrupt a read, the
instrument finishes the read for all the wells you select in the plate and then waits for
your input before continuing. This type of discontinuous kinetic read helps with
acquisition development.

After a kinetic read ends successfully, click laAppend to read the same Plate section
again and append the data to the data that already exists in the Plate section.

e Whenyou select a section in the Navigation Tree, the Home tab displays section-specific
icons:

Notes Controls and Formatting Tools display when you select a Note section. See
Note Sections on page 75.

Plate Tools and Template Tools display when you select a Plate section. See Plate
Sections on page 80.

Cuvette Tools and Template Tool display when you select a Cuvette Set section. See
Cuvette Set Sections on page 83.

Column Tools, Summary Tools, and Formatting Tools display when you select a Group
section. See Group Sections on page 86.

Graph Type and Graph Tools display when you select a Graph section. See Graph
Sections on page 89.
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Protocols Tab
The Protocols tab displays the following icons:

® Protocol Manager - Icons to manage and access the Protocol Library.

7 -
e Click “* Folder Locations to manage the list of folders that display when you click ..E_F

Protocol Manager. See Protocol Library Folder Locations on page 62.

Click B Save As Default to overwrite the default protocol (default.spr) with the
protocol settings you define for the document that is open in the Workspace. When
you open a new document, the settings from the default protocol appearin the
Workspace. The default protocol settings help you get started when you create a new
document. When you install the software, the Basic Endpoint protocol is set as the
default protocol.

Note: When you save a document as the default protocol, the data you collect
in the current document remains unchanged. To keep the data, save the
document as a data document.

Click ..E_F Protocol Manager to display the list of protocols in the Protocol Library. The
Protocol Library contains over 160 protocols that contain instrument settings and
formulas. You can customize the protocols in the Protocol Library to facilitate the data
analysis and report creation.

e Community - Access to the SoftMax Pro Software Community web site.

e Click @ Protocol Home Page to display the SoftMax Pro Software Community web

site. Use the Community website to share protocols, exchange tips and tricks, and
network with other SoftMax Pro Software users. The computer must have access to
the Internet.

Click 'LJ Export for Sharing to export the protocol that is openin the Workspace to a
format that you can upload to the Protocol Home Page Community web site. The
export file contains no data and the first Note section becomes the protocol
description on the web site. The software encrypts the protocol and saves it with a
.spz extension. Do not rename the file because it will not upload properly. To upload

the protocol, click @ Protocol Home Page and follow the instructions on the SoftMax
Pro Software Community web site.
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View Tab
The View tab displays the following icons:
e Show/Hide Panel - Select the Navigation Tree check box to display the Navigation Tree in
the Workspace.
Clear the Navigation Tree check box to hide the Navigation Tree to provide more space
to view the content of the Workspace. See Navigation Tree on page 67.

e Window - Icons to change the layout of the Document tabs in the Workspace. See
Workspace on page 70.

e Click D Single Tab Group to display the data for a single Document tab in the
Workspace.

e Click El New Horizontal Tab Group to tile the content of the Document tabs
horizontally. The tab you select moves below inactive tabs in the Workspace. Content
resizes to accommodate the display for all documents you open in the Workspace.

e Click New Vertical Tab Group to tile the content of the Document tabs vertically.
The tab you select moves to the right of inactive tabs in the Workspace. Content
resizes to accommodate the display for all documents you open in the Workspace.

e Expand/Collapse Sections - Icons to change the amount of data that displays in each
section.

;i
o Click Collapse All Sections to display only the experiment names in the Navigation
Tree and only the section names in the Workspace.

e Click “* Expand All Sections to display all sections in each experiment in the
Navigation Tree and to expand the display of the section content in the Workspace.
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Operations Tab

The Operations tab displays the following icons:

¢ Instrument Tools - Icons that are specific to the instrument that you connect to the
computer.

Click a Calibration to air-calibrate the instrument for the absorbance read mode. The
instrument calibration values are stored in the instrument firmware. See Instrument
Calibration on page 339.

Click O Info to view instrument information such as the serial number and firmware
version. Displays the list of detection cartridges you install in the SpectraMax i3,
SpectraMaxi3x, and SpectraMax Paradigm. Displays the filters you install in the
FilterMax F3, FilterMax F5, and SpectraMax iD5. Use this to configure the excitation and
emission filter slides for the FilterMax F3 and FilterMax F5. See Instrument Information
on page 341.

Click g Filters to define the positions of the filters you install in the EMax® Endpoint
Microplate Reader and VMax® Kinetic Microplate Reader. See Configuring Filters for
the EMax, EMax Plus, and VMax Microplate Readers on page 307.

Click e Configure to adjust the intensity of the lamp for each of the filters you install
in the EMax® Plus Microplate Reader. You can view the positions and wavelengths of
the filters you install and other instrument information like the serial number and
firmware version. See Adjusting the Lamp on page 306.

Click % Initialize to return the EMax Plus plate carrier to its home position.

Click — Recover to restore the FlexStation 3 fluidics module to operating conditions
afteraread error.

Click | BN Air Gap to enter the FlexStation 3 pipette air gap which is the volume
between the end of the pipette tip and the bottom of the liquid in the tip.

Click Refresh to update the software for the detection cartridges you install in the
SpectraMax i3, SpectraMax i3x, and SpectraMax Paradigm and the filter slides you
install in the FilterMax F3 and FilterMax F5.

Click ‘? Wash Injectors to wash the injectors for the SpectraMax® L Luminescence
Microplate Reader.

Click ® Prime Injectors to prime the injectors for the SpectraMaxL.
Click ¢ Reverse Injectors to reverse the injectors for the SpectraMaxL.

==
Click & Injector Tubing to determine when to replace injector tubing for the
SpectraMax L.

Click o' Change Aperture to change the aperture from 96-well plates to 384-well
plates or from 384-well plates to 96-well plates for the SpectraMax L with a manual
aperture.

Click 4 Shake Settings to shake the plate for the SpectraMaxL.
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e Calculations - The software does continuous recalculation of the data when you read
plates, create or change formulas, or change settings that influence data. You may want to
disable recalculations to edit the protocol without waiting for recalculations to complete.
See Calculations and Numerical Precision on page 189.

e Click Pf? Suspend Calculations to disable automatic recalculation. While suspended,
no recalculation occurs regardless of what you change, add, or delete from the
experiment. Use this when you have a large complicated protocol and you want to
modify the formulas without waiting for recalculations to complete.

e Click f'“ﬁ Resume Calculations to use automatic recalculation.

e Click Fog Recalculate Now to recalculate all data one time. Use this when recalculation

is suspended to see the results of the changes you made without enabling continuous
recalculation.

e Click v Function Editor to display the Function Editor dialog where you create
custom curve fits for graphs. See Custom Curve Fit Settings on page 224.
Under certain circumstances, a calculation status message displays in the Workspace
footer. See Workspace on page 70.
e Calculating: Displays when the software calculates the formulas in an experiment and
when you click Recalculate Now.
e Calculating Suspended: Displays when you click Suspend Calculation.
e No message displays under other conditions.
e Automation - Icons to do multiple plate reads and for automation of the software.

] §
e Click 5* Auto Read to automatically read multiple Plate sections in the sequence in
which the Plate sections display in an experiment. See Using Auto Read on page 178.

) |
e Click == Plate Stacker when you use the StakMax Microplate Handling System that
uses the StakMax Software that is integrated in the SoftMax Pro Software. See
StakMax Microplate Handling System on page 336.

e Click wAutomation Mode to place the SoftMax Pro Software in automation mode.
See Automation Mode on page 17.
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GxP Tab (SoftMax Pro Software - GxP Edition)

The GxP tab is available when you use the SoftMax Pro Software - GxP edition (SoftMax Pro
Software - GxP Edition on page 243) and displays the following icons:

e User Account - Icons to manage user account information.

L]
e Click Account Information to display the User Account Information dialog where
you view information about the current user. See Account Information on page 249.

e Click (&4 User Log Off to log the current user off without closing the software.

e Click i\ User Lock Session to reactivate a user session after the session times out
due to inactivity.

L ]
e Click ' Change Password to display the Change Password dialog where you change
your password. See Changing Passwords on page 250.
e Data - Icons to track software usage.

¢
e Click «"r Statements to display the Statements dialog where you view, edit, add, and
sign statements. See GxP Statements on page 260.

o
e Click #% Audit Trail to display the Audit Trail dialog where you view activity related to
the document that is open in the Workspace. See Document Audit Trail on page 266.

e Click "=l Document Status to change the status of the document that is open in the
Workspace. See Document Status on page 259.

e Click D) Release Protocol to release a protocol for the next step in the document
workflow. See Releasing Protocols on page 259.
e |nstrument - Icons to enable and disable the touchscreen for the SpectraMax iD3 or
SpectraMax iD5. See SpectraMax iD3 Multi-Mode Microplate Reader on page 320 and
SpectraMax iD5 Multi-Mode Microplate Reader on page 323.

Workflow Tab

The Workflow tab is for use with the Workflow view of the Workspace (Defining and Running
Workflows on page 104) and displays the following icons:

e Execution-Iconsto “ Start, W Pause, ‘0' Resume, and u Cancel the workflow.
e Designer - Icons to manage the tasks in the workflow and to change the appearance of the
Workspace when you use the Workflow view.
e Click Undo, Redo, and Clear to undo, redo, or clear the tasks in the Workspace.
e Click Zoom In, Zoom Out, and Reset Zoom to change the appearance of the tasks in
Workspace.
e Click Fit To Screen to size the tasks so that the tasks all fit on one screen.
e Click Mini Map to display an Overview dialog that helps you navigate a long timeline.
e Click Save as Image to export animage of the timeline to a .jpg, .png, .gif, or .xps
format.
e Status - Displays the status of the workflow.

e Click “= Execution Log to display the Execution Log dialog where you view the status
of the tasks as the workflow runs in real time.
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Help Tab
The Help tab displays the following icons:
e Help

e Click g SoftMax Pro Help to view the application help.

e Click 53_'{}]‘: Formula Reference to view the SoftMax Pro Data Acquisition and Analysis
Software Formula Reference Guide. This document has four main sections:
e Introduction - Provides a general introduction to formulas.
e Operators - Describes the types of operators you use to assemble formulas.
® Functions - Describes the types of functions you use to assemble formulas.
e Accessors - Describes special functions and protocol settings that you include in
formulas.

e Click Release Notes to view the SoftMax Pro Data Acquisition and Analysis
Software Release Notes for this software release.

e [fthe computer has access to the Internet, click 8"‘ Contact Us to display a menu with
the following options:

e Select What's New to view information about what is new in the software. If you
miss the What's New tab that displayed in the Document Tabs in previous versions
of the software, you can view the information here.

e Select Home Page to view the Molecular Devices web site home page.

e Select Knowledge Base to view the Molecular Devices Knowledge Base.

e Select Request Support to access the Molecular Devices Support Request web
page.

o Click '3'7“ Software License to display the Software License Activation dialog where
you activate the software license. See Activating the Software License on page 10.
e Troubleshooting

e Click Iﬂ Diagnostics to turn on Diagnostics mode in order to record a read that
generates an instrument diagnostics log file. The log file contains information from the

connected instrument to help solve technical issues. Displays @ when you turn the
Diagnostics mode on and the Home tab displays Diagnostics Onin the Instrument
area. (Available for SpectraMax i3, SpectraMax i3x, SpectraMaxiD3, SpectraMax iD5 ,
and SpectraMax Paradigm.) See Instrument Diagnostics Mode on page 65.

e Click i_" Export to export the diagnostics log file after you record a read in
Diagnostics mode. This exports the log file to the computer hard drive orto a USB
drive so that you can send the file to Molecular Devices Support.

e About - Click 9 SoftMax Pro to view the software version number and release
information.
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Protocol Library Folder Locations

Use the Folder Locations dialog to manage the list of folders that appear in the Protocol
Library. The Protocol Manager provides access to protocols included with the software and

the protocols you store in the Protocol Library.

& Folder Locations
i — 4 — 3
Set Protocol Folder Locations
add |
CA\ProgramData\Molecular Devices),
o]

2L

5

Cancel

To manage the folders that display in the Protocol Library:

1. Inthe Ribbon, select the Protocols tab and click n_ﬁP Folder Locations to display the Folder

Locations dialog.
2. Click Add to display the Select Folder dialog.
3. To add afolderto the Protocol Library, either:
e Navigate to a folder and click Select Folder.

e Selectthe folderinto which to add a new folder, click New Folder, enter the folder

name, and then click OK.

4. To delete afolder from the Protocol Library, select the check box for each folder to

remove and click Remove.

% Note: The folder no longer displays in the Protocol Library but the folder and the

documents in the folder remain in the database.

5. Click OK.
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Selecting an Instrument

Use the Instrument Connection dialog to connect the SoftMax Pro Software to the microplate
reader. See the instrument user guide for instructions to connect the cables between the
computer and the instrument. See Supported Instruments on page 305.

% Note: You can use the software without a physical connection between the computer
and the instrument in Offline mode to do data analysis or in Simulator mode to create

protocols.
rﬁ Instrument Connection _— Mw
Select the instrument to connect to. @
Ayailable Instruments @
Offline

COM1: SpectraMax M3

Reader  |spectrahaxMs -

|:| Simulator On

ok || Ccancel

LS o

To select aninstrument:

1. Power onthe instrument and wait for the instrument initialization process to complete.
2. Inthe Ribbon, select the Home tab and click Instrument to display the Instrument
Connection dialog.
3. Ifthe instrument does not appear in the Available Instruments list, click Refresh.
4. Inthe Available Instruments list:
e Selectthe communication port to which you connect the instrument.
e To work offline for data analysis, select Offline, then click the Reader drop-down and
select aninstrument.
e To work in simulator mode to create protocols, select Offline, click the Reader drop-
down and select an instrument, then select the Simulator On check box.
5. Click OK. The Home tab displays an icon for the instrument you select.

% Note: The  iconis fortroubleshooting purposes only.
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Instrument Connection Status

In the Ribbon, on the Home tab, the instrument icon indicates the status of the connection
between the computer and the instrument. If the status indicates the instrument is
disconnected, make sure that the instrument is powered on and that the cables between the
computer and the instrument are secure.

Eg- Instrument connected
% - Instrument disconnected

% - Instrument in Simulator mode

Instrument Calibration

You should calibrate some instruments before use. See Instrument Calibration on page 339.

SpectraMax Paradigm Considerations

When you first setup the SpectraMax Paradigm, you must remove hardware transport locks as
described inthe SpectraMax Paradigm Multi-Mode Microplate Reader User Guide. As a safety
precaution, the SoftMax Pro Software controls internal locks to prevent the drawers from
opening until the software detects and initializes the instrument. See Removing Software
Locks on page 332.

SpectraMaxiD3 and SpectraMaxiD5 Considerations

When you use the SoftMax Pro Software to operate the SpectraMaxiD3 or SpectraMax iD5,
your company network configuration could prevent the connection between the computer
and the instrument.

You can use the Ethernet cable to connect the computer directly to the instrument or you can
connect the computer to the instrument via your company intranet. See SpectraMax iD3 Multi-
Mode Microplate Reader on page 320 and SpectraMax iD5 Multi-Mode Microplate Reader on
page 323.

You may have to do the following to select the SpectraMaxiD3 and SpectraMax iD5:

1. Onthe SpectraMax iD3 and SpectraMax iD5 instrument touchscreen, navigate to the
Maintenance page System Information tab and note the instrument IP address.

g

2. Inthe SoftMax Pro Software, click to open the Application menu and then click the
Options button to display the SoftMax Pro Options dialog.

3. Selectthe SpectraMax iDx Control tab on the left.

4. Selectthe Enable Control of SpectraMax iDx Instruments check box.

5. Inone of the text fields, enter the IP address of the instrument. There are five fields to
enter up to five IP addresses.

6. Click OK.

7. Selectthe Home tab and click Instrument to display the Instrument Connection dialog.
8. Click Refresh if needed and the SpectraMax iD3 and SpectraMax iD5 instruments should
appear. If the instrument does not appear, you may have to work with your company
network administrator to confirm that your company network configuration permits the

communication between the computer and the instrument.

When you use a computer running the SoftMax Pro Software to operate the instrument, the
instrument touchscreen is locked.
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For users that use the SoftMax Pro Software - GxP edition to operate the instrument, the user
must have the Lock/Unlock Instrument permission to use the following icons to lock and unlock
the instrument touchscreen:

e Click 'LanP Mode On to lock the instrument touchscreen and operate the instrument

from the computer running the SoftMax Pro Software in GxP mode. This locks the
instrument touchscreen for all users and you must operate the instrument from a computer
running the SoftMax Pro Software - GxP edition.

Click ngP Mode Off to release the lock from the instrument touchscreen and allow
users to use the instrument touchscreen to run experiments.

% Note: The instrument remains locked until the user with the appropriate permission

clicks f"JGXP Mode Off to stop the GxP mode. You cannot use the Instrument
Connection dialog to disconnect from an instrument that is locked in GxP mode.

Instrument Diagnhostics Mode

For the SpectraMax i3, SpectraMax i3x, SpectraMax iD3, SpectraMax iD5, and SpectraMax

Paradigm, the Help tab contains a @ Diagnostics icon that you use to turn on the Diagnostics
mode. In Diagnostics mode, you run a read that generates an instrument diagnostics log file.
The log file contains information that helps you and Technical Support resolve instrument
issues.

To generate an instrument diagnostics log file:

1.

© 0N O Ok wN

10.

1.
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Connect the software to a SpectraMax i3, SpectraMax i3x, SpectraMax iD3, SpectraMax
iD5, or SpectraMax Paradigm.

Select the Help tab and click @ Diagnostics. The icon changes to @ Diagnostics On.
Click OK in the confirmation message dialog.

Select the Home tab and note that Diagnostics On displays in the Instrument area.
Open adocument and select a Plate section.

Click 'd Read to read the Plate section.

Select the Help tab and click @ Diagnostics On. The icon changes to @ Diagnostics.
Click OK on the confirmation message dialog.

Click i_”‘ Export to export the instrument diagnostics log file that contains the diagnostic
information to the computer hard drive or a USB drive. You can then send the file to
Molecular Devices Support.

In the Save As dialog, navigate to the location where you want to save the log file and in
the File Name field, enter the name of the log file.

Click Save.
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Each tab between the Ribbon and the Workspace is a protocol or data document. The
Untitled1 tab displays the default protocol when you log on for the first time to help you create
your first document. Depending on your View tab settings, as you use the software to define
additional documents, each document appears as a tab above the Workspace to the left of
the Untitled1 tab.

% Note: For the SoftMax Pro Software - GxP edition, no document tabs display and the
Workspace area is empty. Your permissions determine which actions you can perform.
See SoftMax Pro Software - GxP Edition on page 243.

\Document, Comparison | Workflow

Navigation Tree. (=X

I New Experiment (5 New Pate

b - - |

Select a tab to display the contents of the document in the Workspace.

* Tip: If you miss the What's New tab from previous versions of the software, the Help tab
on the Ribbon provides access to the Molecular Devices What's New web page. See
Help Tab on page 61.

b
The Application menu provides access to the SoftMax Pro Options dialog where

you can choose to display the What's New information every time you start the software
if the computer has access to the Internet. See SoftMax Pro Options on page 51.
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Navigation Tree

The Navigation Tree displays section controls, the list of experiments in the open document
and the sections in each experiment. The Navigation Tree displays to the left of the
Workspace when you use the Document view and the Comparison view fora document. The
Workflow view displays icons you can drag into the Workspace. See Workspace on page 70.

trandax .
:.p»;’:'.ﬁ::v (:iimuh':lted] . H e

/% Untitled1
_ Comparison | | Workflow

Navigation Tree ‘? d‘.@ £

B New Experiment [ New Plate

&New Note L(; MNew Graph
¥ Delete Selection [[|| New Cuvette Set

4 B Basic Endpoint
j. Intro

4 I expt1
Platel
fﬁ Standards
J_| Control
fﬁ Unknowns

[ standard curve

-

The following icons appear above the Navigation Tree:

.
° fl - Forthe SoftMax Pro Software - GxP edition, select a section and click to lock the

i

.
section and prevent edits. Sections that are locked display " . Click £-rl again to unlock
the section. See SoftMax Pro Software - GxP Edition on page 243.

° b—@ Select a section and click to prevent the section from appearing in the printed

version of the document. Sections that do not print display b—Q Cl|ckb-Q again to have
the section appearin the printed versions of the document. To prevent or allow printing of
all the sections in an experiment, select the experiment in the Navigation Tree and click

]
U—Q, You can override this setting from the ﬂ Application menu when you print the
contents of the document.

e £ _Clickto hide the Navigation Tree and increase the Workspace area display. In the
Ribbon, use the View tab to hide the Navigation Tree.
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Section Controls

Use the controls in the Navigation Tree to manage the experiments in the document and to
manage the sections in the experiments. Sections include Note, Plate, Graph, and Cuvette Set.
Experiments can also contain Group sections. A Group section contains a group of plate wells
and related formulas. You create Group sections when you configure Plate sections and
Cuvette Set sections from the Template Editor dialog. See Template Editor on page 90.

% Note: If you add an experiment or section to the wrong location in the Navigation Tree,
drag and drop experiments within the hierarchy and drag and drop sections within an
experiment.

To manage experiments:
1. Above the Workspace, select a Document tab. The experiments and the sections in the
document display in the Navigation Tree.
2. To add an experiment to the document, select the experiment that most closely

resembles the experiment to create and click B New Experiment. A duplicate of the
experiment you select displays below the experiment. The software duplicates the
sections and settings but does not duplicate the data.

3. To add a Note section, Plate section, or Cuvette Set section to an experiment, select the
section that most closely resembles the section to create. The software adds the new
section below the section you select.

o Click & New Note to add a Note section. See Note Sections on page 75.
e Click New Plate to add a Plate section. See Plate Sections on page 80.

e Click El New Cuvette Set to add a Cuvette Set section. See Cuvette Set Sections on
page 83.

4. To add a Graph section, click Lﬂ New Graph to display the New Graph dialog. Set the
options for the graph. See Graphing Data on page 210. Click OK. The Graph section
displays below the section you select. See Graph Sections on page 89.

5. To delete a section, select the section or sections to delete (Ctrl+click to multi-select) or

|
select an experiment to delete an entire experiment, then click |§ Delete Selection.

% Note: You cannot undo the deletion. When you delete a Plate section, the software
also deletes the data from the Plate section.

6. To change the sequence of the sections in an experiment, drag the section name and
drop it elsewhere in the Navigation Tree. You can move the sections within an experiment.
You cannot move sections between experiments.

7. Select asectionto display the section content in the Workspace.
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Renaming, Duplicating, Deleting Experiments and Sections

Right-click an experiment or a section to Rename, Duplicate, or Delete the experiment or
section.
e Whenyou duplicate an experiment, the software duplicates all sections in the experiment
to a new experiment, without data.
e Whenyou duplicate a Note section or a Graph section, the software creates a new section
with the contents of the source section.
e Whenyou duplicate a Group section, the software creates a new Group section with the
same properties as the source section.
e Whenyou duplicate a Plate section, the software creates a new Plate section with the
settings from the source Plate section, without data.
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The Workspace appears below the Ribbon. The Document tabs above the Workspace list the

documents you have open. You open and save documents from the Quick Access toolbar and
from the Application Menu.

In the Ribbon, use the View tab to split the Workspace to view multiple documents at the same

time. See View Tab on page 57.
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Use the three buttons below the Document tabs to change the Workspace view. Use each
Workspace view to manage the open document and experiment results.

e Use the Document view to scroll through the experiment sections.

e Use the Comparison view to drag sections from the Navigation Tree and arrange them in
the Workspace wherever you want.

e Use the Workflow view to manage complex experiments that include repeated tasks and
multitask kinetic reads.

The left side of the Workspace is the Navigation Tree that displays the experiments in the
open document. Each document can contain a virtually unlimited number of experiments. Each
experiment can contain a virtually unlimited number of Note, Plate, Cuvette Set, Group, and
Graph sections.

The Navigation Tree for the Document view and Comparison view displays section controls
and a list of the experiment sections. See Workspace Sections on page 73.

After you use the Document view or the Comparison view to define the experiments, the
Workflow view contains icons that you drag into the Workspace to define an experiment
workflow that can include delays and repeated cycles for more complex experiments.

Drag the slider on the bottom right to zoom the focus of the Workspace in or out.
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Workspace Views

Document View

Use the Document view scrollable area to view the experiments and sections in the open
document. The Document view displays by default. Click the Document button above the
Navigation Tree, if needed.
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To view a section either click the section in the Navigation Tree or use the scroll bar on the
right until the section comes into view.
Comparison View

Use the Comparison view to move the sections to the positions where the sections are most
useful. To use the Comparison view, click the Comparison button above the Navigation Tree.
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Drag sections from the Navigation Tree into the Workspace. Sections can overlap. Double-
click a section to add the section to the bottom of the list of sections in the Workspace.
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Workflow View

After you define the experiment in the Document view or the Comparison view, use the
Workflow view to drag-and-drop tasks into the Workspace to create a timeline for a multi-task
document that can involve several experiments with multiple reads. Define the experiments
with all applicable sections from the Document view and then use the Workflow view to create
the workflow that uses the experiments and Plate sections to run more complicated assays
such as multitask kinetic reads that last hours or days. When you click the Workflow button
above the Navigation Tree, the Ribbon automatically displays the Workflow tab. See Defining
and Running Workflows on page 104.

SoftMax Pro

UoHRN -
i
il jome _ Protacols

4 Untitled?
S

4 Operations

(£ Read

o
K Cree Begin & = (> D Qo S End
Set Temperature Cycle Read Delay Read
Incubator:On Cycles:1 Plate:Plate1 00:00:00 Plate:Plate1
Pate Chamber Set oint25°C  Total RinTme:000000  ExperimentiExptt Bxperiment Bxptt
Wait: On Cycle Interval: 00:00:00

To create a workflow:

e Drag tasks from the menu on the left to the timeline on the right.
e To define repeated tasks, place the tasks in a Cycle task.
e |nthe Ribbon, use the Workflow tab to start, pause, resume, and cancel the workflow.
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Workspace Sections

Use the Workspace to manage documents. Each document can contain a virtually unlimited
number of experiments. The Navigation Tree displays the experiments and experiment
sections in the document.

tramlax
pr,:q E:EW (:iimuh':lted] '

H o PN

_ Comparison | | Workflow

Navigation Tree ? ﬂ‘_@ £

3
4

B New Experiment [Ei] New Plate

&_New Note [/ New Graph

¥ Delete Selection [[|| New Cuvette Set

4 B Basic Endpoint
j. Intro

4 I expt1
Platel
fﬁ Standards

J_| Caontrol
fﬁ Unknowns
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Experiments

B Experiments are an organizational tool within the document to maintain separate data sets.
Each experiment can contain a virtually unlimited number of sections. Use sections to
document what the experiment is designed to accomplish, define instrument settings, define
analytical formulas, and define the presentation of the data that the software collects.

Sections in Experiments

Each experiment is made up of Note sections, Plate sections, Cuvette Set sections, Group
sections, and Graph sections. You can create and edit sections at any point in the data
collection process: before you collect data, to adjust how you collect data, and to manage the
presentation of the data you collect. Links in the following list take you to the description of the
settings for each section. The SoftMax Pro Software - GxP edition allows you to lock each
section to restrict changes. See Locking and Unlocking Sections on page 248.

° & Note - Use Note sections to enter text and report summary information to the
experiment. Note sections can contain text, Summary formulas, images such as your
company logo, and images of the other sections in the document. See Note Sections on
page 75.
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° Plate - Use Plate sections to define plate settings and instrument settings to collect
data from the instrument. Use plate settings to define the data display and data reduction.
Each Plate section can have unique instrument settings to run different types of reads
within the experiment. See Plate Sections on page 80.

° B Cuvette Set - Use Cuvette Set sections to define instrument settings to collect data
from a cuvette port. Each Cuvette Set section can have unique instrument settings to run
different types of reads. See Cuvette Set Sections on page 83.

° |_1 Group - Use Group sections to combine the data from wells in a plate or several
cuvettes into groups. You create Group sections in the Template Editor dialog when you
work with Plate sections and Cuvette Set sections. See Group Sections on page 86.

° LC. Graph - Use Graph sections to define the graphical presentation of the data the
software collects as scatter plot graphs or bar graphs. See Graph Sections on page 89.

Managing Experiments

Use the & New Experiment icon in the Navigation Tree to add an experiment to a document.
To add an experiment:

1. Inthe Navigation Tree, select an experiment that is similar to the one you want to add.

2. Click B New Experiment.

A duplicate of the experiment displays below the experiment you select. The software
duplicates the sections and settings, but not the data. Drag it to a different location in the
hierarchy, if needed.
Right-click the experiment:
e Select Rename to change the name of the experiment. Use the Rename Section dialog to
enter a new name for the experiment.
e Select Duplicate to copy the experiment.
e Select Delete to delete the experiment. The software deletes all sections and all data in
the experiment.
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Note Sections

Use Note sections to enter text and data analysis formulas for an experiment. A Note section
can contain text, images, and Summary formulas. Summary formulas can be part of a Note
section or Group section to generate analysis data, text, or user-entered constants such as
certificate values. See Formulas on page 100.

Managing Note Sections

Use the & New Note iconin the Navigation Tree to add a Note section to an experiment.
To add a Note section:
1. Inthe Navigation Tree, select the section above where you want to add a Note section.

2. Click & New Note.

A new blank Note section displays below the section you select. Drag it to a different location
in the hierarchy, if needed.

Right-click the Note section:

e Select Rename to change the name of the Note section. The Rename Section dialog
displays where you to enter a new name for the Note section.
e Select Duplicate to copy the Note section.
e Select Delete to delete the Note section.
When you select a Note section in the Navigation Tree, the Note section content displays in
the Workspace and the section toolbar contains the following icons:

&
e 1N _Click to add a formula from the Formula Editor dialog. See Formula Editor on page
101.

e ™ -Click to add an image from the computer file system. See Managing Images on page
78.

° U;] Click to add an image of a section in the experiment. See Managing Section Images
on page 78.

° g . Click to show or hide the formula in a Summary formula frame. Summary Formula
Tools on page 77.

° @ - Click to refresh the data in a section image.
The Home tab provides:
¢ Note Controls - Contains the icons described above plusicons to —7] Copy, @ Paste, [2'

Delete, and |ﬁ| Edit Summary formulas.
e Formatting Tools - Contains icons to manage text in the frames and the placement of
frames in the section. See Formatting Text in Section Frames on page 79.
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Frames

Everything in a Note section is contained in frames. When you click in the blank area of a Note
section in the Workspace, a new frame appears. You can add as many frames as you need. A
frame has a header bar and an outline. When you click into a frame to make it active, the frame
header bar and outline display. Use Ctrl+click to make multiple frames active within a Note
section.

1. Click in a blank area of the Note section to create a new frame.

% Note: You must place each image in its own frame and the frame cannot contain
text.

To entertext, click into a frame and start typing. Use the Home tab Formatting Tools to

format the text within the frame.

To add animage, click into an empty frame and use the icons in the Note section toolbar

or on the Home tab.

e To resize a frame, hoverthe cursor over the frame side border to display a two arrow head
cursor, then drag the border to change the size.

e To move aframe, hover the cursor over the frame header bar to display a four arrow head

cursor, then drag the frame to the new location.

To align frames, the Home tab Formatting Tools section and the frame header right-click

menu provide the following icons/options (Ctrl+click to multi-select):

e Click “"- to align a single frame to the left edge of the Note section or align the left
edges of multiple frames to the left-most frame.

e Click -"Il to align a single frame to the right edge of the Note section or align the right

edges of multiple frames to the right-most frame.
—_—

e Click T to align a single frame to the top edge of the Note section or align the top
edges of multiple frames to the top-most frame.

o Click é to align a single frame to the bottom edge of the Note section or align the
bottom edges of multiple frames to the bottom-most frame.
e To copy aframe:
e Right-click a frame and select Copy then right-click in a Note section and select Paste.
e Select the frame in the Note section, select the Home tab and click Copy in the Note
Controls then click in a Note section and click Paste on the Home tab.
e To delete aframe:
e Right-click on the frame header and select Delete.
e Select the frame in the Note section, select the Home tab and click Delete in the Note
Controls.
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Managing Text

You manage the text in each frame the same way most text processing software applications
allow you to manage text. The Home tab provides Formatting Tools to format text.

Within a frame, select the text to manage:

e Right-click and select Cut to move the text to the clipboard.

e Right-click and select Copy to copy the text to the clipboard.

e Right-click and select Paste to paste the cut or copied text to the new location.
e Pressthe Delete key to delete the text.

Summary Formula Tools

Use formulas to automate data analysis for results reports. Summary formulas typically reduce
data to a single value or array. Use the Formula Editor dialog to manage the Summary formulas
in Note sections.

o
Fora complete guide to formulas and their use, select the Help tab and click 3;'}] Formula
Reference.

+ +
e To create a new Summary formula, click #% in the Note section toolbar or click ™ New
Summary on the Home tab.
e To edit a Summary formula, double-click in a frame that contains a formula or click a frame

and click |ﬁ| Edit Summary on the Home tab.
e To copy a Summary formula to the clipboard, click a frame that contains a formula and

click J] Copy on the Home tab.
e To paste the Summary formula to a new location, click where you want to paste the

formula and click ﬁﬁ Paste on the Home tab.
e To delete a Summary formula, click a frame that contains a formula (Ctrl+click to multi-

select) and click E] Delete on the Home tab.

By default, Summary formulas in the Note section display the result of the formula without
displaying the actual formula. You can show or hide the formula with the result.

o . .1 .
e Click * "% inthe sectiontoolbar orclick = “* Show Formulas on the Home tab to display all
formulas in the Note section.

e Click f¢§ in the section toolbar or click ﬁﬁ Hide Formulas on the Home tab to hide all
formulas in the section.
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Managing Images
There are two types of images you can insert into a Note section. You can insert an image from
your computer file system such as a company logo and you can insert an image of another
section in the experiment.

To insert animage from your computer file system:

1.
2.

4.
5.

In the Navigation Tree, select a Note section.
Click in a blank area of the Note section to create a new frame.

% Note: You must place each image in its own frame and the frame cannot contain
text.

Click ™ in the Note section toolbar or click ™ Add Image on the Home tab to display the
Open dialog. You can also right-click in a Note section and select Add Image.
Navigate to and select the image to insert.

Click Opento display the image in the Note section.

To delete animage:

e Right-click on the frame header and select Delete.
e |nthe Note section, select the frame. In the Ribbon, select the Home tab. In the Note

Controls, click BI Delete.

Managing Section Images

A sectionimage is a dynamic copy of an entire section you add to a Note section. As you
make changes to the section, the image of that section also updates in the Note section.

To manage section images:

1.
2.

5.

In the Navigation Tree, select a Note section.
Click in a blank area of the Note section to create a new frame.

% Note: You must place each image in its own frame and the frame cannot contain
text.

Click ﬂ in the Note section toolbar or click uAdd Section Image on the Home tab to
display the Add Section Image dialog. You can also right-click in the Note section and
select Add Section Image.

In the list of sections, select the option next to the section to display as animage in the
Note section.

Click Add Section Image to display the section image in the Note section.

To delete a sectionimage, select the section image to delete, right-click and select Delete.

&

Note: When you delete a section from the document, the software also deletes images
of the section from the Note sections. When you delete an experiment from the
document, the software deletes the images of the sections in the experiment from the
remaining Note sections.
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Refreshing Section Images

To refresh the sectionimages in a Note section, click @ in the Note section toolbar.

All the sectionimages in the Note section update to their current state.

Forexample, if you insert an image of a Graph section and then make changes to the
graph section, the Graph section image in the Note section refreshes.

% Note: Section images automatically refresh when you open the document, scroll up and
down, switch between Document and Comparison views, or start to print or print
preview the document.

Formatting Text in Section Frames

The Home tab provides Formatting Tools to format the text you select in a text frame in a Note
section or a Group section. The Formatting Tools are similar to the format tools in most word
processing software applications.

To format text:
1. Inthe Navigation Tree, select a Note section ora Group section.
2. Select the text in the frame that you want to format.

3. Use the following, as needed:

e Selectafonttype =" v

e Selectafontsize =
o Click X to make text subscript.

e Click X" to make text superscript.
e Click “ to undo the previous action.

e Click ™ to redo the previous action.

e Click B to make text bold.

e Click I to make textitalic.

e Click U to underline text.

e C(Click i=to create an unordered bulleted list.
To add a blank line between lines of bulleted text, click at the end of a line and then
press Shift+Enter.

e Click i= to create an ordered numbered list.
To add a blank line between lines of numbered text, click at the end of a line and then
press Shift+Enter.

e Click @to change the font color.

e Click = to align the line to the left edge.
e Click = to center the line.
e Click =to align the text to the right edge.

e Click = to left and right justify the text.
e Click #£to out dent an indented text.
e Click *=to indent the selected text.

—_—
e Click [I"-, -"ll, t ,and é.. to align the frames within the section. See Note Sections
on page 75.
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Plate Sections

Use Plate sections to define plate related instrument settings, data reduction settings, and data
display settings. When you want to read the same physical plate twice with different instrument
settings you create two Plate sections in the experiment. You can create as many Plate
sections as you need. Use Auto Read to read multiple plate sections. See Using Auto Read on
page 178.

Plate sections contain a grid that represents the wells in the plate you select, instrument
Settings Information to the right of the grid, and Reduction Settings below the grid. If colors
appearin the plate grid, the Plate section contains templates. You assign each group in the
template a different color and the Group section table displays the corresponding color. After
a read, Read Information displays below the instrument Settings Information on the right.

Managing Plate Sections

Use the New Plate icon in the Navigation Tree to add a Plate section to an experiment.
To add a Plate section:

1. Inthe Navigation Tree, select the section in the experiment above where you want to add
a Plate section.

2. Click New Plate.

A new blank Plate section displays below the section you select. Drag it to a different location
in the hierarchy, if needed.
Right-click the Plate section:
e Select Rename to change the name of the Plate section. Use the Rename Section dialog
to enter a new name for the section.
e Select Duplicate to copy the Plate section. When you duplicate a Plate section, the new
Plate section contains all the settings from the original Plate section, without data.
e Select Delete to delete the Plate section.
When you select a Plate section in the Navigation Tree, the Plate section settings display in the
Workspace and the section toolbar displays the following icons:

o & _Clickto display the Plate Setup Helper dialog that contains most of the following
icons plus the ability to select a different instrument to do the read. See Plate Setup
Helper on page 82.

o W Click to display the Settings dialog where you configure the acquisition settings such
as read mode, read type, wavelengths, plate type, read area, etc. Also displays in the
Settings Information area to the right of the grid. See Acquisition Settings on page 110.

° LA Click to display the Template Editor dialog where you assign wells in the plate to
groups and create templates and Group sections. See Template Editor on page 90.

L, o |

e i4-Clickto display the Data Reduction dialog where you choose data reduction settings
for analysis. Also displays in the Reduction Settings area below the grid. See Data
Reduction on page 191.

° @ - Click to display the Display Options dialog where you choose options for how to
display results. See Data Display Options on page 202.

° _B Click to mask a cuvette. See Masking Wells or Cuvettes on page 207.

° l:l - Click to zoom. See Zooming Well and Cuvette Display on page 208.
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° o Click to display reduced data in a three dimensional graph. See Viewing Data in 3D
Graphs on page 231.

° U - Click to start the read after you define all settings for the plate. Icon is located in the
Settings Information area to the right of the grid, bottom right corner. See Collecting Data
on page 109.

The Home tab provides:

o
e Plate Tools - Contains the icons described above plus a & Clone Plate iconto clone a
plate in the Plate section.

e Template Tools - Contains the "4 Template Editor icon described above plus icons to

:1] Copy, @ Paste, L% Import, and L.? Export template data. See Template Tools on
page 92.

Cloning Plates

Use plate clones to apply multiple templates and reductions to the same set of raw data. You
can add as many plate clones as needed to the Plate section. Plate clones display in tabs at
the top of the Plate section. The first tab on the left is the original plate. Each plate clone tab
displays the original plate name followed by the number of the clone.

Exptl Platel » <& @ = = i

Platel Platel-1 X Platel-2 X
Platel-2
1 2 3 4 5 6 7 8 9 10
N N PR MY = T P T Lrp_._l..t W

To clone a plate:
1. Inthe Navigation Tree, select the Plate section that contains the plate to clone.

2. Selectthe Home tab and click:-T’ Clone Plate in the Plate Tools. The Plate section
displays the plate clone as a tab next to the original plate name.

3. Click the tab for the plate clone to make the plate clone active in the section.

4. To delete a plate clone, click the X in the clone tab.

Copying Plate Data

You can copy plate data from one Plate section to a different Plate section within the same
document or between different documents. The format of the source plate data must match

the format of the target Plate section. The Clone Plate feature is the most efficient way to copy

plate data between Plate sections in the same document.

You can paste endpoint plate data that you copy from an external program, such as a
spreadsheet or text editor when the format of the data from the external program exactly
matches the format of the target Plate section.

Note: You can paste only endpoint data and the data is limited to one wavelength.
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To copy plate data:

1. Inthe Navigation Tree, select the source Plate section.

2. To copy all data from the entire plate, hover the cursor over the plate grid in the
Workspace, right-click and select Copy.

3. Inthe Navigation Tree, select the destination Plate section.

4. Hoverthe cursor overthe plate grid in the Workspace, right-click and select Paste Plate
Data.
If you paste data from an external program, click Paste Data.

5. When you paste over existing data, click Yes on the confirmation message.
If the format of the data does not match the format of the target plate, a message displays
and data does not paste.

The Read Information on the right indicates that the data was pasted and shows the time and

date of the paste.

Plate Section Data Display

Plate section settings depend on the plate type you select and the actual collection of data.
After you define the Plate section settings and the instrument reads the plate data, the section
displays the results of the read. The precision of the data display depends on the available
screen space. The values that display are a representation of the data. The software rounds
the last digit that displays based on the actual data value. You can customize the data display
to Numeric notation or Scientific notation format and specify the number of significant figures
or decimal places. You can set these options separately for raw data and reduced data. See
Collecting Data on page 109.

Plate Setup Helper

Use the Plate Setup Helper dialog to setup a plate to acquire data. This dialog is useful when
you first learn the software because it walks you through each step to create a Plate sectionin
sequence. However, eachiconis duplicated in the Plate section toolbar and/or on the Home
tab.

r
| #

Configure: Platel @

Current Instrument: SpectraMax Paradigm

I ]
l,?| Choose a different instrument

-S.t Configure your acquisition settings

Configure your plate layout

Choose data analysis settings

=
=

Choose your display settings

[ ] Do not open this Helper with new protocols
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When you first start using the software and you select a Document tab above the Workspace,

the Plate Setup Helper appears. Click 7 in the Plate section toolbar to display the Plate Setup
Helper.

The Configure caption displays the name of the plate.
The Current Instrument caption displays the instrument to do the read.

° [i] - Click to display the Instrument Connection dialog where you select the instrument to
do the read. The iconimage changes to reflect the instrument you select and the icon
displays the connection status between the software and the instrument. After you select
the instrument, you can click any of the following icons in any sequence. The following are
instrument specific and are reset if you change the instrument. See Selecting an Instrument
on page 63.

° &| - Click to display the Settings dialog where you define acquisition settings such as
read mode, read type, wavelengths, etc. See Acquisition Settings on page 110.

° |£| - Click to display the Template Editor dialog where you assign wells in the plate to
Group sections and to create templates. See Template Editor on page 90.

° £| - Click to display the Data Reduction dialog where you define data reduction settings
for analysis. See Data Reduction on page 191.

° E| - Click to display the Display Options dialog where you define how to display results.
See Data Display Options on page 202.

Select the Do Not Open This Helper With New Protocols check box to prevent the display of
the Plate Setup Helper dialog each time you open a new document. The SoftMax Pro Options
dialog has a setting to make the dialog display each time if you change your mind. See
SoftMax Pro Options on page 51.

Cuvette Set Sections

Use Cuvette Set sections to define cuvette related instrument settings, data reduction
settings, and data display settings from instruments that have a cuvette port. You can create as
many Cuvette Set sections as you need and each Cuvette Set section can contain up to 96
cuvettes. Cuvettes are read one at a time.

Cuvette Set sections contain a cuvette data display, instrument Settings Information on the
right, and Reduction Settings below the data display. The software numbers the cuvettesin a
Cuvette Set section as if the cuvettes were wells in a plate. The first 12 cuvettes are numbers
A1through A12, and then the next cuvette is number B1. This representation matches the
software data analysis capabilities. If colors appear in the cuvette data display, the Cuvette Set
section contains templates. You assign each group in the template a different color and the
Group section table displays the corresponding color. After a read, Read Information displays
below the instrument Settings Information on the right.
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Managing Cuvette Set Sections

Use the El New Cuvette Seticon in the Navigation Tree to add a Cuvette Set sectionto an
experiment.

To add a Cuvette Set section:
1. Inthe Navigation Tree, select the section in the experiment above where you want to add
a Cuvette Set section.
2. Click El New Cuvette Set.

A new blank Cuvette Set section displays below the section you select. Drag it to a different
location in the hierarchy, if needed.

Note: When you create a Cuvette Set section with an existing Cuvette Set section
active in the workspace, the software makes a copy of the active Cuvette Set section
and the new Cuvette Set sectionis a duplicate of the active Cuvette Set section.

Right-click the Cuvette Set section:
e Select Rename to change the name of the Cuvette Set section. Use the Rename Section
dialog to enter a new name for the section.
e Select Duplicate to copy the Cuvette Set section.
e Select Delete to delete the Cuvette Set section.

When you select a Cuvette Set section in the Navigation Tree, the Cuvette Set section settings
display in the Workspace and the section toolbar contains the following icons:

o W Click to display the Settings dialog where you configure the acquisition settings such
as read mode, read type, wavelengths, etc. Also displays in the Settings Information area
to the right of the display. See Acquisition Settings on page 110.

° (A _ Click to display the Template Editor dialog where you assign cuvettes in the section
to groups and to create templates and Group sections. See Template Editor on page 90.

—

e ili-Clickto display the Data Reduction dialog where you choose data reduction settings
for analysis. Also displays in the Reduction Settings area below the display. See Data
Reduction on page 191.

° g - Click to display the Display Options dialog where you choose options for how to
display results. See Data Display Options on page 202.

° _B Click to mask cuvettes. See Masking Wells or Cuvettes on page 207.
° Q. - Click to zoom. See Zooming Well and Cuvette Display on page 208.

The Home tab provides:

insi O Reaa, @ @
e Controls and Status - Contains icons to Read, Append, and Reference read the
cuvette you select.
Y Eix
e Cuvette Tools - Contains the icons described above plusiconsto © New and = Delete
cuvettes in the Cuvette Set section.

e Template Tools - Contains the L Template Editoricon described above.
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Managing Cuvettes in a Cuvette Set Section

Each Cuvette Set section can contain up to 96 cuvettes. You can also use the Template Editor
dialog to add cuvettes to a Cuvette Set section.

To manage cuvettes:

1. Inthe Navigation Tree, select a Cuvette Set section.

2. Selectthe Home tab and click =« £ New in the Cuvette Tools to add a cuvette to the
section.
3. Click to select a cuvette or Ctrl+click to multi-select cuvettes.

- X
4. Click = Delete inthe Cuvette Tools onthe Home tab.

Copying Cuvette Data

You can copy cuvette data from one or more cuvettes in a Cuvette Set section to a cuvette or
cuvettes in the same or a different Cuvette Set section. You can copy and paste data within
the same document or between documents. Right-click and select Duplicate to copy all the
cuvette data from one Cuvette Set section to all the cuvettes in a new Cuvette Set sectionin
the same document.

To copy cuvette data:

1. Inthe Navigation Tree, select a Cuvette Set section.

2. Click a cuvette or Ctrl+click to multi-select cuvettes.

3. Right-click and select Copy Cuvette Data to copy the data to the clipboard.

4. Click the cuvette into which to paste the data. If you copy data from multiple cuvettes,
click the first cuvette where you want to paste the data. The software pastes cuvette data
into consecutive cuvettes.

Example: If you copy data from three cuvettes and then click cuvette A6 to paste the data,
the data pastes into cuvettes A6, A7, and A8.

5. Right-click and select Paste Cuvette Data.

The Read Information on the right indicates that the data was pasted and shows the time and
date of the paste.

Cuvette Set Section Data Display

Cuvette Set section settings depend on to the actual collection of data. After you define the
Cuvette Set section settings and the instrument reads the cuvette data, the Cuvette Set
section displays the results of the read. See Collecting Data on page 109.
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Group Sections

Use Group sections to group the wells in a plate or the cuvettes in a Cuvette Set section for
data analysis. When you click a Plate section or a Cuvette Set section in the Navigation Tree,
use the Template Editor dialog to create Group sections. See Template Editor on page 90.
Group sections contain a table and an area to add frames. Frames can contain text or Summary
formulas. See Formulas on page 100.

Each column in the table contains a formula to apply to the data in the column. The table
displays reduced numbers from the Plate section or Cuvette Set section in the Values column.
You can use the columns in the table as plots in the graphs contained in Graph sections. See
Graph Sections on page 89.

o
Fora complete guide to formulas and their use, select the Help tab and click Ejl Formula
Reference.

Managing Group Sections

You add Group sections from the Template Editor dialog. You access the Template Editor
dialog from a Plate Section or from a Cuvette Set section.

To add a Group section:
1. Inthe Navigation Tree, select either a Plate section or a Cuvette Set section.

2. Click Hil in the section toolbar or on the Home tab to display the Template Editor dialog.
See Template Editor on page 90.

3. Selectthe wells or the cuvettes to group.

4. Onthe right side of the Template Editor, click Add in the Groups area to display the Group
Settings dialog. See Group Settings on page 95.

5. Complete the fields in the Group Settings dialog and click OK.

6. Click OKinthe Template Editor dialog to display a new Group section in the Navigation
Tree.

Drag the section to a different location in the hierarchy, if needed.
Right-click the Group section:

e Select Rename to change the name of the Group section. Use the Rename Section dialog
to enter a new name for the Group section.

e Select Duplicate to copy the Group section.

e Select Delete to delete the Group section.

When you select a Group section in the Navigation Tree, the Group section settings display in
the Workspace and the section toolbar contains the following icons:

° * - Click to add a column.

° E - Click to delete a column.

° f-‘? - Click to display the Formula Editor dialog. See Formula Editor on page 101.

° ’ .‘L - Click to show or hide the formula in a Summary formula frame. See Summary Formula
Tools on page 88.

° M_JJ - Click to show or hide columns in the table.
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The Home tab provides:

e Column Tools - Contains icons to manage columns in the table. See below.
e Summary Tools - Contains the icons described above plusicons to —ﬂ Copy, @ Paste,

E] Delete, and |ﬁ| Edit Summary formulas.

e Formatting Tools - Contains icons to manage text in the frames and the placement of
frames in the section. See Formatting Text in Section Frames on page 79.

Column Tools

Columns can contain references to other columns, either in the current section or in a different
section.

For example, to subtract the mean values in one group from those in a different group,
create a new column (in either group). Two groups named “Group 1” and “Group 2” contain
a column entitled “Mean.” Create a column within “Group 1” that subtracts the mean values
in “Group 2” from those in “Group 1.” The column formula is:

Mean — (Mean@Group2)

Drag and drop columns in the table to change the column sequence. Drag the column header
borders to make columns wider or narrower.

Use the Column Tools on the Home tab to manage the column you select in the Group section.
Click a columnin the table. Some icons allow you to Ctrl+click to multi-select columns. Each
icon has a corresponding right-click menu option.

+
e L New - Click to add a column to the right of the column you select. The Formula Editor
dialog displays.

% Note: Do not use reserved characters or names of operators, functions, or
accessors in the formula name if you plan to reference the formula for this column in
a different formula. For example, if you plan to reference the formula in a column of
a group table. See Formula Rules on page 101.

° la.--"I Copy - Click to copy the column you select to the clipboard.

° @ Paste - Select the column to the left of where you want to paste the column and click

@ Paste to paste the column to the right of the column you select. If the Paste iconis
disabled, there is no applicable content on the clipboard. You must first copy content to
the clipboard.

° E‘ Delete - Click to delete the column you select.

° Edit - Click to edit the column you select. The Formula Editor dialog displays.
° é‘l Cut - Click to remove the column you select to the clipboard.

° —| Auto Size - Click to size the column you select to fit the column content.

° \-_JJ Show/Hide - Click to display the Show/Hide Group Table Columns dialog. Select the
check box for each column to display and clear the check box for each column to hide.
Click Show All to select all check boxes. Click Hide All to clear all check boxes.

- .
e |1 | Hide Replicates - Click to hide replicates in the table.
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Summary Formula Tools

Use formulas to create data analysis templates that automate the analysis and results for
experiments. Use the Formula Editor dialog to add and edit Summary formulas in Group
sections. Summary formulas typically reduce data to a single value or array.

S
Fora complete guide to formulas and their use, select the Help tab and click EII Formula
Reference.

+ +
e To create a new Summary formula, click #% in the section toolbar or click #*/ New
Summary on the Home tab.
e To edit a Summary formula, double-click in a frame that contains a formula or click a frame

and click |ﬁ| Edit Summary on the Home tab.
e To copy a Summary formula to the clipboard, click a frame that contains a formula and

click J] Copy on the Home tab.
e To paste the Summary formula to a new location, click where you want to paste the

formula and click ﬁb Paste on the Home tab.
e To delete a Summary formula, click a frame that contains a formula (Ctrl+click to multi-
select) and click E] Delete on the Home tab.

By default, Summary formulas in the Group section display the result of the formula without
displaying the actual formula. You can show or hide the formula with the result.

L. . L .
e Click = "% inthe sectiontoolbar or click = “* Show Formulas on the Home tab to display all
formulas in the active Group section.

e Click fﬁ in the section toolbar or click fﬁﬁ Hide Formulas on the Home tab to hide all
formulas in the section.

You can copy a formula or column from one area of the program to a different area or from one
experiment to a different experiment. After you paste a formula you can edit the copy. You can
copy and paste formulas in contiguous column formulas as a unit.

Frames

Group sections can contain frames. Group section frames are identical to Note section frames
except you cannot enterimages in a Group section. See Note Sections on page 75.
Formatting Tools

The Formatting Tools for a Group section are the same as the Formatting Tools for a Notes
section.
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Graph Sections

Use Graph sections to plot information as a scatter plot graph or a bar graph. You can create
custom graphs and you can graph the data from Group section tables. You can use columns in
a Group section table as the X or Y input for plots on a graph in a Graph section. The Graph
section can use data from any Group section in the document and you can create as many
Graph sections as you need.

Graph sections contain either a scatter plot graph or a bar graph. Scatter plot graphs have a
legend area and curve fit results. You can define Graph sections at any point in the data
collection process but graphs tend to be more relevant for data analysis.

Managing Graph Sections

Use the LC New Graphicon in the Navigation Tree to add a Graph section to an experiment.
To add a Graph section:
1. Inthe Navigation Tree, select the section in the experiment above where you want to add
a Graph section.

2. Click LC New Graph.

3. Use the Plot Editor dialog to create the graph. See Graphing Data on page 210.
Afteryou click OK in the Plot Editor dialog, a new Graph section displays below the section
you select in the Navigation Tree. Drag it to a different location in the hierarchy, if needed.
Right-click the Graph section:

e Select Rename to change the name of the Graph section.
e Select Duplicate to copy the Graph section.
e Select Delete to delete the Graph section.

When you select a Graph section in the Navigation Tree, the Graph section settings display in
the Workspace and the section toolbar contains the following icons:

° L‘.._ Click to display the Plot Editor dialog to edit the graph.

° lﬁ Click to display the Graph Appearance dialog to label the axes and other display
options. See Graph Appearance on page 216.

e Category - Click the drop-down and select a category (scatter plot graphs only).

e Fit - Click the drop-down and select a fit (scatter plot graphs only).

° LC - Click to display the Curve Fit Settings dialog to define curve fits. See Curve Fit
Settings on page 218.

The Home tab provides:
nsi - o i
e Graph Types - Contains icons to switch between a l£_| Scatter graph and a Bar graph.

e Graph Tools - Contains the icons described above plus an I’—I: Export Graphiconto export
graph data to animage format file.

Templates

Templates provide the link between raw data and analysis groups. A template uses a map of
the wells in the plate you assign to a Plate section or the cuvettesin a Cuvette Set sectionto
allow you to identify the wells that are blanks, replicates, samples, and groups. Groups appear
as Group sections in the Navigation Tree. Template tools provide access to the Template
Editor dialog where you create groups and templates. See Template Editor on page 90.
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Each template contains samples and groups:

e A setof one or more replicate wells makes up a sample.
e Asetofrelated samples forms a group.

For example, you can have a group named “Standards” that contains seven samples
named STDO1, STDO2, ..., STDO07, and a group named “Unknowns” that contains five
samples named UNKO1, UNKO2, ..., UNKO5.

You apply each sample to a column or some other subset of wells on a plate orto one or more
cuvettes. Each well you designate to be part of a group has a group name, a sample name (or
replicate ID), a sample descriptor (optional), and a column format for the formula calculations
and data reports you define in the corresponding Group section. Samples and groups can exist
across multiple Plate sections and Cuvette Set sections.

Template Editor

The Template Editor displays a representation of the plate type orthe set of cuvettes as a
grid. Use the grid to designate the location of blanks, standards, controls, unknowns, empty
wells, or to assign wells/cuvettes to groups that become Group sections in an experiment.

The Template Editor for a Cuvette Set section displays a grid with 96 cells in the column and
row format of a 96-well plate. The software numbers the cuvettes in the template as if the
cuvettes were wells in a plate. This representation corresponds with the data analysis
capabilities of the software. When you add a group to a Cuvette Set section template, you add
cuvettes to the Cuvette Set section.

To import a template file orto export a template to a document for use in future experiments,
see Template Tools on page 92.

Each Plate section and Cuvette Set section can have one template. If the section contains a

template, the Template Editor displays the existing template when you click —1J

(1] Template Editor ==

Select wells, then add or select a group (or blank) and assign. @

Groups

Copy. Paste v View (@ Sample Name () Descriptor Add || Edit | |Delete

6 7 3 5 0 1 o1 4Standards

T & mom oo a8 @ o>

Assig
Bianks Standards

Sample 02 -

Plate Blank §
Concentration me/ml
Group Blank
Assig Series

To manage templates:

1. Inthe Navigation Tree, select a Plate section or Cuvette Set section.

2. Click —1] in the section toolbar, on the Home tab, orin the Plate Setup Helper dialog to
display the Template Editor dialog.
3. Select aView option:
e Select Sample Name to display the sample name in the wells in the grid.
e Select Descriptor to display the descriptor information only.
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4. Drag the cursor across the grid to select wells. When you select multiple wells, the
selection must be a rectangular group of contiguous wells.
5. Click one of the following:

® |nthe Assignment Options area, click Plate Blank (Plate sections) or Blank (Cuvette Set
sections) to specify wells/cuvettes as blanks. The software does not add a group in
the Groups area. For kinetic and spectrum data, the software averages and subtracts
the blank value from each point in the read.

® Inthe Groups area, click Add to create a Group section. The Group Settings dialog
displays. See Group Settings on page 95.

6. Afteryoucomplete the fields in the Group Settings dialog, use the Template Editorto do
the following for a group.

e Select a group and click Edit to display the Group Settings dialog where you edit the
group settings.

e Selectagroup and click Delete to delete the group from the template and to delete
the Group section from the Navigation Tree.

e Select a group and click Plate Blank or click Group Blank.

e To specify wells as group blank, select the wells, click Group Blank, and then click
Assign. Select the wells or cuvettes to use for the group blank. These should be wells
or cuvettes you want to assign to a group, but not the “Blank” group. Select a group
from the Group Types list. Click Group Blank and then click Assign

e Selectagroup, select additional wells, and then click Assign to add the wells to the
group.

e Selectagroup, select wells, and then click Series to display the Series dialog where
you define a series. See Creating a Series on page 98.

e Select wellsin one or more groups and click Copy to copy the well assignments to the
clipboard. Use this to duplicate well assignments within the current template. You can
also paste the same sample names but create new groups. You can copy only
contiguous wells in the template. Then click in the well at the corner of the paste area
or highlight the paste area and click Paste to display a menu. To copy and paste an
entire template to a different experiment section see Template Tools on page 92.

e Select Paste to add the new wells to the current group.
e Select Paste With New Group to have the wells create a new group in the Groups
list.

e Select wells that are in a group and click Clear to remove the wells from the group. If
you clear all the wells you assign to a group, the group continues to display in the
Groups area and the Group section continues to display in the Navigation Tree.

7. Select a group then click the Sample drop-down and select a sample. In the Concentration
field, enter the concentration.

8. Click Print to print the Template Editor dialog. You must click OK to save the template
before you can print.

9. Click OK.
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Blanks

Use the Template Editor to configure plate blanks (Plate sections), blanks (Cuvette Set
sections), and group blanks. You can use blanks in combination and have cumulative effects.

Use plate blanks and blanks when you prepare all samples on the plate in the same way. You
can turn off plate blank subtraction in the Data Reduction dialog to review data with or without
plate blank subtraction. See Data Reduction on page 191. Use plate blanks to correct reads
when you prepare all samples on a plate in the same buffer or matrix, and therefore can use
the same correction value. The software subtracts plate blanks from the raw data or after
pathlength correction if you use PathCheck® technology. For kinetic and spectrum data, the
software averages and subtracts the blank value from each point in the read. For Cuvettes Sets
blanks, the software subtracts the average value of all cuvettes in a blank group from individual
cuvette reads in the same Cuvette Set section. Template blanks are subtracted after the
cuvette reference read is subtracted.

In a plate blank group the software subtracts the average value of all the wells in the blank

group from each individual well value in the plate. If you have an instrument that supports
PathCheck technology, the software subtracts the Plate Blank after pathlength correction.

Group Blanks (Plates and Cuvettes)

Use group blanks to correct reads when you prepare samples on a plate in a different buffer or
matrix, and therefore need to be individually corrected. Group blanks can be subtracted from
raw data, like plate blank, or after post-reduction calculations, for example, wavelength, kinetic
reduction, and so on. You can assign blank wells within a group, other than the “Blank” group.
The software subtracts the group blank when you assign a group blank and you do not have
the option to review the uncorrected data. To see the reduced number without the group
blank subtracted, you must mask the group blank wells or cuvettes. See Masking Wells or
Cuvettes on page 207.

Group blanks apply to all wells or cuvettes in a group and can be subtracted from wells or
cuvettes in more than one Plate section or Cuvette Set section.

Template Tools

For a Plate section, use the Home tab Template Tools to copy a template and then paste the
template to another Plate section in the document or even to a comparable sectionina
different document. Both Plate sections must have the same plate type. If the destination Plate
section contains a template, Paste overwrites the existing template with the template copy.

To copy atemplate:

° —"J Copy - Select the source Plate section in the Navigation Tree and click —‘]] Copy to
copy the template from the active Plate section to the clipboard.

° Effx Paste - Select the destination Plate section in the Navigation Tree and click @5 Paste.
e Select Paste to paste only the template settings without the groups.
e Select Paste With New Groups to paste the template and its groups.
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When you copy a template from one experiment and paste it into a different experiment, the
group names and sample names of the destination template are identical to those of the
source template. The full name is different because the templates are in different experiments.

For example, group@experiment#2 instead of group@experiment#1.

e Changes made to the template in the destination Plate section have no effect on the
source Plate section.
e Data from the two Plate sections are not analyzed together.

When you copy a template from a Plate section in an experiment to a different Plate section in
the same experiment, the destination template is an extension of the source template. The
software considers all wells in the destination section to be replicates of the wells in the source
section, with the same group and sample names.
e Changes you make to the template in the destination Plate section are also made to the
template in the source Plate section.
e The software analyzes data from the two Plate sections together.

Importand Export

On the Home tab, use the Template Tools to import template information into a Plate section
from a tab-delimited ASCIl text file in Unicode (UTF-8) format. You can prepare template files
outside the SoftMax Pro Software and then import the file when you are ready to run samples.

Tip: To determine the correct format to import a template, export a template from the
SoftMax Pro Software and examine the contents of the export file.

To import atemplate:
1. Inthe Navigation Tree, select the destination Plate section.
2. Selectthe Home tab and cIickl% Import to display the Open dialog.

3. Navigate to and select the <template>.txt file to import.
4. Click Open.

To export atemplate:

N

In the Navigation Tree, select the source Plate section.

Select the Home tab and cIickL;Q Export to display the Save As dialog.

2.

3. Navigate to the location to save the template file.

4. Inthe File Name field, enter a name for the file.

5. Click the Save As Type drop-down and select Text files (*.txt) or Excel files (*xIs). Text files
save in tab delimited format.

6. Click Save.
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Template File Format

When you save template data as a tab delimited ASCIl text file in Unicode (UTF-8) format, the
template file consists of ten columns of data separated by tabs. Each line of the file provides
information for a single well in the plate.

When you export template information, the first line of data contains template information for
well A1, the second line of data contains template information for well A2, and so on, until the
export file contains a line for each well in the plate. If no template information exists for a well in
a plate, the corresponding line in the file is left blank.

The order of the import template information must match the export order. Blank lines in the
file indicate a well with no template setting.

ASCIl Template File Columns and Descriptions

Col Column Entry Description
A Well Location In this column, the wells do not need to be in order.
B Group Name Assign in the Group Settings dialog. If this field is missing, the rest

ofthe line is ignored. You can enter a text string in this field.

C Group Type Assign in the Template Editor dialog. The software supports three
text strings: Standards, Unknowns, Custom.

Blank groups have an Empty column format. If this field is blank, no
sample name is assigned to the well, although the sample name is
included in the group.

D Sample Name The sample name is set in the Sample field in the Template Editor. If
this field is blank, no sample name is assigned to the well, although
the sample name is included in the group.

E Descriptort Name Assign in the Group Settings dialog.

F Descriptor1 Value Assign in the Group Settings dialog. You can enter a numeric value
in this field or it can be blank.

G Descriptor1 Units Assign in the Group Settings dialog. Supported strings are unit/ml,
mg/ml, pg/ml*, ng/ml, mg, ng, and ml. If this column is blank, unit/ml
is assigned.

H Descriptor2 Name Assign in the Group Settings dialog.

| Descriptor2 Value Assign in the Group Settings dialog. You can enter a numeric value
in this field or it can be blank.

J Descriptor2 Units Assign in the Group Settings dialog. Supported strings are unit/ml,
mg/ml, pg/ml*, ng/ml, mg, ng, and ml. If this column is blank, unit/ml
is assigned.

*The p symbol can be imported only if the ASCII text file is saved in Unicode (UTF-8) format.
You can open a tab delimited ASCII file with a spreadsheet program, such as Microsoft Excel.

Note: Do not edit the file in Excel because the SoftMax Pro Software import only
supports the format for files you save as an ASCIl text file in Unicode (UTF-8) format.
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Use the Group Settings dialog to define the name for a group of related samples, a descriptor
related to the samples, and the initial column format for the data the software calculates and

reports in a Group section.

Use the Template Editor to assign wells to groups. Some protocols automatically create
groups such as Standard or Unknown. When you create a group in the Template Editor dialog,
(evenif you do not select wells in the template), the software adds a Group section in the
Navigation Tree for the experiment. To delete a group, you must delete the Group section.
When you clear a group from the Template Editor, you only remove the assignment of wells
from that group name. Clearing a group does not delete the group.

i Group Settings
Define a group of related samples.

Group Name

558

Sample Descriptor 1

Column Name  Concentration

Units None -

Groupll Set Color... ] D
Group Table Layout
@) Standards (2 Unknowns (O Custom
Group Tabie Column Preview
Sample |Wdl | Concentration |\-’alues | MeanValue Std.Dev. | OV |
Add Columns

[ Sample Descriptor 2
Column Name

Units | None

[ ox ][ cancel

To define group settings:

1. Inthe Navigation Tree, select a Plate section or Cuvette Set section.

2. Click _1] in the section toolbar, on the Home tab, orin the Plate Setup Helper dialog to
display the Template Editor dialog.

3. Drag the cursorto select one or more wells. In the Groups area, click Add or select a group
and click Edit to display the Group Setting dialog.

4. Inthe Group Name field, enter the name to assign to the group.

5. Click Set Color and select the color to display for the wells in the group.

95



SoftMax Pro Software User Guide

6. Select a Group Table Layout option. The Group Table Column Preview shows how the
columns will display in the table in the Group section. The Columns and Formulas table on
the following page summarizes the formulas associated with each column.

e Select Standards to create a group with the following group table columns: Sample,
Well, Concentration, Values, Mean Value, Standard Deviation, and CV%. The
Concentration column becomes the Sample Descriptor1 by default under the
assumption that the Group section will contain concentration information. Use this
column for numerical data such as dilution factor or fraction number.

e Select Unknowns to create a group with the following group table columns: Sample,
Well, Values, Result, Mean Result, Standard Deviation, and CV%.

% Note: The Unknowns group does not have a sample descriptor by default.
Select the respective check boxes to add one ortwo sample descriptors and
then enter the descriptive information.

e Select Custom to create a group with the following group table columns: Sample,
Well, Values, Mean Value, Standard Deviation, and CV%.

Note: The Custom group does not have a sample descriptor by default. You
can select the respective check boxes to add one ortwo sample descriptors
and then enter the descriptive information.

7. Inthe Add Columns area, select the Sample Descriptor1 check box to use the descriptor.
When you select the Standards Group Table Layout the software selects this by default
and sets the column Name to Concentration.

8. Inthe Column Name field, enter the name of the sample descriptor.

% Note: Do not use reserved characters or names of operators, functions, or
accessors in the formula name if you plan to reference the name of this columnin a
formula. See Formula Rules on page 101.

9. Click the Units drop-down and select the unit of measure.
10. Selectthe Sample Descriptor2 check boxto add a second sample descriptor column to
the table.

% Note: The Sample Descriptor you assign in the Group settings dialog yields group
table columns that you cannot edit. To create editable sample descriptor columns,
add new columns and enter a formula such as: !Sampledescriptor, !factor,
Iconcentration.

11. Click OK to close the Group Settings dialog. The software places the wells you selectin
the new group.

12. Click Series to display the Series dialog where you define a series for the wells you select.

13. Click OK to close the Template Editor and apply the template.
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The Group Table Layout you select defines which columns are in the Group section table. The

following lists the default column names and each column's formula for the Standard,

Unknown, or Custom Group Table Layouts.

Columns and Formulas

Column Name Formula Standard Unknown Custom
Sample ISampleNames v v v
Wells IWelllDs v v v
Concentration IConcentration v
Values IWellValues v v v
MeanValue Average(Values) v v
Std.Dev. Stdev(IWellValues) v v
CV% Cv(\WellValues) v v
Result InterpX(STD@ StandardCurve, v

Values)
MeanResult Average(Result) v/
Std.Dev. Stdev(Result) v
CV% Cv(Result) v
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Creating a Series

Use the Series dialog to define several samples as a series. Use a series to enter incremental
sample descriptors (e.g., dilutions or concentrations) and sample names to a template when
the increment is expressed as a mathematical operation. When you work with groups of wells
in the template, the standard value or dilution factor increases or decreases in specific steps.
The series name can also increment.

You define a series in one direction (starting from left, right, top, or bottom) and you must
configure samples sequentially in either ascending or descending order.

i Series

P4

Define samples as a series in a template. @

Series Layout

Start From Pattern of Replicates

Top to Bottom

@
X - Direction 4 well(s)
(@)

(=)
)

4

1J Bottom to Top ¥ - Direction 1 well(s)
=)| Left to Right

© [¢=] Rignt to Left

|:| Reverse Series Order

Sample Information

Starting Sample Name 01

Concentration

Starting Value 1

Step by ,-'v. 2

OK l [ Cancel

.,

To create a series:

1.
2.

o

In the Navigation Tree, select a Plate section or Cuvette Set section.

Click —U in the section toolbar, on the Home tab, orin the Plate Setup Helper dialog to
display the Template Editor dialog.

In the Template Editor dialog, click and drag the mouse to select wells to be part of the
series.

In the Groups area, select a group name.

Click Series to display the Series dialog.

In the Series Layout area select a Start From option for how the series fills the wells.
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In the Patterns of Replicates area, enter the number of replicates in the X-Direction field
and enter the number of replicates in the Y-Direction field.

The maximum number of replicates depends on the well selection and the fill direction.
Forexample, if you select a block of wells that is 4 wells wide by 8 wells high and you
select to fill down from the top, the maximum number of replicates is four. With the same
block of wells, if you select to fill from the left, the number of replicates is eight. If you
choose a number of replicates that does not divide evenly into number of wells and the fill
direction you select, the software labels the wells that cannot contain replicates as
individual wells in the series. To create a series that includes all the wells in the plate,
select all the wells, select the fill direction, and then set the replicates to 1.

Select the Reverse Series Order check box to reverse the order of the series.

Clear the Reverse Series Order to not reverse the order of the series.

In the Sample Information area, in the Starting Sample Name field, enter the name of the
first sample in the series. Subsequent replicates use this name as a base and either
increment the number within the name or append a numberto it.

Select the Concentration check box to increment the sample name and the concentration.

The following two fields are available:

Clear the Concentration check box to increment only the names of a series of samples

without incrementing the concentration or dilution.

a. Inthe Starting Value field, enter a value for the descriptor if you define a sample
descriptor for the group.

b. Click the Step By drop-down and select the operator for the series (+, -, *, or /) and then
enter a value for the increment. For example, enter a starting value of 0.5, the division
operator (/) and the increment 2. The series starts with 0.5 and divides each
subsequent sample by 2 to produce the series 0.5, 0.25, 0.125, and so on.

% Note: Click the Step By drop-down, select the multiplication operator (*), and
then enter a value of 1 for the increment to increment the names of a series of
samples with a constant concentration or dilution.

Click OK.
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Formulas

Formulas are powerful data analysis tools that can automate the analysis and results reporting
for plate reads. Formulas are mathematical functions you create with operators and accessors
to convert and analyze raw data for presentation in the appropriate output format. See Formula
Editor on page 101.

The software includes many formulas to expedite data analysis. The formulas in the software
use a hierarchical naming structure, much like the directories and sub directories in computer
file systems. All objects (for example, columns, Summaries, wells, graphs, plots) in the SoftMax
Pro Software have names. Use these names to refer to the objects when you write formulas.

The SoftMax Pro Data Acquisition and Analysis Software Formula Reference Guide identifies
and enumerates the details about the operators, functions, and accessors in formulas. Select

'fx!
the Help tab and cIickE}l Formula Reference.

e Use Summary formulas in Group sections and Note sections to reduce data to a single
value or array.

e Use Reduction formulas in Plate sections and Cuvette Set sections to apply a formula to
the entire section.

e Use Column formulas in Group sections to apply a formula to each column in the section.

® You can assign formulas to the X and Y axes in a Graph section.

Operators

Use operators to combine other formula building blocks together. Operators let you combine
and compare numbers, functions, accessors, and text strings in a variety of ways within
formulas. Most operators are mathematical symbols, e.g. +, -, *, /, <. > etc. Boolean operators
have text, e.g. If, And, Or, Not.

Functions

In contrast to operators, functions have names and accept up to four parameters. Functions do
operations such as standard deviation or slope. You can input zero to four parameters into
functions. You can use lists of numbers, arrays of numbers, and lists of text strings as input
parameters, and the function can return either lists or arrays of numbers or text. Functions return
numbers, text, or Booleans.

The general format for a function is:

FunctionName(Parameter1, Parameter2, Parameter3, Parameter4)

If a function has more than one parameter, the order in which you list the parameters is
extremely important. If you enter the parameters in the incorrect order, the function returns
erroneous results.

Accessors

Accessors are special functions that provide access to other specific information in the
software. For example, the number of Vmax Points used to calculate the Vmax Rate. Accessors
are frequently used by themselves as column formulas. Use accessors as parameters within
several functions, most notably kinetic and spectrum reduction functions. Combine accessors
with functions and mathematical operators to create complex formulas.

Unlike functions, accessors do not have related parameters. Accessors are always preceded
by an exclamation point (!, also known as a “bang”).
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Formula Rules

The following is a very high level summary of formula rules:

Formulas are not case sensitive.

If an object’s name contains a space, starts with a number, orincludes one or more of the
following special characters: #$ % / * ?, you must enclose the name in single quotation
marks. For example, ‘OD Values’. Do not use * @™ or & in object names because these
characters have special meanings in the software.

When you create a formula that references columns in more than one Group section, the
Group sections must have the same number of rows (samples).

Column formulas must evaluate either to text, to numbers, orto a Boolean (for example, to
True or False) because a column cannot contain text (“Pass”) and numeric (“1.002”) results.
When a formula includes a text result that you want to display, you must enclose the result
in double quotation marks, for example, “Out of Range”.

Formula Editor

Use the Formula Editor dialog to create formulas that convert and analyze raw data for
presentation in the appropriate output format. Use formulas to create powerful data analysis
templates that can automate the analysis and results reporting for experiments.

§it, Forrnula Editor @
Enter 3 formyls, For assistance, enable Symtax Helper, @
Name 7] Hide Name

MinStd

Description

Srmallest standand value

Comments

Formula of | Syntas Helper

Min{MeanValue) *

Check Syntax
Data Desplay
Lample
Humeric notation -
Significant Figures 5 123.457
0 Decimal Places 3
0 Cancel

5049092 F

101



SoftMax Pro Software User Guide

The Formula Editor dialog varies based on how you access the dialog.
To create formulas:
1. There are several ways to access the Formula Editor.
* |nthe Navigation Tree, select a Note Section or a Group section. In the section toolbar

¥ P
click ¥4 on the Home tab click 1 New Summary, or select a formula in a section and
click Edit Summary. This is a Summary formula.

e Inthe Navigation Tree, select a Plate section or a Cuvette Set section. Click _/_; inthe
section toolbar, the Reduction Settings area, or on the Home tab. In the Data

Reduction dialog select Custom from a drop-down and click |ﬁ| This is a Reduction
formula. See Data Reduction on page 191.

r
e Inthe Navigation Tree, select a Group section. In the section toolbar click -/, double-

i
click a column header, or onthe Home tab click -2 New or click Edit in the
Column Tools. This is a Column formula.

i
e Inthe Navigation Tree, select a Graph section orin the Navigation Tree click LC. New

Graph. In the section toolbar click 2 or onthe Home tab click £ Plot Editor. In the
Plot Editor dialog in the Data Input area, click the X-Axis or Y-Axis drop-down and

select Custom and then click L2 |

Note: The following steps describe the flow for Summary formulas. The
Formula Editor has fewer fields for other formula types but the workflow for the
Formula field is the same for all formulas.

2. Inthe Name field, enter the formula name.

3. Select the Hide Name check box to not display the formula name in the Note/Group
section.
Clear the Hide Name check box to display the name and/or description in the section.

Note: If you plan to reference this formula in a different formula, for example
referencing the formula in a column of a group table, do not use reserved
characters or names of operators, functions, or accessors in the formula name. See
Formula Rules on page 101.

4. Inthe Description field, enter a description of the formula. This displays in the section and
can be left blank.

5. Inthe Comments field, enter a comment to annotate the formula. This displays only in the
Formula Editor dialog.

6. Select the Syntax Helper check box to display the Syntax Helper formula completion tool.
The Syntax Helper displays the formulas that are available and the parameters each
formula expects to receive.

Clear the Syntax Helper check box to not use the Syntax Helper feature.

* Tip: When you start to enter a formula, a list displays below the text as you type. The
Syntax Helper analyzes text as you type and compares it to formulas that are
available for use in the software.

7. Inthe Formula field, enter the formula.
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Click Check Syntax to check the validity of the formula. A message displays to help you
troubleshoot the formula syntax.
Click the Data Display drop-down.

e Select Numeric Notation to display the full numeric value in the result.

e Select Scientific Notation to display a concatenated numeric value in the results.
A preview of the Data Display displays in the Sample area on the right when you select
one of the following:

e Select Significant Figures and enter the number of figures to display.

e Select Decimal Places and enter the number of decimal places to display.
Click OK.
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Defining and Running Workflows

Use workflows to define complex reads such as multitask kinetic reads that last hours or days.
Use the Workflow view of the Workspace to drag-and-drop tasks into a timeline. The Workflow

tab in the Ribbon contains the icons to execute and monitor the workflow.

e Undo | Zoomin Fittto Screen e
“ Redo  Zeomouwt M Map i
St Fause Cance Execution

=™ Reset Zoom Save as Image Log

k& Open Drawer
§ SetTemperature
s shake
4 Timing
D Detay

2 cycke Begin 1
P LLLDLDLDIPDDLDLLIDLDLIIDILLIIIIIPIS

£

8

]

E B

g §
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Pause a workflow to work with other features in the software, such as define protocols orrun
short reads, while the software waits to do the next non-timing task in the workflow. When you
pause a workflow, all delays and cycle timings continue to run. When the workflow reaches a
non-timing task, such as a read, the task starts after you resume the workflow. If you resume the
workflow after the scheduled time for a task to start, then the task starts when you resume the

workflow and all subsequent tasks are rescheduled to a later time.

For example, if you set a delay before a read to 30 minutes and you resume the workflow
after 40 minutes, then the read starts when you resume the workflow and the software
reschedules all subsequent tasks to start 10 minutes later than their original times.

To define and run a workflow:
1. Openadocumentinthe Workspace.

2. Selectthe Document view of the Workspace and create the experiments with the
applicable sections. You can define the acquisition settings for each Plate section from the

Workflow view.

3. Select the Workflow view of the Workspace. The Ribbon automatically displays the

Workflow tab.
4. Drag tasks from the Navigation Tree on the left into the timeline on the right.

an—( & e ) 3)—(0 D
Set Temperature Cycle Read Delay Read

Plate: LUM-kinetic 00:10:00 Plate: FL-kinetic
Experiment: Multitask Experiment: Muttitask

Incubator: On Cycles: 8
Platz Charber Set Paint; 35 °C Total Run Time: 04:00:00
Wiait; On Cycle Interval: 00:30:00

e To repeat kinetic tasks, place the tasks to repeatin a Cycle task.

e To gather data overlong periods of time, use the kinetic read type and then define
the Timing settings to acquire a single point with each read. See Timing Settings on

page 123.

% Note: Place only kinetic reads within a cycle. If you place otherread typesina
cycle, the software overwrites the previously acquired data in the Plate section.
You can place an endpoint, well scan, spectrum, or flex read before or aftera cycle

to preserve the data you acquire.

5. Click [4’,] to edit the task settings. See Workflow Task Settings on page 106.

104

5049092 F



5049092 F

6.
7.

10.

1.

Chapter 2: User Interface

Click **_to remove a task from the timeline.
In the Ribbon, select the Workflow tab and use the Designer buttons to manage the
creation of the workflow.
e Click Undo to undo the most recent change you made to the timeline.
e Click Redo to redo an action.
e Click Clear to clear the timeline and start over.
e Click Zoom Into zoom in to the Workflow view similar to using the slider on the bottom
right.
e Click Zoom Out to zoom out of the Workflow view.
e Click Reset Zoom to set the zoom to the default setting.
e Click Fit To Screen to set the view so that the workflow fits on the screen without scroll
bars.
e Click Mini Map to display the Overview dialog that helps you navigate a long timeline.
e Click Save AslImage to export animage of the timeline to animage file with the jpg,
.png, .gif, or .xps format.
Save the document before you start a read.
Insert the plate in the instrument.
In the Ribbon, select the Workflow tab and use the Execution icons to execute the
workflow.

e Click ‘db' Start to run the workflow.

e Click Pause to temporarily stop the workflow.
e Click u Resume to restart the paused workflow.
e Click u Cancel to cancel the workflow.

Click Execution Log to view the status of the tasks the software executes including the
time, step name, and related messages.
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Workflow Task Settings

Each task in the workflow allows you to define settings that are applicable for that task.
1. Select ataskinthe timeline.

2. Click [4‘9] to edit the settings for that task.
Read Task Settings

Use the read task settings to select the experiment and Plate section you define from the
Document view of the Workspace.

m <J Read

Experiment: | Exptl ~

Read Plate Section: | Plate1 v
Plate: Plate
Experiment: Expt]

To define read task settings:

1. Click the Experiment drop-down and select the experiment that contains the Plate section
to read.

2. Click the Plate Section drop-down and select a Plate section.

3. The read uses the acquisition settings you define for the Plate section. To edit the

acquisition settings, click @ See Acquisition Settings on page 110.

* Tip: If you place a kinetic read task in a Cycle for the FilterMax F3, FilterMax F5,
SpectraMax i3x, SpectraMax iD3, SpectraMax iD5, and SpectraMax Paradigm clear the
Show Pre-Read Optimization Options check box. Pre-Read optimization requires user
interaction. If you select this check box, the software waits for user interaction before
eachread. See Show Pre-Read Optimization Options on page 142.

Open Drawer Task Settings

ﬂ {,1 Open Drawer
Wait while drawer is open.

Message to Show:

Open Drawe
Wait : On

To define drawer task settings:
1. Select the Wait While Drawer is Open check box to pause the workflow until the drawer is

closed.

Clear the Wait While Drawer is Open check box to have the workflow continue to the next
task with the drawer open.

2. Inthe Message to Show field, enter the message to display when the drawer opens or
enter instructions for the operator.
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Set Temperature Task Settings

E ‘\J. Set Temperature

® On Plate Chamber Set Point: | 25 °C
Set Tempera

Incubator:on| - Off

Plate Chambg
Wait: On

Wait while the temperature changes !

To define set temperature settings:

e Select Onto turn on the read chamberincubator.
¢ Inthe Plate Chamber Set Point field, enter the temperature.
e Select the Wait While the Temperature Changes check box to pause the workflow
until the read chamber reaches the set point.
Clear the Wait While the Temperature Changes check box to have the workflow
continue to the next task before the chamber reaches the set point.
e Select Off to turn off temperature control.

Shake Task Settings

Shake time: |5

Shake: 5secs

To define shake task settings:

¢ Inthe Shake time field, enter the number of seconds to shake the plate.

Delay Task Settings

m <J Delay

For: /00 : 00 : 00 : 00 [&]
dd: hh : mm . ss

Delay
00:00:00

To define delay task settings:

e Entervalues forthe delay in Days:Hours:Minutes:Seconds, or click a value and use the
arrows on the right.

=| Note: The Delay task continues even when you pause the workflow.
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Cycle Task Settings

The software calculates the number of cycles based on how many Cycle Intervals can be
completed within the Total Run Time.

When you define the timing for a cycle, make sure that the tasks in the cycle finish within the
time you allot. The workflow editor does not calculate the time it takes to do a read. If the read

takes longer than the time you allot for the cycle, then the next cycle begins immediately after
the cycle tasks complete.

E {J Cycle

Total Run Time: 00

Cycle Cycle Interval: |00 :
Cycles: 1 dd :
Total Run Ti

Cycle Interval: 00:00:00

To define cycle task settings:

1. Toinclude atask in the cycle, drag the task between the start and end points of the cycle

task.
2. Inthe Total Run Time field, enter values in Days:Hours:Minutes:Seconds to define the total
time for all the cycles to complete.
3. Inthe Cycle Interval field, enter values in Days:Hours:Minutes:Seconds to define the time
from the start of one cycle to the start of the next cycle.
e 150
Begin e I\L) End
Cycle %Fﬂ
Cycles: 8
Total Run Tirne: 04:00:00
Crcle Intereal 00:30:00
o
=| Note: The cycle interval continues even when you pause the workflow.
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Data collection depends upon the settings you define for each Plate section and each Cuvette
Set section inthe document.

% Note: When you do not physically connect the computer to an instrument, you can
select Offline or Simulator On to create documents for later use. Document settings are
specific to the instrument that you select. If you change instruments, some settings may
be reset to the default protocol settings.

Instrument Settings

Use the Settings dialog to configure the settings for the instrument to use to read each Plate
section and Cuvette Set section. Settings include the read mode, the read type, wavelengths,
plate type, wells to read, PathCheck technology, optics settings, shake parameters, timing for
kinetic runs, speed read, and more.

To access the Settings dialog:

1. Inthe Navigation Tree, select a Plate section or Cuvette Set section.

2. Click <, in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.

Standard View

Use the Settings dialog, for all instruments, to select a read mode and a read type. The settings

that determine how the instrument is to read the plate or cuvette are then grouped into

categories along the left side of the dialog. This is known as the Standard view of the Settings

dialog. See Acquisition Settings on page 110.

You must use the Standard view to define the settings for Imaging reads and ScanLater

Western Blot reads.

Note: If you define an Imaging read or a ScanLater Western Blot read in the Standard
view and then switch to the Acquisition view, your settings are not saved.

Acquisition View
The Settings dialog for the SpectraMax i3, SpectraMax i3x, SpectraMax iD3, and SpectraMax
iD5 provides an Acquisition view to configure plate reads.

The Acquisition view uses an acquisition plan with tools that allow you to define settingsin a
workflow designh when you need to do multi-step plate reads. See Acquisition View and Reads
With Injectors on page 152.

To switch between the Standard view and the Acquisition view:

o Clickl Standard View _Acqmsmnn View

Note: You must use the Acquisition view to define reads with injection. If you define a
read with injection and then switch to the Standard view, your settings are not saved.

in the lower-left corner in the Settings dialog.
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Acquisition Settings

Use the Settings dialog to configure the following parameters for a Plate section or Cuvette
Set section: read type, read mode, wavelengths, plate type, wells to read, PathCheck
technology, optics, shake, timing for kinetic reads, speed read, and more.

L settings =
Read Mode 150 o xts s T
| g
% 4 =l b=l 56D ) )
ABS FL LUM TRF F
[ ]
Read Type O O
Endpoint Kinetic Spectrum Well Scan
Category Semings Information
Wavelengths Wavelength Settings Endpaint
4 Absorbance
Plate Type Lmi 405
Read Area Number of Wavelengths Lm2 426
PathCheck Lm3 426
Shake Lmil 405 . am Lm4 426
Speed Read 4 Plate Tyoe
Lm2 425 nm
More Settings . 96 Well Standard cirbtm
Lm3 426 . nm 4 Read Area
EntirePlate
Lma4 426 . nm

4 Mare Settings

Shake OF

Calibrate On

Carrizge Spesd Normal
Calumn Priarity

You can specify to up to six different wavelengths. Type the wavelengths in the fields.

More Information

Co )

Each Plate section or Cuvette Set section in a document must use the same instrument but can
have different parameters for the acquisition settings.

To define acquisition settings:

1. Inthe Navigation Tree, select a Plate section or Cuvette Set section.

2. Click <, in the section toolbar, in the Settings Information area, or on the Home tab to

display the Settings dialog.

3. Forthe SpectraMax i3, SpectraMax i3x, and SpectraMax Paradigm select the detection
cartridge or optical configuration to use. This determines the available read modes. See
Selecting a Detection Cartridge or Optical Configuration on page 112.
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4. Forallinstruments, select a read mode. This determines the available read types.

Absorbance Read Mode, see page 270

Fluorescence Intensity Read Mode, see page 275 Fluorescence Intensity Dual
Wavelength is available for the SpectraMax Paradigm.

Luminescence Read Mode, see page 280 Luminescence Dual Wavelength is
available for the FilterMax F3, FilterMax F5, SpectraMax i3x, SpectraMax iD5,
SpectraMax L, and SpectraMax Paradigm.

Time-Resolved Fluorescence Read Mode, see page 283 Time Resolved
Fluorescence Dual Wavelength is available for the SpectraMaxi3x and SpectraMax
Paradigm.

FRET Read Mode, see page 287

HTRF Read Mode, see page 290

Fluorescence Polarization Read Mode, see page 293

AlphaScreen Read Mode, see page 296

Western Blot Read Mode on page 298

Imaging Read Mode, see page 301

5. Select aread type. This determines which setting categories appear in the Category list.

Endpoint Read Type, see page 267
Kinetic Read Type, see page 268
Spectrum Read Type, see page 269
Well Scan Read Type, see page 269
FlexRead Type, see page 268
Membrane Read Type, see page 268

6. Select each category inthe list on the left to display the corresponding settings.

Wavelength Settings, see page 113

Plate Type Settings, see page 116

Read Area Settings, see page 119
PathCheck Settings, see page 120

TRF Settings, see page 121

PMT and Optics Settings on page 121
Timing Settings on page 123

Well Scan Settings, see page 124

Shake Settings, see page 125

Speed Read Settings, see page 125

Well Area Settings, see page 126

Image Acquisition Settings, see page 126
Image Analysis Settings, see page 128
Region of Interest Settings, see page 140
More Settings, see page 141

Compound Transfer Settings, see page 144
Compound Source Settings on page 147
Pipette Tips Layout Settings, see page 148
Compound and Tips Columns Settings, see page 149
Triturate Settings, see page 152
Acquisition View and Reads With Injectors, see page 152

7. Afteryou define the instrument settings, click OK to close the Settings dialog.
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Selecting a Detection Cartridge or Optical Configuration

When the instrument uses detection cartridges or another optional optical configuration, the
Settings dialog displays the additional options above the read modes. Each detection
cartridge contains the light source, optics, and electrical components needed to do specific
read modes for some applications. See Supported Detection Cartridges on page 343.

e The SpectraMax i3x supports user-installable detection cartridges to expand its read
capabilities. Cartridges are for top reads only.
e The SpectraMax Paradigm requires detection cartridges to do reads.

% Note: When you select to work offline in Simulator mode, the Settings dialog displays
all detection cartridges that the instrument supports.
When you connect the computer to an instrument, the Settings dialog displays the
detection cartridges that you install in the instrument.

For the SpectraMax i3x:

e Select monochromator to use the instrument monochromator.

e Select MiniMax forimaging reads that use the SpectraMax® MiniMax™ 300 Imaging
Cytometer. For transmitted light imaging, you must install the Transmitted Light (TL)
detection cartridge, but you do not need to select it in the Settings dialog.

After you select the detection cartridge or optical configuration, select the read mode and
read type for the protocol.

Temperature Control

Use the Temperature Control dialog to set the temperature in the plate chamber when you use
an instrument that provides temperature control. The instrument monitors the temperature of
the air inside the plate chamber and the software displays the air temperature of the chamber
on the Home tab. The temperature display continuously updates with the current air
temperature in the chamber.

For instruments with a cuvette chamber, the instrument control panel displays the temperature
within the cuvette chamber. The plate chambertemperature can be different from what
displays on the instrument control panel. The software plate chambertemperature display
should be similar to the control panel temperature display after both chambers reach
equilibrium. During warm-up, you might notice a discrepancy in temperatures, which is normal.

You can set the temperature 2°C or more above the current air temperature in the chamber.
After youturn on the temperature control, the chamber can take from 10 to 30 minutes to reach
the set temperature, depending on the difference between the start temperature and the set
temperature.

% Note: The instrument temperature sensors detect the temperature of the airinside the
chamber, not the temperature of the samples in the plate. If you use the instrument to
warm the samples, you should use a seal or lid on the plate to prevent evaporation of
the sample. A seal or lid helps to maintain uniform temperature. Letting the prepared
sample equilibrate inside the plate chamber can take an hour or more. You can speed
up equilibration by pre-warming the sample and the assay reagents before you place
the plate in the chamber. Validate the data quality to determine whether the seal or lid
can stay on the plate for the read.
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$ Temperature Control

Adjust the temperature of the plate chamber. @

@ On Plate Chamber Set Point 35 i

off

OK || Cancel |

To set the temperature in the plate chamber:

1. Select the Home tab and click & Temperature to display the Temperature Control
dialog.

Select the On option.

In the Plate Chamber Set Point field, enter the temperature in degrees Celsius.
Click OK.

After you turn off the temperature control, open the plate drawer to help the plate
chamber cool to the ambient temperature.

o s~ wN

Wavelength Settings

Use the Wavelengths category in the Settings dialog to define wavelength settings. These
settings are dependent on the instrument, read mode, and read type you select.

Some instruments allow you to choose to use all wavelengths for the read or to specify
specific bandwidths. Select the spectral bandwidth of the wavelength. The instrument uses the
bandwidth you select for all the wavelengths in a multiple wavelength read.

The user guide for each instrument describes the instrument's bandwidth range and how to
optimize excitation and emission wavelengths for a protocol. See Documentation on page 7.

Fluorescence Intensity Read Mode
To define wavelengths for the Fluorescence Intensity read mode:

1. Click the Number of Wavelength Pairs drop-down and select the number of wavelength
pairs.
2. Inthe Excitation fields, enter the excitation wavelengths.
3. Inthe Emission fields, enter the emission wavelengths.
Endpoint, Kinetic, Well Scan, and Flex Read Types
To define wavelengths for the endpoint, kinetic, well scan, and flex read types:
1. Click the Number of Wavelengths drop-down and select the number of wavelengths to
read.
2. Foreachwavelength, enter or select the wavelength value for the read.
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Spectrum Read Type
To define wavelengths for the spectrum read type:

1. Inthe Start field, enter the starting wavelength.

2. Inthe Stop field, enter the ending wavelength.

3. Inthe Step field, enter the value for how much the wavelength should increment between
reads. The minimum step incrementis 1 nm.

Cutoffs

The Gemini™ EM Dual Scanning Microplate Spectrofluorometer, Gemini™ XPS Dual Scanning
Microplate Spectrofluorometer, SpectraMax® M2 Multi-Mode Microplate Reader, SpectraMax®
M2e Multi-Mode Microplate Reader, SpectraMax® M3 Multi-Mode Microplate Reader,
SpectraMax® M4 Multi-Mode Microplate Reader, SpectraMax® M5 Multi-Mode Microplate
Reader, and SpectraMax® M5e Multi-Mode Microplate Reader support cutoff filters. The term
cutoff refers to the longpass filters the instrument uses to block unwanted residual excitation
light and minimize background interference.

The cutoff settings depend on the read mode (Fluorescence, Fluorescence Polarization, or
Time Resolved Fluorescence) and the read type (endpoint, kinetic, spectrum, or well scan).
The Luminescence read mode does not use emission cutoff filters.

To define the cutoff filters:

e Select the Auto Cutoff check box to have the software choose the longpass emission filter
based on the excitation wavelength you enter.

e Clear the Auto Cutoff check box, then click the drop-down and select the cutoff filter for
each wavelength. For the spectrum read type you must select a cutoff filter (or None).

When you clear the Auto Cutoff check box, to determine the manual setting for a cutoff filter,
you need to know the value of the Stokes shift, which is the difference between the
wavelengths of the excitation and emission maxima. If the Stokes shift is small, choose an
excitation wavelength that is as far as possible from the emission maximum while still capable
of exciting the fluorophore. This causes less of the excited light to overlap the emission
spectrum which permits better selection and quantitation of the emitted light.
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Imaging Read Mode

When you install the SpectraMax MiniMax 300 Imaging Cytometer with the SpectraMax i3x, you
can select the wavelengths or channels to use. The software acquires images separately for
each wavelength or channel and you can analyze each image separately.

The SpectraMax MiniMax 300 Imaging Cytometer captures images from the bottom of each
plate well. You can illuminate the sample with white transmitted light from the top of the plate
when you use the Transmitted Light (TL) detection cartridge, or you can use fluorescent
excitation from the bottom of the plate. See Imaging - Transmitted Light Detection Cartridge
on page 347.

)
~—)

Path of Selected Light Sources

Item Description

1 Transmitted Light (TL) detection cartridge

2 Path of white light from the Transmitted Light (TL) detection cartridge
3 Path of fluorescent excitation

4 Light source for fluorescent excitation

5 Camera lens

For best results with transmitted-light reads, use a plate with no cover. You can use a clear
cover, if required. For Fluorescent reads, you can use a plate with a solid cover.

5049092 F 15



SoftMax Pro Software User Guide

Plate Type Settings

Use the Plate Type category in the Settings dialog to select the type of plate to read. The
software includes a plate library that contains plates of various sizes with standard dimensions.
If you are uncertain which plate to use, select the Standard plate definition.

If you change the Plate Type setting, the software discards the well assignments for the
template you assign to that Plate section. Group sections remain and you can select new wells
to assign to the existing Group sections.

Your plate selection determines the display of the wells in the Plate section in the Workspace.
To define the plate setting:

1. Click the Plate Format drop-down and select the number of wells in the plate.
2. Selectthe IsLidded check box if the plate has a lid.

Note: If the plate has a lid, you must verify that the plate height with a lid is set
accurately in the Plate Editor dialog before you start a read.

3. Inthe Select Specific list, select the plate to read.
For the FilterMax F3, FilterMax F5, and SpectraMax Paradigm you can define the plate
orientation to match the orientation of the plate in the drawer.
Click the Orientation drop-down:
e Select Landscape to put the A1 location in the upper-left corner closest to the instrument.
e Select Portrait to put the Allocation in the upper-right corner closest to the instrument.
e Select Opposite Landscape to put the A1 location in the lower-right corner farthest from
the instrument.
e Select Opposite Portrait to put the Al location in the lower-left corner farthest from the
instrument.

Edit Plate
You can edit the dimensions of a plate or add custom plates to the plate library.

Note: You can use the custom plate definitions you create or edit for Imaging reads
when you select the Imaging read mode. Plate definitions you create, edit, or optimize
for other read modes do not appear in the list of available plates for the Imaging read
mode.

To edit the dimensions of a plate orto add new plates to the library:

Select a plate from the list.

Click Edit Plate to display the Plate Editor dialog. See Plate Editor on page 117.
For a new plate, in the Plate Name field, enter the name for the plate.

Define the plate dimensions and click Save.

Select a plate and click Remove to remove a plate from the plate library.

O b W N =

CAUTION! The FilterMax F5,SpectraMax i3x, SpectraMax iD3, SpectraMax iD5, and
SpectraMax Paradigm have an automatic read height (Z-height) adjustment for
Fluorescence read mode and Luminescence read mode. For top reads, the lens or the
plate can be damaged if you do not properly set the plate height. If the plate has a lid,
you must select the Is Lidded check box and verify that the plate height with a lid is set
accurately in the Plate Editor dialog before you start a read.
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Import Plate Definitions

You can import plates for the FilterMax F3, FilterMax F5, SpectraMax i3, SpectraMax i3x,
SpectraMax D3, SpectraMaxiD5, and SpectraMax Paradigm.

To import plate definitions:

1. Click Import Plate to display the Open dialog.

2. Navigate to and select the plate definition file: Plate File .plt file extension or Multimode
File .xml file extension.

3. Click Open.

Plate Editor

Use the Plate Editor dialog to modify the definition of a plate or to add plate definitions to the
plate library. The software saves plate definitions with a .plt file extension in a sub-folder of the
Program Data folder. Custom plate definitions save to the computer. Whenyou opena
protocol that uses a custom plate definition that you save on a different computer, the
software allows you to save the custom plate definition on the new computer.

CAUTION! To prevent damage to the instrument, set the plate height and read height
accurately before you start a read.

To edit a plate definition:

1. Inthe Navigation Tree, select a Plate section.

2. Click <, in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.

Select the Plate Type category.

Click the Plate Format drop-down and select the number of wells in the plate.

In the Select Specific list, select the plate to edit or copy.

o 0k w

Click Edit Plate to display the Plate Editor dialog. In the Acquisition view, click @ to

display the Plate Editor dialog.

To create a new plate, in the Plate Name field, enter the new plate name.

8. If you access the Plate Editor from the Acquisition view, you can click Delete to remove a
custom plate definition. You cannot remove the plates installed with the software.

9. Afteryou define the plate settings described in the table on the following page, click

Save.

N

% Note: For the Left Edge to Left Well Center measurement in the table on the following
page, the distance from the left edge of the plate to the center of well A1 must also
include an offset for the angle of the optics. To determine the correct settings for these
fields, measure the applicable areas of the plate in the lab.
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Plate Editor Settings (all measurements in millimeters)

Field Name

Left Edge to
Left Well
Center

Image

O C

Description

Enter the distance from the left edge of the plate to the center of well A1.

Horizontal
Center to
Center

Enter the horizontal distance between well centers.

Top Edge to
Top Left Well
Center

Enter the distance from the top edge of the plate to the center of well A1.

Vertical
Center to
Center

Enter the vertical distance between well centers.

Well Diameter

Enter the diameter of a round well or the width of a square well. For the FilterMax F3,

and Well FilterMax F5, SpectraMax i3, SpectraMax i3x, SpectraMax iD3, SpectraMax iD5, and
Shape SpectraMax Paradigm, select the Well Shape Square check box for square wells.

Well Bottom Select the Clear Well Bottom check box if the wells have a clear bottom, rather than
Type / opaque. For the SpectraMax i3x with the SpectraMax MiniMax 300 Imaging

Thickness Cytometer, enter the thickness of the bottom of the well of the plate. This determines

the initial focus distance for Imaging reads.

Well Volume /
Depth

For the FilterMax F3, FilterMax F5, SpectraMax i3, SpectraMax i3x, SpectraMax iD3,
SpectraMax iD5, and SpectraMax Paradigm, enter the depth of the well. For the
SpectraMax i3x with the SpectraMax Injector cartridge, enter the working volume of
the well for the plate in microliters. This determines the maximum allowable dispense
volume for reads with injection.

Plate Height

For the FilterMax F3, FilterMax F5, SpectraMax i3, SpectraMax i3x, SpectraMax iD3,
SpectraMax iD5, and SpectraMax Paradigm, enter the height of the plate in millimeters
and also the height of the plate with a lid. This determines the read height for top
reads.

Plate Length

For the FilterMax F3, FilterMax F5, SpectraMax i3, SpectraMax i3x, SpectraMax iD3,
SpectraMax iD5, and SpectraMax Paradigm, enter the length of the plate.

Plate Width

For the FilterMax F3, FilterMax F5, SpectraMax i3, SpectraMax i3x, SpectraMax iD3,
SpectraMax iD5, and SpectraMax Paradigm, enter the width of the plate.

18

5049092 F



5049092 F

Chapter 3: Collecting Data

Read Area Settings

Use the Read Area category in the Settings dialog to select the wells to read. Partial plate
reads are available for all read types. This is useful for the fast kinetic read type and the
Imaging read mode to significantly reduce the time required for the kinetic read orto acquire
images.
To select a contiguous, rectangular region on the plate:
e Drag the mouse pointer to select the wells to read.
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Columns do not need to start with “1” but must be contiguous.

To read all the wells in the plate:
e Selectthe Select All check box.
To select non-contiguous wells for the SpectraMax i3, SpectraMax i3x, SpectraMax iD3, and
SpectraMax iD5:
1. Select the More Settings category.
2. Selectthe Well read order.
3. Selectthe Read Area category.
4. Pressthe Ctrl key as you click each well.
When you do not select to read all wells in the plate, the Workspace displays only the wells

you select to read, to indicate that the instrument will not collect data for the other wells. All
wells display in the Template Editor dialog.
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Western Blot Membrane Read Area Settings

You must place the membrane in a Molecular Devices ScanLater” membrane holderto scan a
membrane . See Loading the Membrane Holder on page 174.

A high resolution scan of the entire surface can take approximately 15 minutes. Define a
smaller area for the scan to reduce the scantime. The Read Area category displays the
approximate area to scan.

To select the area to scan from the Target Read Area list:

e Select Mini Membrane to scan an area 85 mm x 65 mm.

e Select Whole Membrane Holder to scan an area 109 mm x 77 mm.

e Select ROl Selection to scan an area based on the region of interest (ROI) you define and
acquire in the Plate section.
If you do not define and acquire a region of interest in the Plate section, the ROI Selection
optionis not available.

PathCheck Settings

Use the PathCheck category in the Settings dialog to use PathCheck technology for
Absorbance read mode endpoint read type protocols. See PathCheck Technology on page
272.

To define PathCheck settings:

e Select the PathCheck check box to use the PathCheck technology Water Constant
correction.

e Clearthe PathCheck check boxto not use the PathCheck technology Water Constant
correction.

The temperature-independent PathCheck technology normalizes absorbance valuesto alcm
path length based on the near-infrared absorbance of water.

The Beer—Lambert law states that absorbance is proportional to the distance that light travels
through the sample:

Microplate readers use a vertical light path so the distance of the light through the sample
depends on the volume. This variable pathlength makes it difficult to do extinction-based
assays and makes it confusing to compare results between microplate readers and
spectrophotometers.

The standard pathlength of a1 cm cuvette is the conventional basis to quantify the unique
absorptivity properties of compounds in solution. Quantitative analysis can be done on the
basis of extinction coefficients, without standard curves (for example, NADH-based enzyme
assays). When you use a cuvette, the pathlength is known and is independent of sample
volume, so absorbance is directly proportional to concentration when there is no background
interference.
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TRF Settings

Use the TRF Settings category in the Settings dialog to define the integration delay before
datais collected and the integration time of the fluorescence signal. The Time-Resolved
Fluorescence read mode measures fluorescence as a function of time after excitation. See
Time-Resolved Fluorescence Read Mode on page 283.

1. Click the Integration Delay drop-down and select the amount of time to elapse between
the flash of the lamp (excitation) and the beginning of data acquisition from the well

(emission).

2. Click the Integration Time drop-down and select the amount of time for the instrument to
read the well.

PMT and Optics Settings

Use the PMT and Optics category in the Settings dialog to define sensitivity settings for the
Photomultiplier Tubes and optics for all read modes except Absorbance.

Click the PMT Gain drop-down:

e Select Automatic to have the instrument automatically adjust the PMT voltage for varying
concentrations of sample in the plate. Available for the Fluorescence read mode with the
Endpoint, Spectrum, and Well Scan read types. The Luminescence and Time-Resolved
Fluorescence read modes use the Automatic setting and the following options are not
available.

e Select High for samples that have a lower concentration (dim samples).

e Select Medium for samples that have medium concentration.

e Select Low for samples that have a higher concentration (bright samples).

e Select Manual to enter a specific voltage.

The SpectraMax i3x uses two light sources. The Spectral Fusion™ lllumination uses the spectral
range of a high power Xenon flash lamp intensified by LEDs in the visible range. The
instrument uses automatic LED power adjustment with high PMT Gain when the excitation
wavelength is between 430 nm and 680 nm for high sensitivity across multiple fluorophores. In
multiple-wavelength reads, the PMT Gain is set to High and cannot be changed.

For some instruments, the PMT sensitivity is set to Automatic for the Luminescence and Time
Resolved Fluorescence read modes. For these instruments, the PMT Gain category is not
available for these read modes.

To set the resolution for the full scan and for a secondary scan of a region of interest for
Western Blot membrane scans:
1. Click the Default Scan Resolution and select the resolution to apply to the entire read area

of the membrane you define inthe Read Area category settings.

2. Click the ROI Scan Resolution and select the resolution to apply to the region of interest
(ROI) you define in the Plate section.

A High resolution scan provides the best results. A Low resolution scan provides the fastest

read.

The general workflow to acquire Western Blot data is to scan the read area of the membrane

you define with a low resolution and then scan the region of interest (ROI) you define at a high

resolution.

For some instruments in certain read modes, you can enter the Integration Time or the number
of Flashes Per Read.
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On-the-Fly Detection

Some detection cartridges for the SpectraMax i3x and SpectraMax Paradigm provide the On
the Fly Detection options.
On-the-Fly Detection yields faster read times because the plate moves continuously as the
instrument measures each well.
To disable On-the-Fly Detection and have the plate stop moving for each read:

e Select Off-Stop and Go.
To use On-the-Fly Detection:

e Select Performance for a faster read time than not using On the Fly Detection, but not as
fast as the Speed mode. Performance provides considerably better results than Speed for
demanding assays.

e Select Speed for the fastest possible read time per plate. However, there is a tradeoff

between the data quality and read speed because the instrument samples each well for
shorter integration times.

To set the integration time for the FilterMax F5, SpectraMax i3x, and SpectraMax Paradigm with
some detection cartridges:

¢ Inthe Integration Time field, enter the number of milliseconds to validate the
measurement time per well.

To have aninstrument with bottom read capability read up through the bottom of the plate:
e Select the Read From Bottom check box.

For the FilterMax F5, SpectraMax i3, SpectraMax i3x, SpectraMax iD3, SpectraMax iD5, and
SpectraMax Paradigm you can enter the read height.

CAUTION! To prevent damage to the instrument, set the plate height and read height
accurately before you start a read.

To set the read height:

* Inthe Read Height field, enter the distance in millimeters between the objective lens and
the plate.

Read Height Optimization
Use the Read Height Optimization feature to find the optimized read height before the read.

1. Select the More Settings category.
2. Select the Show Pre-Read Optimization Options check box.
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Timing Settings

Use the Timing category in the Settings dialog to define the total run time and the time interval
between reads for the Kinetic read type and Flex read type.

Each instrument has a unique minimum read interval that depends on factors that include the
number of wavelengths, the number of wells to read, and the distance the instrument filter
wheel must move. The maximum read interval also varies by instrument, for example, the
SpectraMax M2 has a maximum read interval of 2 hours and 45 minutes, and the SpectraMax
Paradigm has a maximum read interval of 18 hours and 12 minutes. If you enter an invalid read
interval, a message indicates the minimum or maximum value for the read interval.

* Tip: In some cases, choosing wavelengths in ascending order can yield the shortest
possible interval.

The software calculates the minimum interval, maximum interval, and number of reads based
on the values you enter in the Total Run Time field and the Interval field. The minimum
permitted interval values display below the Interval field.

To define Timing settings when you select the Row and Column read order in the More
Settings category:
1. Inthe Total Run Time field, enter the total run time.
2. Inthe Interval field, enter the time to wait between reads.
To define Timing settings when you select the Well read order in the More Settings category:

1. Inthe Well Run Time field, enter the well run time.
2. Inthe Interval field, enter the time to wait between reads. You can define the Interval down
to the millisecond.

Single Point Read

Single Point Read sets the Total Run Time and the Interval to the same value and is useful for a
multitask kinetic read with alternating read modes within a cycle. See Defining and Running
Workflows on page 104.

To read only one time point:
e Click Single Point Read.
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Well Scan Settings

Use the Well Scan Settings category in the Settings dialog to define the pattern and density for
the reads within each well.

The well scan read type takes reads at more than one location within a well. The well scan
read type takes multiple reads of a single well of a plate on an evenly spaced pattern inside of
each well at single or multiple wavelengths.

For applications that involve the detection of cells in large area tissue culture plates, the well
scan read type permits maximum surface area detection in cell-based protocols. Since many
cell lines tend to grow as clumps or in the corners of plate wells, you can choose the well scan
pattern and define the number of points to scan in order achieve the best results.

The image in the Well Scan settings displays the shape of the well based on the definition of
the plate you select. The fill pattern is either round or square to match the well shape. The
number of available points depends on the well size.

Density determines the number of points to read in the line patterns and the maximum number
of horizontal and vertical points to include in the cross or fill pattern.

To define Well Scan settings:
1. Select a Pattern. Up to four scan patterns are available, depending on the instrument.

0 @

Heorizontal Vertical Cross Fill

2. Click the Density drop-down and select the density.
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Shake Settings

Use the Shake category in the Settings dialog to set options to shake the plate inthe chamber.
Shake options are dependent on the instrument and the read type you select.

To define shake settings:
e Select the Before First Read check box to shake the plate for the duration you enter into
the text field before the first wavelength read.
e Clearthe Before First Read check box to not shake the plate.
For the Kinetic read type, you can shake the plate before the first read and you can shake the
plate between reads. For single wavelength reads, this shakes the plate before eachread at
that wavelength. For multiple wavelength reads, this shakes the plate before each read at the
first wavelength only.
To define shake settings for the Kinetic read type:
e Select the Between Reads check box to shake the plate for the duration you enterinto the
text fields between reads.
e Clearthe Between Reads check boxto not shake the plate between reads.

% Note: The Before First Read and Between Reads options are available in the Standard
View. To shake the plate from the Acquisition view, place a Shake node in the time line
where you want the shake to occur.

For the FilterMax F3, FilterMax F5, SpectraMax i3, SpectraMax i3x, and SpectraMax Paradigm,
define the following shake settings:
1. Select the Before First Read check box.
2. Inthe text field, enter the length of time to shake the plate in seconds.
3. Click the Shake Intensity drop-down and select Low, Medium, or High. The actual shake
speed is based on the plate format.
4. Click the Shake Mode drop-down and select Linear or Orbital.
For the SpectraMax iD3 and SpectraMax iD5, define the following shake settings:
1. Select the Before First Read check box.
2. Inthe text field, enter the length of time to shake the plate in seconds.
3. Click the Shake Intensity drop-down and select Low, Medium, or High. The actual shake
speed is based on the plate format.
4. Click the Shake Mode drop-down and select Orbital, Linear, or Double Orbital.

Speed Read Settings

Use the Speed Read category in the Settings dialog to read the plate faster for the
Absorbance read mode by decreasing the number of lamp flashes. The Speed Read optionis
useful for the spectrum read type and can greatly reduce the protocol run time.

For instruments that support software calibration, Speed Read turns off calibration and uses the
air calibration values stored in the instrument firmware. As a result, Speed Read might not
provide as accurate an absorbance measurement at each wavelength of a scan as with the
normal read.

To define Speed Read settings:

e Selectthe Speed Read check box to use the speed read.
e Clearthe Speed Read check box to not use speed read.
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Well Area Settings

Use the Well Area Settings category in the Settings dialog to acquire images at more than one
location, or site, within a well to form a single seamless tiled image for the Imaging read mode.
If you select to acquire images of more than one site in the well, the software tiles the images
togetherinto a single image for analysis. Image acquisition time increases with each site you
select. For fasterimage acquisition, select fewer sites.

To define Well Area settings, select the number of sites to acquire:

Well Area Settings

) 15Site

) 2 Sites
@ 4 Sites
) 9 Sites

1 12 Sites

Image Acquisition Settings

Use the Image Acquisition Settings category in the Settings dialog to define the exposure time
and focus adjustment for two sample wells. The instrument uses these settings for every wellin
the plate during acquisition. You can set the exposure and focus adjustment separately for
each wavelength or channel.

The instrument acquires one site in each well. If you select to acquire more than one site, the
instrument acquires the first site.

To acquire the image for maximum intensity:

1. Click E]to the right of the Well field above the maximum intensity image area.
2. Click the well you expect to have the brightest image. The well displays red.
3. Click Acquire Max Image and wait for the instrument to acquire the image.

To acquire the image for minimum intensity:

1. Click E]to the right of the Well field above the minimum intensity image area.

2. Click the well you expect to have the darkest image. The well displays blue.

3. Click Acquire Min Image and wait for the instrument to acquire the image.
For some multi-channel experiments, the brightest and darkest images for one channel can be
different than the brightest and darkest images for another channel. In this case, try to locate
the wells that give you the best results between the different channels.
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To view the image for a specific wavelength:

e C(Click the tab above the image for that wavelength.
To view animage with all the wavelengths:

e Click Composite.
To zoom the image in and out:

e Right-click the image and select Zoom In or Zoom Out,
e Hold the CTRL key and press + or -.
e Use the mouse wheelto zoom in or out.

To move the image in the image area:

e Use the scroll bars or click the image and drag it into position.
To view a larger version of the image area:

e Double-click the image to display the Zoom Well dialog.
See Zooming Image in a Well on page 176.

Set Exposure Time and Focus Adjustment
You can adjust the exposure and focus separately for each wavelength or channel.
To view the image for a specific wavelength:

e Click the tab above the image for that wavelength.
To view an image with all the wavelengths:

e Click Composite.
Set the exposure and focus adjustment in the row you designate for the specific channel.
Exposure
Use Auto Exposure to have the software determine the perceived best intensity for the Max
Intensity or Min Intensity image, whichever is brightest. To view what effect the new exposure
value has on the images, acquire the maximum intensity and minimum intensity images again.
To have the software determine the best exposure:

e Click Auto Expose.
Increase the exposure time to increase the intensity of the image or decrease the exposure

time to decrease the intensity of the image. After each adjustment, acquire the images again
to view what effect the change has on the intensity.

To manually adjust the intensity of the images,
e |nthe Exposure field, enter the number of milliseconds to hold the camera shutter open.
Focus

The system optics use a laser automatic focus system and software algorithms to find the initial
focus distance for the cells in the plate wells. Increase the Focus Adjustment value to move the
objective lens closer to the sample. Decrease the Focus Adjustment value to move the
objective lens farther away from the sample. The instrument uses this setting for every well in
the plate during acquisition.

For transmitted light images, make sure that enough contrast exists between the objects and
the background. Less contrast exists as you make the focus sharper. For best results when you
use a preset drawing analysis, make sure that the objects are brighter than the background.
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To adjust the focus:

® Inthe Focus Adjustment field, enter the number of microns to move the objective lens
closer to or farther away from the sample.

After each adjustment, acquire the images again to view what effect the change has on the
focus.

Image Analysis Settings

Use the Image Analysis Settings category in the Settings dialog to define how to analyze
images for the Imaging read mode.

To acquire images without analysis:
e Click No Analysis.

Discrete Object Analysis

Discrete Object Analysis uses proprietary algorithms to analyze separate objects, or cells,
based on multiple parameters including the signal intensity over the background and the size
of the objects. You can use transmitted light or a fluorescent wavelength to find nuclei or easily
separable objects in the image. The StainFree Cell Detection Algorithm uses proprietary
transmitted light analysis technology to eliminate cell staining for cell counting and confluency
measurements.

To define discrete object analysis settings:

1. Click Discrete Object Analysis to display the Wavelength for Finding Objects list.

2. Select the wavelength to use to identify the objects in the well images.

3. Selectthe Image Analysis Settings category.

4. Click Find Objects and enter size and intensity values or use proprietary algorithms with
the drawing tools to graphically define the objects and the background areas for the
analysis. See Finding Discrete Objects or Confluent Areas on page 129.

5. Click Classify Objects and define separate measurements for different types of found
objects, or cells. See Classifying Discrete Objects on page 133.

6. Click Select Measurements and view the results of the analysis for the wells you select.
See Viewing and Selecting Measurement Statistics on page 134.

Field Analysis

Field Analysis uses proprietary algorithms to analyze confluent areas based on parameters
including the signal intensity over the background and the size of the areas.

To define field analysis settings:

1. Click Field Analysis to display the Wavelength for Finding Confluent Areas list.

2. Select the wavelength to use to identify the confluent areas in the well images. The
StainFree Cell Detection Algorithm eliminates cell staining for cell counting and confluency
measurements using proprietary transmitted light analysis technology.

3. Click Find Confluent Areas and use proprietary algorithms with the provided drawing tools
to graphically define the confluent areas and the background areas for the analysis. See
Finding Discrete Objects or Confluent Areas on page 129.

4. Click Select Measurements and view the results of the analysis for the wells you select.
See Viewing and Selecting Measurement Statistics on page 134.

The SoftMax Pro Software proprietary algorithms with the drawing tools in the Find Objects

and Find Confluent Areas settings help the software learn the patterns of the objects you want

to find. Depending on the complexity of the object patterns, this teaching process can take

several iterations. See Resolving Issues with Object Drawing and Finding on page 135.
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Finding Discrete Objects or Confluent Areas

The Find Objects or Find Confluent Areas settings display the minimum and maximum images
from the Image Acquisition Settings.

E A
e Click @to view the page in full screen.

o
e Click to restore the page to its original size.

In full screen view, select the tabs at the top of the page to switch between the different
analysis settings.

Use the buttons above the image to switch the view of the image between wavelengths and
to show or hide found objects (or confluent areas) and drawings. When a button is filled, the
related wavelength, objects (or confluent areas), and drawings display in the image. When a
button is outlined, the related wavelength, objects (or confluent areas), and drawings do not
display in the image. When you click a button above one of the images, it affects the display of
both images.

(M su G3) (Objecs) (Drawing)

Use the controls below the image to adjust the intensity of each wavelength.

To adjust the wavelength intensity:

1. Select the wavelength to adjust.
-~ I

2. Drag the slider bar on the left to adjust the low level of intensity or click @to move the
sliders to the outside edges. The intensity level displays above the bar.

3. Drag the slider bar on the right to adjust the high level of intensity or click @ to move the
sliders to the outside edges.
4. From the list on the right, select the color for the view.
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For fluorescent acquisition and discrete object analysis, select a Finding Method:

e Select Set Size and Intensity to define the intensity threshold above the background
intensity to apply separately to each object in the image that meets the defined size
range. Use this analysis to detect objects in areas of the image where the intensity is
uneven.

e Select Draw onlImages to use the drawing tools to help the software learn the patterns of
the objects you want to find.

Set Size and Intensity

The Set Size and Intensity settings are available for fluorescent acquisition and discrete object
analysis.

To define set size and intensity settings:

Click !

Click four or more representative objects on the images that you want to detect as cells.

In the Min Width field, enter the minimum width of the object to find, in microns.

In the Max Width field, enter the maximum width of the object to find, in microns.

In the Intensity Above Background field, enter the intensity threshold above the
background intensity at which to detect the dimmest object. For example, if the
background intensity is 1000 and the intensity of the dimmest object is 1200, enter 200.

6. Click Apply.

Grow

Use the Grow setting to define the number of pixels to increase the diameter of the found
objects in one wavelength, so the objects can be measured at the new size in another
wavelength of the acquisition. For example, if you use a stain for nuclei, you can find the object
in the first wavelength and then increase the diameter to find the protein of interest in another
fluorescence wavelength. The innovative "grow without touching" algorithm increases the size
of the measured areas without letting the areas touch or overlap their edges.

O s> W N =

Draw onImages
Use the drawing tools to help the software learn the patterns of the objects or confluent areas
you want to find. Depending on the complexity of the object or area patterns this teaching
process can take some time. Each preset drawing analysis works with specific cell types.
Select the preset analysis that works best with yourimages.
To use a preset drawing analysis:

1. Inthe Settings list, select a preset drawing.

2. Click Apply to find objects or confluent areas that use the preset.

3. Afteryou acquire data, select Stored Setting in the Settings list to use the previously

defined analysis settings.
4. To start from scratch, select Create New Setting in the Settings list.
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To select the objects for fluorescent acquisition and discrete object analysis:

% Note: This method is not available for transmitted light acquisition or for confluent area
analysis.

1. Click .

2. Click a line width.

3. Click four or more representative objects on the images.
To define the objects or confluent areas:

1. Click the object orarea pen

2. Select aline width.

3. Fordiscrete object analysis, draw inside the object up to the edge, but do not include the
edge. When the object is filled in with yellow, the drawing is outlined in green. For best
results, fill in four or more representative objects.

4. Forfield analysis, draw across confluent areas, avoiding background. For best results, draw
across four or more representative areas.

To define the background:

1. Click the background pen
2. Select aline width.
3. Draw onthe image to define artifacts and background areas in blue.

* Tip: For best results, define four or more representative background areas.
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To correct a drawing of an object or area:

e Click Undo to undo the most recent action.
e Click Redo to restore the most recent action.
e Click Start Over to clear the drawings from the image.

To erase parts of drawings:

F

Click Erase.

Select a line width.

Drag the eraser across the drawings to remove.

After you define the objects and areas, click Apply to find the objects or confluent areas in
the image.

5. Continue to draw and to apply until you get satisfactory results. See Resolving Issues with
Object Drawing and Finding on page 135.

A WN -

You can then classify objects or view the measurement statistics.
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Classifying Discrete Objects

The Classify Objects settings display the minimum and maximum images from the Image
Acquisition settings display along with the found objects from the Find Objects settings. The
Classify Objects settings are not available for field analysis of confluent areas.

% Note: Before you can classify objects, you must first find objects in the Find Objects
settings. See Finding Discrete Objects or Confluent Areas on page 129.

Use the bottom of the page to classify the found objects in the images into two separate
classifications.
Settings Classification Selection
Use Existing Classification | & |i I
| Skip Classification

(@ Create New Classification | O IEJ"‘l'J"‘|’E| Q | Typ=E

Start Over Apply

To classify the found objects:
e Select Use Existing Classification to use the previously defined classification settings
when in Re-Analysis mode.
e Select Skip Classification to not use classification in the analysis.
e Select Create New Classification to replace the Type A and Type B titles with your own
titles for the classifications. See below.
Create New Classification
When you select Create New Classification, you can replace the Type A and Type B titles with
your own titles for the classifications. Titles must use only letters, numbers, and spaces, and
can be up to 16 characters long, including spaces. Titles must start and end with a letter. The
titles must be unique and you cannot use "Exclude" as a title, since this is a reserved word.

To create a new classification:

1. Click |a to select objects for the first classification then click the objects in the images.

2. Click |i| to select objects for the second classification then click the objects in the
images.

3. To exclude objects from being classified, click |ﬂ then click the objects in the images. If
you exclude objects, you must also use at least one of the classifications types to include
objects.

To deselect a selected object click it again.

To remove all the selections from the images, click Start Over.

Click Apply to find and classify the objects in the image.

Continue to select and to apply until you get satisfactory results.

View the measurement statistics.

0 N O
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Viewing and Selecting Measurement Statistics

The Measurement Selections settings table displays the analysis results for the minimum
intensity and maximum intensity images. The possible included measurements are as follows:

Object Count: The total number of objects detected in the image. Do not use for field
analysis of confluent areas.

Field Count: The total number of confluent areas detected in the image. Do not use for
discrete object analysis.

Object Percentage: The percentage the objects detected in the image by classification.
Do not use for field analysis of confluent areas.

Covered Area: The combined area of all the objects or confluent areas detected in the
image as a percentage of the entire image area.

Object Area: The average area of the objects detected in the image expressed in um?2. Do
not use for field analysis of confluent areas.

Field Area: The average area of the confluent areas detected in the image expressed in
um?. Do not use for discrete object analysis.

Object Roundness: The average roundness of each object detected in the image. A shape
factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all. Do not use
for field analysis of confluent areas.

Field Roundness: The average roundness of each confluent area detected in the image. A
shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all. Do
not use for discrete object analysis.

Object Average Intensity: The average fluorescent signal intensity of the objects detected
in the image. Do not use for field analysis of confluent areas or for transmitted light.

Field Average Intensity: The average fluorescent signal intensity of the confluent areas
detected in the image. This is not used for discrete object analysis or for transmitted light.
Object Intensity: The average total fluorescent signal intensity of the objects detected in
the image. Do not use for field analysis of confluent areas or for transmitted light.

Field Intensity: The average total fluorescent signal intensity of the confluent areas
detected in the image. Do not use for discrete object analysis and do not use for
transmitted light.

Total Intensity: The combined total fluorescent signal intensity of the objects or confluent
areas detected in the image expressed in million intensity counts. Do not use for
transmitted light.

To include the measurements in the analysis:

1.

Click Select Measurements in the lower-right area of the page.

e Click Remove to exclude a measurement.

e Click Add to include a measurement.

e Click Remove All to exclude all measurements.

e Click Add All to include all measurements.
Click Done to add the measurements to the data reduction list that you use to view data in
the Plate section or to add to a Group section for further analysis. See Plate Sections on
page 80 or Group Sections on page 86.
Click Show Detalls to view the measurements in an interactive image, data table, and
chart. See Viewing Imaging Data in Wells on page 205.
If no measurements display and you did not make changes to the analysis settings since
the last measurement, click Measure to analyze the selected wells. This is useful if you
change acquisition wells and want to analyze the new wells.
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Resolving Issues with Object Drawing and Finding

The SoftMax Pro Software proprietary algorithms provide drawing tools in the Find Objects or
Find Confluent Areas settings to help the software learn the patterns of the objects that you
want to find. Depending on the complexity of the object patterns, this teaching process can
take several iterations.

The software uses a complex algorithm to learn the properties of the cells or confluent areas in
the image. The algorithm examines each pixel and how it relates to its surrounding area. Cells
change shape and size under different conditions such as confluency. Artifacts can look like
cells or confuse the algorithm. Cells that are touching are more difficult to find than sparse cells
in animage. Compleximages can require more drawing examples to create a good training
set.

Some common issues with finding cells and confluent areas are as follows:

e Under splitting finds multiple cells or confluent areas that can also include background.

e Over splitting finds portions of cells or confluent areas and can include several found
objects within a single cell or confluent area.

e Artifacts can be found and counted as cells or confluent areas.

e Ghosting finds background areas next to cells or confluent areas.

Each preset drawing analysis is designed to work with specific cell types. Select the preset
analysis that works best with yourimages.

To resolve issues:

1. Inthe Settings list, select a preset drawing analysis.
2. Click Apply to find objects or confluent areas using the preset.

For transmitted light images, make sure that enough contrast exists between the objects and
the background. The sharper the focus, the less contrast exists. To increase the contrast
between the objects and the background, move the lens closer to or farther away from the
plate.

Adjust the focus in the Image Acquisition Settings. Increase the Focus Adjustment value to
move the objective lens closer to the sample. Decrease the Focus Adjustment value to move
the objective lens farther away from the sample. In general, move the lens closer to make the
objects darker than the background, move the lens farther away to make the objects brighter
than the background.

% Note: For best results when you use a preset drawing analysis, make sure that the
objects are brighter than the background.

To create aniterative training set for compleximages:

1. Carefully draw four or more cells or confluent areas that best represent your target
population. Draw inside the cell or confluent area up to the edge, but do not include the
edge.

2. Define the artifacts and background areas in the image.

Apply the drawing and then try to fix the problems.

4. Continue to adjust the drawings. After you fix some problems, the results can look worse
as the algorithm emphasizes the fixes. Continue to adjust to create a complete training set.

5. Afterthe result looks reasonable, scroll and look around the image for otherissues.

6. Stop whenyou are satisfied or you get diminishing returns. As the training data set grows,
more drawings will have less impact. At some point changes will be of little benefit.

w
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If, at the end of the process, it is still not right, start again and repeat all the steps. Sometimes
there is something that had an unexpected influence on the algorithm and starting over can
produce a better result.

Resolve Under Splitting Issues

Under splitting finds multiple cells or confluent areas that can also include background.

Under splitting can be caused by drawing outside of the edge of the cells or confluent areas.
The lines between the cells or confluent areas are interpreted as being part of the cell or
confluent area structure.
To resolve under splitting issues:
e Draw inside the cell or confluent area up to the edge, but do not include the edge. You can
also use the background pen to draw on the lines between the cells or confluent areas.
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Resolve Over Splitting Issues

Over splitting finds portions of cells or confluent areas and can include several found objects
within a single cell or confluent area.

Over splitting can be caused by drawing too small within the cells or confluent areas.
Sometimes over splitting can happen after you use the background pen to remove an artifact.

To resolve over splitting issues:

e Draw inside the cell or confluent area up to the edge, but do not include the edge.

]

If over splitting is the result of artifact removal:

e FErase the blue from the artifact you defined with the background pen.
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Resolve Artifact Issues
Artifacts can be found and counted as cells or confluent areas.

]

Artifact issues can be caused by debris or other artifacts in the image where the edges and
surrounding pixels confuse the software.

To resolve artifact issues:

e Use the background pen to define artifacts as background and not cells or confluent areas.
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Resolve Ghosting Issues
Ghosting finds background areas next to cells or confluent areas.

]

Ghosting can be caused by the edges of cells or confluent areas and the surrounding pixels
that confuse the software.
To resolve ghosting issues:
e Use the background pen to draw over the area of the ghost. Draw this area right to the
edge of the cell or confluent area.

e |f necessary, use the object pento draw on the cell or confluent area so that the drawing
goes out to the edge of the cell or confluent area.
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Region of Interest Settings

You can define a region of interest for the images in all wells to analyze for your application.
The software uses only the region of interest you select for analysis. This is useful if cells tend
to congregate in the same region of the wells.

To select the well to use to define the region of interest:

1. Click E]to the right of the Well field above the image area. The well fills with red and is
used to determine the region of interest.
2. Select the well to use and click Acquire All Sites.

To view the image for a specific wavelength:

e Click the tab above the image for that wavelength.
To view an image with all the wavelengths:

e Click Composite.
To zoom the image in and out:

e Right-click the image and select Zoom In or Zoom Out,
e Hold the CTRL key and press + or-.
e Use the mouse wheel to zoom in or out.

To move the image in the image area:
e Use the scroll bars or click the image and drag it into position.
To define a region of interest:

1. Select the Enable Region Selection check box to display a rectangle on the image. Click
Resize and then drag the corners of the rectangle to redefine the size of the region.
Clear the Enable Region Selection check box to use the entire image for the analysis.

2. Tostart over, click Draw and then drag a new rectangle on the image to define the region.
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More Settings

The More Settings category in the Settings dialog provides more settings options. The options
vary depending on the instrument, read mode, and read type.

Calibrate

The More Settings category in the Settings dialog provides a Calibrate option for some
instruments.

Forthe Absorbance read mode, the instrument makes an air-calibration measurement at each
wavelength before the read. If you turn calibration off, the software uses the air-calibration
values stored in the instrument firmware or the values from the previous calibration.

For Fluorescence and Luminescence read modes, the instrument makes a reference read at
each wavelength before the read. If you turn calibration off, the software uses the default
values stored in the instrument firmware or the values from the previous calibration.

For the kinetic read type, the instrument makes the calibration measurement between reads
during a run, unless the read interval is too short to allow calibration.

To define calibration settings:

Calibrate:

New calibrations overwrite the calibration setting stored in firmware for the current data
acquisition read, and for any subsequent reads you do with the Calibration check box clear.

When you power the instrument off and then back on, calibrations reset to those stored in the
firmware.

e Select the Calibrate check box to have the instrument run calibration for the wavelengths
you specify before each read. You should calibrate at each assay wavelength for at least
one plate before you turn off calibration.

e Clearthe Calibration check box to have the instrument begin reads or complete reads
more quickly.

To update air-calibration values stored in the firmware:

1. Select the Operations tab.

2. Click Calibration.
3. See Instrument Calibration on page 339.

Carriage Speed

The More Settings category in the Settings dialog provides a Carriage Speed option for some
instruments. You can slow down the carriage speed for samples (such as, fragile clots) that
rapid carriage movement can disrupt.

Click the Carriage Speed drop-down:

e Select Normal to use the normal carriage speed.
e Select Slow to use a slower carriage speed.
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Read Order

The More Settings category in the Settings dialog provides a Read Order option that varies
depending on the instrument, read mode, and read type.

Read Order:
Click the Read Order drop-down:

e Select Column to have the instrument read the entire plate (or a number of strips) at the
first wavelength. The instrument then goes back and reads the plate at the second and
subsequent wavelengths.

e Select Wavelength to have the instrument read all wavelengths for the first column of wells
in the plate first and then read all wavelengths for the second column, third column, and so
on.

Read Order:
Click the Read Order drop-down:

e Select Row to have the instrument read the entire plate row-by-row at the first wavelength.
The instrument then goes back and reads the plate at the second and subsequent
wavelengths.

e Select Column to have the instrument read the entire plate column-by-column at the first
wavelength. The instrument then goes back and reads the plate at the second and
subsequent wavelengths.

e Select Wellto read each well individually with all wavelengths and intervals you define for
the read before the software reads the next well.

Settling Time

The More Settings category in the Settings dialog provides a Settling Time option for some
instruments.

Settling Time:

Settling Time is the delay between the motion of the instrument and the start of the read. This
delay allows time for the meniscus motion to cease, which can improve precision, especially in
the low density, high volume plates with fewer than 96 wells.

e Select the Settling Time check boxto add a delay between the read of each column. In
the Duration field, enter the delay time between 100 and 1000 milliseconds. There is no
delay between each wellin a column.

e Clearthe Settling Time check boxto not have a delay.

Show Pre-Read Optimization Options

The More Settings category in the Settings dialog provides a Show Pre-Read Optimization
Options check box for some instruments. From the Acquisition view, you can add Plate
Optimization to the beginning of the time line. Plate dimensions can vary slightly between
production lots, which can have a potential effect on measurement accuracy.

To define pre-read optimization settings:

e Select the Show Pre-Read Optimization Options check box to display the Pre-Read
Optimization Options dialog before the instrument reads the plate. Use this dialog to
optimize the plate dimensions after you click Read and before the instrument reads the
plate. See Pre-Read Optimization Options on page 181.

e Clearthe Show Pre-Read Optimization Options check box to use the plate dimensions
saved in the plate library.
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Use the Pre-Read Optimization Options dialog helps you optimize plate dimensions by
determining the centers of the four corner wells on the plate. The software adds a new plate
definition to the plate library each time you optimize a plate. If you change the plate
orientations for measurements, you must optimize each orientation separately.

If the instrument has an adjustable objective lens, the Pre-Read Optimization Options dialog
allows you to move the lens up and down to optimize the read height for several read modes.
You optimize the read height to match the focus of the optics with the sample volume. This
maximizes the raw signal, which yields the highest precision and maximum sensitivity.

Attenuation

The More Settings category in the Settings dialog provides an Attenuation option for some
instruments. Attenuation filters reduce the intensity of very bright samples that can exceed the
linear dynamic range of the detection system.

To define Attenuation settings:

e Select the Attenuation check boxto use attenuation filters for very bright samples.
e Clearthe Attenuation check boxto not use attenuation filters.

Normalization

The More Settings category in the Settings dialog provides a Normalization option for
instruments that support the AlphaScreen read mode. The conversion rate of photons to
counts is individual for each detector. Raw data from the same plate can seem to be different
from one instrument to the next. The data format each instrument manufacturer uses can be
counts normalized-per-second or not-normalized counts, therefore raw data can be different
by several orders of magnitude.

% Note: The number of counts and the size of figures is in no way an indication of
sensitivity.

To define normalization settings:

e Select the Normalization check box to normalize raw data to counts per second.
e Clearthe Normalization check box to not normalize raw data to counts per second.

Interlaced Reading

The More Settings category in the Settings dialog provides an Interlaced Reading option for
the SpectraMax i3x and SpectraMax Paradigm when you install the AlphaScreen detection
cartridge and do an Endpoint read type.

When you read a sample with a small signal, an interference can occur from the afterglow of a
very strong emitting adjacent sample that the instrument just measured. Such cross talk can
occur through the wall of a white 384-well plate. Use Interlaced Reading to have the instrument
read every other well in a checkerboard pattern, and then do another plate run to read the
omitted wells.

Although background is significantly lower with the AlphaScreen read mode than with the
Fluorescence Intensity read mode measurements, you should use blank or assay controls for
background correction. Use blank replicates to effectively measure the background. For
improved results, use replicates for all blanks, controls, and samples.
To define interlaced reading settings:

e Select the Interlaced Reading check box to prevent interference.

e Clearthe Interlaced Reading check box to not use the feature.
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Compound Transfer Settings
The Compound Transfer category in the Settings dialog displays for the FlexStation 3.

You must configure all compound transfer settings correctly. When you select to do compound
transfers, four additional categories appear in the Settings dialog. Use these settings to define
precise fluid transfers for the protocol and help prevent flooding of the assay plate. Keep in
mind the actual maximum volume the wells allow as you define the settings. The maximum
cumulative volume depends on the assay plate type you select.

For the Endpoint and Kinetic read types, the transfers are done to all the wells you select
before the first read.

Forthe Flex read type, the transfers are done for a column while that columnis read. All
transfers and reads are done for that column before the instrument moves to the next column.

To set the number of compound transfers in each column during a read:
Click the No. of Compound Transfers drop-down.

e Select 0to not do compound transfers for the read. No other options display and no other
settings are required.

e Select1to do one compound transfer. "‘ displays with additional settings.
e Select 2 to do two compound transfers. " f displays with additional settings.

e Select 3 to do three compound transfers. ( f 'f displays with additional settings.
Initial Volume

The software assigns the initial volume to all wells and uses this value to compute the total
volume in each well after all fluids dispense. As you define the volume for each transfer in the
Compound & Tips Column category, the software uses the Initial Volume value to warn you of
the potential for overflow of fluid from the wells. See Compound and Tips Columns Settings on
page 149.
In the Initial Volume field, enter a value that equals the largest initial volume in the wells of the
assay plate before the compound transfers. If there is no fluid volume in the assay plate before
the compound transfers, enter O.
e Fora 96-well plate, this value can be O pL to 269 pL. Typical values are about 10 pL to
200 pL.
e Fora 384-well plate, this value can be O pL to 120 pL. Typical values are about 5 L to
80 L.
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Transfer Settings
You define the following settings for each compound transfer.

1. Select the compound transfer to define.

Note: The compound transfer you select displays with a light blue background and
this is the only indication for which transfer you are defining.

2. Inthe Pipette Height field, enter a value between 1 pL to 300 pL for a 96-well plate or1 pL
to 130 pL for a 384-well plate. This setting determines the volume of fluid in microliters,
measured from the bottom of the assay plate well, above which the tip of the pipette is to
remain during the dispense portion of the transfer event. Use this setting to place the tip of
the pipette below the surface of the liquid at the end of the transfer to minimize the
possibility that undispensed drops remain on the tips.

% Note: As you configure subsequent transfers, calculate the amount of fluid added
and set the pipette height accordingly. Example: If the initial volume is 15 pL and the
first transfer dispenses 20 pL, set the pipette height for the first transferto 25 pL. If
the second transfer dispenses 15 pL, set the pipette height for the second transfer
to 45 L.

3. Inthe Volume field, enter the volume of liquid to dispense to each well of the assay plate
that you select to receive the transfer.
e Fora 96-well plate, the range is 1 pyL to 200 pL.
e Fora 384-well plate, the range is 1 pL to 30 pL.

Note: Keep in mind the maximum total volume each well can hold as you
accumulate volumes with multiple transfers.

4. Inthe Rate field, enter a value of 1to 8. This setting determines the rate at which the
instrument dispenses fluid into the well of the assay plate.
® |na96-well plate, a setting of 1is equal to 16 pL per second and each subsequent
number increases in increments of V16 pL per second, so that a setting of 2 is equal to
31 L persecond.
® Ina 384-well plate, a setting of 1is equal to 4 pL per second and each subsequent
numberincreases in increments of 4 pL per second, so that a setting of 2 is equal to
8 yL persecond.
A setting of 1 or 2 can help minimize cell damage or dislodgment. For non-contact
dispensing, use a rate of 8 to make sure that all liquid dispenses from the pipette tip.

5. Inthe Time Point field, enter the point in time after the read starts when the fluid is to begin
being dispensed. This value must be equal to or greater than the value the instrument
displays for the Minimum Time up to 9999 seconds. This time point becomes the baseline
time. This is not the time interval between transfers. For the Endpoint and Kinetic read
types, Time Point is the time at which the first dispense occurs. The Endpoint or Kinetic
read begins after all transfers are made.

% Note: The Time Point value cannot be less than the Minimum Time the software
identifies for each transfer.
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6. The Minimum Time field displays the minimum time required before a pipetting event can
occur. This minimum time value is cumulative, not an interval between pipetting events.
The value is the minimum number of seconds of elapsed time from the beginning of the
read. It considers the mechanical speed of the pipette head and the time needed to load
and unload tips, aspirate and dispense fluids, triturate fluids, and shake the plate.

The minimum time for the second pipetting event depends on when the first pipetting
event occurs. The calculation for the second event starts at the end of the first event and
adds the total time necessary to load pipette tips, aspirate new fluids from the compound
plate, and dispense them into the assay plate.

Leave Tips On Between Columns

For the Flex read type, the pipettor returns the tips to the tip rack after all the transfers for a
column are complete and then installs tips from the tip rack before the first transfer for the next
column.

e Select the Leave Tips On Between Columns check box to use tips from the same position
in the tip rack for the first and last transfers in each column. This can reduce the cycle time
between columns.

e Clearthe Leave Tips On Between Columns check box to have the instrument install tips
from the tip rack before the first transfer for the next column.

You define tip assignments in the Compound & Tips Columns category. See Compound and
Tips Columns Settings on page 149.

Avoiding Problems

Time point calculations are based on the number of wells you select in the Read Area
category and the Pipette Tips & Columns category settings you define for the transfer. If your
Time Point entry is not long enough to be compatible with the volumes and transfer speed you
define, a message instructs you to increase the Time Point entry.

If you enter transfer volumes that add up to more than the maximum that can fit in the assay
plate, an overflow message indicates that you have exceeded the volume limit of the assay
plate.

% Note: The Minimum Time Value that displays below the Time Point field is different for
each transfer you define.

5049092 F



Chapter 3: Collecting Data

Compound Source Settings

Use the Compound Source category in the Settings dialog to select the plate type for the
compound plate. The instrument aspirates (withdraws) fluids from the compound plate and
then dispenses (injects) the fluids into the assay plate during the run.

The plate type you select in the Compound Source category must match the type and well
configuration of the actual compound plate to use and it must be compatible with the number
of wells in the plate type you select for the assay plate in the Plate Type category. See Plate
Type Settings on page 116.
The instrument sets the pipette height for the compound plate. The well bottom height is
different for different types of plates. Select the plate type correctly to prevent jamming the
pipette tips into the bottom of the well.
e For 96-well plates, the instrument aspirates using a pipette height of 20 pyL above the
bottom of the well.
e For 384-well plates, the instrument aspirates using a pipette height of 10 pL above the
bottom of the well.
You define the pipette height for the assay plate in the Compound Transfer category. See
Compound Transfer Settings on page 144.

Pipette

Pipette

Well Bottom

Compound

A CAUTION! Selection of an incorrect compound plate type can result in the pipette tips
jamming into the wells and damaging the plate, the tips, and the instrument.
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Pipette Tips Layout Settings

Use the Pipette Tips Layout category in the Settings dialog to define which pipette tips to use.
If you use a partial rack of tips, use this category to have the software instruct the instrument to
pull tips from the location of the tips you insert in the tip drawer.

When you select a 96-well assay plate in the Plate Type category, the Plate Tips Layout
category displays a column of 12 tips. See Plate Type Settings on page 116.

[] select Al

When you select a 384-well assay plate in the Plate Type category, the Plate Tips Layout
category displays a column of 24 tips.

: Select All

1234567 8 9101112131415161718192021222324

\ VVVVVVVIVAY

To use all the tips in the rack:
e Selectthe Select All check box.
The tips selection must be contiguous. To select a contiguous set of tips:

e Drag the mouse to select the tips to use.

If you change the assay plate type in the Plate Type category to a plate with a different
number of wells (for example, from 96-wells to 384-wells), the Pipette Tips Layout category
defaults to the selection of the full rack of tips.

A CAUTION! You should use a full rack of tips each time you do a fluid transfer. If you
configure a pipetting function from a tip that is not present, your samples do not receive
the intended compound. There is potential of damage to the plate, the tips, and the
instrument.
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Compound and Tips Columns Settings
Use the Compound & Tips Columns category in the Settings dialog to define the tips and
compounds to use for each transfer.

These settings are dependent on the selection you make in the Plate Type category for the
assay plate and the number of transfers you define in the Compound Transfer category. See
Plate Type Settings on page 116 and Compound Transfer Settings on page 144.

e Fora 96-well assay plate, 12 columns display.

e For 384-well assay plate, use the scroll bar to view the additional columns.
Each transfer appears as a color coded row.

[Auto Popuste
|auto populate

muopopulste] Kl 4| 2|3 |4|s|a|7|d|s]s|a

1008

75%

25% _ Volume

One transfer 96-well assay plate Two transfers 96-well assay plate Three transfers 384-well assay plate

The black row at the bottom represents the initial volume in the wells based on your Initial
Volume entry in the Compound Transfer category.

Your Read Area category setting also affects these settings. See Read Area Settings on page
19.
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Display for a read area that includes columns 3 - 8 on a 96-well assay plate

The left axis displays the dispensed compound volume as a percentage of the total well
volume on the assay plate.
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Each assay plate column has two indicators for each transfer:

e #T =Tips: Displays the column in the tip rack drawer from which the instrument will pull the
tip for the transfer. You define available tips in the Pipette Tips Layout category. See
Pipette Tips Layout Settings on page 148.

e #C=Compound: Displays the column in the compound plate from which the instrument
will aspirate the fluid to transfer to the assay plate for each pipetting event.

e Hoverthe mouse over a cell to display details including the transfer volume.

* Tip: To leave the tips on between columns for the Flex read type, select the Leave Tips
On between Columns check box in the Compound Transfer category.

Auto Populate

Use the Auto Populate feature to have the software assign the fluid to aspirate from the
compound plate starting with the first available column. The instrument then dispenses the
aspirated fluid to the first available column in the assay plate based on your Read Area
category settings.

The software makes the assignments based on the following conditions:

e All columns you select in the Read Area category are to receive fluid.

e The fluids transfer from left to right. The read-transfer-read sequence in each columnis
initiated only after the read-transfer-read event from the previous column completes (the
total read time for that column).

e The fluid transfer targets are cumulative from transfer to transfer. That is, the targets for the
second transfer start with the next available clean tip and untargeted compound column
rather than reusing tips and compound columns targeted by the preceding fluid transfer.

e Eachfluid transfer uses a new tip.

Example: Suppose you define the following settings for three fluid transfers:

e Read Area category: Columns 1through 4
e Compound Source category: 12-column compound plate, such as a 96-well plate
e Pipette Tips Layout category: Full rack of tips
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The software instructs the instrument to selects tips from columns 1 - 4 in the tip rack drawer, to
aspirate compound from columns 1 - 4 in the compound plate drawer, and to dispense the
compound into the wells in columns 1 -4 on the assay plate in the read chamber drawer. The
second transfer uses the next four columns (5 through 8), and the third transfer uses the
remaining four unused columns (9 through 12).

% Note: The software does not assign targets beyond the limitations of the available tips
and compound source columns. After all available tips and compound source columns
have been assigned, the software stops assigning targets.

To have the software automatically assign the tips and columns:

e Click Auto Populate.

Manually Populate
For more complex assays, you can manually define the tips to use and the columns from which

to aspirate compound.
Auto Pcpulate-
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Image example displays:

Read Area: columns 3 - 8 on a 96-well assay plate

Compound Transfers: 2

Selecting a tip with Pipette Tips Layout: columns 3-8

No fluid transfer for compound 2 into column 3

You can manually assign tips and source columns for each and every transfer.

To assign each transfer a set of tips from the tip rack and a column from the source plate:

1. Click T ina column to display a drop-down list of the pipette tip columns you made
available in the Pipette Tips Layout category. Select the column from which to have the
instrument pull the tip from the instrument tip drawer.

2. Click Cinacolumnto display a drop-down list of the number of columns in the compound
plate from which the instrument can aspirate the compound. Select the column on the
source plate from which to aspirate the compound.

3. Ifthe assay requires that no fluid is to transfer to the assay plate fora column during one or

more transfer operations, click X at the top of the drop-down list. _.I‘j displays for the
columns to skip.
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4. To allow a transfer for a skipped column, click |£I then assign the tip and source columns
for the transfer.

* Tip: To leave the tips on between columns for the Flex read type, select the Leave Tips
On between Columns check box in the Compound Transfer category.

Triturate Settings

Use the Triturate category in the Settings dialog to define how to mix the contents of the wells
in a plate by using the pipettor to alternately aspirate fluid from a well and then dispense it
back into the well.

Trituration is recommended when you need to resuspend the compound in the source plate
before it is added, when you transfer low volumes of fluid to the assay plate, or when you
transfer fluid before or during an absorbance read to make sure that the well contents are
properly mixed.

To define triturate settings:

1. ' f f - Select the compound transfer to define and repeat the following steps for
each applicable transfer.

2. Selectthe Compound Source check boxto do trituration in the compound plate.

3. Selectthe Assay Plate check boxto do trituration in the assay plate.

o
=] Note: Select both check boxes to do trituration in both plates.

4. Inthe Volume field, enter the volume of fluid in microliters to withdraw from the well.

In the Cycles field, enter the number of times to aspirate and dispense the fluid in the well.

6. Forthe Assay Plate, enter a value for the Height at which the trituration occurs. The height
setting must consider the trituration volume you enter and the total volume in the well to
have the tips remain below the liquid surface and not aspirate air.

o

% Note: If you enter a Time Point that is incompatible with the Triturate settings, a
message appears. You modify the Time Point in the Compound Transfer category. See
Compound Transfer Settings on page 144.

Acquisition View and Reads With Injectors

152

The Settings dialog for the SpectraMax i3, SpectraMax i3x, SpectraMax iD3, and SpectraMax
iD5 provides two methods to configure a plate read.

The Acquisition view uses an acquisition plan with tools that allow you to define settingsin a
workflow designh when you need to do multi-step plate reads.

=| Note: You must use the Acquisition view to define reads with injection.

To switch between the views:

° ClickI Standard View) Acquisition View inthe lower-left corner in the Settings dialog.

Note: If you define a read with injection and then switch to the Standard view, your
settings are not saved.
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The following image shows a read for a 96-well Standard plate of an entire plate with an
Acquisition Plan for a Luminescence kinetic read with Smartinject™ technology. The Acquisition
Plan starts with plate optimization and does 10 baseline reads before the injection step. It then
delays one second after the injection ends before the Luminescence read starts. All the
acquisition steps are in a Loop between the For Each Well node and the Next Well node.
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Use the top area of the dialog to select the plate settings, read area, and read order.

To define plate settings:

1.
2.

3.

Click the Plate Size drop-down and select the number of wells in the plate.
Click the Plate Name drop-down and select a plate.

Click @to display the Plate Editor dialog where you edit and create plates. See Plate
Editor on page 117.
Select the Plate has a Lid on Top check box if the plate has a lid.

Note: If the plate has a lid, you must verify that the plate height with a lid is set
accurately in the Plate Editor dialog before you start a read.

Click Read Area:
e Select the Select All check box to read all the wells in the plate.
e To select a contiguous, rectangular region on the plate, use your mouse to drag the
pointer and select the wells to read.
Select a Read Order:
e Select Row to read the plate row-by-row.
e Select Column to read the plate column-by-column.
e To do aWellread order, add a For Each Well loop in the Acquisition view.
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Toolbox and Acquisition Plan

The lower area of the dialog provides a toolbox that contains the available steps and the
Acquisition Plan that displays the time line of steps for the protocol.

° ﬁ Shake - Add a Shake step to have the instrument shake the plate in the chamber. Click

[-"ﬁ] to display Shake settings where you define the shake duration and shake method. To
shake the plate at the same time as an injection, add a Smartinject step not an Inject step
or a Shake step.

1@ Plate Optimizer - Add a Plate Optimizer node to have the software display the Pre-
Read Optimization Options dialog before the plate is read. You can place this step only at
the beginning of the Acquisition Plan. See Show Pre-Read Optimization Options on page
142.

@ Delay - Add a Delay step after an Inject step or a Smartinject step to have the

instrument wait after the injection before the read begins. Click [4‘?] to display Delay
settings where you define the number of seconds to wait between steps (from 0.001
seconds to 100 seconds). The Delay hode compensates for the hardware delay. See
below for details.

ﬁ Inject - Add an Inject step for a simple injection. Click [41?] to display Inject settings.
Select the injector to use and enter the number of microliters (uL) to dispense. You can
dispense from 1 pL to the maximum allowable volume of the well, based on the plate type
you select. Define the dispense volume based on the requirements of your assay and the
net volume available in the well. To shake the plate after an injection, add a Shake step
after the Inject step. To shake the plate during an injection, use a Smartlnject step not an
Inject step.

P
ﬁ;‘ Smart Inject - Add a Smartlnject step to shake the plate during an injection. The plate
continues to shake through the following delay step, if you add a Delay step and stops

shaking before the instrument reads the well. Click [4"“] to display Smartinject settings.
Select the injector to use and enter the number of microliters (uL) to dispense. You can
dispense from 1 pL to the maximum allowable volume of the well, based on the plate type
you select. Define the dispense volume based on the requirements of your assay and the
net volume available in the well.

E Baseline - For the kinetic read type, add a Baseline step before an Inject step ora

Smartlnject step to have the instrument take baseline reads. Click ["F] and enter the
number of baseline reads (from 1to 999). You can then subtract the baseline data from the
reads that follow the injection. You can use the Formula Editor dialog to automate baseline
subtraction.

tlf For Each Well - Reads with injection are generally done well-by-well. Use the For Each
Well loop to have the instrument run all the steps in the Acquisition Plan for each well
individually. All the injections, delays, and reads you define are done on the first well
before the steps are run again for the next well. The software adds a Next Well node to the
end of the plan. Add the steps for the assay between the For Each Well node and the Next
Well node.
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Creating Acquisition Plans

The steps in the Acquisition Plan occur in sequence from left to right between the Begin node
and the End node. When a step has multiple settings, the settings display below the step in the
time line.

To create an acquisition plan:

1. To start from scratch, click Clear All or click the Load Predefined Acquisition Template
drop-down and select a predefined Acquisition Plan.

2. Inthe Toolbox area onthe left, either double-click or drag Acquisitions, Actions, and Loops
to the Acquisition Plan. The software allows you to place each step in an appropriate place
in the plan. Example: You can place the Plate Optimizer node only at the beginning of the
plan.

3. Whenyou add a step to the Acquisition Plan, a prompt appears:

e Some Acquisitions require you to select hardware for the optical configuration. This
can be the monochromator or a detection cartridge for the SpectraMaxi3x. See
Supported Detection Cartridges on page 343.

e All Acquisitions require you to select a read type. See Endpoint Read Type on page
267, Kinetic Read Type on page 268, Spectrum Read Type on page 269, and Well
Scan Read Type on page 269.

4. Add Actions and Loops.

5. Add aninjector step or a Smartlnject step.

6. Click a node to display E@

e Click i to delete the node.

° Click[{”l to display settings for the node.

e \Wavelength Settings, see page 113

e PathCheck Settings, see page 120

e PMT and Optics Settings, see page 121

e Timing Settings, see page 123

e Well Scan Settings, see page 124

e Shake Settings, see page 125

e Speed Read Settings, see page 125

e Normalization, see page 143 (for SpectraMax i3x)

e [nterlaced Reading, see page 143
7. Afteryou define the settings for a step in the Acquisition Plan, click the Workspace outside
of the settings.
After you define the instrument settings, click OK to close the Settings dialog.
9. Before you start a read, you should save the document. See Saving Protocols and Data

Documents on page 31.

o
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SpectraMax i3x Injector Reads
To define injector reads for the SpectraMax i3x:

1. Install the SpectraMax Injector cartridge into the cartridge drawer.

2. Whenyou add a Luminescence read to the Acquisition Plan, select INJECTOR from the
Select Hardware list to use the SpectraMax Injector cartridge for the read. A
Luminescence read with injection is taken from the top of the plate.

3. Whenyou add a Fluorescence Intensity read to the Acquisition Plan, select MONO from
the Select Hardware list to use the instrument's built-in monochromator for the read.

Delay Details
SpectraMax i3x Delay
e ForLuminescence reads, there is a delay of 0.3 seconds after the injection ends and
before the read begins to allow time for the detector to move into position for the read.
e For Fluorescence intensity reads, there is no delay for injector number 1. The read starts at
the same time as the injection unless you add a Delay step. For injector number 2, there is
a delay of 0.3 seconds after the injection ends and before the read begins.
SpectraMax iD3 and SpectraMax iD5 Delay
The Delay step compensates for the hardware delay. If the delay you define is longer than the
hardware delay, then the actual delay time is the delay time you define. However, if the delay
you define is shorter than the hardware delay, then the actual delay time is the hardware delay
time. For example, if you define a Luminescence read delay of 1 second, then the actual delay
time between the end of the injection and the beginning of the read is 1 second. However, if
you define a Luminescence read delay of 0.05 seconds, then the actual delay time between
the end of the injection and the beginning of the read is 0.3 seconds due to the hardware
delay.
e For Absorbance reads there is an 800 msec delay afterinjection for both injectors.
e ForLuminescence top reads there is a 500 msec delay after injection for both injectors.
e For Fluorescence top and bottom reads there is a 500 msec delay when the injector1
injection starts and a 500 msec delay after the injector 2 injection ends.

156 5049092 F



Chapter 3: Collecting Data

Creating Absorbance Mode Protocols

5049092 F

To create an Absorbance Mode protocol:

Start the software. See Starting the Software on page 9.

Select aninstrument. See Selecting an Instrument on page 63.

Open adocument.

In the Navigation Tree, select a Plate section or a Cuvette Set section.

o » W N =

Click <, in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.

6. Forthe SpectraMaxi3x, select Monochromator. For the SpectraMax Paradigm, select the
Absorbance detection cartridge.

7. Selectthe “* ABS read mode.

8. SelectaRead Type.

9. Define the settings.

For more information about the settings, see the SoftMax Pro Software Application Help.

10. Afteryou define the instrument settings, click OK to close the Settings dialog.

11. Create atemplate, if applicable. See Template Editor on page 90.
12. Set Data Reduction parameters, if applicable. See Data Reduction on page 191.

13. Set Display options, if applicable. See Data Display Options on page 202.

14. Save the settings to a protocol. See Saving Protocols and Data Documents on page 31.

Absorbance Mode Protocol Overview

Absorbance is the quantity of light absorbed by a solution. To measure absorbance accurately,
it is necessary to eliminate light scatter. If there is no turbidity, then absorbance = optical
density.

A =logyo(lo /1) = =logqo(l/lp)
where [, is intensity of the incident light before it enters the sample divided by the light after it
passes through the sample, and A is the measured absorbance.

Applications of Absorbance

Absorbance measurements are used to quantify the concentration of an absorbing species. It
must be known at what wavelength a species absorbs light. For example, the concentration of
nucleic acids can be quantified by measuring the absorbance at 260 nm.

Optimizing Absorbance Assays

You can adjust the wavelength of the incident light in 1 nm increments. The software allows you
to read up to six wavelengths per plate or cuvette for Endpoint and Kinetic read types and up
to four wavelengths for Well Scan reads.

It is good scientific practice to designate wells in the plate to serve as plate blanks or group
blanks in the Template Editor dialog from a Plate section. See Template Editor on page 90.

You can use the PathCheck technology feature to normalize the data to a 1 cm pathlength. See
PathCheck Technology on page 272.
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Creating Fluorescence Intensity Mode Protocols

To create a Fluorescence Intensity protocol:

Start the software. See Starting the Software on page 9.

Select aninstrument. See Selecting an Instrument on page 63.
Open adocument.

In the Navigation Tree, select a Plate section or Cuvette Set section.

o » W N =

Click <, in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.

6. Forthe SpectraMaxi3x, select either Monochromator or select a Fluorescence Intensity
cartridge. For the SpectraMax Paradigm, select a Fluorescence Intensity cartridge.

7. Selectthe Ve FL read mode.

8. SelectaRead Type.

9. Define the settings.

For more information about the settings, see the SoftMax Pro Software Application Help.

10. Afteryou define the instrument settings, click OK to close the Settings dialog.

11. Create atemplate, if applicable. See Template Editor on page 90.
12. Set Data Reduction parameters, if applicable. See Data Reduction on page 191.

13. Set Display options, if applicable. See Data Display Options on page 202.

14. Save the settings to a protocol. See Saving Protocols and Data Documents on page 31.

Fluorescence Intensity Mode Overview

Fluorescence occurs when absorbed light is re-radiated at a longer wavelength. In the
Fluorescence Intensity (FL) read mode, the instrument measures the intensity of the re-radiated
light and expresses the result in Relative Fluorescence Units (RFU).

The governing equation for fluorescence is:

Fluorescence = extinction coefficient x concentration x quantum yield x excitation intensity
x pathlength x emission collection efficiency

Fluorescent materials absorb light energy of a characteristic wavelength (excitation), undergo
an electronic state change, and instantaneously emit light of a longer wavelength (emission).
Most common fluorescent materials have well-characterized excitation and emission spectra.
The following figure shows an example of excitation and emission spectra for a fluorophore.
The excitation and emission bands are each fairly broad, with half-bandwidths of
approximately 40 nm, and the difference between the wavelengths of the excitation and
emission maxima (the Stokes shift) is generally fairly small, about 30 nm. There is considerable
overlap between the excitation and emission spectra (gray area) when a small Stokes shift is
present.

158 5049092 F



Chapter 3: Collecting Data

Excitation maximum

Emission maximum

+ Stokes
Shift
1.0 —

[

()

S Absorption

A

[

_

o

=

b 0.5 —

(]

=

e

©

(D)

o

0 T T T T
500 550 600 650

Wavelength (nm)

* Tip: If the Stokes shift is small, choose an excitation wavelength that is as far away from
the emission maximum as possible while still being capable of stimulating the
fluorophore so that less of the excited light overlaps the emission spectrum, permitting
better selection and quantitation of the emitted light.

Because the intensity of the excitation light is usually many tens of thousands of times greater
than that of the emitted light, some type of spectral separation is necessary to reduce the
interference of the excitation light with detection of the emitted light.

The SpectraMax readers incorporate many features designed to restrict interference from
reflected excitation light. These features include a set of long-pass emission cutoff filters that
can be set automatically by the instrument or manually by the user.
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The previous figure shows that the best results are often obtained when the excitation and
emission wavelengths used for reads are not the same as the peak wavelengths or maxima of
the excitation and emission spectra of the fluorophore. When the wavelengths for excitation
and emission are separated, a smaller quantity of excitation light passes through to the
emission monochromator (gray area) and on to the PMT, resulting in a purer emission signal
and more accurate data.

The SpectraMax readers permit scanning of both excitation and emission wavelengths, using
separate tunable monochromators. One benefit of scanning emission spectra is that you can
determine more accurately whether the emissionis, in fact, the expected fluorophore, or
multiple fluorophores, and not one generated by a variety of background sources or by
contaminants. One more benefit is that you can find excitation and emission wavelengths that
prevent interference when interfering fluorescent species are present.

For this reason, it is desirable to scan emission for both an intermediate concentration of
labeled sample, as well as the background of unlabeled sample. The optimal setting is where
the ratio of the sample emission to background emission is at the maximum.
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Optimizing Fluorescence Intensity Assays

The optimal instrument settings for detection of a particular fluorophore depend on a number
of different factors. Settings you can adjust for assay optimization include the excitation and
emission wavelengths, emission cutoff filter, reads per well, the PMT voltage, and the
temperature of the read chamber.

Another important factor that is independent of the instrument but can affect assay
optimization is the Stokes shift, which is the difference between the wavelengths of the
excitation and emission maxima. When the Stokes shift is very small, optimizing the excitation
and emission wavelengths and correct cutoff filter choices are very important.

e Excitation and Emission Wavelengths
The excitation and emission wavelengths can be setin 1 nm increments between 250 nm
and 850 nm. The available wavelengths are dependent on the instrument. For more
information about the available wavelengths, see the documentation for the instrument
you are using.
A procedure to optimize excitation and emission wavelengths for a given assay is outlined
in Spectral Scanning on page 161.

e Emission Cutoff Filter
The emission cutoff filters assist in reducing background. Sources of background include
stray excitation light and native fluorescence of plate materials, sample constituents, and
solvents (including water). The default setting lets the instrument and the software
determine which cutoff filter to use for the endpoint and kinetic read types. The spectrum
read type default uses no cutoff filter.

e Reads PerWell
The number of reads per well can vary between 1 (for a quick estimate) and 100 (for very
precise measurements). The default number of reads per well varies with the read mode:
for Fluorescence, the default is 6, and for Luminescence the instrument does 1 read per
well.

e PMT Voltage
The voltage of the photomultiplier tube can be set to low (for higher concentration
samples), medium, or high (for lower concentration samples) for all read modes. For the
endpoint and spectrum read types, you can select Automatic to have the instrument
automatically adjusts the PMT voltage for varying concentrations of sample in the plate.

e Temperature Control
The chamber of the instrument is isothermal at ambient as well as at elevated
temperatures.
The temperature in the read chamber can be adjusted from 2°C (3.6°F) above ambient to
the maximum temperature for the instrument. See the instrument user guide.

Spectral Scanning

This procedure optimizes excitation and emission wavelengths for Fluorescence assays using
spectral scanning.

For the SpectraMax i3x, SpectraMax iD3, SpectraMax iD5, and SpectraMax Paradigm with a
Tunable Wavelength (TUNE) detection cartridge, see Spectral Optimization on page 179.

Pipette 200 pL of sample that includes the fluorophore and 200 pL of a buffer control into
separate wells of the plate.
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Excitation Scan

1. Set up a Plate section for the Fluorescence read mode, spectrum read type, Em Fixed/Ex
Scan, with no cutoff filter (default), and medium PMT.

2. Setthe emission wavelength based on the tentative value from the literature (or from a
customary filter set used to measure the fluorophore). If the emission wavelength is not
known, select a tentative emission wavelength about 50 nanometers greater than the
absorbance maximum of the fluorophore. If necessary, the absorbance maximum can be
determined by performing an optical density spectral scan first.

3. Setthe excitation scan to start/stop approximately 50 nm below/above the tentative
excitation value from the literature (or the customary excitation filter).

4. Setthe step incrementto 2 nm or 3 nm. You can choose to do a preliminary scan with a
10 nm increment to determine the approximate peak location, and then repeat the scan
over a narrower wavelength range with a 2 nm or 3 nm increment.

5. Do the scan and view the results as a plot of emission fluorescence vs. excitation
wavelength. Note the excitation wavelength at the emission peak and the maximum RFU
value.

If a Missing Data Points message occurs, it can be due to possible saturation reported by
the software at the end of the spectral scan. Reset the PMT to Low and rescan the sample
(scan the buffer blank with the PMT set to Medium or High). If the error occurs after you
scan with the PMT set to Low, you may need to dilute the sample.

If the excitation scan shows no apparent peak, change the PMT setting to High and rescan
the sample. If the spectral scan still shows no apparent peak, adjust the Y-scale of the
zoom plot so that the plot fills the graph.

6. Selectthe optimal excitation wavelength.

e |[f the excitation peak wavelength and emission wavelength are separated by more
than 80 nm, use the excitation peak wavelength value.

e |f the excitation and emission wavelengths are less than 80 nm apart, use the shortest
excitation wavelength that gives 90% maximal emission. Follow the plot to the left of
the peak until the RFU value falls to approximately 90% of the maximum, and then drop

a line from the 90% point on the plot to the x-axis as shown in the following figure.

RFU at 90%
of maximum lambda

Maximum lambda

Wavelength
Plot of RFU and Wavelength
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Emission Scan #1
1. Setup a second Plate section for the Fluorescence read mode, spectrum read type, Ex
Fixed/Em Scan, with no cutoff filter (default), and Medium PMT.
2. Setthe excitation wavelength to the value you determine in the Excitation Scan section
above.
3. Setthe emission scan to start/stop approximately 50 nm below or above the tentative
emission value from the literature (or existing filter pair).

% Note: If the Stokes shift is less than 50 nm, then start the emission scan above the
excitation wavelength.

4. Setthe stepincrementto 2 nmto 3 nm (or do a preliminary scan with a 10 nm increment to
determine the approximate peak location and then repeat the scan over a narrower
wavelength range using a 2 nm to 3 nm increment.)

5. Do the scan and view the results as a plot of fluorescence vs. emission wavelength.

Choose the Emission Filter

Select an emission cutoff filter that blocks as much of the residual excitation light as possible
without unduly reducing the fluorescence signal. The cutoff wavelength choices are 325, 420,
435, 475, 495, 515, 530, 550, 570, 590, 610, 630, 665, or 695 nm. The cutoff value should be
near the maximum emission wavelength (preferably between the excitation wavelength and
the maximal emission wavelength) but a minimum of 10 nm less than the emission wavelength.
If you have questions, contact Molecular Devices Technical Support and speak to an
application scientist.

Emission Scan #2

1. Set up a third Plate section for an emission scan as specified in Emission Scan #1, except
select the Manual Cutoff Filter and set the wavelength to the value you determine in the
Choose the Emission Filter section above.

2. Do the scan and view the results as a plot of fluorescence vs. emission wavelength.

Note the wavelength that gives the maximum emission (the optimal emission wavelength).

3. Compare the spectra of the sample that contains the fluorophore to the spectra of the
buffer blank to get an estimate of the signal-to-noise ratio. If there is significant
background interference, repeat the Choose the Emission Filter steps and the steps in this
section with a different choice of cutoff filter.

Results

The optimal excitation and emission wavelengths are those you determine in the Excitation
Scan section and the Emission Scan #2 section.
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Comments

e Forthe Fluorescence read mode with the endpoint or kinetic read type, the AutoCutoff
feature generally selects the same cutoff filter wavelength as the previously described
optimization method. However, you can specify the cutoff filters manually.

e Foremission wavelengths less than 325 nanometers, experimental iteration is usually the
best method to determine the optimal emission and excitation wavelengths. Start the
previously described optimization procedure. Try emission and excitation wavelength
combinations with the 325 cutoff or with no cutoff filter. For excitation wavelengths greater
than 660 nanometers, try emission and excitation wavelength combinations with the 695
cutoff or with no cutoff filter.

The following table lists default settings for the emission cutoff filters.

Emission Cutoff Filter Default Settings For FlexStation 3, SpectraMax M2, SpectraMax M2e,
SpectraMax M3, SpectraMax M4, SpectraMax M5, and SpectraMax M5e

Automatic Cutoff Selection Wavelength Endpoint and Kinetic Modes Emission

(nm) Wavelength (nm)
1 None <415
2 420 415-434
3 435 435-454
4 455 455-474
5 475 475-494
6 495 495-514
7 515 515-529
8 530 530-549
9 550 550-569
10 570 570-589
1" 590 590-609
12 610 610-629
13 630 630-664
14 665 665-694
15 695 695-850
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Creating Luminescence Mode Protocols

The SpectraMax L has a unique set of Luminescence Mode settings. For details see the
SpectraMax L Luminescence Microplate Reader User Guide.

To create a Luminescence Mode protocol:

Start the software. See Starting the Software on page 9.

Select aninstrument. See Selecting an Instrument on page 63.
Open adocument.

In the Navigation Tree, select a Plate section or Cuvette Set section.

o » W N =

Click ‘-’f- in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.

6. Forthe SpectraMaxi3x, select either Monochromator or select a Luminescence cartridge.
For the SpectraMax Paradigm, select a Luminescence cartridge.

7. Selectthe 4 LUM read mode.

8. SelectaRead Type.

9. Define the settings.

For more information about the settings, see the SoftMax Pro Software Application Help.

10. Afteryou define the instrument settings, click OK to close the Settings dialog.

11. Create atemplate, if applicable. See Template Editor on page 90.
12. Set Data Reduction parameters, if applicable. See Data Reduction on page 191.
13. Set Display options, if applicable. See Data Display Options on page 202.
14. Save the settings to a protocol. See Saving Protocols and Data Documents on page 31.

Luminescence Mode Protocol Overview

Luminescence is the emission of light by processes that derive energy from essentially non-
thermal changes, the motion of subatomic particles, or the excitation of an atomic system by
radiation. Luminescence detection relies on the production of light from a chemical reaction in
a sample.

In luminescence read mode, no excitation is necessary as the species being measured emit
light naturally. For this reason, the lamp does not flash, so no background interference occurs.
A dark estimate is done over a dark reference, and multiple reads are averaged togetherinto
one read perwell.

The default setting for luminescence is the “zero order” position where the grating
monochromator acts as a mirror that reflects all light to the PMT detector. You can choose the
wavelength where peak emission is expected to occur. Also, multiple wavelength choices let
species with multiple components be differentiated and measured easily. In luminescence
read mode, no emission cutoff filteris used.

5049092 F 165



SoftMax Pro Software User Guide

166

Optimizing Luminescence Assays

Luminescence can be read from the top or the bottom of a plate. You should use solid white
plates or white plates with clear bottoms for luminescence reads.

For standard luminescence a separate light path without monochromators carries the emitted
light to a dedicated PMT. The optimal emission wavelength is between 360 nm and 630 nm. In
the Settings dialog the emission says All.

For wavelength-selectable luminescence, the instrument uses the emission monochromator to
differentiate the wavelengths being emitted from the well. You can define multiple emission
wavelengths.

To read only one luminescent event in the well, you can get the best sensitivity using the
standard luminescence measurement, without a wavelength selected.

Luminescence read times are not designated by multiple reads per well, but rather by the total
integration time you enter (between 1 ms and 1500 ms). Typical luminescence assays require
between 500 ms and 1000 ms integration.

If wells are incubated for a long period of time, you should mix the plate before the read. This
can be done using the Shake setting.

If it seems that the signal is always higher in the first wells read (for example, column A), you
should dark adapt the plate to reduce the auto-luminescence of the white plastic. To help
eliminate background luminescence from a plate that has been exposed to light, you should
dark adapt the plate by placing the sample-loaded plate inside the instrument for several
minutes before you start the read.

5049092 F



Chapter 3: Collecting Data

Creating Time-Resolved Fluorescence Mode Protocols
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To create a Time-Resolved Fluorescence Mode protocol:

Start the software. See Starting the Software on page 9.

Select aninstrument. See Selecting an Instrument on page 63.
Open adocument.

In the Navigation Tree, select a Plate section or Cuvette Set section.

o » W N =

Click <, in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.

6. Forthe SpectraMaxi3x and SpectraMax Paradigm, select a TRF-capable detection
cartridge.

7. Click !é TRF to select the Time-Resolved Fluorescence read mode.

8. Click a Read Type.

9. Define the settings.

For more information about the settings, see the SoftMax Pro Software Application Help.

10. Afteryou define the instrument settings, click OK to close the Settings dialog.

11. Create atemplate, if applicable. See Template Editor on page 90.
12. Set Data Reduction parameters, if applicable. See Data Reduction on page 191.

13. Set Display options, if applicable. See Data Display Options on page 202.

14. Save the settings to a protocol. See Saving Protocols and Data Documents on page 31.

Time-Resolved Fluorescence Mode Overview

In Time-Resolved Fluorescence (TRF) read mode, the instrument detects the extremely long
emission half-lives of rare earth elements called lanthanides.

Time-Resolved Fluorescence is a measurement technique that depends on three
characteristics that lead to better discrimination between the specific signal, proportional to
the quantity of label, and the unspecific fluorescence resulting from background and
compound interference:

e Pulsed excitation light sources
e Time-gated electronics faster than the fluorescence lifetime
e |abels with prolonged fluorescence lifetime

The time-gating electronics introduce a delay between the cutoff of each light pulse and the
start of signal collection. During the delay, the unspecific fluorescence (caused by test
compounds, assay reagents, and the plate) vanishes, while only a small portion of the specific
fluorescence from the label is sacrificed. Enough of the specific signal remains during the
decay period, with the added benefit of reduced background.

The use of long-lived fluorophores combined with time-resolved detection (a delay between
excitation and emission detection) minimizes interference from fluorescence excitation light.
Assays with these long-lifetime fluorophores have the advantage of very low background
fluorescence. TRF detection is widely used in high throughput screening applications such as
kinase assays.
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In normal Fluorescence Intensity mode, the reads are taken while the lamp is on. The most
common limitation to sensitivity in normal fluorescence is excitation energy or background
fluorescence that cannot be eliminated from the emission signal. Since the lamp is the source
of excitation energy, turning it off provides the best means of eliminating background
excitation. The elimination of background excitation is the critical difference between
fluorescence intensity measurements and TRF measurements.

Optimizing Time-Resolved Fluorescence Assays

Forthe Time-Resolved Fluorescence read mode, the instrument flashes the excitation lamp,
then, after the lamp is off, collects the delayed emission for a period of time before the lamp
flashes again. Long-lifetime rare-earth lanthanide dyes are generally used to provide a long-
lived fluorescent signal that persists after the lamp turns off. Background fluorescence fades,
while lanthanide chelates and cryptates have fluorescent lifetimes between 100 ps and 2 ms.

Time-Resolved Fluorescence assays can be read from the top or bottom of a plate. You
should use solid white plates for top reads, and white plates with clear bottoms for bottom
reads.

To optimize data collection for a particular assay, you define when to start and end data
acquisition. The minimum is 50 ps after the lamp turns off and the maximum is 1450 ps, in 50 ps
or 200 ys steps.

If the assay you use has low signal or gives results with high %CV, use 100 reads per well. If you
require a faster read speed, experiment with fewer flashes per well until you achieve
acceptable precision and speed.

The important settings to get the best results in Time-Resolved Fluorescence assays are
integration delay and integration time.

1. Click the Integration Delay drop-down and select the amount of time to elapse between
the flash of the lamp (excitation) and the beginning of data acquisition from the well
(emission).

2. Click the Integration Time drop-down and select the amount of time for the instrument to
read the well.

The integration delay and integration time are usually specified in the package insert of
commercially available Time-Resolved Fluorescence reagent kits. If you do not use a kit, start
with a delay of 50 ps and try different delays up to 400 ps with a fixed integration time of

400 ps. After you choose the optimal delay, based on the highest ratio of a well that contains a
fluorophore divided by wells that contain only buffer, optimize the integration time, which is
generally between 400 ps and 1000 ps.

Some examples of TRF assays are:

e IMAP® TR-FRET

e Cisbio HTRF

e |anthaScreen TR-FRET
e LANCE TR-FRET

e DELFIA TRF
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Creating FRET Mode Protocols
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To create a Fluorescence Resonance Energy Transfer (FRET) protocol:

Start the software. See Starting the Software on page 9.

Select aninstrument. See Selecting an Instrument on page 63.
Open adocument.

In the Navigation Tree, select a Plate section or Cuvette Set section.

o » W N =

Click <, in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.

6. Forthe SpectraMaxi3x and SpectraMax Paradigm select a FRET-capable detection
cartridge.

7. Selectthe ¥ FRET read mode.

8. SelectaRead Type.

9. Define the settings.

For more information about the settings, see the SoftMax Pro Software Application Help.

10. Afteryou define the instrument settings, click OK to close the Settings dialog.

11. Create atemplate, if applicable. See Template Editor on page 90.
12. Set Data Reduction parameters, if applicable. See Data Reduction on page 191.
13. Set Display options, if applicable. See Data Display Options on page 202.
14. Save the settings to a protocol. See Saving Protocols and Data Documents on page 31.

Fluorescence Resonance Energy Transfer Overview

Fluorescence resonance energy transfer (FRET) is a distance-dependent interaction between
the electronic excited states of two dye molecules in which excitation is transferred from a
donor molecule to an acceptor molecule without emission of a photon.

FRET relies on the distance-dependent transfer of energy from a donor molecule to an
acceptor molecule. Due to its sensitivity to distance, you can use FRET to investigate
molecular interactions. FRET is the radiationless transmission of energy from a donor molecule
to an acceptor molecule. The donor molecule is the dye or chromophore that initially absorbs
the energy and the acceptoris the chromophore to which the energy is subsequently
transferred. This resonance interaction occurs over greater than interatomic distances, without
conversion to thermal energy, and without a molecular collision. The transfer of energy leads
to a reduction in the fluorescence intensity and excited state lifetime of the donor, and an
increase in the emission intensity of the acceptor. A pair of molecules that interact in such a
manner that FRET occurs is often referred to as a donor/acceptor pair.

While there are many factors that influence FRET, the primary conditions that need to be met
for FRET to occur are relatively few:
e The donor and acceptor molecules must be in close proximity to each other.

e The absorption or excitation spectrum of the acceptor must overlap the fluorescence
emission spectrum of the donor.

The degree to which they overlap is referred to as the spectral overlap integral (J).
e The donor and acceptor transition must be approximately parallel.
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To create a Fluorescence Polarization Mode protocol:

Start the software. See Starting the Software on page 9.

Select aninstrument. See Selecting an Instrument on page 63.
Open adocument.

In the Navigation Tree, select a Plate section or Cuvette Set section.

o » W N =

Click <, in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.

6. Forthe SpectraMaxi3x and SpectraMax Paradigm , select a Fluorescence Polarization (FP)
detection cartridge.

7. Selectthe “* FP read mode.

8. SelectaRead Type.

9. Define the settings.

For more information about the settings, see the SoftMax Pro Software Application Help.

10. Afteryou define the instrument settings, click OK to close the Settings dialog.

11. Create atemplate, if applicable. See Template Editor on page 90.
12. Set Data Reduction parameters, if applicable. See Data Reduction on page 191.
13. Set Display options, if applicable. See Data Display Options on page 202.
14. Save the settings to a protocol. See Saving Protocols and Data Documents on page 31.

Fluorescence Polarization Mode Protocol Overview

Fluorescence Polarization detection is based on Fluorescence Intensity, with the important
difference that it uses plane-polarized light, rather than non-polarized light. Microplate readers
measure the Fluorescence Polarization of the sample by detecting light emitted both parallel
and perpendicular to the plane of excitation.

By using a fluorescent dye to label a small molecule, the binding of a small molecule to an
interaction partner of equal or greater size can be monitored through its speed of rotation.

The Fluorescence Polarization read mode returns two sets of data: one for fluorescence
intensity parallel (P) to the excitation plane, and the other for fluorescence intensity
perpendicular (S) to the excitation plane. The software uses the S and P values to calculate the
Polarization (mP) and Anisotropy (r) values.

Although the raw S and P values are the true actual values returned from the instrument, the
calculated Polarization (mP) and Anisotropy (r) values are treated as the raw data. These
become the basis for further reduction calculations.

You can choose to display these data types in the Plate section. When raw (S&P) is displayed,
the mP value is by default used for all reduction calculations. When exporting, the raw values
that display are exported, whether mP, r, or Raw (S&P).

Polarization (mP) is calculated as follows:

(parallel - (G  perpendicular))

mP = 1000
* (parallel + (G * perpendicular))

Anisotropy (1) is calculated as follows:

(parallel - (G * perpendicular))

(parallel + (2G * perpendicular))
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Optimizing Fluorescence Polarization Assays

Fluorescence Polarization can be read from the top of a plate. The plastic from which a plate is
formed has an effect on the light polarization, precluding bottom reads and reads of a covered
plate from the top.

You should use solid black plates for reads. If the assay components seem to bind to the plate,
as evidenced by poor mP dynamic range (small difference between bound and unbound
tracer), you should use plates treated to minimize binding, or polypropylene plates, and add a
very small quantity of detergent to the assay buffer.

Background wells, which contain all assay components minus the fluorophore, should be run
alongside samples. If the signal in the background wells is more than 1/10 the signal in the wells
that contain fluorophore, then background wells should be run on each assay plate. The
average raw signal from the background's parallel and perpendicular reads should be
subtracted from the raw parallel and perpendicular reads of each sample well before the mP
calculation is done.

For best precision in assays that uses a low quantity of fluorophore (for example, <5 nm
fluorescein), set the PMT sensitivity to High and the number of reads to 100. If a faster read
speed is required, experiment with fewer flashes per well until acceptable precision and
speed are achieved. Fewer flashes result in a higher speed, but with less precision.
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Creating AlphaScreen Mode Protocols

To create an AlphaScreen Mode protocol:

1. Start the software. See Starting the Software on page 9.

2. Selectthe SpectraMaxi3x or SpectraMax Paradigm. See Selecting an Instrument on page
63.

3. Openadocument.

4. Inthe Navigation Tree, select a Plate section.

5. Click <, in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.

6. Select an AlphaScreen detection cartridge.

7. Selectthe ¥ Screen read mode.

8. SelectaRead Type.

9. Define the settings.

For more information about the settings, see the SoftMax Pro Software Application Help.
10. Afteryou define the instrument settings, click OK to close the Settings dialog.
11. Create atemplate, if applicable. See Template Editor on page 90.
12. Set Data Reduction parameters, if applicable. See Data Reduction on page 191.
13. Set Display options, if applicable. See Data Display Options on page 202.
14. Save the settings to a protocol. See Saving Protocols and Data Documents on page 31.

AlphaScreen Mode Protocol Overview

ALPHA stands for Amplified Luminescent Proximity Homogeneous Assay. AlphaScreen®is a
bead-based chemistry used to study molecular interactions between moieties A and B, for
example. When a biological interaction between A and B moves beads (coated with A and B,
respectively) together, a cascade of chemical reactions produce a greatly amplified signal.

The cascade result signal is triggered by laser excitation (680 nm), that makes a
photosensitizer on the A-beads convert oxygen to an excited (singlet) state. The energized
oxygen diffuses away from the A-bead. When reaching the B-bead in close proximity, it reacts
with a thioxene derivative on the B-bead to generate chemiluminescence at 370 nm. Energy
transfer to a fluorescent dye on the same bead shifts the emission wavelength into the 520 nm
to 620 nm range. The limited lifetime of singlet oxygenin solvent (Y4 microseconds) lets
diffusion reach up to only around 200 nm distance. Thus, only B-beads in the proximity of A-
beads yield signal, which indicates binding between moieties A and B.

An AlphaScreen measurement includes a light pulse, by turning on the laser diode for a
specified time, turning off the laser diode, followed by the measurement of the AlphaScreen
signal, as specified in the measurement protocol timing parameters.

AlphaScreen beads are light sensitive. Beads are best handled under subdued (<100 lux) or
green filtered (Roscolux filters #389 from Rosco, or equivalent) light conditions. Do incubation
steps in the dark.
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Creating Western Blot TRF Mode Protocols
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To create a Western Blot TRF Mode protocol:

1. Start the software. See Starting the Software on page 9.

2. Selectthe SpectraMaxi3x, SpectraMaxiD5, or SpectraMax Paradigm. See Selecting an
Instrument on page 63.

3. Openadocument.

4. Inthe Navigation tree, select a Plate section.

5. Click <, in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.

6. Selectthe SCANLATER WB cartridge for the ScanLater Western Blot (WB) detection
cartridge. (Skip this step for the SpectraMax iD5.)

L)
7. Selectthe “{5 TRF read mode.

8. Selectthe - Membrane read type.
9. Define the settings. For more information about the settings, see the SoftMax Pro Software
Application Help.
10. After you define the instrument settings, click OK to close the Settings dialog.
11. Save the settings to a protocol. See Saving Protocols and Data Documents on page 31.

Western Blot TRF Mode Overview

Western Blots (WB), or protein immunoblots, are one of the most common methods for protein
detection in pharmaceutical and clinical research. You can use various techniques to detect
proteins on Western Blot membranes including fluorescence, silver staining, and
chemiluminescence. Each technique has its limitations. There is a continuous need to improve
quantitation, accuracy, and dynamic range of Western Blots.

The Molecular Devices ScanLater™ Western Blot Assay Kit is a novel system for protein
analysis that you can use with the SpectraMax i3x, SpectraMax iD5, and SpectraMax Paradigm.
Membranes are incubated with Eu-chelate labeled secondary antibodies or streptavidin that
bind specifically to the target protein-specific primary antibody. Europium has a long
fluorescence lifetime, on the order of 1 msec, and detection is done in Time Resolved
Fluorescence (TRF) mode which significantly reduces background from auto-fluorescence or
other sources of short lifetime emissions. The membranes are placed into the instrument
where the membranes are scanned with the ScanLater Western Blot (WB) detection cartridge
(SpectraMax iD5 uses the Enhanced TRF module).

The method does not involve enzyme detection, and the Eu-chelates are resistant to photo-
bleaching, so the signal remains stable for long periods of time (weeks to months). This allows
you repeat the read of membranes and the potential for comparison of band intensities to
known standards for more accurate quantitation. There is also no camera blooming, as can
occur with chemiluminescence or fluorescence detection, so the system gives sharp bands
and excellent image quality.

The TRF detection employs photon counting, so the theoretical dynamic range is >10°. In
practice, however, dynamic range is limited by saturation of binding sites on high-abundant
bands and non-specific binding to background membrane.

The SpectraMax Western Blot system is a simple, sensitive, and stable platform that provides
excellent Western Blot capability for the SpectraMax i3x, SpectraMax iD5, and SpectraMax
Paradigm to extend the uses of these essential laboratory instruments.
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Loading the Membrane Holder

Note: Handle membranes only by the edges using clean forceps. Take care to not
touch the membrane with gloved or bare hands.

You must place the membrane in a Molecular Devices ScanLater” membrane holderto scan a
membrane . The maximum size of a membrane that fits in the membrane holderis 109 mm x
77 mm.

To load the membrane holder:

1. Place the membrane on the membrane holder with one corner of the membrane aligned
with the A1 corner of the membrane holder.

2. Slide the holder clips to place them over the membrane as close to the edges of the
membrane as possible to expose the maximum scanning area of the blot.

3. Lowerthe holder clips into place and then gently press the end of each holder clip to snap
it into place and secure the membrane to the holder.

CAUTION! To prevent damage to the instrument or the membrane holder, make
sure that all the holder clips are securely snapped into place before you insert the
membrane holder into the instrument.

4. Load the membrane holderinto the plate drawer with the A1 corner in the A1 position of
the drawer. See the user guide for your instrument.
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Creating Imaging Mode Protocols
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To create an Imaging mode protocol:

Start the software. See Starting the Software on page 9.

Select the SpectraMax i3x. See Selecting an Instrument on page 63.
Open adocument.

In the Navigation Tree, select a Plate section or Cuvette Set section.

o » W N =

Click <, in the section toolbar, the Settings Information area, or on the Home tab to
display the Settings dialog.
Select @) MiniMax in the Optical Configuration list.
Select the Imaging read mode.
If you have previously acquired images and want to make changes to the analysis settings
forthose images, select the Re-analysis read mode.
8. Define the Imaging read settings or the Re-analysis settings.
For more information about the Imaging read settings or Re-analysis settings, see the
SoftMax Pro Software application help.
9. Afteryou define the instrument settings, click OK to close the Settings dialog.
10. Create atemplate, if applicable. See Template Editor on page 90.
11. Set Data Reduction parameters, if applicable. See Data Reduction on page 191.
12. Set Display options, if applicable. See Data Display Options on page 202.
13. Save the settings to a protocol. See Saving Protocols and Data Documents on page 31.

~ o

Imaging Mode Protocol Overview
Imaging read mode does whole-cell imaging assays.

Whole-cell imaging assays are cell-based, or object-based, rather than the single-point
measurements found in other types of plate reads. These types of assays can yield more
biologically meaningful results that can discriminate the fluorescence related to objects, such
as cells or beads, from the bulk solution within a plate well.

The measurement is primarily fluorescent with quantification of cell size, shape, area, and
intensity. Brightfield, transmitted light imaging supports label-free quantification. The camera
resolution in the SpectraMax MiniMax 300 Imaging Cytometer is sufficient to determine the
approximate shape of small 8 micron objects, such as blood cells.

Optimizing the Computer for Image Acquisition

Acquiring images requires a large portion of computer memory and resources. When the
software has limited access to computer memory and resources, image acquisition can take a
long time. In some cases, images of some of the wells can be lost. Turn off all other programs
to minimize the demands on computer memory and resources.

Before you start an image acquisition, save the protocol to a .txt file format, in a location with
enough capacity for the image files. For best results, save Imaging mode files on the
secondary hard drive inside the computer. If you use Auto Save to save multiple Imaging
mode documents, the software saves each new document without the folders required to
save images and analysis results.

Note: Use of an external hard drive can slow the data acquisition and is not
recommended. Use of a USB flash drive or saving to a network location is not
supported.
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When you create a document for an Imaging mode experiment or a Western Blot experiment,
the software creates a folder with the same name as the document. Each image file can be
larger than 2 megabytes. The software can generate 300 megabytes of image data whenyou
acquire the image of a single site in each well of a 96-well plate. A 384-well plate can generate
1 gigabyte of image data. When you acquire images of multiple sites, you increase the data
storage requirement.

Zooming Image in a Well

Animage of the selected well displays in the Image Acquisition, Image Selection, and Region
of Interest categories in the Settings dialog.

To view a larger version of the image area:

e Double-click the image to display the Zoom Well dialog.
In the Zoom Well dialog, the image area displays the acquired image from the selected well.
To zoom the image in and out:

e Right-click the image and select Zoom In or Zoom Out,
e Hold the CTRL key and press + or -.
e Use the mouse wheelto zoom in or out.

To move the image in the image area:

e Use the scroll bars or click the image and drag it into position.
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Collecting Data From Plates

You can start a read after you define the acquisition settings. You do not need to define groups
and assign wells in the Template Editor dialog before the read. The values that the software
receives from the instrument are raw values. The settings in the Template Editor have no
effect on these raw values.

The SoftMax Pro Options dialog has an option to have the plate remain inside the instrument
after the read completes. See SoftMax Pro Options on page 51.

Use auto read to read multiple Plate sections in the same experiment. See Using Auto Read on
page 178.

To collect data from plates:

1.

8.

9.
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To open the plate drawer of the instrument, select the Home tab and click |-5
Open/Close. See Home Tab on page 54.

The plate carrier on the EMax Plus moves in and out of the read chamber during the read,
and then returns to the home position after the read ends. If the plate carrier does not
return to the home position, select the Operations tab and click Initialize.

Insert the prepared plate matching well A1 with position A1 in the plate drawer. Make sure
the plate is flat against the drawer bottom or against the adapter.

Click |-5 Open/Close to close the plate drawer.

Open the document that contains the acquisition settings for the plate read. As an
alternative, create new acquisition settings for the Plate section in the Settings dialog. See
Acquisition Settings on page 110.

Save the document before you start a read. For Imaging reads and Western Blot reads,
you must save the document before you start the read.

Click 'd." Read below the Settings Information area or on the Home tab.

The Read button changes to ° Stop so you can terminate a read.
The software reads the Plate section you select.

e Forthe FilterMax F3, FilterMax F5, SpectraMax i3x, SpectraMax iD3, SpectraMax iD5,
and SpectraMax Paradigm, when you select to do pre-read optimizations, the Pre-
Read Optimization Options dialog displays. See Pre-Read Optimization Options on
page 181.

e Forthe SpectraMaxi3x and SpectraMax Paradigm with a Tunable Wavelength (TUNE)
detection cartridge, when you select to run spectral optimization, the Spectral
Optimization Wizard runs before the instrument reads the plate. See Spectral
Optimization on page 179.

After the read completes, the plate drawer opens so you can remove the plate. If
temperature control is on, the drawer closes again after approximately 10 seconds.
After the read completes, save the document and do any additional data analysis.
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Using Auto Read

Use auto read to have the software automatically advances to the next Plate section aftera
read. The reads progress in the sequence that the Plate sections display within an experiment

in the Navigation Tree. When you start a read for a Plate section that you configure to

automatically advance with Auto Read, the software advances to the next Plate section in the
experiment and then reads that plate. If you configure multiple Plate sections to automatically
advance with Auto Read, the Auto Read feature reads all enabled Plate sections until it reads a
non-enabled Plate section or the last Plate section in the experiment. The software does not
read the Plate sections that appear above the Plate section you select in the Navigation Tree.

For example, if you have five Plate sections (Plate 1, Plate 2, Plate 3, Plate 4, and Plate 5)in
an experiment and you configure Plate 1, Plate 2, and Plate 3 to automatically advance
with Auto Read, if you select Plate 2 when you start the read, the software reads Plate 2,
Plate 3, and Plate 4 in sequence. Plate 1is not read, since it comes before Plate 2. Plate 5
is not read since Plate 4 is not configured to automatically advance with Auto Read.

The software collects the data using the instrument settings that are specific for each Plate

section and stores the data in a single document.

You can set aninterval, or delay time, between plate reads.

To enable Auto Read:
1. Inthe Navigation Tree, select the experiment that has the Plate sections you want to

automatically advance with Auto Read.

) 5
2. Select the Operations tab and click a* Auto Read to display the Auto Read dialog.

4 Auto Read ==
Select the Plate sections that yeu want to enable to automatically advance @
a Exptl
Platel
Plate3
[ plates
[C] Piates
Delay o Seconds
(o |

3. Selectthe check box for each Plate section you want to automatically advance with Auto

Read.

4. Inthe Delay field, enter the number of seconds to delay (the interval) between each Plate
section read.

5. Click OK.

% Note: If you have a Cuvette Set section that follows an enabled Plate section, Auto

Read does not advance to or beyond the Cuvette Set section.
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Spectral Optimization

Spectral optimization is available for Fluorescence Intensity reads on the SpectraMax i3x (using
the instrument's built-in monochromator), SpectraMax iD3, and SpectraMax iD5 .

Spectral optimization for is available for both Fluorescence Intensity and Luminescence reads
when you install the Tunable Wavelength (TUNE) detection cartridge in the SpectraMax
Paradigm.

Spectral optimization in spectral assays improves accuracy while reducing data acquisition and
computational burden. Spectral optimization helps to get the maximum signal-to-background
ratio for most fluorophores or luminescence labels that are compatible with the wavelength
ranges of the instrument or detection cartridge.

To do spectral optimization, there must be a minimum of 10 data points in the range for both
the excitation and emission wavelengths. Make sure that the Wavelength Increment permits a
minimum of 10 data points in each range.

The start emission wavelength value must be a minimum of 20 nm greater than the start
excitation wavelength value. You should use an emission value that is a minimum of 40 nm
greater than the excitation value.

To add spectral optimization to a protocol:

1.
2.

4.
5.
6.

In the Navigation Tree, select a Plate section.

Click <, in the section toolbar, in the Settings Information area, or on the Home tab to
display the Settings dialog.

Select the Fluorescence Intensity read mode and any read type other than spectrum. For
the SpectraMax Paradigm you can select the Luminescence read mode.

On the left, select the Wavelengths category.

Select the Unknown option.

Define all acquisition settings and click OK to close the Settings dialog.

Spectral Optimization Wizard

To run spectral optimization:

1.
2.

In the Navigation Tree, select the Plate section.

Click "‘J Read below the Settings Information area or on the Home tab to display the
Spectral Optimization Wizard.
On the Read Settings page:
a. Enterthe wavelength ranges and other optimization parameters. You can enter only
emission values for Luminescence reads.
Click Advanced Parameters to display advanced parameters.
In the Reading Height field, enter the read height.
In the Integration Time field, enter the integration time.
For Time-Resolved Fluorescence reads, enter Pulse Length, Number of Pulses, and
Measurement Delay.
f. Click Next to display the Blank Well page.
On the Blank Well page:
a. Selectthe well that corresponds with a well that contains buffer or other liquid for
background correction.
b. Click Nextto display the Sample Well page.

20T
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5.

10.

1.
12.

13.
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On the Sample Well page:

a. Selectthe well that corresponds with a well that contains your sample.

b. Click Next and wait while the indicator displays the progress.

On the Optimization Complete page:

a. View the 3-dimensional heat map image. The software uses the formula (S—B)/Bto
generate, where S = signal and B = background.

=| Note: Forthe Luminescence read mode, this is a 2-dimensional graph.

b. Inthe image, locate the cross hair that indicates the optimized peak wavelengths.
To change the wavelengths for the read, either:
e Drag the cross hairto a new location
e Entervalues in the Excitation field and the Emission field. The Emission value must be
a minimum of 20 nm greater than the Excitation value. Use an emission value that is a
minimum of 40 nm greater than the excitation value. You can specify only emission
values for Luminescence reads.
Select the Use Log Scale check box to use log scale for the display of the heat map
image.
Clear the Use Log Scale check box to not use log scale.
If you edit the Wavelength (Custom) values, click Reset to Optimized Peak to reset the
values to the software defined optimized peak.
Right-click on the image:
e Select Copy Raw Data to copy the data in a tab-delimited format that you can paste
into a spreadsheet or text editor (not available for the SpectraMax Paradigm).
e Select Copy Image to copy the image into a bitmap file that you can paste into an
image editing program.
e Select Save Raw Data to Disk to save the data into a text file in tab delimited format
(not available for the SpectraMax Paradigm).
e Select Save Image to Disk to save the image into a .bmp file.
Click Restart Wizard to redefine the settings and run the wizard again.
To save the wavelength values without reading the plate, click Cancel and then click Yes
in the message.
Click Read to save the protocol with the specified excitation and emission wavelengths
and use these values to read the plate.
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Pre-Read Optimization Options

Use the Pre-Read Optimization Options dialog to run the Microplate Optimization wizard and
the Read Height Optimization wizard before the instrument reads the plate.

Plate dimensions can vary slightly between production lots, which can have a potential effect
on measurement accuracy. Use the software to optimize plate dimensions by determining the
centers of the four corner wells on the plate. Each time you optimize a plate, the software adds
a new plate definition with dimensions specific to that lot.

For the FilterMax F3, FilterMax F5, SpectraMax i3x, SpectraMax iD3, SpectraMax iD5, and
SpectraMax Paradigm, in certain read modes, you can use pre-read optimization to do plate
optimization and read height adjustment. The settings are dependent on the instrument and
the read mode.

To have the Pre-Read Optimization Options dialog display before a plate read:
1. Inthe Navigation Tree, select a Plate section.

2. Click < in the section toolbar, in the Settings Information area, or on the Home tab to
display the Settings dialog.

3. Onthe left, select the More Settings category.

4. Selectthe Show Pre-Read Optimization Options check box to display the Pre-Read
Optimization Options dialog before each plate read.
Clear the Show Pre-Read Optimization Options check box to not display the Pre-Read
Optimization Options dialog before each plate read.
From the Acquisition view, add a Plate Optimizer node to the beginning of the Acquisition
Plan.

5. Define all acquisition settings and click OK to close the Settings dialog.

Run Pre-Read Optimization Options
To run a protocol with pre-read optimization options:

1. Inthe Navigation Tree, select the Plate section.

2. Click 'd) Read below the Settings Information area or on the Home tab to display the Pre-
Read Optimization Options dialog.

3. Select the Run Microplate Optimization... check box to run the Microplate Optimization
wizard before the plate read.
Clear the Run Microplate Optimization... check box to not run the Microplate Optimization
wizard before the plate read.

4. Selectthe Run Read Height Adjustment... check box to run the Read Height Optimization
wizard before the plate read.
Clear the Run Read Height Adjustment... check box to not run the Read Height
Optimization wizard before the plate read.

5. Select the Plate is Lidded check box if the plate has a lid.
Clearthe Plate is Lidded check box if the plate does not have a lid.
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6. Some instruments allow you to select the plate orientation. If you change the plate
orientation for a read, you must do plate optimization for each plate orientation separately.
Select a Microplate orientation option:

e Select Landscape to put the Allocation in the upper-left corner closest to the
instrument.

e Select Portrait to put the A1 location in the upper-right corner closest to the instrument.

e Select Opposite Landscape to put the Allocation in the lower-right corner farthest
from the instrument.

e Select Opposite Portrait to put the A1 location in the lower-left corner farthest from the
instrument.

7. Click Run Optimization to run the optimization options.

e [fyou select the Run Microplate Optimization... check box, the Microplate Optimization
wizard displays.

e [fyou select the Run Read Height Adjustment... check box, the Read Height
Optimization wizard displays. If you select both check boxes the Read Height
Optimization wizard displays after you finish the Microplate Optimization wizard.

8. Afterthe wizards run, the Pre-Read Optimization Options dialog displays. Click Read Plate
to start the read.

Microplate Optimization Wizard

Use the Microplate Optimization wizard to optimize the plate dimensions to determine the
centers of the four corner wells on the plate. Each time you optimize a plate, the software adds
a new plate to the plate library.

To do plate optimization:

1. Inthe Pre-Read Optimization Options dialog, select the Run Microplate Optimization
Before Reading the Plate check box.

2. Selectthe Plate Is Lidded check box if the plate has a lid.

Clear the Plate Is Lidded check box if the plate does not have a lid.

3. Some instruments allow you to select the plate orientation. If you change the plate
orientation for a read, you must do plate optimization for each plate orientation separately.
Select a Microplate orientation option:

e Select Landscape to put the Allocation in the upper-left corner closest to the
instrument.

e Select Portrait to put the Allocation in the upper-right corner closest to the instrument.

e Select Opposite Landscape to put the A1 location in the lower-right corner farthest
from the instrument.

e Select Opposite Portrait to put the Al location in the lower-left corner farthest from the
instrument.

4. Click Run Optimization to display the Microplate Optimization wizard.
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Chapter 3: Collecting Data

On the Insert the Microplate page:

a. Click % Open the Microplate Drawer to move the plate drawer outside the
instrument.

b. Fill the corner wells of the plate with identical samples. To ensure accuracy, samples
must be applicable for the read mode. Sample concentration and volume must be
identical in each well.

c. Place the prepared plate on the plate drawer.

Click % Close the Microplate Drawer to load the plate into the instrument.
Select the Select the Microplate Orientation option that matches the orientation of the
plate in the plate drawer and is the same as the orientation you select in the Pre-Read
Optimization Options dialog. The orientation displays on the right, with well A1 marked.

f. Click Next to start the optimization.

On the Optimize page:

e Wait for the software to optimize the plate.

e |f needed, click Stop Optimization to stop the plate optimization.

Onthe Select the Center of the Up... page:

a. Drag the cross hair to the center of the upper left well.

b. Click Next.

On the Select the Center of the Lo... page.

a. Drag the cross hairto the center of the lower left well.

b. Click Next.

On the Select the Center of the Up... page:

a. Drag the cross hair to the center of the upper right well.

b. Click Next.

On the Select the Center of the Lo... page:

a. Drag the cross hair to the center of the lower right well.

b. Click Next.

On the Verify Well Centers page:

a. Verify that the x and y offset and distances between rows and columns are correct. If
needed, click in each Microplate Dimensions field and enter the dimension in
millimeters.

b. Inthe Microplate Name field, enter the name of the plate.

Click Save to add the plate definition to the plate library and to either return to the Pre-

Read Optimization dialog or to start the Read Height Optimization wizard.

Read Height Optimization Wizard

When the instrument features an objective lens, use the Read Height Optimization Wizard to
adjust the read height for the Luminescence, Fluorescence Intensity, Fluorescence
Polarization, and Time-Resolved Fluorescence read modes. Read height is the distance
between the top (for top reads) or bottom (for bottom read) of the plate and the objective lens.
You optimize the read height to match the focus of the optics with the sample volume. This
maximizes the raw signal, which yields the highest precision and maximum sensitivity.
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Use a standard or sample position with a good signal or pipette liquid with a known maximum
signal into a well. The concentration of the optimization sample should be a minimum of ten
times greater than the detection limit. The sample volume should be the same as that of
samples measured in the protocol. If you use a layout with standards, the software selects the
standard well closest to the center of the plate. If you do not use a layout with standards, the
software selects the first sample.

Note: When you optimize read height for the Fluorescence read mode, make sure the
optimization sample is the same fluorescent substance that the detection method is
configured to detect.

To use the Read Height Optimization wizard:

1.

10.

In a plate of the same type for the read, place a single sample that has a known maximum

signal and volume.

Place the plate into the instrument plate chamber.

In the Pre-Read Optimization Options dialog, select the Run Read Height Adjustment...

check box.
Select the Plate Is Lidded check box if the plate has a lid.
Clearthe Plate Is Lidded check box if the plate does not have a lid.
Some instruments allow you to select the plate orientation. If you change the plate
orientation for a read, you must do read height optimization for each plate orientation
separately. Select a Microplate orientation option:
e Select Landscape to put the A1 location in the upper-left corner closest to the
instrument.
e Select Portrait to put the A1 location in the upper-right corner closest to the instrument.
e Select Opposite Landscape to put the Allocation in the lower-right corner farthest
from the instrument.
e Select Opposite Portrait to put the Al location in the lower-left corner farthest from the
instrument.

Click Run Optimization to display the Read Height Optimization wizard.

On the Select Well page:

a. Selectthe wellin the plate image that contains the sample.

b. Click Next.

On the Optimize page:

e Wait for the software to optimize. Optimization can take from several seconds to
several minutes depending on the detection methods you use.

On the Optimization Complete page:

a. To specify a different read height, enter a value in the Custom Read Height field, in
millimeters.

b. Click Save to save the read height with the protocol and to display the Pre-Read
Optimization dialog. The software uses this read height for all subsequent runs of the
protocol until you either perform a new optimization or you manually enter a read
height.

Click Read Plate to start the plate read.
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Collecting Data From Cuvettes
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Two types of data collection are possible when you use a cuvette: a reference read and a
sample read.

You can start a read after you define the acquisition settings. You do not need to define groups
and assign cuvettes in the Template Editor dialog before the read, but you can use the
Template Editor to create the required number of cuvettes in the section. As an alternative,

you can create a small number of cuvettes one at a time with the Ei New Cuvette Seticonin
the Navigation Tree.
Instrument settings must be the same for all cuvettes in a Cuvette Set section.

Cuvette Set sections have a limit of 96 cuvettes. If you reach this limit, create a new Cuvette
Set section.

Sample Read

If you select more than one cuvette, the software starts with the left-most selected cuvette that
does not contain sample read data.

To do a sample read:

1. Inthe Navigation Tree, select a cuvette in the Cuvette Set section.
2. Click 'd Read on the Home tab or below the Settings Information area. The Read button

changesto ° Stop, to terminate a read.

Reference Read

You can take a reference read either on air or you can use a cuvette that contains the buffer of
your sample.

The reference can be read before or after you read samples.

If you do not take a reference read in a Cuvette Set section before samples were read and
you then read a reference, the following occurs:
e The software applies the reference read to all cuvettes in the Cuvette Set sectionifitis
the first reference read.
e |nsubsequent reference reads, if you select one or more cuvettes, the software
selectively replaces the reference read for the cuvettes you select.
e The time and date of the read displays under each cuvette in the section.
e The software applies the reference to new cuvettes you subsequently create in the
section.
You can have more than one reference per Cuvette Set section.
To do areference read:
1. Select the cuvettesin the Cuvette Set section.
2. Place the correct reference in the cuvette port.

3. Click &' Ref.
The time and date stamp of the reference for the cuvettes you select changes.

Any new cuvettes you create in the Cuvette Set section after you read a second reference use
the new reference read.
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The software applies the reference read to all cuvettes in the Cuvette Set section, unless you
select specific cuvettes. The reference value does not display. To see the reference value,
use one of the following procedures.

Procedure 1:

1. Create a cuvette inthe Cuvette Set section and Ref on air (empty cuvette port).
2. Read a cuvette that contains the blanking solution.
If you want to have both reference and read values available, do the following:
Create a Cuvette Set section with up to the maximum of 96 cuvettes.
Define a template blank in the Cuvette Set section.

3
4
5. Place bufferinthe cuvette and click H) Read.
6

Click 'd Read again to read the remaining samples.

The software subtracts the optical density of the cuvette you designate as the template blank
from the optical density of all the other cuvettes in the Cuvette Set section.
Procedure 2:

1. Create a Cuvette Set section with up to the maximum of 96 cuvettes.

2. Reference and read the cuvette.

3. Create atemplate with the applicable groups.

4. Create a columnin each Group table with the formula wellprereadLmf.
If you have a multiple wavelength read and you want to see the reference at each wavelength,

create more columns with the formula lwellprereadLmx where X is 2, 3, or 4, corresponding to
the wavelength for which you want to see a reference.

The OD/RFU/RLU with the reference subtracted displays in the Values column. The reference
value for each sample displays in the custom column you create.
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Collecting Data From Membrane Holders
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If you use the SoftMax Pro Software - GxP edition, you must have the following permissions to
complete a Western Blot membrane read:

e Read Empty Plates/Cuvettes to start a read.
e Create/Save Data Documents to save the data document before the read.
e Overwrite Plate/Cuvette Data to do a high-resolution ROl read.

See SoftMax Pro Software - GxP Edition on page 243.

For information on the data-analysis tools for Western Blot images, see Viewing Western Blot
Membrane Data on page 236.

To collect data from a membrane holder:

1.
2.

10.

Select the Home tab and click |-5 Open/Close to openthe instrument drawer.

Insert the prepared membrane holder matching the A1 position on the membrane holder
with the A1 position in the plate drawer in landscape orientation. Make sure the membrane
holder is flat against the drawer bottom.

A CAUTION! To prevent damage to the instrument or the membrane holder, make
sure that all the holder clips are securely snapped into place before you insert the
membrane holder into the instrument.

Click |-&':F Open/Close to close the drawer.

Open the document for the membrane read. To define membrane holder acquisition
settings, select a Plate section in the Navigation Tree and configure the acquisition
settings in the Settings dialog. See Acquisition Settings on page 110.

Save the document before you start a read. For Imaging reads and Western Blot reads,
you must save the document before you start the read.

Click 'd Read on the Home tab or below the Settings Information area. The Read button
changesto ° Stop, to terminate a read.

==
After the software reads the Plate section, click &t on the left side of the Plate section
and then drag across the image to define the region of interest (ROI) to scan.

Click 0 to scan the region using the ROl Scan Resolution you define in the Settings
dialog. The data from the ROl scan replaces the data from the original scan. See Creating
Western Blot TRF Mode Protocols on page 173.

When the read completes, click |-5 Open/Close to open the drawer and remove the
membrane holder.
Save the document.
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Chapter 4:

Calculations
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Analyzing Data

Each document has a minimum of one Plate section or one Cuvette Set section. Most
documents have a plate template and related Group sections, Graph sections, and Note
sections. Depending upon the protocol and how you want to report the data, some documents
may not have all sections.

Some simple protocols, such as a read of the absorbance of proteins at 280 nm in a cuvette or
in a plate with PathCheck technology, let you calculate concentration in the Plate section or
Cuvette Set section which makes Group sections and Graph sections necessary only if you
want to display the data in tables or graphically.

Many protocols consist of data acquired in a Plate section or Cuvette Set section. You define
standards and unknowns in a template. The software then interpolates the unknowns from a
standard curve.

and Numerical Precision

The calculations done by the software on real numbers use 64-bit double-precision (15+ digits
of precision) as defined by the Institute of Electrical and Electronics Engineers standard for
floating point arithmetic (IEEE 754). Computations always use the maximum available precision.
Rounding occurs only as required for display formatting purposes, or in the evaluation of a
formula in which the Round operator is used.

See “Technical Details of Numerical Calculations” in the application help.

Numbers from Plate sections, Cuvette Set sections, Group sections, and Summaries display,
print, and export with as many digits after the decimal point as you specify. All numbers the
software saves for the document are stored with full 64-bit double-precision.

The precision of the Plate section data display varies based on the space available to view the
characters. When you increase the number of digits, the font size of the values in the Plate
section decreases. If the value becomes too long, the numbers are cut off at the edge of the
wells. When you export plate data, the values are not limited by space and can have more
digits for each well. The values that display in a Plate section are only a representation of the
data. In both the Plate section and in the exported data, the last digit that displays or exports is
rounded based on the actual data value.

You can customize the data display to Numeric notation or Scientific notation format and
specify the number of Significant Figures or Decimal Places. You can set these options
separately for raw data and reduced data.

Although the software can display reads and the numbers derived from those reads with more
than four decimal places, the resolution of the instrument ultimately determines the precision
of the calculations. For more information see the instrument user guide.

% Note: In SoftMax Pro Software versions older than version 6.0, the software used a text-
conversion algorithm with a slight upward bias. This can result in a mismatch between
the rounded values in the newer version and the older version. Example: When
rounding the raw value 14.849999... to one decimal place, versions 6.0 and newer
display 14.8, while older versions display 14.9. This does not affect the accuracy of the
calculations, since rounding occurs only as required for display formatting purposes, or
in the evaluation of a formula in which you use the Round operator. Computations
always use the maximum available precision.
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Calculation Hierarchy

When reducing the data the instrument collects, the software does calculations hierarchically. If
you do not select an option in the hierarchy in the Settings dialog, an option is not available for
the instrument you use, an option is not applicable to the type of read being done, or an option
is not defined in the Template Editor dialog or the Reductions dialog, then the software
continues with the next listed calculation in the hierarchy.

The following is the general hierarchy of reduction calculations:

Apply Well Masking

Subtract Plate Background constant

Apply PathCheck Technology normalization
Subtract Plate Blank

Apply Smoothing

Time Alignment (Interpolate Raw Data)
Subtract Group Blank (pre-reduction option)
Calculate mP or Anisotropy

Set first data point to zero

Convert ODto %T

. Apply Reduction Limits

Apply Wavelength Combination

Apply Baseline Options

Apply Kinetic or Spectrum Reduction

15. Subtract Group Blank (post-reduction option)

© 0 NI A~ WN =

— —
BN =0

For more information on calculations, see:

e Kinetic Data Reduction Options on page 198

e Spectrum Data Reduction Options on page 200

e Absorbance Read Mode on page 270 Optical Density and %Transmittance calculations

e PathCheck Technology on page 272

e Fluorescence Polarization Read Mode on page 293

e Curve Fit Functions on page 363

e Forinformation on statistical functions, see the SoftMax Pro Data Acquisition and Analysis
Software Formula Reference Guide.
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Data Reduction
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Use the Data Reduction dialog to define how the software is to reduce data. The reduction
process is based on formulas that reduce the raw data to show a single number for each well
or cuvette. Further analysis of this reduced number is done in Group sections and Graph
sections.

When the software reduces the raw information the instrument collects, calculations are done
hierarchically. Only the data reduction calculations that apply to the data based onthe
instrument, read mode, read type, and settings are done. See Calculation Hierarchy on page
190.

Click z in the section toolbar, in the Reduction Settings area, or on the Home tab to display
the Data Reduction dialog.

- =

. Data Reduction [

Raw Data Steps

o [¥] Use Plate Blank

Gl‘dup Blank Dprl_ot_\s_
@) After Reduction | () Before Reduction

o [7] Set first data point o zero
o Raw Cata Mode
@ Optical Density ¥ Transmittance

Data Reduction Steps

o Limits

Min OD: 0 Lag Time: o

Max OD: 4 End Time: 500

o Wavelength Options
itm1 v

o Kinetic Reduction

|Vmax (milli-units per | Vmax Paints: 71 out of 21

o Group Blank Subtracted

| OK | [ Cancel

The Data Reduction dialog displays only the reduction options that are available for the
instrument you use, the options you select in the Settings dialog, and the options you define in
the template.

The software does the applicable calculations in the Plate section or Cuvette Set sectionin the
order that displays in the Data Reduction dialog. If you do not select an option in the Settings
dialog, an option is not available for the instrument you use, or an option is not defined in the
template, the software continues with the next applicable calculation.
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Raw Data Steps
The software uses the following steps to calculate the raw data displays:
Apply PathCheck (Absorbance Endpoint only)

PathCheck technology normalization calculations apply to the data only when you use
PathCheck technology in the PathCheck category for an Absorbance Endpoint read. When
you use PathCheck technology, you can disable this calculation in the Data Reduction dialog
by clearing the Apply PathCheck check box. See PathCheck Technology on page 272.

)

-

. Data Reduction

Raw Data Steps

Pathcheck Options
Apply Pathcheck Apply Plate Background OD

Lml 0

o Use Plate Blank

o Group Blank Options
- () After Reduction @ Before Reduction

o Raw Data Mode

@ Optical Density () %Transmittance
Data Reduction Steps

Wavelength Options

[!Lml o

| ok || cance

Apply Plate Background OD (Absorbance Endpoint only)

The Plate Background OD is the OD of the plate material. It is independent of liquid volume in
the well. Subtraction of the Plate Background constant applies to the data only when you use
PathCheck technology in the PathCheck category for an Absorbance Endpoint read. To define
the constant, enter a value in the field. When you use PathCheck technology, you can disable
this calculation in the Data Reduction dialog by clearing the Apply Plate Background OD check
box.

Use Plate Blank

The Use Plate Blank calculation is available when you specify a plate blank in the Template
Editor for the plate. To allow subtraction of the plate blank value, select the Use Plate Blank
check box. See Template Editor on page 90.
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Smoothing

Use smoothing to reduce noise in Kinetic reads for the FlexStation 3 data. This setting takes
the moving average of the raw data and displays the plot using the averaged values.

The default is no smoothing, or a setting of 1 “averaged” point.

e A setting of 3 provides the least amount of smoothing, where the software adds the value
of the center point to the values of the points on either side. The software then divides the
sum of these points by three and substitutes the resulting value for the center point.

e A setting of 9 averages the center point with the four points on each side.

When you read multiple wavelengths, the software does smoothing before doing wavelength
combination calculations such as ratios or multiplication. For example, if you read at two
wavelengths and choose to take a ratio of those wavelengths, the software performs
smoothing on each individual wavelength and the wavelength ratio is calculated using
smoothed data.

Time Alignment

For the FlexStation 3, the software logs each data value with its own read time and can align
the time points by Wavelength or by Well to interpolate the data against a single time point.

e Select the Time Alignment check box and then click Wavelength to do wavelength
combination calculations correctly. For example, you can take a ratio of two different
wavelengths (Lm1/Lm2) in a single well that have been read at two different time points.
The Wavelength option is available only when two or more wavelengths are present in the
data.

With Wavelength selected, the software uses quadratic interpolation to calculate the
interpolated values. This results in the loss of one point at each end of the plot. Before
starting the calculation, the software determines the starting point by averaging the initial
data points of the separate wavelengths. For example, if the first data points of the two
wavelengths have time values of 0.3 and 0.5 seconds, the software averages these data
points and uses 0.4 seconds as its initial point for interpolation.

e Select the Time Alignment check box and then click Well to normalize the kinetic read
times of the wells in the column against the read time of the first well in the column.
Injection occurs at the same time in all the wells of a column, but each of the wells is read
sequentially. So, each well is read at a different time point during the reaction from the
injection. With Well selected, the data in the wells are interpolated against the time point
of the read of the first well.

Group Blank Options
The Group Blank Options calculation is available when you specify a group blank in the
Template Editor for the plate. The subtraction of the group blank value can be selected as a
pre-reduction process or a post-reduction process.
e To use the group blank value subtraction calculation as a pre-reduction process, click
Before Reduction.
e To use the group blank value subtraction calculation as a post-reduction process, click
After Reduction. When you select After Reduction in Group Blank Options, the last step in
the Data Reduction dialog shows Group Blank Subtracted.
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Polarization or Anisotropy (Fluorescence Polarization read mode only)

The Fluorescence Polarization read mode returns two sets of data: one for fluorescence
intensity parallel (P) to the excitation plane, and the other for fluorescence intensity
perpendicular (S) to the excitation plane. The software uses the S and P values to calculate the
Polarization (mP) and Anisotropy (r) values. Click the data type to use as the raw data for the
reduction.

G Factor

Use the G factor, or grating factor, in Fluorescence Polarization to correct polarization data for
optical artifacts which converts relative mP data to theoretical mP data. Optical systems,
particularly with reflective components, pass light of different polarization with different
efficiency. G factor corrects for this instrument-based bias. To define the G Factor, enter a
value in the field.

Set first data point to zero (Kinetic read type only)

Select this check box to offset the first data point to (0,) and shift all other data accordingly. If
you clear this check box, some data points that do not fall within the reduction limits can
disappear.

To see more data and still display absolute values, increase the reduction limits for Min OD,
Min RLU, or Min RFU and the Max OD, Max RLU, or Max RFU.

Raw Data Display Mode (Absorbance read mode only)

For Absorbance reads, choose whether to display absorbance data as Optical Density or
%Transmittance.

e Optical Density: The quantity of light passing through a sample to a detector relative to the
total quantity of light available. Optical Density includes absorbance of the sample plus
light scatter from turbidity.

* % Transmittance: The ratio of transmitted light to the incident light (for the Absorbance
read mode).

Click the data type to use as the raw data for the reduction.

% Note: The software uses separate mathematical calculations to handle Optical Density
(OD) and %Transmittance (%T) calculations for Pre-read plate blanking, PathCheck
technology, and Reference, because OD calculations are done on a linear scale, while
%T calculations are done on a logarithmic scale. However, the software does not do
other calculations differently for OD and %T modes. Because of this, you should use %T
only for raw OD, raw OD with Pre-read plate blank subtraction, or raw OD reads which
are normalized by the PathCheck technology. Use caution when you use %T on
reduced numbers or the reads that apply to other calculations since the software might
not calculate data correctly.
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Data Reduction Steps

Data Reduction display includes one or more of the following calculations:
Baseline Options

Baseline options affect the way that the data is graphed for the FlexStation 3.

e Absolute displays the raw data without any change in the way it is graphed. The software
uses raw data in subsequent reduction calculations.

e Zero Baseline offsets the graph slightly. For example, if you enter 5 for the number of
points, then the software uses the average of the first 5 points as the baseline value, and
all raw data is subtracted from this value.

Baseline subtraction applies only to the reduced data. The raw data plots do not change.
To view the plot with baseline subtraction, select Reduced Plot in the Display dialog or
select Show Reduced inthe Zoom Well dialog.

If two or more wavelengths are present in a read, and you combine these wavelengths
with the Zero Baseline selected, the zero baseline applies only after the wavelength
combination.

e % Baseline makes data from the FlexStation 3 look similar to data from the FLIPR System.
You can import data from the FLIPR System into the software, and this option modifies the
plot and reduction calculations to make data from the FlexStation 3 comparable to data
from the FLIPR System.

This method averages the first number of points you specify (the upper box), divides the
raw data by this average value, and then multiplies by 100 (%). Enter a value from 0.001 to
99999 to use to multiply the % Baseline value.
This calculation is done only on the reduced data and only after any wavelength
combinations are calculated.
To view the modified plot, select Reduced Plot in the Display dialog or select Show
Reduced in the Zoom Well dialog.
Limits
Apply the specified reduction limits to the reduced data after this step. To specify the limits,
enter values in the fields.

Limits define the data that displays and is included in data reduction. If you change a limit to
show less data, you can change the limit to display the excluded data again.

The display of OD, RFU, or RLU values is relative to the first point measured for each well.

Negative Kinetic values decrease with time, and limits should be set accordingly (below 0) to
view negative Kinetic data.

e Min OD, Min RFU, or Min RLU defines the limit for the minimum value to report. Values from
the read that are under this limit do not display and are excluded from data reduction. The
default is 0 OD or RFU/RLU. To display negative Kinetics, set the value below O (zero).

e Max OD, Max RFU, or Max RLU defines the limit for the maximum value to report. Values
from the read that are above this limit do not display and are excluded from data
reduction.

e Lag Time for the Kinetic read type defines the period of time to be excluded from data
reduction. It can be used to ignore the initial lag phase of reactions.

e End Time for the Kinetic read type specifies the time after which data points are excluded
from data reduction. The default setting is the total assay time for the Kinetic read type.
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e Start for the Spectrum read type specifies the limit in nm for the minimum wavelength
setting to report. Values from the read that are under this limit do not appear in the
reduced display and are excluded from data reduction.

e End forthe Spectrum read type specifies the limit for the maximum wavelength setting to
report. Values from reads that are above this limit do not appear in the reduced display
and are excluded from data reduction.

Wavelength Options

Select an available wavelength formula from the list. To use a custom reduction, select Custom
from the list and then, click |ﬁ| to display the Formula Editor dialog. See Data Reduction
Formulas on page 197.

Kinetic Reduction

Select a Kinetic reduction mode from the list. To use a custom reduction, select Custom from
the list and then, click |ﬁ| to display the Formula Editor dialog. See Data Reduction Formulas
on page 197.

Set the number of Vmax Points as needed to ensure that the Vmax line segment passes
though the most linear region of the reaction.

Spectrum Reduction

Select a Spectrum reductiognode from the list. To use a custom reduction, select Custom
from the list and then, click |ﬁ| to display the Formula Editor dialog. See Data Reduction
Formulas on page 197.

Well Scan Reduction

Select Maximum, Minimum, Average, or Custom from the list. Average provides the average
value for all points in the Well Scan. To use a custom reduction, select Custom from the list and
then, click |ﬁ| to display the Formula Editor dialog. See Data Reduction Formulas on page 197.
Group Blank Subtracted

When you select After Reduction under Group Blank Options, the last step in the Data
Reduction dialog displays Group Blank Subtracted.

After you set all applicable data reduction options, click OK.
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Data Reduction Formulas

Chapter 4: Analyzing Data

The software reduction process is based on formulas that reduce the raw data to show a single
number for each well or cuvette. Further analysis of the reduced number is done in Group
sections and Graph sections. See Group Sections on page 86 and Graphing Data on page 210.

For a full discussion of custom formulas, see the SoftMax Pro Data Acquisition and Analysis
Software Formula Reference Guide.

Custom Reduction Formulas

If the predefined Reduction formulas do not meet your needs, you can select Custom from the
menus or dialogs to display a Formula button. The Formula button provides access to the
Formula Editor dialog where you can create custom formulas.

The following tables list examples of formulas you use to combine multiple wavelengths.

Wavelength Reduction Formula Examples for Specific Wavelength Combinations

2 Wavelengths

3 Wavelengths

4 to 6 Wavelengths

ILm1+ILm2 Lm1+ILm2 +!Lm3 ILm1+ILm2+ ... +ILmn
ILm1-1Lm2 ('Lm1—1Lm3)/(ILm2 —!Lm3) ('tm1—ILm®6) /(ILm2 —
ILm5)/ (ILm3 —ILm4)
ILm1/ILm2 ILm1/ILm3 ILm1/ILmn
ILm1*ILm2 ILm1*ILm3 ILm1*ILmn
Log10(ILm1/1Lm2) Log10(ILm1/1Lm3) Log10(ILm1/!Lmn)
IPathlength IPathlength IPathlength

Wavelength Reduction Formula Examples for Wavelength Combinations

Formula

ILmx / constant

Description

For example, Lm1/1.44 for quantitating a polyclonal antibody by
measuring the absorbance at A280 with PathCheck technology
on.

Average(ILm1&!ILm2&!ILm3)

Averages together the optical densities for multiple reads at
the same wavelength (for example, if you read the well three
times at 280 nm).

Min(ILm1&!ILm2&!Lm3)

Reports the minimum OD/RFU/RLU recorded for multiple
wavelength reads in each well.

Max('Lm1&!ILm2&!Lm3)

Reports the maximum OD/RFU/RLU recorded for multiple
wavelength reads in each well.

If(lLmz<A,makeerr(118), (if(lLmx>B,
makeerr(117), ILm1)))

Reports “low” for a well with an OD/RFU/RLU less than A, “high”
for an OD/ RFU/RLU greater than B, and the OD/ RFU/RLU of a
well that lies between A and B.

197



SoftMax Pro Software User Guide

198

Use custom Reduction formulas that contain mathematical operators or terms to obtain
specific types of data. The following table provides examples of formulas for the kinetic read
type and the spectrum read type.

Kinetic Reduction Formula Examples

Formula Description

Vmaxcorr(lcombinedplot, Reports Vmax correlation coefficient for plots in all 96 wells.
'Vmaxpoints,!readinterval)

Vmax(Delta(lcombinedplot), Reports the Vmax Rate of the delta between each time point.
I'Vmaxpoints,!readinterval)

Spectrum or Kinetic Reduction Formula Example

Formula Description

Nthitem | Reports the optical density at item X in the list of reads. For example, if you have a Kinetic

('Lm1,X) run with 20 time points and X is 10, it reports the OD/RFU/RLU of the 10th time point.
Similarly, if you have a Spectrum scan with 20 measurements and X is 10, it reports the
OD/RFU/RLU of the 10th wavelength measured.

Enclose the accessor names for custom Reduction formulas forimaging data in square
brackets to prevent conflicts with other formula elements.

Imaging Reduction Formula Example

Formula Description
[TypeAObjectCount] - Reports the difference between the number of Type A and
[TypeBObjectCount] Type B cells detected in the image.

Kinetic Data Reduction Options

The software applies kinetic reductions to the value at each time point after the wavelength
combination formula is applied.

Vmax

Vmax is the maximum slope of the kinetic display of mOD/min or RFU/RLU per second. The
software calculates Vmax by measuring the slopes of a number of straight lines, where Vmax
Points determines the number of contiguous points over which each straight line is defined.

An alternative method to analyze non-linear kinetic reactions is to report the elapsed time until
the maximum reaction rate is reached, rather than to report the maximum rate itself. When you
use this in conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line
defined by Vmax Points and used to calculate Vmax.

Vmax Rate is reported as signal/min (milli-OD, RFU, or RLU units per minute) for the kinetic read
type. Itis calculated using a linear curve fit, y = Ax + B. A creeping iteration is done using Vmax
Points and the slope of the steepest line segment is reported as Vmax Rate. It can also be
reported as units per second (the default for Fluorescence and Luminescence read modes).

Vmax (milli-units per min) and Vmax (units per sec) reductions are available for all instruments
that support the kinetic read type. The default Absorbance kinetic reduction is Vmax (milli-units
per min).
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Time to Vmax is useful for applications that include coagulation chemistry where the changing
concentration of the reagents does not change Vmax, but rather changes the time at which the
reaction reaches the maximum rate.

The software determines the number of available Vmax Points from the Timing settings. Enter
a value in the Vmax Points field to define the maximum size of the line segment used to
determine the slope of the line used to calculate the rate of the reaction. The default is the
total number of points taken in the read.

The first slope is calculated for a line drawn that starts at the first read as defined by Lag Time
and ends at a total number of reads equal to the Vmax Points setting. The second and
subsequent slopes are calculated to start at the second time point and end at a total number of
reads equal to the Vmax Points setting. The steepest positive or negative slope is reported as
Vmax.

If the data plot displays fewer time points (data points) than Vmax Points, the software uses all
the time points to determine the slope of the data.

Onset Time

Onset Time reports the time required for a kinetic reaction to reach a specified OD or RFU/RLU
(onset OD/RFU/RLU).

This elapsed time data is useful for cascade reactions including clot formation (such as,
endotoxin testing) and clot lysis applications where the change in reagent concentration does
not have an effect on the maximum optical density change but changes the time required for
the reaction to reach completion.

Time at Minimum
Reports the time at the minimum OD, RFU/RLU, or %T that falls within the reduction limits.

Time at Maximum
Reports the time at the maximum OD, RFU/RLU, or %T that falls within the reduction limits.

Time at 1/2 Maximum

Reports the time at the half of the maximum OD, RFU/RLU, or %T that falls within the reduction
limits.

To calculate this reduction, the software determines the kinetic point (within the reduction

limits) that has the maximum signal level (OD or %T) and divides it by 2 to get the 1/2 Maximum
value. Then it finds the time value at the 1/2 Maximum.

Area Under Curve

This reduction estimates the area under the curve as defined by the data plots within the
reduction limits. The data plots are treated as a series of trapezoids with vertices at successive
data points and at the X-axis coordinates of the data points. The areas defined by each of the
trapezoids are then computed and summed.

Slope

The slope reduction option determines the slope of the combined plot (for example, the slope
of the line using linear regression after the wavelength combination reduction). This reduction
uses all visible time points in the reduction window.

Slope is the same as Vmax Rate when Vmax Rate is set to the same number of points as the
run but is different if you have modified Vmax Points.
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Spectrum Data Reduction Options

The software applies the Spectrum Reduction formula to the list of numbers in each well
(values at each wavelength) after the wavelength combination formula is applied. The default
reduction for the spectrum read type is Lambda at Maximum.

Maximum: Reports the maximum absorbance (optical density) or percent transmittance
(%T), RFU, or RLU within the reduction limits.

Minimum: Reports the minimum absorbance (optical density) or percent transmittance (%T),
RFU, or RLU within the reduction limits.

Lambda at Maximum: Reports the wavelength at which maximum absorbance (optical
density) or percent transmittance (%T), RFU, or RLU within the reduction limits.

Lambda at Minimum: Reports the wavelength of minimum absorbance (optical density) or
percent transmittance (%T), RFU, or RLU within the reduction limits.

Area Under Curve: Estimates the area under the curve as defined by the data plots, within
the reduction limits. The data plots are treated as a series of trapezoids with vertices at
successive data points and at the X-axis coordinates of the data points. The software
computes and sums the areas defined by each of the trapezoids.

Imaging Data Reduction Options

The Imaging Data list contains the measurement selections from the Image Analysis Settings in
the Settings dialog. See Viewing and Selecting Measurement Statistics on page 134.

Separate data types are available for each measured wavelength and classification.

Object Count: The total number of objects detected in the image. Do not use for field
analysis of confluent areas.

Field Count: The total number of confluent areas detected in the image. Do not use for
discrete object analysis.

Object Percentage: The percentage the objects detected in the image by classification.
Do not use for field analysis of confluent areas.

Covered Area: The combined area of all the objects or confluent areas detected in the
image as a percentage of the entire image area.

Object Area: The average area of the objects detected in the image expressed in um?. Do
not use for field analysis of confluent areas.

Field Area: The average area of the confluent areas detected in the image expressed in
um?. Do not use for discrete object analysis.

Object Roundness: The average roundness of each object detected in the image. A shape
factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all. Do not use
for field analysis of confluent areas.

Field Roundness: The average roundness of each confluent area detected in the image. A
shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all. Do
not use for discrete object analysis.

Object Average Intensity: The average fluorescent signal intensity of the objects detected
in the image. Do not use for field analysis of confluent areas or for transmitted light.

Field Average Intensity: The average fluorescent signal intensity of the confluent areas
detected in the image. This is not used for discrete object analysis or for transmitted light.
Object Intensity: The average total fluorescent signal intensity of the objects detected in
the image. Do not use for field analysis of confluent areas or for transmitted light.
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¢ Field Intensity: The average total fluorescent signal intensity of the confluent areas
detected in the image. Do not use for discrete object analysis and do not use for
transmitted light.

e Total Intensity: The combined total fluorescent signal intensity of the objects or confluent
areas detected in the image expressed in million intensity counts. Do not use for
transmitted light.
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Use the Display Options dialog to specify how to display data for Plate sections and Cuvette
Set sections. The values that display in a Plate section are only a representation of the data. In
the Plate section, the last digit that displays is rounded based on the actual data value. The
values are not limited by space and can have more digits for each well when you export plate
data.

You can clone a plate to view both raw and reduced data or multiple reductions of the same
data. See Plate Sections on page 80.

% Note: If you change the display setting for one cuvette, you change the display settings
for all the cuvettes in that Cuvette Set section.

-

4 Display Options

Specify how data is displayed. @

@ Raw Data ) Reduced Data

Raw Data Units: OD

Reduction:
D with Reduced Number Qptions: | Mumber
Raw Data Format Reduced Data Format
| Defauit - Default
Significant Figures 3 Significant Figures 3
Decimal Places 3 Decimal Places 3
Sample Sample
12345 12345

oK |[ Cancel

To define display options:

1. Click g in the section toolbar or on the Home tab to display the Display Options dialog.
2. Select a Specify How Data Is Displayed option:
e Select Raw Data to display the default data type for the read type you select, See the
Raw Data Settings section below.
e Select Reduced Data to display reduced data. See the Reduced Data Settings section
below.
e Forthe Imaging read mode Imaging Data replaces the Raw Data option. See the
Imaging Data Settings section below.
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3. Inthe Raw/Reduced Data Format area, click the drop-down:

e Select Default to have the software determine the number of decimal places to
display based on the space available. For example, for a plate with 96 wells or fewer,
each well is limited to five digits, plus one character for the decimal point, if
applicable. For a 384-well plate, each well is limited to four characters, including the
decimal point. If the value requires greater precision than can fit in the available space,
the format changes to scientific notation.

Select Numeric Notation to display data in numeric format. Select to display either
Significant Figures or Decimal Places and then enter the number of figures or places to
display.
Select Scientific Notation to display data in scientific notation format. Select to display
either Significant Figures or Decimal Places and then enter the number of figures or
places to display.

4. Click OK.

Raw Data Settings

Select Raw Data to display the default data type for the read type you select.

The Endpoint read type displays raw absorbance, fluorescence, or luminescence values.
The Kinetic read type displays the change in raw OD/RFU/RLU values overtime as a plot.
The Spectrum read type displays raw OD/RFU/RLU values for the range of wavelengths as
aplot.

The Well Scan read type displays raw OD/RFU/RLU values as shades of blue to red.

To display a reduced number, select the With Reduced Number check box.

Reduced Data Settings

Select Reduced Data to display reduced data only. The software reports the reduced number
in the Group section when you define a template. The reduced data display is based on the
selections you make in the Data Reduction dialog. See Data Reduction on page 191.

e Click the Options drop-down:

e Select Number to view only the reduced number.
e Select Plot for the Kinetic read type to display a plot of the raw data. To also view the

reduced number, select the Reduced Number check box.

Select Grayscale to display the raw data in eight shades of gray, that range from light
for values less than or equal to the low limit, to dark for values greater than or equal to
the high limit. Enter the High Limit and the Low Limit for the grayscale map. To also
view the reduced number, select the Reduced Number check box.

Select Color Map to display the raw data in eight colors, that range from blue for
values less than or equal to the low limit, to red for values greater than or equal to the
high limit. To define the High Limit and the Low Limit for the color map, enter values in
the fields. To also view the reduced number, select the Reduced Number check box.
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Imaging Data Settings

For the Imaging read mode Imaging Data replaces the Raw Data option.

e Click the Data Type drop-down. The options available are the measurement selections
you set in the Image Analysis Settings category in the Settings dialog. Separate data types
are available for each measured wavelength and classification, if applicable. See Viewing
and Selecting Measurement Statistics on page 134.

Select Object Count to display the total number of objects detected in the image. Not
used for field analysis of confluent areas.

Select Field Count to display the total number of confluent areas detected in the
image. Not used for discrete object analysis.

Select Object Percentage to display the percentage the objects detected in the
image by classification. Not used for field analysis of confluent areas.

Select Covered Area to display the combined area of all the objects or confluent
areas detected in the image as a percentage of the entire image area.

Select Object Area to display the average area of the objects detected in the image
expressed in pm2. Not used for field analysis of confluent areas.

Select Field Area to display the average area of the confluent areas detected in the
image expressed in pm?. Not used for discrete object analysis.

Select Object Roundness to display the average roundness of each object detected
in the image. A shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is
not round at all. Not used for field analysis of confluent areas.

Select Field Roundness to display the average roundness of each confluent area
detected in the image. A shape factor of 1.00 is perfectly round, while a shape factor
of 0.00 is not round at all. Not used for discrete object analysis.

Select Object Average Intensity to display the average fluorescent signal intensity of
the objects detected in the image. This measurement is not used for field analysis of
confluent areas. Not used for transmitted light.

Select Field Average Intensity to display the average fluorescent signal intensity of
the confluent areas detected in the image. This measurement is not used for discrete
object analysis and not used for transmitted light.

Select Object Intensity to display the average total fluorescent signal intensity of the
objects detected in the image. Not used for field analysis of confluent areas and not
used for transmitted light.

Select Field Intensity to display the average total fluorescent signal intensity of the
confluent areas detected in the image. Not used for discrete object analysis and not
used for transmitted light.

Select Total Intensity to display the combined total fluorescent signal intensity of the
objects or confluent areas detected in the image expressed in million intensity counts.
Not used for transmitted light.

Optionally, select the With Reduced Number check box to include the reduced data
number in the display.

5049092 F



5049092 F

Chapter 4: Analyzing Data

Viewing Membrane Images

After you scan a membrane for Western Blot data, the data displays in the software as an
image. Use the image tools in the Plate section to zoom, crop, colorize, and adjust the intensity
of the image. You can select a region of interest (ROI) and rescan the membrane at a higher
resolution. See Viewing Western Blot Membrane Data on page 236.

Western Blot membrane data is saved as a TIFF image to allow you to use the image analysis
tool of your choice for analysis. The SoftMax Pro Software includes a version of the ImageJ
software from U.S. National Institute of Health (NIH). See Analyzing Western Blot Images on
page 241.

To view the membrane image in the ImageJ software, click < 1 in the section toolbar and then
click ImagedJ Editor.

To view the membrane image with another image-analysis tool, click <1 in the section toolbar
and then click External Image Editor. This option is available if you have tif files associated
with a program other than the ImageJ software. The icon for this tool changes depending on
the image-analysis tool you select. See Defining the Membrane Image-Analysis Tool on page
241.

Note: The image tools are available when you view a Plate section that contains
membrane data.

Viewing Imaging Data in Wells

You can view a combination of the raw image and the analysis data in up to four wells from a
Plate section or the two wells from the Image Analysis Settings. See Plate Sections on page
80 orImage Analysis Settings on page 128.

The Zoom icon becomes active for a Plate section when the imaging data in a well is available
fora zoomed display.

To display the SoftMax Pro MiniMax Well Viewer dialog from a Plate section, double-click the
well that you want to zoom or click ﬁ in the section toolbar orthe Home tab. In the Image
Analysis Settings Measurement Selection, click Show Details.

To view more than one well in a Plate section, drag the cursor to select up to four wells before
you access the Zoom Well dialog.

It can take some time before the SoftMax Pro MiniMax Well Viewer dialog displays. It can also
display behind the SoftMax Pro Software window. To bring the well viewer to the front, click
the SoftMax Pro MiniMax Well Viewer icon in the Windows task bar.

B SoftMax Pro MiniMax Well Viewer

The SoftMax Pro MiniMax Well Viewer dialog displays a zoomed image of the well, a table of
data, and chart of the data. To choose to display one or more of these areas, select or clear
the Show Images, Show Tables, or Show Charts check boxes in the lower-left area.
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The three areas in the dialog are interactive.

e Click the cells inthe image to highlight the data in the table and the data in the chart.
e Click the data in the table to highlight the cells in the image and the data in the chart.
e Click the data in the chart to highlight the cells in the image and the data in the table.

To use animage of the SoftMax Pro MiniMax Well Viewer dialog in a Microsoft PowerPoint
presentation, click Send to PowerPoint. A new document opens in PowerPoint with animage
of the Zoom Well dialog in a slide.

Image Area Options
The image area displays the acquired image from the well you select.
To zoom the image in and out:

e Right-click the image and select Zoom In or Zoom Out,
e Hold the CTRL key and press + or-.
e Use the mouse wheel to zoom in or out.

To move the image in the image area:
e Use the scroll bars or click the image and drag it into position.

Click the buttons above the image to switch the view of the image between wavelengths, and
to display or hide the found objects or confluent areas.

G s G13) (Objects)

e When a button s filled in, the related wavelength, objects, or areas display in the image.
e When a button is outlined, the related wavelength, objects, or areas do not display in the
image.

When you click a button above the images, it affects the display of all the images.
Use the controls below the image to adjust the intensity of each wavelength.

©]

To adjust the wavelength intensity:
1. Select the wavelength to adjust.

- I

2. Drag the slider bar on the left to adjust the low level of intensity or click @ to move the
sliders to the outside edges. The intensity level displays above the bar.

3. Drag the slider bar on the right to adjust the high level of intensity or click @ to move the
sliders to the outside edges.
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4. From the list on the right, select the color for the view.

-

=

IE Monochrome
Wavelength

W e

Ii' Green

IE' Blus

To automatically scale the intensity of all the wavelengths in the image, click Auto Scale All
Wavelengths.

Table Area Options

In the table area, drag the separator lines to change the size the columns. Drag the scroll bars
to view the data in the table.

To use the table data in Microsoft Excel, click Send to Excel. A new spreadsheet opensin
Excel with the data from the table in the cells.

Chart Area Options
To change the type of chart that displays in the chart area, click Histogram or Scatter Plot.

e Fora histogram, select a data type for the X Axis Data.
e For a scatter plot, select data types for the X Axis Data and the Y Axis Data.

Masking Wells or Cuvettes

Use the Mask feature to hide data so that the data is not used for calculations and is not
reported. You mask wells to suppress outliers from data reduction calculations. You can use
masking as a “what if?” tool. For example, if you include a group blank in a template and want
to see the data both with and without the blank, mask the group blanks to suppress the
blanking function and unmask the group blanks to use the blanking function.
To mask wells and cuvettes:

1. Ina Plate section or a Cuvette Set section, select the wells or cuvettes to mask.

e Click and drag the cursor across the wells to select multiple wells in a plate.

e Press CTRL and click to select multiple cuvettes.

2. Click st in the section toolbar or on the Home tab orright-click a well or cuvette and
select Mask.

3. Click ‘ a second time to unmask masked wells or cuvettes.
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Zooming Well and Cuvette Display

Use the Zoom Well and Zoom Well Options dialogs to magnify the well display. This feature is
available when the data in a well or cuvette can be enlarged.

L Zoom Well (==

wml

0s

o 50 W 150 200 20 ®0 30 40 450 S0 S0 600
Tee (Sect)
Whax Points 21
wel )
Wrnax (milli-units per minj 13964
e 0.563
print Scale to Data [ Reducmion | [ opoons Close

To zoom a well or cuvette:
1. Click the well or cuvette into which to zoom.

2. Click Q in the section toolbar or on the Home tab or double-click the well to display the
Zoom Well dialog where the data displays in a zoomed graph.
e Click Print to print the graph dialog.
e Select the Scale to Data check box to scale the display to the data.
e Click Show Reduced or Show Raw to toggle between reduced and raw data.
e Click Reduction to display the Data Reduction dialog where you modify the reduction
settings. See Data Reduction on page 191.
3. Click Close to close the Zoom Well dialog.
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Zoom Well Options

Use the Zoom Well Options dialog to change the display of the well graph that displays in the
Zoom Well dialog.

L3 Zoom Well Options [ZxT]
Graph Type Settings @

o Lhow Pot Symibads o Show Dats Coondirates

Charscterinties
Scaled KAy e
Aume Soae
Minimym | 0 o
Masimim  [gog
Gesd Linses. LTS el
Magar Grid Lines o e
Minar Grid Lines

To define zoom well options:

1. Inthe Zoom Well dialog, click Options to display the Zoom Well Options dialog.
2. Inthe Graph Type Settings area:

e Select the Show Plot Settings check box to display the plot symbols you define in the
Plot Editor dialog. Clear the Show Plot Settings check box to display the graph line
without plot symbols.

e Select the Show Data Coordinates check boxto display the data coordinates upon
cursor hover. Clear the Show Data Coordinates check box to not have the coordinates
display.

3. Inthe Characteristics area, do the following for both the X-Axis and the Y-Axis:

e Select the Auto Scale check box to have the software scale the data. Clear the Auto
Scale check box and enter the Minimum and Maximum scale values to define the
scale.

e Select each Grid Lines check box for the grid lines to display.

4. Click OK.
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Use the Plot Editor dialog to create a graph from the data the software collects.

Use Graph sections to plot information as a scatter plot graph or a bar graph. You can create
custom graphs and you can graph the data from Group section tables. You can use columns in
a Group section table as the X or Y input for plots on a graph in a Graph section. The Graph
section can use data from any Group section in the document and you can create as many
Graph sections as you need.

Creating New Graphs
|

|£?:'E:':—E:—:"' X|
| Define one or more plots, select a data source for each, and set plot properties. @ |
Graph Title |Graphl ‘
Plot List Plot Properties
Add Delete Plot Name  Plotl
Plotl - I
Available Groups Data Input
4 Exptl X-Axis |
Standards] P— v
Unknowns
Unk_Dilution =ftx] |
Control
Y-Axis
Meanvalue 2
- ||
Error | No Error ¥
Plot Attributes
Symbol Style L =
Symbol Size . =
Line =
Set Color... .
| 0K ‘ | Cancel |

To create a new graph:

1. Click Lﬂ New Graph above the Navigation Tree to display the Plot Editor dialog.

2. Inthe Graph Title field, enter the graph name.

3. Use Plot1 to get started. In the Plot Name field, enter the plot name. The Plot List displays
the name change.

4. Inthe Available Groups list, select the Group section that contains the data to graph. The
columns in the group you select appear in the X-Axis drop-down and the Y-Axis drop-
down.

5. Inthe Data Input area, click the X-Axis drop-down and select a Group section column or
select Custom to assign data to the graph's X-axis. If you select Custom, the Formula Editor
dialog displays where you define the formula for the data to appearin the X-axis. See
Formula Editor on page 101.

6. Click the Y-Axis drop-down and select the Group section column or select Custom to
assign data to the Y axis. If you select Custom, the Formula Editor dialog displays where
you define the formula for the data to appearin the Y-axis.
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7. Click the Error drop-down and select a column or select No Error to define the display of
error bars.

% Note: For scatter plot graphs, you can choose to display error bars for the plot of
the data for the X-axis and Y-axis. Error bars are lines that extend outside of a
plotted value in either or both directions and graphically represent some errorin
plotted data.

8. Inthe Plot Attributes area:
e Click the Symbol Style drop-down and select the symbol to use to mark each data
pointin a scatter plot graph.
e Click the Symbol Size drop-down and select the size of the symbol in a scatter plot.
e C(Click the Line drop-down and select the line style to use between data pointsin a
scatter plot.
e Click Set Color and select the color of the symbol and the line in a scatter plot or the
color of the barin a bar graph.
9. Click OK.

The Graph section displays in the Navigation Tree and the data plots display in the Workspace.
See Workspace on page 70.
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Editing Graphs

Use Graph sections to plot information as a scatter plot graph or a bar graph. You can create
custom graphs and you can graph the data from Group section tables. You can use columns in
a Group section table as the X or Y input for plots on a graph in a Graph section. The Graph
section can use data from any Group section in the document and you can create as many
Graph sections as you need.

Exptl Graphl & |4 A

Graphl  [# (A curveFit |Quadratic Grapht

Grapht

2 2 P P ) 9 2,
r RS % 2, % kS & =

W Platl ([ Stendards: MeanValus vs Cenc | Weighting: Fixed

Curve Fit Results &

Estimated Value Std. Error Confidence Interval

A 0130 0.050 10037, 0.343]
[0852,3.193]

11111 a5z [-2507, 0177

To edit a graph:

1.
2.

212

In the Navigation Tree, select a Graph section.

To change the name of the Graph section, right-click the Graph section in the Navigation
Tree and select Rename. The Rename Section dialog displays.

Select the Home tab:

e Click I‘L to display data as a scatter plot graph.
o Click L-lt to display data as a bar graph.

Click LL in the Graph section toolbar or on the Home tab to display the Plot Editor dialog.
See below for additional steps.

Click E in the Graph section toolbar or on the Home tab to display the Graph
Appearance dialog where you define the graph appearance including axis labels. See
Graph Appearance on page 216.

For scatter plot graphs, use the Category drop-down, Fit drop-down and I-ﬁ- to define
curve fits. See Curve Fit Settings on page 218.

Click ['—I to export the graph data. See Exporting Images of Graph Sections on page 230.
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Plot Editor
Use the Plot Editor dialog to change the plots and the data or plot attributes.

lg# Plot Editor - Gra

Define one or more plots, select a data source for each, and set plot properties. @
Graph Title | Graphl ‘
Plot List Plot Properties
Add Delete Plot Name  Plot1
Plot1
Available Groups Data Input
4 Exptl X-Axis
L J Conc o
Unknowns
Unk_Dilution =ftx1
Control
Y-Axis
MeanValue bt
~ftx)
Error | No Error had
Plot Attributes
Symbol Style .
symbol Size .
Line ~
"

To change plots and plot attributes:

—_

> w N

10.

1.

12.

In the Navigation Tree, select a Graph section.

Click L in the Graph section toolbar or on the Home tab to display the Plot Editor dialog.
In the Graph Title field, enter the graph name.
Above the Plot List, click Add to add a plot to the graph. Use Plot1 to get started. Select a
plot and click Delete to remove a plot from the graph.
In the Plot List, select a plot to define its properties on the right side of the dialog. You do
the following for each plot in the Plot List.
In the Plot Name field, enter the plot name. The Plot List displays the name change.
In the Available Groups list, select the Group section to graph. The columns in the group
you select appear in the X-Axis drop-down and the Y-Axis drop-down.
In the Data Input area, click the X-Axis drop-down and select a Group section column or
select Custom to assign data to the graph's X-axis. If you select Custom, the Formula Editor
dialog displays where you define the formula for the data to appear in the X-axis.
Click the Y-Axis drop-down and select the Group section column or select Custom to
assign data to the Y axis. If you select Custom, the Formula Editor dialog displays where
you define the formula for the data to appear in the Y-axis.
Click the Error drop-down and select the data to display error bars or select No Error to
not display error bars. Error bars are lines that extend outside of a plotted value in either or
both directions and graphically represent some error in plotted data.
Scatter plot graphs can display error bars for the plot of data for the X-axis and Y-axis.
In the Plot Attributes area:
e Click the Symbol Style drop-down and select the symbol to use to mark each data
point in a scatter plot graph.
e Click the Symbol Size drop-down and select the size of the symbol in a scatter plot.
e Click the Line drop-down and select the line style to use between data pointsin a
scatter plot.
e Click Set Color and select the color of the symbol and the line in a scatter plot or the
color of the barin a bar graph.
Click OK.
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Graph Legend

A bar graph does not have a legend. For a scatter plot graph, click Curve Fit Results on the
right below the graph to view or hide the legend.

Independent Fits

For each curve fit function:

e The formulas for the selected curve fits
e Foreach plot:

e RZvalue

e ECgq value (where applicable)

e Foreach parameter:

Global Fits

Estimated Value

Standard Error (Std. Error) of the estimate

Confidence Interval of the estimate: The confidence interval for a given
confidence level is a range such that the true value lies within the range with the
desired probability. The confidence level is usually specified as a percentage.
The greater the confidence level, the wider the resulting confidence interval.
Calculation of the confidence interval is based on sampling statistics. For example,
suppose that many data sets are obtained, and the confidence interval is
calculated for each data set based on a chosen statistic. The percentage of the
confidence intervals that contain the true value is the specified confidence level.
Select the Confidence Interval Method on the Statistics tab in the Curve Fit
Settings dialog. See Curve Fit Statistics Tab on page 222.

Independence: Parameter Independence is one way to examine the suitability of
a given curve fit for the data set. It is a measure of the extent to which the best
value of one parameter depends on the best values of the other parameters, and
is a number between O and 1, with 1 being the ideal. In the graph fit legend,
parameterindependence has been translated into bars, where 10 bars indicate a
high degree of independence. Because only very small values indicate a
problem, a nonlinear transformation is used for this translation. If one or more
parameters have few bars or no bars, the curve fit might not be a good fit for the
data set.

For example, if the data set is sigmoidal with clear lower and upper asymptotes, 4-
parameter fits should be applicable with many bars for all parameters. However, if
one or both asymptotes is missing, the A or the D parameter will have few bars,
indicating that reliable values cannot be deduced from the data set.

e The formula for the selected curve fit

e Foreach plot:
e Estimated Relative Potency (Estimated Rel. Pot.)
e Standard Error (Std. Error) of the estimate
e Confidence Interval of the estimate (see above)
e [ndependence (see above)
e ECg, value (where applicable)

e The list of weighting formulas
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e RZvalue
e Chi-Squared (sum of squared errors)
e F-Stat (the F-statistic comparing the parallel and unconstrained models)
e F-Prob (the probability associated with F-Stat)
e Foreach parameter:
e Estimated Value
Standard Error (Std. Error) of the estimate
Confidence Interval of the estimate
Independence
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Graph Appearance
Use the Graph Appearance dialog to specify labels, styles, and graphic-display options.
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To change a graph appearance:

1.
2.

In the Navigation Tree, select a Graph section.

Click M in the section toolbar or on the Home tab to display the Graph Appearance
dialog.
In the Axis Labels area, X-Axis Label field, enter the label to display for the x-axis. Axis
labels use the font you specify in the Font Styles area.
In the Y-Axis Label field, enter label to display for the y-axis.
In the Font Styles area, click Set next to Graph Title to display the Font Style dialog where
you select the font, font size, bold, and italics for the graph title display.
Click Set next to Axis Labels to display the Font Style dialog where you select the font,
font size, bold, and italics for the axis label display.
In the Scales area, either:
e Select the Auto Scale check box for the X-Axis and/ or Y-Axis to automatically scale
one or both axes.
OR
e Enter the Minimum and Maximum scaling values and then select either Linear or Log
for the display of each axis.
In the Grid Lines area, select the Major and/or Minor check boxes to display the major
and/or minor grid lines for the X-Axis and the Y-Axis.
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9. The Plot Options area for a scatter plot graph provides the following options:

e Select the Plot Symbols check box to display the symbol you define for each data
point in the Plot Editor dialog. See Editing Graphs on page 212.

e Select the Connect Points check box to display a line that connects the data points.

e Select the Show Data Coordinates check boxto display the coordinates when you
hoverthe cursor over a data point.

10. The Plot Options area for a bar graph provides the following options:

e Click the X-Axis Type drop-down:

e Select Evenly Spaced Axis to evenly space the axis.

e Select Separated Axis to separate the axis.

e Select X Value Positioned and then select the Show All Labels check box to
display all the labels for the defined interval. Clear the Show All Labels check box
to display labels only for the bars that have data.

e Select the Bar Values Show check box to display the data values above each bar and
then select either Vertical or Horizontal. Click the Significant Figures drop-down and
select the number of significant figures to display.

e Click the X-Axis Label Orientation drop-down and select Horizontal, Vertical, or
Inclined. For Inclined, enter a value in the Angle field.

e Select the Enable X-Axis Custom Labels check box allow users to double-click the
label in the Graph section to edit the label. Clear this check box to lock the labels to
the labels you define in the Graph Appearance dialog.

% Note: When you select the Enable X-Axis Custom Labels check box, the X-Axis
Label Orientation is set to Horizontal. After you edit the labels, you can change
the X-Axis Label Orientation to Vertical or Inclined.
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Curve Fit Settings

For scatter plot graphs, use the Curve Fit Settings dialog to define the graph's curve fit. When
you create a graph, the data does not have a related fit. Use the Graph section tool bar
Category drop-down to filter the list of fits that appear in the Fit drop-down list. After you select
a fit type, the software determines the parameter values that best fit the data. The function with
these parameters is drawn on the graph.

Note: Ideally, the type of fit you use is determined by the underlying chemistry of the
assay and can be set before data is read.

Generally, a standard curve refers to the curve fitted to the plot of concentration compared to
the mean value for the Standard group. When a fit is done, the parameter values are tabulated
in the legend at the bottom of the graph. The parameter table also contains information
regarding the uncertainty of the parameters, specifically standard errors and (optionally)
confidence intervals.

The software includes many curve fits and allows you to create custom curve fits, if needed.
See Custom Curve Fit Settings on page 224.

To define a curve fit for the plots in a graph, click I-ﬂ in the Graph section toolbar or on the
Home tab to display the Curve Fit Settings dialog.

e Select the Curve Fit tab to apply a curve fit to each graph plot.

e Select the Weighting tab to specify whether the data should be weighted and the
weighting formula. See Curve Fit Weighting Tab on page 221.

e Select the Statistics tab to specify the statistics display, the method of confidence, and the
level of confidence. See Curve Fit Statistics Tab on page 222.

Curve Fit Tab
Use the Curve Fit tab to select a plot from the graph and a curve fit to apply to that plot.
L Curve Fit Settings E || 42 curve Fit Settings )
Curve Fit | weighting | Staustics Curve Fit | weighting | statistes
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piot: [s1om. v Category 4 = | it [4-parametes Logunc = | paralel Uine Anakysis |41+ |Fit[sParamet = | Roference Plot [STORL =
Parameter  Formula Role Formula Confidence interval Parameter  Formula Role Formula Confidence Interval
A None v A None =

None ~ None ¥

9| @ ==

B [
c [ c Hone =
o 3

None * None ¥

Caleulate Relative Potency Confidence Intervals

Chosse either to fit each plat independently, oF to combing all plots Into o data 56t for  global it For linear €hoose a function for parallel line analysis. Specify whether confidence intervals should be cakulated for the
its, paramaters can be fned at specified values. For nondlingar fits, an (nitial vakue can be specified for each relative potency factors. Choose the reference plot; relative potency factors are cakculated with respect 1o this
parameter, This can be designated as an initial estimate, or as the fired value. plet.

oK Cancel Ok cancel

You can independently define the fit for each plot or you can combine all plots into one data
set and globally define the fit for all plots on a graph.

e SelectIndependent Fits to fit each plot independently.
e Select Global Fit (PLA) to combine all plots into one data set.
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Independent Fits
To independently fit a curve fit function to each plotin a graph:

Select Independent Fits option.
Click the Plot drop-down and select a plot.
Click the Category drop-down and select a category to filter the list of curve fits.
Click the Fit drop-down and select the curve fit function to apply to the plot.
For each parameter, click the Formula Role drop-down:
e Select None to not assign a formula role.
e Select Fixed to fix the parameter value. Use the Formula Editor dialog to define the

o s> W N =

fixed curve fit formula for the parameter. Click © =fix} .| to display the Formula Editor
dialog where you edit the formula. See Formula Editor on page 101.
e Select Seed to start the curve fit algorithm search. Use the Formula Editor dialog to

define the curve fit formula for the parameter. Click | ~fted.| to display the Formula
Editor dialog where you edit the formula.
6. Foreach parameter, select the Confidence Interval check box to calculate a confidence
interval for the parameter. Leave clear to not calculate a confidence interval.
7. Repeatforeach plot.

% Note: Forindependent fits (and global to a limited extent), you can fix values. Curve fit
parameter values can either be fixed, or "manually seeded" to start the curve fit
algorithm search.

Afteryou select a fit type, the software determines the parameter values that best fit the data.
The function with these parameters is drawn on the graph.

e Forlinear fits, parameters can be fixed at specified values.

e For nonlinear fits, an initial value can be specified for each parameter. This can be

designated as an initial estimate (the seed value), or as the fixed value.

You can specify whether a Confidence Interval should be calculated for each parameter.
The confidence interval for a given confidence level is a range such that the true value lies
within the range with the desired probability. The confidence level is usually specified as a
percentage. The greater the confidence level, the wider the resulting confidence interval.
Calculation of the confidence interval is based on sampling statistics. For example, suppose
that many data sets are obtained, and the confidence interval is calculated for each data set
based on a chosen statistic. The percentage of the confidence intervals that contain the true
value is the specified confidence level.

Global Fit (PLA)
To globally fit the curve fit function to all the plots in a graph:
1. Select the Global Fit (PLA) option.
2. Click the Parallel Line Analysis drop-down and select an option to filter the list that appears
in the Fit drop-down. See below for details.
3. Click the Fit drop-down and select the curve fit function to use.
4. Click the Reference Plot drop-down and select the plot to use as the reference.
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5. Foreach parameter, click the Formula Role drop-down:
e Select None to not assign a formula role.
e Select Fixed to fix the parameter value. Use the Formula Editor dialog to define the

fixed curve fit formula for the parameter. Click © -fix} |to display the Formula Editor
dialog to edit the formula.
e Select Seed to start the curve fit algorithm search. Use the Formula Editor dialog to

define the curve fit formula for the parameter. Click ! =l |to display the Formula
Editor dialog to edit the formula.
6. Foreach parameter, select the Confidence Interval check box to calculate a confidence
interval for the parameter. Leave clear to not calculate a confidence interval.
7. Select the Relative Potency Confidence Interval check box to. Leave clear to.

Parallel Line Analysis

Determining parallelism between a standard and test compound, and subsequent estimation
of relative potency, are fundamentals of bioassay use in biopharmaceutical development and
testing. For linear data, parallelism can be evaluated by examining the similarity between the
slopes of straight lines.

Bioassay data and immunoassays in particular, have been demonstrated to fit well with a
sigmoidal shape defined by a 4-parameter or 5-parameter curve fit. The basic question of
whether a curve with a specified shape can fit both standard and test data sets when shifted
along the X-axis can be addressed following a method detailed by Gottschalk and Dunn
(Journal of Biopharmaceutical Statistics, 15:437- 463, 2005).

The parameters are those for the fit function, plus a relative potency factor for each data set
relative to one designated as a reference. The values, standard errors, and (optionally)
confidence intervals display below the graph.

The software includes function operators that summarize this information in a Notes section.
For more details, see the SoftMax Pro Data Acquisition and Analysis Software Formula
Reference Guide.

Judge a Good Curve Fit

Visual inspection is always useful to evaluate a curve fit. The legend at the bottom of the graph
contains information that summarizes the numerical output of the fit. This includes the
coefficient of determination R?, a traditional measure of goodness of fit. R? is the fraction of the
variance of the y-values explained by the fit and is 1 for a perfect fit. You should not use this to
determine the statistical significance of the fit, orto compare the suitability of different curve fit
functions. For such purposes, you can use statistics such as chi-squared or Fisher-F. These
statistics can be obtained from the formula system.

Even fora good fit, as judged by eye or R?, some parameters might have high uncertainty.

See “Data Analysis and Quality Control of Assays: A Practical Primer” by R. P. Channing Rogers
in Practical Immuno Assay, edited by Wilfrid R. Butt (published by Marcel Dekker, Inc., New
York, 1984).

5049092 F



5049092 F

Chapter 4: Analyzing Data

Curve Fit Weighting Tab

Use the Weighting tab in the Curve Fit Settings dialog to define the independent weighting of
individual plots within a Graph section. Least-squares fitting assumes that errors are normally
distributed. If the variance of each point in the fitis known, or can be estimated by some
means, its inverse should be specified as the weight for the point. If the variances are not
known but are believed to be non-uniform across the data, that is, a known function of y, then a
weighting function should be used to reflect this information. If a formula for the weighting is
not provided, then all points have equal weight.

[/ Curve Fit Settings @I

[ curve Fit | Weighting | staristics |

)

‘Weighting

(5t =

[] Apply Weighting

|:| Weights are Inverse Variances

For each plot, specify whether the data should be weighted and, if so, the desired weighting formula, which must
evaluate to an array of numbers.

[ ok [ canca |

For each plot, specify whether the data should be weighted and, if so, the applicable
weighting formula, which must evaluate to an array of numbers.

To define curve fit weighting:

1. Click LC. in the Graph section toolbar or on the Home tab to display the Curve Fit Settings
dialog.

2. Select the Weighting tab.

3. Click the Weighting drop-down and select a plot.

4. Selectthe Apply Weighting check box and then click ! ~ftx) | to display the Formula Editor
dialog where you define the weighting formula. See Formula Editor on page 101. Clear the
check boxto make all points have equal weight.

5. Select the Weights are Inverse Variances check box if the defined weighting is the
inverse of the data variance. When you select this check box, and apply weighting, the
confidence interval method based on the chi-squared distribution becomes available.

6. Repeat foreach plotto weigh.

% Note: If you select both check boxes for each plot, the Profile Method (Chi-Squared
Distribution) option is available on the Statistics tab. See Curve Fit Statistics Tab on
page 222.
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Curve Fit Statistics Tab
Use the Statistics tab in the Curve Fit Settings dialog to specify the statistics display.
A Curve Fit Settings

Curve Fit | Weighting | Statistics

........

Statistics
Confidence Interval Method | Asymptotic Approximation v
Confidence Level |95 %
|:| Calculate Parameter Dependencies
D Calculate Confidence Band

[] Calculate Prediction Band

Choose the method by which confidence intervals are calculated, and a desired level of confidence. The greater the
confidence level, the wider the resulting interval. Profile methods reguire mare computation than the asymptotic
approximation, but are generally more accurate. Calculation of confidence and prediction bands, with the specified
confidence level, may also be chasen.

[ ok || conca |

Choose the method by which confidence intervals are calculated and a level of confidence.

The confidence interval for a given confidence level is a range such that the true value lies
within the range with the desired probability. The confidence level is usually specified as a
percentage. The greater the confidence level, the wider the resulting confidence interval.
Calculation of the confidence interval is based on sampling statistics. For example, suppose
that many data sets are obtained, and the confidence interval is calculated for each data set
based on a chosen statistic. The percentage of the confidence intervals that contain the true
value is the specified confidence level.

To define curve fit statistics:

1. Click the Confidence Interval Method drop-down:

e Select Asymptotic Approximation to calculate Wald confidence interval, which is
simply related to the standard error.

e Select Profile Method (F Distribution) to calculate based on model comparison with F-
statistic.

e Select Profile Method (Chi-Squared Distribution) to calculate based on model
comparison with chi-squared-statistic. This option is available when you select the
Apply Weighting check box and the Weights are Inverse Variances check box on the
Weighting tab on the Weighting tab for each plot.

e Select Profile Method (t Distribution) to calculate based on T-profile function.

Note: Profile methods require more computation than the asymptotic
approximation but are generally more accurate.

2. Inthe Confidence Level field, enter the percentage for how likely the interval is to contain
the parameter is determined. Increase the confidence level to widen the confidence
interval.
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3. Select the Calculate Parameter Dependencies check box to calculate dependencies
between parameters. With this option selected, the graphical representation in the graph
legend represents the parameter independence of the curve fit.

4. Select the Calculate Confidence Band check box to allow calculation and display of the
confidence band for each curve fit. The confidence band is a region bounded by lower
and upper curves and is constructed such that the probability that it contains the true curve
is approximately the specified confidence level. This calculation is available for all curve
fits except Point-to-Point, Cubic Spline, and Log-Logit.

5. Select the Calculate Prediction Band check box to allow calculation and display of the
prediction band for each curve fit. The prediction band is a region bounded by lower and
upper curves and is constructed such that the probability that it contains all data points is
approximately the specified confidence level. This calculation is available for all curve fits
except Point-to-Point, Cubic Spline, and Log-Logit.

Parameter Independence is one way to examine the suitability of a given curve fit for the data

set. It is a measure of the extent to which the best value of one parameter depends on the best

values of the other parameters, and is a number between 0 and 1, with 1 being the ideal. In the
graph fit legend, parameterindependence has been translated into bars, where 10 bars

indicate a high degree of independence. Because only very small values indicate a problem, a

nonlinear transformation is used for this translation. If one or more parameters have few bars or

no bars, the curve fit might not be a good fit for the data set.

For example, if the data set is sigmoidal with clear lower and upper asymptotes, 4-parameter

fits should be applicable with many bars for all parameters. However, if one or both

asymptotes is missing, the A or the D parameter will have few bars, indicating that reliable
values cannot be deduced from the data set.
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Custom Curve Fit Settings

Use the Function Editor dialog to specify functions for custom curve fits. These functions are
functions of a single independent variable, x, and a set of parameters denoted A, B, C, D, G, H,
I, J. These functions supplement the curve fits that are included with the software and you can
use custom curve fits anywhere within the protocols in which you define these functions.

Note: The equation images that display for the curve fits that are included in the
software do not appear for custom curve fit functions.

A custom function is available to fit data in any graph section in the protocol in which it is
defined. In the list of curve fits options, the curve fits you create in the Function Editor display in
the Custom category. You must assign initial parameter values in the Curve Fit Settings dialog.
This is in contrast to the built-in functions for which initial values may be specified but are not
required. Initial parameter values are formulas and may contain document references. A
parameter may be fixed at its initial value. After you assign the initial parameter value, the
software stores the initial value formulas in the protocol.

Note: Parameter names display in upper case in the curve fit legend (below the graph),
even if you define the name in lower case in the Function Editor dialog.

Use the three tabs in the Function Editor dialog to define custom curve fits:

e Explicit - Use to create an explicit function that is defined by an explicit formula f(x,p),
where p represents any subset of the parameters.

e Implicit - Use to create an implicit function that is defined by an implicit equation fix,y,p) = O.
The value of the function is the value of y which satisfies this equation for a given value of x
and set of parameters p. See Custom Implicit Curve Fits on page 225.

e Differential - Use to create a differential function that is defined as a componentina
system of first-order differential equations. Up to eight components are allowed and are
denoted fi (i=1to 8), with some particular fi being the reference component that defines
the function value. See Custom Differential Curve Fits on page 226.

For information about the curve fit functions that are included in the software, see Curve Fit
Functions on page 363.
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Explicit Tab
Use the Explicit Fit tab to create an explicit function that is defined by an explicit formula f(x,p),
where p represents any subset of the parameters.

v Function Editor

Explicit | implicit | Differential

Add Delete e
Name |9PL Derivatives

4pL

i [D+(a-DI/[1+(x/C}"B} ‘

otjon | MLBICIB)

affos (D-A)*log(x/C)* ([x/CH"B)* (1+{x/C}"B)*-2

affec (A-D)*(B/C)*((x/C)"B)*(1+(x/C}"B}"-2

affon 1/{1+{x/C)"-8)

affoG

ok || cancel

To define a custom curve fit for the plots in a graph:

1.
2.

Select the Operations tab and click Function Editor to display the Function Editor dialog.
Click Add to get started. Function1 appears in the function list and in the Name field.

e Click Delete to remove the function you select from the list.

e Click Duplicate to make a copy of the function you select in the list.
In the Name field, update the function name. As you change the Name field the list
displays the updates you make.
Select the Derivatives check box to specify the derivative of the function with respect to
any parameter. The software numerically estimates any derivative that you do not specify.
You should provide derivative formulas to improve the accuracy of curve fitting results.
The derivative of each component may be a function of the parameters and of the
components.
In the fix) field, enter the formula. The syntax of the formulas is the same as that of the
formula system, except that document references such as accessors, Summary formulas,
and operators referencing plots are not allowed. Parameter names are case insensitive.
Click Check Syntax to check the syntax of the formula. This checks only the formula syntax
not the mathematical correctness of the formula.
Click Add to add additional functions to the curve fit.
Click OK. The custom curve fit appears in the list of curve fits available from Graph
sections.

Custom Implicit Curve Fits

Use the Implicit tab in the Function Editor dialog to create an implicit function that is defined by
an implicit equation f(x,y,p) = 0. The value of the function is the value of y which satisfies the
equation for a given value of x and set of parameters p.

5049092 F

225



SoftMax Pro Software User Guide

Note: Parameter names display in upper case in the curve fit legend (below the graph),
even if you define the name in lower case in the Function Editor dialog.

The equation images that display for the curve fits that are included in the software do not
appear for custom curve fit functions.

v Function Editor

Explicit | Implicit | Differential

Add Delete
Mame MichaelisMenten
MichaelisMenten
fixy l,r+C‘(ex|:|[A“3r-B“x]-1ﬂ ‘ =0
Check Syntax
| ok |[ canca

To independently fit a curve fit function to each plotin a graph:

1. Select the Operations tab and click Function Editor to display the Function Editor dialog.

2. Select the Implicit tab.

3. Click Add to get started. Function1 appears in the function list and in the Name field.

e Click Delete to remove the function you select from the list.
e Click Duplicate to make a copy of the function you select in the list.

4. Inthe f(x) field, enter the formula. The syntax of the formulas is the same as that of the
formula system, except that document references such as accessors, Summary formulas,
and operators referencing plots are not allowed. Parameter names are case insensitive.

5. Click Check Syntax to check the syntax of the formula. This checks only the formula syntax
not the mathematical correctness of the formula.

6. Click Add to add additional functions to the curve fit.

7. Click OK. The custom curve fit appears in the list of curve fits available from Graph
sections.

Custom Differential Curve Fits

Use the Differential tab in the Function Editor dialog to create a differential function. A
differential function is defined as a component in a system of first-order differential equations.
Up to eight components are allowed and are denoted fi (i = 1to 8), with some particular fi being
the reference component that defines the function value.
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% Note: The equation images that display for the curve fits that are included in the
software do not appear for custom curve fit functions. Parameter names display in
upper case in the curve fit legend (below the graph), even if you define the name in
lower case in the Function Editor dialog.

v Function Editor

Explicit | |mplicit | Differential

Add Delete
Name CompartmentModel Compeonents |2~
Compartmenthlodel X0 Ia:l
1{x0) dfl/dx
o~ 0 A=f2-B*f1 Reference
[] Jacobian
[ ok || canca |

=| Note: For systems requiring stiff integration, the Jacobian matrix must be specified.

To define a Differential custom curve fit:

1. Select the Operations tab and click Function Editor to display the Function Editor dialog.
2. Select the Differential tab.
3. Click Add to get started. Function1 appears in the function list and in the Name field.
e Click Delete to remove the function you select from the list.
e Click Duplicate to make a copy of the function you select in the list.
4. Click the Components drop-down and select the number of components to include. Each
component is denoted fi (i = 1to 8). You will select the Reference check box for the fi that
you want to be the reference component that defines the function value.
In the xO field enter
Click the f<i> drop-down and select the component to define.
In the f<i>(x0) field, enter
In the df<i>/dx field, enter the formula. The syntax of the formulas is the same as that of the
formula system, except that document references such as accessors, Summary formulas,
and operators referencing plots are not allowed. Parameter names are case insensitive.
9. Click Check Syntax to check the syntax of the formula. This checks only the formula syntax
not the mathematical correctness of the formula.
10. Repeat foreach Component and remember to select the Reference check box for the fi
that you want to be the reference component that defines the function value.
11. Click Add to add additional functions to the curve fit.
12. Click OK. The custom curve fit appears in the list of curve fits available from Graph
sections.

0 N’
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The initial value of x and each component must be specified and may be a function of the
parameters. The derivative of each component may be a function of the parameters and of the
components. For example, this two component system defines a compartment model as used
in pharmacokinetics (Bates, D.M., and Watts, D.G. (1988), Nonlinear Regression Analysis and Its
Applications, John. Wiley & Sons, New York).

Function Editor "] Function Editor
Expict | mpickt| Diterentsl Expicit | impiicie| Diterential
paar] [ oeee |
ettt ame. [Compurmrendfea comores 7] @ ] Nome. [Comprmentiode comorens (27 @
ouplicate | Duplicate |
Comparmenttaocel o Comparmentodel o B
1{x0) afL/ax 12(x0) af2/ax
n~| [0 AM2EL ] Reference 7~ [ AT [] Reference
] scotion ] tcotia
Check Syntax Check Syntax
ok | [ cancet ok | [ cancel

Confidence Interval Calculations

The following is a description of the calculation of confidence intervals for curve fit parameter
estimates. Assuming normally distributed error in the data, a maximum likelihood parameter
estimate, p, is obtained by least-squares regression. Given a required confidence level
(typically but not necessarily 95%, corresponding to significance a = 0.05), a confidence
interval for the estimate may be constructed.

Two important points:

e Such aninterval should not be construed to mean that there is a 95% probability that the
true parameter value falls in the interval, which would be meaningless because the true
value is not a statistic. Rather it implies that the interval has been calculated by a method
such that it has a probability of 95% of containing the true value.

e Fora function with P parameters, least squares regression implies a P-dimensional
confidence region, not a set of P confidence intervals. Therefore, reported confidence
intervals are actually the limits of the confidence region along each dimension.

The software implements various methods for the construction of confidence intervals, which
are discussed in the following sections.
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Asymptotic Approximation

This method is based on the formula relating confidence interval to the standard error of the
mean of a normally distributed variable. The standard error is given by

i &
o Variance* SSE
N-P

where Variance is the variance of the parameter as determined by the regression calculation,
SSE is the minimum sum-of-squared errors, N the number of data points and P the number of
variable parameters. The end points of the confidence interval are then

p :pbesr iSE*r(N—PDO{)

where t(N-P,qa) is the value of the inverse Student's t distribution for degrees of freedom N - P
and specified significance a. Note that the interval is symmetrical about the best fit value, ppegt-

Profile t Method

This method is a generalization of the asymptotic approximation which is more appropriate for
nonlinear regression [1]. The confidence interval is defined by the two solutions for p to the
equation:

[ [t =P ),
SSE(p)_[H{ = = ]] SSE

where SSE(p) is the sum-of-squared errors for parameter value p with all other parameters
varied to minimize SSE(p). For general linear regression this equation may be solved
analytically, the result being equal to the asymptotic approximation described above.
However, for nonlinear regression numerical solution is required. The resulting interval is not in
general symmetrical about the parameter estimate, and there is no guarantee that a solution
exists. This method is illustrated below for parameter B in a four-parameter logistic fit. The
function SSE(B) is shown in red, and the right-hand-side of the above equation is shown in
green. The points of intersection, hollow green circles, define the confidence interval. For
comparison, the asymptotic confidence interval is defined by the filled green circles, obtained
by the asymptotic approximation to SSE(B), shown in blue.

SSE(B)
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Profile F Method

This method is based on model comparison between a set of parameters and the best fit
parameters, using extra sum-of-squares ANOVA [1,2]. The confidence interval is defined by the
two solutions for p to the equation:

P*F(P,.N-P.a)
N-P

SSE(p)=|1+ * SSE

where SSE(p) is the sum-of-squared errors for parameter value p with all other parameters
varied to minimize SSE(p), and F(P,N-P,a) is the inverse of the Fisher F distribution with the
specified degrees of freedom factors P, N-P and significance a. As with the profile t method,
numerical solution is required, and the interval is asymmetric and not guaranteed to exist.

Profile Chi-Squared Method

This method [3]is similar to the other profile methods but is applicable only if the sum-of-
squared errors has the chi-squared distribution, which follows if data points are weighted with
theirinverse variances in forming the sum. The end points of the interval are defined by the
equation:

SSE(p)=SSE+ 7 (L)

where 4 2(1,a) is the critical value of the chi-squared distribution with one degree of freedom
and significance a. As with the other profile methods numerical solution is required.

References:

1. Douglas M. Bates and Donald G. Watts, Nonlinear Regression Analysis and Its Applications,
Wiley, 1988.

2. H.J. Motulsky and A Christopoulos, Fitting models to biological data using linear and
nonlinear regression. A practical guide to curve fitting. 2003, GraphPad. Software Inc.

3. W.H. Press, S.A. Teukolsky, W.T. Vetterling, and B.P. Flannery, Numerical Recipes: The Art of
Scientific Computing, Third Edition, Cambridge University Press, 2007.

Exporting Images of Graph Sections

Use the Home tab to export a 300 DPlimage of a Graph section for use in another program.

You can also right-click anywhere on the Graph section and select Copy to then paste an
image of the section directly into a word processor or spreadsheet program.

Note: The 300 DPlimage might appear very large in the program into which you import
or paste. You might need to scale or resize the image in that program after you import
or paste the Graph sectionimage.

To export a graph image:
1. Inthe Navigation Tree, select a Graph section.

2. Selectthe Home tab and click LT to display the Save As dialog.
3. Navigate the computer file hierarchy to the file location where you want to save the .png

file.
4. Inthe File Name field, enter a name for the file.
5. Click Save.
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Viewing Data in 3D Graphs

Use the 3D Graph dialog to view a three-dimensional graph of reduced plate data.

MY 3D Graph (=)

Plate1l

2750

Reduced Data
e o
a 2 & B
4 3 2 3
Rows

Columns

In the Navigation Tree, select a Plate section and click i in the section toolbar oron the
Home tab to display the 3D Graph dialog.

To rotate the 3D graph:

e To rotate the graph vertically, drag the vertical scroll bar located to the right of the graph.

e To rotate the graph horizontally, drag the horizontal scroll bar located below the graph.

e To start or stop a continuous animated horizontal graph rotation, double-click the graph.

Drag a side or a corner of the dialog to resize the 3D Graph dialog.
Right-click on the 3D graph for additional options:

e Select Viewing Style and then select the viewing styles. The options you select display a
check mark in the list.

e Select Border Style and then select: No Border, Thin Line, Shadow, or Inset.

e Select Font Size and then select: Large, Medium, or Small.

e Select Grid Options and then select: Show X and Y Axis Grid Lines, Show Y-Axis Grid
Lines, Show X-Axis Grid Lines, or Hide Grid Lines.

e Select Bounding Box and then select: While Rotating, Always, or Never.

e Select Rotation Animation to have the image rotate continuously. Double-click the image
to stop the rotation.

e Select Rotation Increment and then select the speed and direction of rotation. Values
closer to zero rotate slower, while values farther from zero rotate faster. To rotate counter-
clockwise, select a negative value.

e Select Rotation Detail and then select: Wire Frame, Plotting Style, or Full Detail.

e Select Plotting Method and then select: Wire Frame, Surface, or Surface With Shading.

e Select Shading Style and then select: White or Color.

e Select Maximize to display the graph in full screen mode. Pres Esc to shrink the image
back.

e Select Customization Dialog to display the Customization dialog where you define the
above settings and more. See Customizing 3D Graphs on page 232.

e Select Export Dialog to display the Export Control dialog where you define settings to
export the 3D graph. See Exporting 3D Graphs on page 234.
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Customizing 3D Graphs
Use the five tabs in the Customization dialog to customize a 3D graph.
Custornization...
General | More I Font } Color | Style |
Main Title:  [Flate [
Sub Title: |
Barder Style {E”g Lti:es . o
" Mo Border & Line © v 2
" None
" Shadow 7 3D Inset
Wiewing Style
{s" Color
" Monochrome A 8 X
" Monochrome + Symbols S
Show Bounding Box
Font Size @ ‘while Fotating
& Large " Med " Small € flways
" Mever
ok | Cancel | Apply ‘ Export... Maximize..

Most of the following options are available when you right-click the 3D graph. Right-click a 3D
graph and select Customization Dialog to display the Customization dialog.

General Tab
The following options appear on the General tab:

e Main Title: Enter the text for the graph title.

e Sub Title: Enter the text to display below the graph title.

e Show Annotations: Select this check box to display notes. Not available if there are no
notes available.

e Border Style: Select Line, Shadow, or 3D Inset to define the outside image border or
select No Border to not display a border.

e Viewing Style: Select Color, Monochrome, or Monochrome + Symbols to define the
image background.

e Font Size: Select Large, Med, or Small to define the text font size.

e Grid Lines: Select Both, X, or Y to display the x-axis and/or y-axis grid lines or select None
to not display grid lines.

e Rotation Animation: Select this check box to continuously rotate the graph.

e Show Bounding Box: Select While Rotating or Always to display a wire-frame box around
the graph or select Never to not display a wire frame.

More Tab
The following options appear on the More tab:

e Rotation Detail: To change the display style when the graph rotates, select Wireframe to
display only the outlines of the 3D graph, Plotting Method to display the data plot in full 3D
while displaying only outlines for the grid, or Full to display the entire graph in full 3D during
rotation.

e Rotation Increment: Select anincrement to control the speed and direction of the
animated rotation. Values closer to zero rotate slower, while values farther from zero rotate
faster. To rotate counter-clockwise, select a negative value.

e Shading Style: Select White or Color to change the shading. This option has no effect on
the display if there is no shading.

* Plotting Method: Select Wire Frame, Surface, or Surface with Shading to change the data
plot display.
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Font Tab
The following options appear on the Font tab:
e Main Title: Select the font for the graph title and then select to add Bold, ltalic, and
Underline styles.
e Sub-Title: Select the font for the text directly below the graph title and then select to add
Bold, ltalic, and Underline styles.
e Subset/Point/Axis Labels: Select the font for all other text in the graph and then select to
add Bold, ltalic, and Underline styles.

Color Tab
The following options appear on the Color tab.

Select a Graph Attribute option on the left to define color settings for that attribute and then
repeat for all other attributes.
e Desk Foreground: Select to define the color of the text of the graph title and subtitle.
e Desk Background: Select to define the color of the area behind the graph title and
subtitle.
e Shadow Color: Select to define the color of the border shadowing when you select
Shadow for the Border Style on the General tab.
e Graph Foreground: Select to define the color of all text except the title and subtitle, and
the border around the graph.
e Graph Background: Select to define the color of the area within the border and behind the
graph.
e X and Z Axis Plane: Select to define the color of the graph floor.
e Y Axis Plane: Select to define the color of the graph walls.

Select a color from the color pallet.
In the Quick Styles area:

e Select the Bitmap/Gradient Styles check box to add texture to the graph.
e Select one option for the Inset, Shadow, Line, and No Border from the Light, Medium, or
Dark columns.

Style Tab

The options that appear on the Style tab are dependent on the selections on the other tabs,
and onthe type of data.

Select anitem in the list and then click the color for your selection.
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Exporting 3D Graphs

Use the Export Control dialog to export animage of a 3D graph and to export the data from a
3D graph. Before you export animage of a 3D graph, make sure to define all customization
options including the rotation increment. See Customizing 3D Graphs on page 232.

Export Control @

Export

¢ EMF

Export Destination
{* ClipBoard

" File

" Prirter

Export Size

" wiF - BMP 7 PG " PMG " Tewt/Data

|

f* Milimeters " Inches " Paints

width: [152400 /107600 Millmeters
DRI |300 - ™ Large Font Cancel

To export 3D graphs:

1.

From the 3D Graph dialog, right-click the graph and select Export Dialog to display the
Export Control dialog.

In the Export area, select the image file format or select Text/Data to export the data
without the image.

In the Export Destination area, select the location to where you want to export the image
or data:

Select Clip Board to export the image or data to the computer clipboard to paste into
a word processor program or a spreadsheet.

Select File to save the image or data as a file on your computer or network. Click
Browse to choose the destination and name the file.

Select Printer to export the image or data directly to a printer. After you click Print you
can select the printer and printer options.

In the Export Size area, options are dependent on your previous selections:

Select Full Page to print to a full page. (Export Destination = Printer)

Select No Specific Size to have the export operation set the image size. (Export =
WMF and Export Destination = Clipboard or File)

Select Pixels to define the number of pixels. (Export = BMP, JPG, or PNG and Export
Destination = Clipboard or File)

Select Millimeters, Inches, or Points and then enter the Width and Height of the image.
(Export = EMF or WMF all Export Destination and all Export options when Export
Destination = Printer)

Click the DPI drop-down and select the number of dots perinch (Export = EMF, BMP,
JPG, or PNG and Export Destination = Clipboard or File).

Select the Large Font check box to increase the size of the text. (Export Destination =
Clipboard or File).

5. When you finish your export options, click Export or Print.
If you export the data as text, then the Export dialog displays with more options to format
the export data.

6.

234
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Exporting Text/Data
Use the Export dialog to define the format for data you export from a 3D graph.

1. Inthe Export Control dialog, select the Text/Data Export option, complete the other
options described above and then click Export to display the Export dialog.
2. Inthe Select Subsets and Points area:

e Select All Data to export all data.

e Select Selected Data and then use the Subsets to Export fields to select the number
that corresponds to each columns of data and the letter that corresponds to each data
point. To multi-select Shift click or CTRL.

3. Inthe Export What area select to export just the Data or the Data and Labels.
When multiple values are available, select an option in the Data to Export area.
5. Inthe Export Style area:

e Select List and then select Tab or Comma as the delimiter. The delimiter must match
the requirements of the program to where the data will export.

e Select Table and then select Subsets/Points to place the data from the plate column
numbers into the rows of the table and the data from the plate row letter into the
columns of the table, or select Point/Subsets to place the data from the plate row
letters into the rows of the table and the data from the plate column numbers into the
columns of the table.

6. Inthe Numeric Precision area:

e Select Current Precision to export the data using the rounding defined in the graph.
e Select Maximum Precision to export the rounding available in the document.
7. Click Export. If you export the data to the computer clipboard, immediately open the
program where you want to use the data and paste the data into that program.

>
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Viewing Western Blot Membrane Data

After you scan a membrane for Western Blot data, the data displays in the software as an
image. Use the image tools in the Plate section to zoom, crop, colorize, and adjust the intensity
of the image. You can select a region of interest (ROI) and rescan the membrane at a higher
resolution.

Drag the slider on the side of the Plate section to zoom the image in or out.
click 111 on the side of the Plate section to view the image at its actual size.

Click Fit on the side of the Plate section to fit the image to the Plate section.

Click "'1 on the side of the Plate section and then drag across the image to define the
area to zoom to zoom in on a specific area of the image.

Click * on the side of the Plate section and then drag the image to move it to move the
image within the Plate section.

Click tl' on the side of the Plate section and then drag across the image to define the
cropped area to crop the image.

Select a color option from the LUT list at the top of the Plate section to colorize the image
from a look-up table.

In the Subtract field, enter the value to subtract from the image intensity to adjust the
intensity of the image.

Select the Log check box to scale the image intensity.

Select the Invert check box to invert the colors of the image similar to a photographic

negative.
_+u-
Click ket on the left side of the Plate section and then drag across the image to define the

region of interest (ROI) to scan. Click 0 to scan the region using the ROl Scan Resolution
you define in the Settings dialog. The data from the ROI scan replaces the data from the
original scan.

Click the following to adjust the resolution of the scanned image:

o Click a to view the image at the scanned resolution.
e Click i to view the image at a fine resolution suitable for external analysis.
e Click n to view the image at a very fine resolution suitable for publishing.

Click ;) to restore the image and use the data from the last scan.

Use the Plate section to export the image for further analysis or to publish. These tools are on
the right side of the top in the Plate section

236

-
Click = = and then Excel Analysis to open the raw image data in a Microsoft Excel
template for analysis. See Using Excel to Analyze Western Blot Data on page 237.

-
Click = and then ImageJ Editor to open the raw image in the ImageJ software. See
Analyzing Western Blot Images on page 241.
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-
e Click = and then External Image Editor to open the raw image in a pre-defined image-
analysis tool. This option is available when you have tif files associated with a program
otherthan ImageJ software.

% Note: If you use the ImageJ software or an external image analysis tool to make and
save changes to the original image file, the edited image displays in the Plate

section and “# appears at the top of the section to indicate that you cannot edit

the image. Click ='> to restore the image and use the data from the last scan.

-
e Click = ,click Export as Text, and then select a name for the exported text file to export
the raw image data to a text file.

-
e Click =, click Export as Image, and then select a name and format for the image export
file to export the edited image as it displays in the Plate section.

For information on how to locate the generated image, see Managing Documents on page 25.

Using Excel to Analyze Western Blot Data

You can export the Western Blot image data to a Microsoft Excel template to analyze the
image data.

-
Click = = and then click Excel Analysis to export the raw image data to an Excel template.

An Excel file opens to display the data you export. The Excel file has three worksheets.

Data Segmentation Analysis

* The Analysis worksheet displays the data using automatic background subtraction. You
can select the bands to measure and display a bar graph showing an analysis of the
selected bands in the Analysis worksheet. See Measuring Select Bands on page 238.

® The Segmentation worksheet displays the segmented bands with background
subtraction. The segmented bands are displayed on a white background. You can adjust
the background noise level and the minimum and maximum band size in the Segmentation
worksheet. See Defining Segmentation Criteria on page 239.

e The Data worksheet displays the TIFF image and a color rendering of the raw data. No
further analysis is shown in the Data worksheet. If the automatic background subtraction in
the Analysis worksheet is not sufficient for your data, you can manually define the
background for subtraction in the Data worksheet. See Selecting the Background for
Subtraction on page 240.

Save the Excel file to save the data and analysis for future reference.
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Measuring Select Bands

Use the Analysis tab at the bottom of the Excel window to select the bands to measure and
displays a bar graph of the selected bands.

Mean Intensity
Minimur Particle Size =10
7,000,000

ScanLater - Measure Selected Bands,

6,000,000

4bands detected
O sum

Use the mouse to seect Excel
workshet celscontaining the bands
measured

@ Mean tobe,

5,000,000

4,000,000

B Mean Intensity
3,000,000 |

2,000,000 |

1,000,000 |

n sum MAX MEAN
1 21,768,076 633,165 334,893
2 70,708,952 2,100,630 1,010,128
3 243,163,552 8,484,870 2,366,233
4 519,776,448 14422545 6,663,801

The Analysis worksheet uses automatic background subtraction for the data display.
e Click Measure All Bands to measure all the bands that display.

e Click Measure Selected Bands, and then drag the cursor to draw a rectangle around the
bands to measure. In the ScanLater - Measure Selected Bands dialog, click Measure.

4 bands detected Measure |

Reset |
warksheet cells containing the bands
to be measured Close

e Click Clear Measurements to remove the measurement analysis from the worksheet.

Use the mouse ko select Excel

After you select the bands to measure, a bar graph displays with a table below it to show an
analysis of the bands based on the analysis criteria. Labels on the blot show the locations of
the bands that you reference in the graph and the table.

You can adjust the background noise level and the minimum and maximum band size in the
Segmentation worksheet. See Defining Segmentation Criteria on page 239.

If the automatic background subtraction is not sufficient for your data, you can define the

background for subtraction in the Data worksheet. See Selecting the Background for
Subtraction on page 240.
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Defining Segmentation Criteria

Use the Segmentation worksheet to adjust the background noise level and the minimum and
maximum band size. You can also remove artifacts that you do not want to include in your
measurements. The segmented bands display on a white background.

SegmentBands e - i *“'ﬁ“ﬁ

ScanLater - Segment Bands Ed

Background Noiss Level: [lw =~
Minimurn Band Size: 10 Defaults
Maximum Band Size: [ Close

Band sizes re calculated as the nurber of Excel workshest celk
they occupy.

To adjust the segmentation of the bands, click Segment Bands to display the ScanLater -
Segment Bands dialog. Select either a Low or High background noise level to subtract and
define the minimum and a maximum band size for the segmentation. The band size is the total
number of cells in the Excel worksheet that the band occupies. To view the result of your
settings, click Segment.

To remove artifacts from the data display, drag the cursor in a rectangle around the artifact,
right-click the rectangle, and select Clear Contents.

E‘ﬁn‘- Cug

R Copy

= Pazte Options:

il

A
Paste Specizl.
[nsert,
Delete,,
Clear Contents \L
E Duick Analysis N
Filter 3
ot ]
£F Insert Comment
[ Eormat Cells..
Pick Fromn Drop-dosen List..,
Drafine Mame.,

& Hyoedink..

You can select the bands to measure and display a bar graph that displays an analysis of the
bands you select in the Analysis worksheet. See Measuring Select Bands on page 238.

If the automatic background subtraction is not sufficient for your data, you can define the
background for subtraction in the Data worksheet. See Selecting the Background for
Subtraction on page 240.
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Selecting the Background for Subtraction

Use the Data worksheet to define the background for subtraction in the Data worksheet. The
worksheet displays the TIFF image and a color rendering of the raw data with no further
analysis.

To define the background for subtraction, drag the cursor in a rectangle around the area to use
as the background to display the ScanLater - Select Background dialog. Click OK.

Dowou wvant ko select this region as Background? If Wes Click QK to perform
background subtraction,

(0] 4 I Cancel

You can select the bands to measure and display a bar graph to display an analysis of the
bands you select bands in the Analysis worksheet. See Measuring Select Bands on page 238.

You can adjust the background noise level and the minimum and maximum band size in the
Segmentation worksheet. See Defining Segmentation Criteria on page 239.
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Analyzing Western Blot Images

Western Blot membrane data is saved as a TIFF image to allow you to use the image analysis
tool of your choice for analysis. The SoftMax Pro Software includes a version of the ImageJ
software from U.S. National Institute of Health (NIH).

-
To view the membrane image in the ImageJ software, click = inthe section toolbar and then
click ImageJ Editor.

To view the membrane image with another image-analysis tool, click € in the section toolbar
and then click External Image Editor. This option is available if you have tif files associated
with a program other than the ImageJ software. The icon for this tool changes depending on
the image-analysis tool you select. See Defining the Membrane Image-Analysis Tool on page
241.

% Note: If you use the ImageJ software or an external image analysis tool to make and
save changes to the original image file, the edited image displays in the Plate section

and “& appears at the top of the section to indicate that you cannot edit the image.

Click r:} to restore the image and use the data from the last scan.

To retain the editing capabilities within the software and edit the image with an external editor,
export the image or make a copy of the generated .tiff image to openin the editor. For
information on how to locate the generated .tiff image, see Managing Documents on page 25.

Defining the Membrane Image-Analysis Tool

1. In Windows Explorer, right-click a file with a .tif extension.
2. Click Open With > Choose Default Program to display the Open With dialog.
3. Selectthe program to use for membrane image analysis.
e [f the program displays in the Recommended Programs list, select it.
e |f the program does not display in the Recommended Programs list, click Browse.
Locate and select the .exe file for the program to use, and then click Open.
The ImageJ software .exe file installed with the SoftMax Pro Software can be found in
the ImageJ folder within the SoftMax Pro Software installation folder.
4. Selectthe Always Use the Selected Program to Open This Kind of File check box.
5. Click OK.

The next time you open a Western Blot document, the Image icon changes to match the
program you select.
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Chapter 5: SoftMax Pro Software - GxP Edition

Molecular Devices provides a fully integrated hardware and software solution for adherence to
Good Manufacturing Practices (GMP), Good Laboratory Practices (GLP), and many other
regulatory compliance requirements including 21 CFR Part 11. The SoftMax Pro GxP Software
Suite extends the SoftMax Pro Software into regulated laboratories that work under GMP, GLP,
and 21 CFR Part 11 guidelines for secure electronic records. SoftMax Pro Software - GxP edition
functions similarly to the SoftMax Pro Software - Standard edition but adds a userlogon
requirement, electronic signature capability, and auditing features that maintain audit trails for
electronic records.

The typical regulated laboratory environment has several check points to confirm the integrity

of an assay. The SoftMax Pro Software - GxP edition allows users with appropriate permissions

to assign a corresponding status to documents to track and restrict the document through each
check point. See Document Workflow on page 251.

There are three software applications that make up this integrated solution:

e GxP Admin Software - (has no user interface)
e GxP Admin Portal Software
e SoftMax Pro Software - GxP edition

GxP Admin Portal Software

Use the GxP Admin Portal Software to create users and to assign each user to at least one
Project. You can assign a user to multiple Projects and the user can have a different set of Role
permissions for each Project. A Project restricts what documents the user can access within the
SoftMax Pro Software - GxP edition and a Role restricts what the user can do with the
documents. See Default Roles on page 252.

Each user action triggers an event and all events are added to the GxP Admin Portal Software
System Audit Trail for compliance purposes. See Audit Trail on page 265.

See the GxP Admin Software User Guide for how to manage users, Projects, and Roles.

SoftMax Pro Software - GxP Edition

The SoftMax Pro Software - Standard edition is very similar to the SoftMax Pro Software -
Standard edition for data collection and analysis of the data from a Molecular Devices
microplate reader. Exceptions include a requirement that the user must enter a user name and
password and then select a Project to use the SoftMax Pro Software - Standard edition. Users
with the SoftMax Pro Access permission are assigned to at least one Project and the user's
Role in each Project restricts what the user can do in the software.

The SoftMax Pro Software - GxP edition creates an audit trail for each document. The
document-specific audit trail records the events that users trigger as the users interact with the
document. See Document Audit Trail on page 266.
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Administratively Controlled Access
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The GxP Admin Portal Software is the interactive user interface for the GxP Admin Software.
Use the GxP Admin Portal Software to create users. You grant users Access permissions to
allow use of specific software applications. You then assign users with the SoftMax Pro Access
permission to Projects that limit their access to documents. For each Project, you assign users
to a Role that allows users to perform the tasks for which the users are responsible.

The computer that runs the SoftMax Pro GxP Software must be able to access the server that
contains the GxP Admin Software to enforce the features that are under administrative control.

Projects - Document Access Restrictions

Each user with the SoftMax Pro Access permission must be a member of at least one Project.
Use Projects to limit which documents the user can access. Each user can be a member of
multiple Projects.

Roles - Workflow Permissions

Each user with the SoftMax Pro Access permission can have one Role in each Project. Each
user can be a member of multiple Projects and can have a different Role in each Project. Use
Roles to restrict the user's responsibilities in the SoftMax Pro Software - GxP edition.

Role permissions are grouped into the following categories:

Document Access Permissions

Use Document Access permissions to manage what users can do with documents.

e Openlmported - Allows users to open documents that have the status: Imported.

e OpenInWork - Allows users to open documents that have the status: In Work.

e Open Review Pending - Allows users to open documents that have the status: Review
Pending.

e Open Reviewed - Allows users to open documents that have the status: Reviewed.

e Open Released - Allows users to open documents that have the status: Released.

e Open Outdated - Allows users to open documents that have the status: Outdated.

e OpenlInProgress - Allows users to open documents that have the status: In Progress.

e Open Approval Pending - Allows users to open documents that have the status: Approval
Pending.

e Open Approved - Allows users to open documents that have the status: Approved.

e Open Canceled - Allows users to open documents that have the status: Canceled.

Document Workflow Permissions
Use Document Workflow permissions to manage what users can do in the document workflow.

e Set Review Pending - Allows users to set documents to the status: Review Pending.

e Set Reviewed - Allows users to set documents to the status: Reviewed.

e Release Protocol - Allows users to release a document as a protocol which sets the
document status to Released.

e Set Outdated - Allows users to set documents to the status: Outdated.

e Generate Compliance Data - Allows users to generate compliance data. For example,
(using the system default Roles) this user would be the Lab Technician who can open a
protocol document with the status Released. The software prompts the user to save the
document as a data document and assigns the document the status In Progress. The user
then runs the assay to generate compliance data.

e Set Approval Pending - Allows users to set documents to the status: Approval Pending.
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Set Approved - Allows users to set documents to the status: Approved.
Set Canceled - Allows users to set documents to the status: Canceled.

Document Editing Permissions

Use Document Editing permissions to manage what users can do with documents.

Edit Reader Settings - Allows users to define microplate reader acquisition settings.
Edit Notes Text - Allows users to edit Note sections in the experiments in documents.
Read Empty Plates/Cuvettes - Allows users to read empty Plate sections and empty
Cuvette Set sections.

Function Editor - Allows users to create custom curve fit functions.

Overwrite Plate/Cuvette Data - Allows users to overwrite the data in Plate sections and
Cuvette Set sections.

Edit Graphs, Summaries, and Reductions - Allows users to edit Graph sections and to edit
Summary formulas and Reduction formulas.

Assign Plate Layouts - Allows users to assign plate layouts.

Edit Sample and Group Information - Allows users to edit sample and Group section
information.

Add/Delete Groups - Allows users to add and delete Group sections from the experiments
in documents.

Edit Formulas - Allows users to edit formulas in documents.

Edit Print Options - Allows users to edit the print options.

Lock/Unlock Sections - Allows users to lock and unlock sections in the experiments in
documents.

Mask/Unmask Wells - Allows users to mask and unmask wells.

Create/Save As Data Document - Allows users to save data documents to the database.
Create/Save As Protocol - Allows users to save protocol documents to the database.
Change Auto Save Settings - Allows users to change Auto Save settings.

Change Auto Export Settings - Allows users to change Auto Export settings.

Statements & Signatures Permissions

Use Statement and Signatures permissions to manage what users can do with the statements.

Add/Modify Statements - Allows users to edit statements.

Sign Statements - Allows users to sign statements.

Revoke Own Signature - Allows users to remove only their own signatures from
statements.

Revoke Any Signature - Allows users to remove any signature from statements.

Document Management Permissions

Use Document Management permissions to manage what users can do with the documents in
the database.

Rename Document - Allows users to rename documents.

Move Document - Allows users to move documents to different folders in the database.
Delete Document - Allows users to delete documents from the database.

Unlock Document - Allows users to unlock documents.

Import Documents - Allows users to import documents into the database.

Export Documents - Allows users to export documents out of the database.
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Folder Management Permissions

Use Folder Access permissions to manage what users can do with the document storage
folders in the database.

e Add Folder - Allows users to create new folders in the database.

e Rename Folder - Allows users to rename folders in the database.

e Move Folder - Allows users to move folders in the database.

e Delete Empty Folder - Allows users to delete empty folders from the database.

e Hide/Unhide Folder - Allows users to hide and unhide folders and to use hidden folders in
the database.

Instrument Permissions
Use Instrument permissions to manage what users can do with the microplate reader.

e Lock/Unlock Instrument - Allows users of the SpectraMax® iD3 Multi-Mode Microplate
Reader and the SpectraMax® iD5 Multi-Mode Microplate Reader to lock and unlock the
instrument touchscreen.

e Instrument Simulator - Allows users to simulate the connection between the SoftMax Pro
GxP Software and an instrument.

Logging In to the SoftMax Pro Software - GxP Edition
The SoftMax Pro GxP Log On dialog displays when you start the software.

¥

[] show password

Contact:

ExitSMP |

To log onto the SoftMax Pro Software - GxP edition:

1. Inthe <User ID> field, enter your user name.
2. Inthe <Password> field, enter your password (case sensitive).
3. Click Next to display the Please Select a Project dialog.

4 SoftMax Pro GxP - Log On x

Please select a project: @

Workflow Project
Role: Lab manager

Validation Project

Role: Lab manager

@it

4. Select aProject and click Log In.
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Logging In From Within the Software

In the Ribbon, on the GxP tab, use the icons to log out of the software and thenlog onto a
different Project or as a different user.

1. Inthe Ribbon, select the GxP tab.

2. Click &4 User Log Off to log off. The SoftMax Pro GxP Log On dialog displays.
3. Follow the steps above to log on.

SpectraMax iD3 and SpectraMax iD5 Considerations

For users that use the SoftMax Pro Software - GxP edition to operate the instrument, the user
must have the following permission to lock and unlock the instrument touchscreen:

e SoftMax Pro Software - GxP edition version 7.1.x users require the Lock/Unlock Instrument
permission.

In the Ribbon, on the GxP tab, users with appropriate permission can use the following icons to
lock and unlock the instrument touchscreen:

e Click @ GxP Mode On to lock the instrument touchscreen and operate the instrument
from the computer running the SoftMax Pro Software in GxP mode. This locks the
instrument touchscreen for all users and you must operate the instrument from a computer
running the SoftMax Pro Software - GxP edition.

e Click ! GxP Mode Off to release the lock from the instrument touchscreen and allow
users to use the instrument touchscreen to run experiments.

% Note: The instrument remains locked until the user with the appropriate permission

clicks Lg GxP Mode Off to stop the GxP mode. You cannot use the Instrument
Connection dialog to disconnect from an instrument that is locked in GxP mode.
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Locking and Unlocking Sections

The SoftMax Pro Software - GxP edition allows users with the Lock/Unlock Sections permission
to lock sections in an experiment to prevent changes. Users who do not have this permission
cannot delete or edit a locked section. You can print locked sections with the document.

Navigation Tree a (@ <

B New Experiment

&New Note [/ New Graph

Delete Selection | | New Cuvette Set

4 ﬂ BasicEndpaoint

3 Intro
4 I expt1

i Platel -
_U Standards -
i Unknowns i
_j Unk_Dilution '
fﬂ Control &
|/ standardCurve

.
Select a section in the Navigation Tree and click “#  above the Navigation Tree to lock the

)
section you select. Click “®  again to unlock the section.
)
Select an experiment in the Navigation Tree and click “# | above the Navigation Tree to lock

all the sections in the experiment.

You cannot overwrite the data in a locked Plate section, but if a Plate section has no data, data
can be acquired and added to the section.
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Use the User Account Information dialog to view information about the user who is logged on.

User Account Information

Name

Log On Time

Scientist

x

)

: Tuesday, October 16, 2018 1:21:35 PM

Primary Admin

Jenny Administrator
867-5309

Permissions:

Add folder

Delete document
Delete empty folder
Hide/Unhide folder
Move document
Move folder

Open Approved
Open Cancelled
Open Imported
Open In Work

Open Outdated
Open Released
Open Reviewed
Open Approval Pending
Rename document
Rename folder

Set Cancelled

Set Review Pending

Inctrsmant cimmelatoe

Close

To view user account information:

1. Inthe Ribbon, select the GxP tab.

L]
2. Click Account Information to display the User Account Information dialog.
The top section displays the user name and the time the userlogged on.
The middle section displays the contact information for the GxP Admin Software

5049092 F

administrator.
The lower section displays the permissions assigned to the user based on the user's
Role in the Project selected uponlog on.
3. Click Close.
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User Lock Session

Use the Session Is Currently Locked dialog to unlock your SoftMax Pro Software - GxP edition
session after the software locks you out due to inactivity. The GxP Admin Software
administrator defines the inactivity before the software lock duration.

The software continues to collect data even when the useris locked out due to inactivity.

B Session Is Currently Lockec X

)

UserID: * Scientist User

Password:

Verify Stop Read Close SMP

If your session is locked due to inactivity, do the following to unlock your session.

1. The SessionIs Currently Locked dialog displays when your session is locked due to

inactivity. You can also select the GxP tab and click 6\ User Lock Session to display the
Session Is Currently Locked dialog.
2. Inthe Password field, enter your password.
3. Click one of the following:
e Click Verify to verify your credentials and unlock the software.
e Click Stop Read to stop a read in progress.
e Click Close SMP to close the SoftMax Pro Software - GxP edition and end the session
(password not required).

Changing Passwords

Use the Change Password dialog to change your password. The GxP Admin Software
administrator can define rules to require password changes and password strength.

ange Passworc *

@

To change your password:
1. Inthe Ribbon, select the GxP tab.

Click -i-f‘ Change Password to display the Change Password dialog.

In the <Password> field, enter your current password.

In the <New Password> field, enter your new password.

In the <Confirm Password> field, enter your new password again to confirm it.
Click OK.

o0 s wN
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Document Workflow

5049092 F

The document life-cycle in a compliant lab consists of multiple different development and
review steps and requires a system to indicate the document state. The status system allows a
Project team to track and approve documents while the document moves through the pipeline
of development, review, release and usage in a controlled environment.
Document Statuses
The SoftMax Pro GxP Software Suite installation includes three default Roles; Scientist, Lab
Technician, and Lab Manager. The default permissions for these Roles correspond to the
document statuses that are present in the SoftMax Pro GxP Software. You can modify the
default Role permissions, if needed. See Default Roles on page 252.

e |nWork

e Review Pending

e Reviewed

® Released

e |nProgress

e Approval Pending

e Approved

e Qutdated

e Canceled
The following document workflow corresponds to the default Roles. Your laboratory can
define Roles and document workflows that meet your needs.

Rewoke signature via =5ave as” Revoke signature via “Save as”

—p  Anainis p At —p sl y - Anali
— s a0 s st — i
Swal Samd Sl St » St d S d”
CANCELED © CANCELED o] CANCELED © S| CAMNCELED o ‘CANCELED o] CANCELED o
i:- Develop -)( Review -:I [: Release } ( Measure ] ( Approve :]
Sclentist Lab Manager Lab Manager Lab Technician Lab Manager
= _ © New st Statement
Document status Permission © Copy / 5
User Wgratiing
docp:r;aenl mﬁﬂ: [:::2 @ e

In Work Document Status - Scientist Role

Scientist open and save new data documents that contain the instrument settings in Plate
sections and define data analysis settings. The software assigns a new document the status In
Work. Scientists add statements to the documents to provide communication to the other
users responsible for the document. Scientists sign the first statement to prevent further edits
and set the document status to Review Pending.
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Review Pending Document Status - Lab Manager Role

Lab managers review the data documents with the status Review Pending, sign the second
statement, and set the document status to Reviewed.

Reviewed Document Status - Release Protocol - Lab Manager Role

If the data document with the status Reviewed is correct, the lab managers then release the
documents as a protocols. The software saves the protocols with the status Released for
reuse.

If a document has a newer iteration or is incorrect, the lab managers can set documents that
have the status Released to the Outdated status.

In Progress Document Status - Lab Technician Role

Lab technicians open protocols with the Released status and the software prompts the lab
technicians to save the protocols as data documents before the lab technicians can run the
experiments. Because the Lab Technician Role has the Generate Compliance Data permission,
the software sets the data document status to In Progress and removes the two signed
statements. This allows lab technicians to run experiments and generate the compliance data.

When lab technicians finish their work, they sign a statement to prevent further changes and
set the document status to Approval Pending.

Approval Pending Document Status - Lab Manager Role

Lab managers confirm that documents with the Approval Pending status meet regulatory
requirements, sign a statement, and set the document status to Approved.

Canceled Document Status

Users with appropriate permissions can set the document status to Canceled at the applicable
points in the document workflow.

Default Roles

Use the GxP Admin Portal Software default Roles to assign users permissions to perform the
tasks that correspond to each document status. You can create your own Roles and you can
edit the default Roles.

Default Role Permissions

Permission Lab Manager Lab Technician Scientist

Add/Delete Groups v

Add Folder v

Add/Modify Statements

Assign Plate Layouts v

Change Auto Export Settings

Change Auto Save Settings

Create/Save As Data Document \/

NENENENENENEN

Create/Save As Protocol
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Default Role Permissions (continued)

Permission

Delete Document
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Lab Manager Lab Technician Scientist

v v

Delete Empty Folder

v’

Edit Formulas

Edit Graphs, Summaries, and Reductions

Edit Notes Text

Edit Print Options

Edit Reader Settings

Edit Sample and Group Information

Export Documents

Function Editor

NENENENENENENENEN

Generate Compliance Data

Hide/Unhide Folder

Import Documents

Instrument Simulator

Lock/Unlock Instrument

Lock/Unlock Sections

Mask/Unmask Wells

Move Document

Move Folder

Open Approval Pending

Open Approved

Open Canceled

NN ANENENEN

Open Imported

N ANENENENENENENENENENEN

Open In Progress

Open In Work

<.

Open Outdated

<.
<.

Open Released

<
<.
<.

Open Review Pending
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Default Role Permissions (continued)

Permission Lab Manager Lab Technician Scientist
Open Reviewed v v
Overwrite Plate/Cuvette Data v
Read Empty Plates/Cuvettes v v
Release Protocol v
Rename Document v v
Rename Folder v v
Revoke Any Signature
Revoke Own Signature v v v
Set Approval Pending v
Set Approved v
Set Canceled v v v
Set Outdated v
Set Review Pending v
Set Reviewed v
Sign Statements v v v
Unlock Document v
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Saving Documents

Use the Save dialog to save a document to the database. The Save dialog displays the folders
and documents that are included in the Project you select when you log on.

' Save Dialog
aidi]

Actions

1

Add Rename Delete Unhide Hide Cut Paste || Rename Delete Unlock

v [ Workflow Project Name User Size Last Access locked  Status S/S Data
Assay Development

» Production

Name: New

Save as type:| Data Documents v

Save Cancel

When you open a new document, the software prompts you to save the document before you
do any additional work.

To save a document:

1. Save vs. Save As
o Click E in the Quick Access toolbar or click £ to open the Applications menu
and select LJ Save to update the currently open document with updated information
in the same location with the same name. The document saves with no further steps
required.
}E';-'-i
e Click in the Quick Access toolbar or click to open the Applications menu
and select N Save As to rename a document, to save a protocol as a data document,
to save a data document as a protocol, to move a document to a different location in
the database, orto give a new document a name. The Save As dialog displays.
2. Navigate to where you want to save the document.
In the Name field, enter the document name.
4. Click the Save As Type drop-down.
e Select Protocol Documents to save the document as a protocol.
e Select Data Documents to save the document as a data document.
5. Click Save.

w
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The left side contains the folder hierarchy similar to the folder hierarchy in any other computer
application. The top level folder is the name of the Project you select when you log on and
you have access only to the documents for that project.

The toolbar contains the following icons:

o &) Add - Click to add a folder subordinate to the folder you select in the hierarchy.

° \—d Rename - Click to rename the folder you select in the hierarchy.

o L Delete - Click to delete the folderyou select in the hierarchy.
e L Unhide - Click to unhide the hidden folder you select in the hierarchy.

o %2 Hide - Click to hide the folder you select in the hierarchy.

e % Cut- Click to copy the folder or document you select to the computer clipboard for the
first step in moving the folder or document to a different location in the database.

e I Paste - Click to paste the folder ordocument from the computer clipboard to the
location you select to move the folder or document in the database.

e _Z Rename - Click to rename the document you select in the document list.
° QJ Delete - Click to delete the document you select in the document list.

o Unlock - Click to unlock a locked document.

The right side displays the documents in the folder you select along with the following
information:

e Name - Displays the document name.

e User - Displays the full name of the user who last touched the document.

e Size - Displays the size of the document.

e Last Access - Displays the date and time the document was most recently accessed.

e Locked - Displays a check mark if the document is open by another user and is therefore

locked to users who do not have the Unlock Files permission.
e Status - Displays the document status.
e S/S Data - Displays the number of statements and the number of signed statements.
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Opening Documents

Use the Open dialog to open a document from the database. The Open dialog displays the
folders and documents that are included in the Project you select when you log on.

: Actions

Open Dialog

1

Add Rename Delete Unhide Hide Cut Paste || Rename Delete Unlock

~ [} Workflow Project

Open type: Data Documents

Assay D

» Producti
RS Name User Size LastAccess  locked  Status §/5 Data

Selected Folder: Workflow Project/ Open

To open an existing document:

1. Click = in the Quick Access toolbar or click ﬂto openthe Application menu and
R

select “« Open to display the Open dialog.
2. Click the Open Type drop-down:
e Select Data Documents to open a data document.
e Select Protocol Documents to open a protocol.
3. Navigate to the document and select it.
4. Click Open.

5049092 F 257



SoftMax Pro Software User Guide

Openlcons

The left side contains the folder hierarchy similar to the folder hierarchy in any other computer
application. The top level folder is the name of the Project you selected when you logged on
and you have access only to the documents for that project.

The dialog toolbar contains the following icons:
o &) Add - Click to add a folder subordinate to the folder you select in the hierarchy.

° \—d Rename - Click to rename the folder you select in the hierarchy.

o L Delete - Click to delete the folderyou select in the hierarchy.
e L Unhide - Click to unhide the hidden folder you select in the hierarchy.

o %2 Hide - Click to hide the folder you select in the hierarchy.

e % Cut- Click to copy the folder or document you select to the computer clipboard for the
first step in moving the folder or document to a different location in the database.

e I Paste - Click to paste the folder ordocument from the computer clipboard to the
location you select to move the folder or document in the database.

e _Z Rename - Click to rename the document you select in the document list.
° QJ Delete - Click to delete the document you select in the document list.

o Unlock - Click to unlock a locked document.

The right side displays the documents in the folder you select along with the following
information:

e Name - Displays the document name.

e User - Displays the full name of the user who last touched the document.

e Size - Displays the size of the document.

e Last Access - Displays the date and time the document was most recently accessed.

e Locked - Displays a check mark if the document is open by another user and is therefore

locked to users who do not have the Unlock Files permission.
e Status - Displays the document status.
e S/S Data - Displays the number of statements and the number of signed statements.
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Document Status

Use the Document Status dialog to change the status of a document to move the document
through the document workflow.

@) Document Status X
Current Document Status: In Work
Set Document Status to: Review pending ~ 1

Click OK button to accept new document status.

The permissions granted to your Role determine what document statuses are available to you.
To change a document status:

1. Select the GxP tab and click ‘= Document Status or click the status indicator above the

— W~

=] inwork | €/ No statements

right side of the Workspace »asass.sssss.s todisplay the Document Status dialog.
2. Click the Set Document Status To drop-down and select a document status.
3. Click OK.

Releasing Protocols

Use the Release a Protocol dialog to take a data document with the Reviewed status and
release the document as a protocol with the Released status.

B Release a Protoco X
Current Document Status: Reviewed @
Browse for protocol name Browse...

Press Browse button to select a folder and name. Then press "Release Protocol” button to
create a released Protocol.

Release Protocol Cancel

To release a protocol:
1. Open a document with the status Reviewed.

2. Selectthe GxP tab and click P ) Release Protocol to display the Release a Protocol
dialog.

Click Browse to display the Save dialog. See Saving Documents on page 255.

Navigate to the folder into which to save the document.

In the Name field, enter the name of the protocol.

Click Save to display the Release a Protocol dialog. The Browse For Protocol Name field
displays the path and protocol name.

7. Click Release Protocol.

o U~ w
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GxP Statements

Use the Statements dialog to manage statements. Use statements to communicate and get
sign off for a document. You use statements in conjunction with the document status to
indicate who created the document, reviewed the document, ran the assay, and approved the
results.

Each document can have multiple statements. Each statement can have one signature so if the
document requires multiple signatures, you need to add the corresponding number of
statements. Each user can sign only one statement. After a statement is signed you cannot edit
the document or add new statements so you should add all the required statements before
you start getting signatures.

The following user permissions pertain to statements:

e Add/Modify Statements - Grants users permission to add or modify statements. See
Adding Statements on page 262.

e Sign Statements - Grants users permission to sign statements. See Signing Statements on
page 263.

e Revoke Any Signature - Grants users permission to revoke any signature from statements.
See Revoking Signatures from Statements on page 264.

e Revoke Own Signature - Grants users permission to revoke only their own signatures from
statements.

|
W~

..-_, Work cl" Mo Statements

\kAAAAAAAAAAA

c\f No Statements
Click above the right side of the Workspace or select the GxP tab and

click Statements to display the Statements dialog.

After you add statements and after you sign statements, the button reflects the changes made
to the statements for the document.

cf 4 Statements (2 Signed)
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‘ Ell statements X |

View / Edit / Add Statements @ |

@R X O® £ 58 4 |

Review Pending - Scientist
The typical workflow for the Scientist is to create a new data document or to open a document with the status In Work, define the
instrument settings, and define analysis formulas. The Scientist adds four signs the first and sets the |
document status to Review Pending.

Statement Not Signed

Reviewed, Released - Lab Manager
The Lab Manager reviews the document, signs the second statement, and sets the document status to Reviewed. The Lab Manager
Releases the data document as a protocol. The software sets the protocol status to Released. The Lab Manager can then set the
status to Outdated, if needed.

Statement Not Signed

Approval Pending - Lab Tech
The Lab Technician opens the Released protocol. The software promts the Lab Technician to save the protocol as a data document,
sets the document status to In Progress and removes the first two statements. The Lab Technician runs the experiments, signs the
first remaining statement, and sets the document status to Approval Pending.

Statement Not Signed

Approved - Lab Manager
The Lab Manager reviews the Lab Technician's work, signs the remaining and sets the d status to Appi

Statement Not Signed

Close

The first time you access the Statements dialog you need to add a statement before the icons
in the dialog toolbar are available.

Use the following icons in the Statements dialog toolbar to manage statements.

o @l Click to display the Add Statement dialog where you add additional statements to
the document.

o 8. Select a statement and click to display the Edit Statement dialog where you edit the
statement. See Editing Statements on page 262.

° x - Click to display the Delete Statements dialog. This deletes all statements in the list.
You cannot delete an individual statement.

° —ﬂ - Select a statement and click to copy the statement to the computer clipboard. You
can then paste the statement into the list of statements for the current document oryou
can paste the statement to another document.

° Ifﬁ - Click to paste the statement from the computer clipboard into the list of statements.
This can be for the original document or for a different document.

-
% -Select a statement and click to display the Sign Statement dialog. After any
statement associated with a document is signed, the document is locked. You cannot add

additional statements or edit the document.

o . Click to display the Revoke Signature dialog where you confirm that you want to
revoke the signature from the statement you select.

° é and =D Click to include or exclude the statement from the printed version of the
document. Statements also print when you print the document audit trail. See Printing on
page 36.

[ -
I and '@ - Click to lock or unlock statements to permit or prevent the ability to edit and
manage the statement. You cannot lock signed statements.

Click Close to close the Statements dialog.
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Adding Statements

Use the Add Statement dialog to add a statement to a document. Each statement can have
one signature so if the document requires multiple signatures, you need to add the
corresponding number of statements. After a statement is signed you cannot edit the
document or add new statements so you should add all the required statements before you
start getting signatures.

&

v

¥ Add Statement

To add a statement:

1. Select the GxP tab and click Statements to display the Statements dialog.
2. Ifthe document has no statements, complete the following two fields and then click Add. If
the document has statements, select the statement above where you want to add the new

statement and then click ® in the Statements dialog toolbar to display the Add
Statement dialog.

3. Inthe New Statement Title field, enter the statement title.

4. Inthe New Statement Description field, enter the statement content.

5. Click Add.

Editing Statements

Use the Edit Statement dialog to edit a statement. After any statement fora document is
signed, you cannot edit the document or the statements associated with the document.

©[ Edit Statement be

?)

Review Pending - Scientist

The typical workflow for the Scientist is to create a new data document or to open a document with the status In Work, define the
instrument settings, and define analysis formulas. The Scientist adds four statements, signs the first statement, and sets the document
status to Review Pending.

Save Cancel

To edit a statement:
Select the GxP tab and click Statements to display the Statements dialog.
Select the statement to edit.

Click 18 in the Statements dialog toolbar to display the Edit Statement dialog.
In the upper field, edit the statement title.

In the lower field, edit the statement content.

Click Save.

o0~ W N
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Signing Statements

Use the Sign Statement dialog to apply an electronic signature to a statement. Each statement
can have one signature. After you sign a statement, the document is locked to prevent further

changes and you cannot add additional statements. Remember to add as many statements as
the document requires before you get any statements signed. You must revoke all signatures

from all statements to unlock the document.

| £ Sign Statement x|
Review Pending - Scientist

The typical workflow for the Scientist is to create a new data document or to open a document with the status In Work, define the
instrument settings, and define analysis formulas. The Scientist adds four statements, signs the first statement, and sets the
document status to Review Pending.

Statement Not Signed

Note (Required):

Scientist creates the document, signs the first statement to lock the document, and then sets the document status to Review Pending to let
|| the Lab Manager know that the document is ready for reiew.

To sign a statement:

Select the GxP tab and click Statements to display the Statements dialog.
Select the statement to sign.

In the Note field, enter a note.
Click Sign to display the User Verification dialog.

i." User Werification

1
2
-
3. Click * inthe Statements dialog toolbar to display the Sign Statement dialog.
4
5

=
)

User Id: Scientist

Password; essssss

I Werify i[ Cancel

6. Inthe Password field, enter your password.
7. Click Verify.
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Revoking Signatures from Statements

Use the Revoke Signature dialog to revoke the signature from the statement you select.

% Revoke Signature X
g

Review Pending - Scientist

The typical workflow for the Scientist is to create a new data document or to open a document with the status In Work, define the
instrument settings, and define analysis formulas. The Scientis adds four statements, signs the first statement, and sets the document
status to Review Pending.

Statement signed by Userl on Wednesday, November 14, 2018 1:45:38 PM

Note (Required):

Revoke Cancel

To revoke the signature from a statement:
1. Select the GxP tab and click Statements to display the Statements dialog.
Select the statement from which to revoke the signature.

2
3. Click b3 in the dialog toolbar to display a confirmation message.
4. Click OK to display the Revoke Signature dialog.

CAUTION! There is no undo for this. After you revoke all signatures, the document is
unlocked and can be changed.

In the Note field, enter the reason for the signature removal.
Click Revoke to display the User Verification dialog.

In the Password field, enter your password.

Click Verify.

0 N’
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The GxP Admin Software and the SoftMax Pro Software - GxP edition generate audit trails that
record the events that user actions trigger. For each event instance, the audit trail records the
date and time, the username of the person who was logged on, and the event action. Users
cannot alter the audit trail, nor can they edit or delete audit trail entries.

GxP Admin Software Events

The GxP Admin Software saves the audit trail to the database and you view the System Audit
Trail in the GxP Admin Portal Software. For a list of events that are saved to the system audit
trail, see the GxP Admin Software User Guide.

SoftMax Pro Software - GxP Edition Events

In addition to the GxP Admin Software System Audit Trail, the SoftMax Pro Software - GxP
edition records document-specific events to an audit trail for the document. You view the
document-specific audit trail in the SoftMax Pro Software - GxP edition.

e For protocols, the SoftMax Pro Software - GxP edition does not retain an audit trail. The
GxP Admin Software System Audit Trail records applicable protocol event information.

e Fordata documents, the SoftMax Pro Software - GxP edition audit trail records events that
pertain to the document that is active in the Workspace and saves the document-specific
events with the data document. Additionally, the document-specific audit trail includes
general activities such as log in and log out when a document is open during those events.

The audit trail for each Plate section in a data document includes the following information:

e The name of the user who logged in when the read began.

e The instrument type used to do the read and the instrument ROM version number. For the
SpectraMax® i3x Multi-Mode Detection Platform and the SpectraMax® Paradigm® Multi-
Mode Microplate Reader, the audit trail also includes the serial number of the detection
cartridge.
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Document Audit Trail

Use the Audit Trail dialog to view the audit trail for the open document. You can add a note to
the audit trail but you cannot edit the content of the audit trail.

;-f;,“—,c.:'; X
|

View Audit Trail for “playground” @ ‘

Wednesday, November 14, 2018 717:11:09 AM  User ID: User1 ‘
User created a new document.
Created from: C:\ProgramData\Molecular Devices\SMP7 1\Protocol Librany\Default.sprx
Created by: SoftMax Pro 7.1 GxP
Product Key: 1129729309426700646 ‘

Wednesday, November 14, 2018 11:11:24 AM  User ID: User1
Document Workflow Summary:
There is no workflow activity.

Wednesday, November 14, 2018 11:11:24 AM  User ID: User1
User saved a document using Save or Save As.
Document saved as: Workflow Project/playground

5 & oo | [ o

For a list of the events that are included in the document audit trail, see the GxP Admin
Software User Guide.

Select the GxP tab and click ﬂ Audit Trail to display the Audit Trail dialog.
Each entry in the audit trail has a time-and-date stamp and identifies the user who performed

the task.

° —ﬂ - Click to copy the content of the entire audit trail to the computer clipboard. You can
then paste the audit trail into a text editor software application.

o = and =9 - Click to include or exclude the audit trail in the printed version of the
document. See Printing on page 36.

e Add Note - Click to display the Add a Note dialog where you add a note to the audit trail.

e Click Close.
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Read Modes

Use the software to define the parameters for the read mode and read type of your assay.

e Absorbance Read Mode, see page 270

e Fluorescence Intensity Read Mode, see page 275 Fluorescence Intensity Dual
Wavelength is available for the SpectraMax Paradigm

e |uminescence Read Mode, see page 280 Luminescence Dual Wavelength is available
for the FilterMax F3, FilterMax F5, SpectraMax i3x, SpectraMax iD5, and SpectraMax L

e Time-Resolved Fluorescence Read Mode, see page 283 Time Resolved Fluorescence
Dual Wavelength is available for the SpectraMax i3x and SpectraMax Paradigm

e FRET Read Mode, see page 287

e HTRF Read Mode, see page 290

e Fluorescence Polarization Read Mode, see page 293

e AlphaScreen Read Mode, see page 296

e Western Blot Read Mode, see page 298

e |maging Read Mode, see page 301

Application notes with specific application protocol suggestions are in the Information Center
and Knowledge Base on the Molecular Devices web site at www.moleculardevices.com.

Read Types

For most read modes, you can use the endpoint, kinetic, well scan, and spectrum read types.
The FlexStation 3 supports the flex read type that allow you to integrate fluid transfer with a
kinetic read. The SpectraMax L supports the fast kinetic read type and the dual read type that
allow the instrument to perform reads with injection.

Dual Read Type

Forthe SpectraMax L dual read type, each well receives two injections and two reads. The first
injection is the P-injection with a subsequent read. The second injection is the M-injection with
a subsequent read. You can set a delay time after each injection, from 0.1 to 3,600 seconds for
the P-injection, and from O to 3,600 seconds for the M-injection.

Endpoint Read Type

For the endpoint read type, a read of each plate well is taken in the center of each well, at a
single wavelength or at multiple wavelengths. Depending on the read mode, the software
reports raw data values as optical density (OD), % Transmittance (%T), relative fluorescence
units (RFU), or relative luminescence units (RLU).

Fast Kinetic Read Type

For the SpectraMax L fast kinetic read type, one or more wells are read repeatedly up to a 200
point maximum integration. All reads of a single well are made before the next well is read. You
cannot pre-read a plate with the fast kinetic read type. Each well can receive multiple
injections and reads. You can specify multiple injections and multiple reads, for multiple times.
You can set the integration time from 0.01to 3600 seconds.
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Flex Read Type

The FlexStation 3 has a fluidics module that aspirates fluids from a compound source plate and
dispenses them into an assay plate. Fluid transfer is made possible with an 8-channel or 16-
channel pipettor that is fully automated, including changing the tips from a tip rack.

In the flex read type, one to eight or one to sixteen wells in one column of the assay plate are
read repeatedly for the total experimental time. At a certain point or points, the pipettor
transfers up to three reagents from the compound plate to the assay plate. The instrument
continues to read at the time intervals before and after each fluid transfer. After completion of
a column read, the instrument repeats this cycle with other columns. All data the software
collects in one document is represented as a 96-well or 384-well plate.

For example, an experiment with a two-minute run time accommodates a 96-well plate in
about 24 minutes.

Runtime x Number of columns = Plate time

2 minutes x 12 columns = 24 minutes

Kinetic Read Type

For the kinetic read type, the instrument collects data over time with reads taken in the center
of each well at regular intervals. To get the shortest possible interval for multiple-wavelength
kinetic reads, choose wavelengths in ascending order.

The values calculated based on raw kinetic data include VMax, VMax per Sec, Time to VMax,
Onset Time, and more. Kinetic reads can be single-wavelength or multiple-wavelength reads.

Kinetic analysis can collect data points in time intervals of seconds, minutes, hours, or days.

Kinetic analysis has many advantages when determining the relative activity of an enzyme in
different types of plate assays, including ELISAs and the purification and characterization of
enzymes and enzyme conjugates. Kinetic analysis can provide improved dynamic range,
precision, and sensitivity relative to endpoint analysis.

Peak Pro™ Analysis functions provide advanced peak detection and characterization for
applicable kinetic reads. See the SoftMax Pro Data Acquisition and Analysis Software Formula
Reference Guide.

Membrane Read Type

The SpectraMax i3x, SpectraMax iD5, and SpectraMax Paradigm use the membrane read type
for Time-Resolved Fluorescence reads of a Western Blot membrane. The software reads the
area you select and generates a TIFF image with the results of the read.
The Molecular Devices ScanLater™ Western Blot Assay Kit is a novel system for protein
analysis. Membranes are incubated with Eu-chelate labeled secondary antibodies or
streptavidin that bind specifically to the target protein-specific primary antibody. For more
information, contact your Molecular Devices representative or search the knowledge base for
ScanLater or Western Blot at support.moleculardevices.com.
If you use the SoftMax Pro Software - GxP edition, you must have the following permissions to
complete a Western Blot membrane read:

e Read Empty Plates/Cuvettes to start a read.

e Create/Save Data Documents to save the data document before the read.

e Overwrite Plate/Cuvette Data to do a high-resolution ROI read.

See SoftMax Pro Software - GxP Edition on page 243.
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Spectrum Read Type

Depending on the read mode you select, the spectrum read type measures optical density
(OD), % Transmittance (%T), relative fluorescence units (RFU), or relative luminescence units
(RLU) across a spectrum of wavelengths.

Well Scan Read Type

The well scan read type takes reads at more than one location within a well. The well scan
read type takes multiple reads of a single well of a plate on an evenly spaced pattern inside of
each well at single or multiple wavelengths.

For applications that involve the detection of cells in large area tissue culture plates, the well
scan read type permits maximum surface area detection in cell-based protocols. Since many
cell lines tend to grow as clumps or in the corners of plate wells, you can choose the well scan
pattern and define the number of points to scan in order achieve the best results.

Depending on the read mode selected, the values are reported as optical density (OD),
%Transmittance (%T), relative fluorescence units (RFU), or relative luminescence units (RLU).
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The instrument uses the Absorbance (ABS) read mode to measure the Optical Density (OD) of
the sample solutions.

Absorbance is the quantity of light absorbed by a solution. To measure absorbance accurately,
it is necessary to eliminate light scatter. If there is no turbidity, then absorbance = optical
density.

A =logyo(lo /1) = =logqo(l/lp)
where [, is intensity of the incident light before it enters the sample divided by the light after it
passes through the sample, and A is the measured absorbance.

The instrument allows you to choose whether to display absorbance data as Optical Density
(OD) or % Transmittance (%T).

Optical Density

Optical density (OD) is the quantity of light passing through a sample to a detector relative to
the total quantity of light available. Optical Density includes absorbance of the sample plus
light scatter from turbidity and background. You can compensate for background using blanks.

A blank well contains everything used with the sample wells except the chromophore and
sample-specific compounds. Do not use an empty well for a blank.

Some applications are designed for turbid samples, such as algae or other micro-organisms in
suspension. The reported OD values for turbid samples are likely to be different when read by
different instruments.

For optimal results, you should run replicates for all blanks, controls, and samples. In this case,
the blank value that will be subtracted is the average value of all blanks.

% Transmittance
%Transmittance is the ratio of transmitted light to the incident light for absorbance reads.

T=1/
%T =100T

where /is the intensity of light after it passes through the sample and /, is incident light before it
enters the sample.

Optical Density and %Transmittance are related by the following formulas:
%T =10%°P

OD =2 —10g(%T)

The factor of two comes from the fact that %T is expressed as a percent of the transmitted light
and log;p(100) = 2.

When in % Transmittance analysis mode, the instrument converts the raw OD values reported
by the instrument to %Transmittance using the above formula. All subsequent calculations are
done onthe converted numbers.

Applications of Absorbance

Absorbance-based detection is commonly used to evaluate changes in color or turbidity,
permitting widespread use including ELISAs, protein quantitation, endotoxin assays, and
cytotoxicity assays. With absorbance readers that are capable of measuring in the ultraviolet
(UV) range, the concentration of nucleic acids (DNA and RNA) can be found using their molar
extinction coefficients.
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For micro-volume measurements, you can use SpectraDrop 24-well Low Volume Microplate
and SpectraDrop 64-well Low Volume Microplate.

For information about how to set up absorbance mode protocols, see Creating Absorbance
Mode Protocols on page 157.

Absorbance Instruments
The following instruments have absorbance read mode capability:

e EMax Endpoint Microplate Reader, see page 306

e EMax Plus Microplate Reader, see page 307

e FilterMax F3 Multi-Mode Microplate Reader, see page 308

e FilterMax F5 Multi-Mode Microplate Reader, see page 311

e FlexStation 3 Multi-Mode Microplate Reader, see page 312

e SpectraMax 190 Microplate Spectrophotometer, see page 314

e SpectraMax 340PC384 Microplate Spectrophotometer, see page 314

e SpectraMax ABS Microplate Spectrophotometer, see page 315

e SpectraMax ABS Plus Microplate Spectrophotometer on page 315

e SpectraMax i3 Multi-Mode Platform, see page 316

e SpectraMax i3x Multi-Mode Detection Platform, see page 318

e SpectraMaxiD3 Multi-Mode Microplate Reader, see page 320

e SpectraMaxiD5 Multi-Mode Microplate Reader, see page 323

e SpectraMax M2 Multi-Mode Microplate Reader, see page 328

e SpectraMax M2e Multi-Mode Microplate Reader, see page 328

e SpectraMax M3 Multi-Mode Microplate Reader, see page 329

e SpectraMax M4 Multi-Mode Microplate Reader, see page 329

e SpectraMax M5 Multi-Mode Microplate Reader, see page 330

e SpectraMax M5e Multi-Mode Microplate Reader, see page 330

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 331 Requires the
Absorbance Detection Cartridge, see page 343.

e SpectraMax Plus 384 Microplate Spectrophotometer, see page 334

e VersaMax Microplate Spectrophotometer, see page 334

e V/Max Kinetic Microplate Reader, see page 335
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PathCheck Technology

To use PathCheck technology, select the PathCheck check box in the PathCheck Settings
category in the Settings dialog for absorbance endpoint reads.

The temperature-independent PathCheck technology normalizes absorbance valuesto alcm
path length based on the near-infrared absorbance of water.

The Beer—Lambert law states that absorbance is proportional to the distance that light travels
through the sample:

Microplate readers use a vertical light path so the distance of the light through the sample
depends on the volume. This variable pathlength makes it difficult to do extinction-based
assays and makes it confusing to compare results between microplate readers and
spectrophotometers.

The standard pathlength of a 1 cm cuvette is the conventional basis to quantify the unique
absorptivity properties of compounds in solution. Quantitative analysis can be done on the
basis of extinction coefficients, without standard curves (for example, NADH-based enzyme
assays). When you use a cuvette, the pathlength is known and is independent of sample
volume, so absorbance is directly proportional to concentration when there is no background
interference.

In a plate, pathlength is dependent on the liquid volume, so absorbance is proportional to both
the concentration and the pathlength of the sample. Standard curves are often used to
determine analyte concentrations in vertical-beam photometry of unknowns, yet errors can still
occur from pipetting the samples and standards. The PathCheck technology determines the
pathlength of aqueous samples in the plate and normalizes the absorbance in each well to a
pathlength of 1 cm. This way of correcting the microwell absorbance values is accurate to
within £4% of the values obtained directly ina 1 cm cuvette.

\_/
Vertical light path

Horizontal .
light path

N

Cuvette Microplate wells

PathCheck technology normalizes the data acquired from an absorbance read mode endpoint
read type to a1 cm pathlength, correcting the OD for each well to the value expected if the
sample were read in a1 cm cuvette. The instrument uses the factory installed water constant to
obtain the 1 cm values.

For the SpectraMax ABS Plus, SpectraMax M2, SpectraMax M2e, SpectraMax M3, SpectraMax
M4, SpectraMax M5, SpectraMax M5e, and SpectraMax Plus 384 you can read a cuvette that
contains deionized water or buffer to use the cuvette reference correction method (typically
not necessary when you use aqueous solutions with minimal alcohol, salt, or organic solvent
content).
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% Note: You must select the PathCheck check box before a read because you cannot
apply the PathCheck technology after the read. After you read a plate with PathCheck
technology turned on, the software stores PathCheck information permanently within
the document.

Water Constant

The PathCheck technology is based on the absorbance of water in the near infrared spectral
region (between 900 nm and 1000 nm). If the sample is completely aqueous, has no turbidity
and has a low salt concentration (less than 0.5 M), the water constant correction method is
sufficient. The water constant is determined for each instrument during manufacture and is
stored in the instrument.

Cuvette Reference

The cuvette reference correction method is supported by the SpectraMax ABS Plus,
SpectraMax M2, SpectraMax M2e, SpectraMax M3, SpectraMax M4, SpectraMax M5,
SpectraMax M5e, and SpectraMax Plus 384. This method is not applicable if the solvent
contains a substance that absorbs in the 900 nm to 1000 nm range. See Interfering Substances
on page 274.

The cuvette reference that the software uses with the PathCheck technology is different from
the reference read of a cuvette that occurs when you click the Ref button in the Cuvette Set
section tool bar. The software uses the cuvette reference data for PathCheck calculations
does not produce data that displays in a Cuvette Set section. The software uses the cuvette
reference data for the PathCheck calculations in plates, not cuvettes. However, you can use
the accessors in the Formula Editor dialog to obtain these values. See the IPathCheckLm1000
and !PathCheckLm900 accessor in the SoftMax Pro Data Acquisition and Analysis Software
Formula Reference Guide.

Eliminating the Pathlength Independent Component

Raw OD measurements of plate samples include both pathlength-dependent components
(sample and solvent) and a pathlength-independent component (OD of plate material). The
pathlength-independent component must be eliminated from the calculation to get valid
results that have been normalized by the PathCheck technology. You can do this using a plate
blank or using a plate background constant.

Using a Plate Blank

You can use this method if all samples in the plate are the same volume and the read does not
depend on the PathCheck technology to correct for variability in volumes.

To use a plate blank:

1. Designate a minimum of one well (preferably several) as Plate Blank.

2. Pipette buffer (for example, your sample matrix) into those wells and read along with the
samples. Do not use an empty well for a blank.
The instrument automatically subtracts the average of the blank wells from each of the
samples. The OD of the plate material is subtracted as part of the blank.

3. Select the Use Plate Blank check boxin the Data Reduction dialog.
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Using a Plate Background OD

If your sample volumes are not identical or if you choose not to use a Plate Blank, thenyou
must use a Plate Background OD. Omitting a Plate Background OD results in artificially high
values after being normalized by the PathCheck technology.

To determine the Plate Background OD:

1. Fill a clean plate with water.

2. Read at the wavelengths you will use for the samples.
The average OD value is the Plate Background OD. If you intend to read your samples at more
than one wavelength, there should be a corresponding number of Plate Background OD
values for each wavelength.

% Note: It is important that you put water in the wells and do not read a dry plate for the
Plate Background OD. A dry plate has a slightly higher OD value than a water filled plate
because of differences in refractive indices. Use of a dry plate results in PathCheck
technology normalized values that are lower than 1 cm cuvette values.

Interfering Substances

Material that absorbs in the 900 nm to 1000 nm spectral region could interfere with PathCheck
technology measurements. Fortunately, there are few materials that do interfere at the
concentrations generally used.

Turbidity is the most common interference. If you can detect turbidity in your sample, you
should not use the PathCheck technology. Turbidity elevates the 900 nm measurement more
than the 1000 nm measurement and causes an erroneously low estimate of pathlength. Use of
the Cuvette Reference does not reliably correct for turbidity.

Samples that are highly colored in the upper-visible spectrum might have absorbance that
extends into the near-infrared (NIR) spectrum and can interfere with the PathCheck technology.
Examplesinclude Lowry assays, molybdate-based assays, and samples that contain
hemoglobins or porphyrins. In general, if the sample is distinctly red or purple, you should
check forinterference before you use the PathCheck technology.

To determine possible colorinterference:

e Measure the OD at 900 nm and 1000 nm (both measured with air reference).
e Subtract the 900 nm value from the 1000 nm value.

Do the same for pure water.

If the delta OD for the sample differs significantly from the delta OD for water, then you should
not use the PathCheck technology.

Organic solvents could interfere with the PathCheck technology if the solvents have
absorbance in the region of the NIR water peak. Solvents such as ethanol and methanol do not
absorb in the NIR region, so the solvents do not interfere, except to cause a decrease in the
water absorbance to the extent of their presence in the solution. If the solvent absorbs
between 900 nm and 1000 nm, the interference would be similar to the interference of highly
colored samples. If you add an organic solvent other than ethanol or methanol, you should run
a Spectrum scan between 900 nm and 1000 nm to determine if the solvent would interfere
with the PathCheck technology.
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Fluorescence Intensity Read Mode

5049092 F

Fluorescence occurs when absorbed light is re-radiated at a longer wavelength. In the
Fluorescence Intensity (FL) read mode, the instrument measures the intensity of the re-radiated
light and expresses the result in Relative Fluorescence Units (RFU).

The governing equation for fluorescence is:

Fluorescence = extinction coefficient x concentration x quantum yield x excitation intensity
x pathlength x emission collection efficiency

Fluorescent materials absorb light energy of a characteristic wavelength (excitation), undergo
an electronic state change, and instantaneously emit light of a longer wavelength (emission).
Most common fluorescent materials have well-characterized excitation and emission spectra.
The following figure shows an example of excitation and emission spectra for a fluorophore.
The excitation and emission bands are each fairly broad with half-bandwidths of approximately
40 nm, and the difference between the wavelengths of the excitation and emission maxima
(the Stokes shift) is generally fairly small, about 30 nm. There is considerable overlap between
the excitation and emission spectra (gray area) when a small Stokes shift is present.
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Excitation and Emission Spectra

Because the intensity of the excitation light is usually many tens of thousands of times greater
than that of the emitted light, you must have sufficient spectral separation to reduce the
interference of the excitation light with detection of the emitted light.

* Tip: If the Stokes shift is small, you should choose an excitation wavelength that is as far
away from the emission maximum as possible while still able to stimulate the
fluorophore so that less of the excited light overlaps the emission spectrum, which
permits better selection and quantitation of the emitted light.
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The Spectral Optimization wizard provides the best method to maximize the signal to
background window (S-B)/B while minimizing the optimization time. The Spectral Optimization
wizard is available for the SpectraMax i3x, SpectraMax iD3, SpectraMax iD5, and the
SpectraMax Paradigm with a Tunable Wavelength (TUNE) detection cartridge installed. See
Spectral Optimization on page 179.
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Optimized Excitation and Emission Read Wavelengths

The previous figure shows that the best results are often obtained when the excitation and
emission wavelengths you use for the read are not the same as the peak wavelengths of the
excitation and emission spectra of the fluorophore. When the read wavelengths for excitation
and emission are separated, a smaller quantity of excitation light passes through to the
emission monochromator (gray area) and on to the PMT, which results in a purer emission
signal and more accurate data.

The instrument allows you to scan both excitation and emission wavelengths, using separate
tunable dual monochromators. One benefit of scanning emission spectra is that you can
determine more accurately whether the emission is, in fact, the expected fluorophore, or
multiple fluorophores, and not one generated by a variety of background sources or by
contaminants. One more benefit is that you can find excitation and emission wavelengths that
prevent interference when interfering fluorescent species are present.

For this reason, it is desirable to scan emission for both an intermediate concentration of
labeled sample, as well as the background of unlabeled sample. The optimal setting is where
the ratio of the sample emission to background emission is at the maximum.

Fluorescence intensity data is dependent on several variables.
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Applications of Fluorescence Intensity

Fluorescence intensity is used widely in applications such as fluorescent ELISAs, protein
assays, nucleic acid quantitation, reporter gene assays, cell viability, cell proliferation, and
cytotoxicity. One more major application is to study the kinetics of ion release.

Some assays use a fluorescent label to selectively attach to certain compounds. The quantity
or concentration of the compound can then be quantified by measuring the fluorescence
intensity of the label, which is attached to the compound. Such methods are often used to
quantify low concentrations of DNA or RNA, for example.

For information about how to set up fluorescence intensity mode protocols, see Creating
Fluorescence Intensity Mode Protocols on page 158.

Fluorescence Intensity Instruments
The following instruments have fluorescence intensity read mode capability:

e FilterMax F3 Multi-Mode Microplate Reader, see page 308

e FilterMax F5 Multi-Mode Microplate Reader, see page 311

e FlexStation 3 Multi-Mode Microplate Reader, see page 312

e Gemini EM Dual Scanning Microplate Spectrofluorometer, see page 313

e Gemini XPS Dual Scanning Microplate Spectrofluorometer, see page 313

e SpectraMax i3x Multi-Mode Detection Platform, see page 318 Supports Fluorescence
Intensity Detection Cartridges, see page 344

e SpectraMaxiD3 Multi-Mode Microplate Reader, see page 320

e SpectraMaxiD5 Multi-Mode Microplate Reader, see page 323

e SpectraMax M2 Multi-Mode Microplate Reader, see page 328

e SpectraMax M2e Multi-Mode Microplate Reader, see page 328

e SpectraMax M3 Multi-Mode Microplate Reader, see page 329

e SpectraMax M4 Multi-Mode Microplate Reader, see page 329

e SpectraMax M5 Multi-Mode Microplate Reader, see page 330

e SpectraMax M5e Multi-Mode Microplate Reader, see page 330

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 331 Requires
Fluorescence Intensity Detection Cartridges, see page 344
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Fluorescence Intensity Reads with Injectors

Injectors deliver a specified volume of a reagent to the wells of a plate. You generally use
injectors when delivery of the reagent initiates a reaction that occurs rapidly and results in a
luminescent or fluorescent signal that you must quickly detect.

Common inject-and-read assays include calcium flux assays.

When you install the SpectraMax Injector cartridge in the SpectraMax i3x, you can create a
protocol to inject and read well by well to reduce signal loss.

Background Correction and Quantification

A blank well contains everything used with the sample wells except the label and sample-
specific compounds. Do not use an empty well for a blank.

The blank sample reveals the offset underlying each data sample. This offset does not carry
information on the label and is generally subtracted before data reduction is done.

Within the linear detection range, the blank-subtracted raw data are proportional to the
quantity of label in a sample such that the label concentration is quantified by the following
equation.

(sample-blank)
label (sEEIanE)

CONCgd

conc

where concgyis the concentration of the standard, and sample, blank, and std are average
values of replicates for the sample, blank, and standard wells. In the general case where the
standard curve covers a concentration range of more than a few linear logs, (std — blank)/
concgyis equivalent to the slope of the standard curve, and so the concentration of the label is
determined by (sample — blank)/ (slope of standard curve).

For optimal results, you should run replicates for all blanks, controls, and samples. In this case,
the blank value that will be subtracted is the average value of all blanks.

Detection Limit

The detection limit is the smallest sample concentration that can be detected reliably above
the blank. Determining the detection limit requires taking a number of blank measurements
and calculating an average value and standard deviation for the blanks. The detection
threshold is defined as the average blank plus three standard deviations. If the average
sample value measures above the threshold, the sample can be detected at a statistically
significant level.

The detection limit can be described by the following equation:

3 StDevb]ank

Det Limit=
sta-blan.
( concgtq )

where concgy,is the concentration of the standard, StDevg,,, is the standard deviation of the
blank replicates, and blank and std are average values of the replicates for the blank and
standard wells.

Determining detection limits for assays requires multiple blanks to calculate their standard
deviation.
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Linearity and the Linear Dynamic Range

Within a wide range at moderately high concentrations, blanked raw data is proportional to the
quantity of label in a sample.

The linear dynamic range (LDR) is defined by:

max conc lin
LDR = log,,

detection limit

where LDRis expressed as a log, and max conc linis the highest concentration in the linear
range that can be quantified.

When the standard curve after blank reduction is not linear in concentration at the lower end,
there might be anincorrect or contaminated blank.

When the standard curve levels are off at the highest concentrations, this can be addressed to
the inner filter effect: excitation does not reach as deep into the sample for lower
concentrations, without being more significantly attenuated (absorbance) layer by layer.
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Luminescence is the emission of light by processes that derive energy from essentially non-
thermal changes, the motion of subatomic particles, or the excitation of an atomic system by
radiation. Luminescence detection relies on the production of light from a chemical reactionin
a sample.

In luminescence (LUM) read mode, no excitation is necessary as the measured species emit
light naturally. For this reason, the lamp does not flash, so no background excitation
interference occurs.

For the luminescence read mode, the instrument provides measurements in Relative Light
Units (RLUs).

To help eliminate background luminescence from a plate that has been exposed to light, you
should dark adapt the plate by placing the sample-loaded plate inside the instrument for
several minutes before you start the read.

For some monochromator-based instruments, the default setting for luminescence is the “zero
order” position where the grating monochromator acts as a mirror that reflects all light to the
PMT detector.

The instrument bypasses the emission monochromator for luminescence reads that detect all
wavelengths.

You can choose the wavelength where peak emission is expected to occur. Also, multiple
wavelength choices let species with multiple components be differentiated and measured
easily.

Concentrations or qualitative results are derived from raw data with a standard curve or by
comparison with reference controls.

Applications of Luminescence

Chemiluminescent or bioluminescent reactions can be induced to measure the quantity of a
particular compound in a sample. Examples of luminescent assays include the following:
e Reporter gene assays (the measurement of luciferase gene expression)
e Quantitation of adenosine triphosphate (ATP) as an indication of cell counts with cell-
proliferation, cytotoxicity, and biomass assays
® Enzyme measurements with luminescent substrates, such as immunoassays

For information about how to set up luminescence mode protocols, see Creating
Luminescence Mode Protocols on page 165.

Luminescence Instruments
The following instruments have luminescence read mode capability:

e FilterMax F3 Multi-Mode Microplate Reader, see page 308

e FilterMax F5 Multi-Mode Microplate Reader, see page 311

e FlexStation 3 Multi-Mode Microplate Reader, see page 312

e Gemini EM Dual Scanning Microplate Spectrofluorometer, see page 313

e Gemini XPS Dual Scanning Microplate Spectrofluorometer, see page 313

e SpectraMax i3x Multi-Mode Detection Platform, see page 318 Supports Luminescence
Detection Cartridges, see page 347

e SpectraMax iD3 Multi-Mode Microplate Reader, see page 320

e SpectraMaxiD5 Multi-Mode Microplate Reader, see page 323

e SpectraMax L Luminescence Microplate Reader, see page 325
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e SpectraMax M2 Multi-Mode Microplate Reader, see page 328

e SpectraMax M2e Multi-Mode Microplate Reader, see page 328

e SpectraMax M3 Multi-Mode Microplate Reader, see page 329

e SpectraMax M4 Multi-Mode Microplate Reader, see page 329

e SpectraMax M5 Multi-Mode Microplate Reader, see page 330

e SpectraMax M5e Multi-Mode Microplate Reader, see page 330

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 331 Requires

Luminescence Detection Cartridges, see page 347

Luminescence Reads with Injectors

Injectors deliver a specified volume of a reagent to the wells of a plate. You generally use
injectors when delivery of the reagent initiates a reaction that occurs rapidly and results in a
luminescent or fluorescent signal that you must quickly detect.

Common inject-and-read assays include calcium flux assays.

When you install the SpectraMax Injector cartridge in the SpectraMax i3x, you can create a
protocol to inject and read well by well to reduce signal loss.

Common inject-and-read assays include luciferase reporter assays.

The SpectraMax Injector cartridge is DLReady™ certified by Promega for
the Dual-Luciferase Reporter (DLR™) assay system. [ [ ) |
|

DLReady, DLR, and the DLReady logo are trademarks of Promega Corporation. E v

Analyzing Luminescence Data

The conversion rate of photons to counts is individual for each reader. Therefore, raw data
from the same plate can seem significantly different from one instrument to the next. Also, the
data format used by other manufacturers might not be counts per second and can be different
by several orders of magnitude. It is important to know that the number of counts and the size
of figures is not a benchmark of sensitivity.

Concentrations or qualitative results are derived from raw data with a standard curve or by
comparison with reference controls. The raw data can then be expressed in equivalent
concentration of a reference label. The raw data is normalized to counts per second by
dividing the number of counts by the read time per well.

Background Correction

The light detected in a luminescent measurement generally has two components: specific
light from the luminescent reaction and an approximately constant level of background light
caused by various factors, including the plate material and impurities in the reagents. The
background can be effectively measured using blank replicates. Blanks should include the
luminescent substrate (chemical energy source) but not the luminescence agent (generally an
enzymatic group which makes the substrate glow).

A blank well contains everything used with the sample wells except the label and sample-
specific compounds. Do not use an empty well for a blank.

The blank sample reveals the offset underlying each data sample. This offset does not carry
information on the label and is generally subtracted before data reduction is done.

For optimal results, you should run replicates for all blanks, controls, and samples. In this case,
the blank value that will be subtracted is the average value of all blanks.
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To help eliminate background luminescence from a plate that has been exposed to light, you
should dark adapt the plate by placing the sample-loaded plate inside the instrument for
several minutes before you start the read.

Sample Volumes and Concentration of Reactants

The concentration of the luminescent agent impacts the quantity of light outputin a
luminescent reaction. Light is emitted as a result of a reaction between two or more
compounds. Therefore, the quantity of light output is proportional to the quantity of the limiting
reagent in the sample.

For example, in an ATP/Iuciferin-luciferase system, when total volume is held constant and ATP
is the limiting reagent, the blanked light output is proportional to the concentration of ATP in
the sample. Even if the reaction begins with a high concentration of ATP, as it gets used up it
can become rate-limiting. In this case, the non-linearity is an effect of the assay and not caused
by the microplate reader.

% Note: Very bright samples can exceed the linear dynamic range of the instrument. If so,
the read can be done with an attenuation filter.

Data Optimization

Measurement noise is dependent on the read time per sample (time per plate ortime per
well). The detection limit improves when you increase the read time. It is important to enter the
read time when you compare measurements.

All low-light-level detection devices have some measurement noise in common. To average
out the measurement noise, optimization of the time per well involves accumulating as many
counts as possible. Within some range, you can reduce noise (CVs, detection limit) by
increasing the read time perwell, as far as is acceptable from throughput and sample stability
considerations.

Z is the standard statistical parameter in the high-throughput screening community to measure
the quality of a screening assay independent of test compounds. Use this as a measure of the
signal separation between the positive controls and the negative controls in an assay.

Use the following formula to determine the value of Z":
3(SD,, ) +3(sD_)

- | Mean_ —Mean |
c+ [

where SD is the standard deviation, ¢+ is the positive control, and ¢c— is the negative control.

A Z  value greater than or equal to 0.4 is the generally acceptable minimum for an assay. You
can use higher values when results are more critical.

Z is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z" value, increase the quantity of label in the
sample, if acceptable for the assay, or increase the read time per well.
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Time-Resolved Fluorescence Read Mode

Time-Resolved Fluorescence is a measurement technique that depends on three
characteristics that lead to better discrimination between the specific signal, proportional to
the quantity of label, and the unspecific fluorescence resulting from background and
compound interference:

e Pulsed excitation light sources
e Time-gated electronics faster than the fluorescence lifetime
e Labels with prolonged fluorescence lifetime

The time-gating electronics introduce a delay between the cutoff of each light pulse and the
start of signal collection. During the delay, the unspecific fluorescence (caused by test
compounds, assay reagents, and the plate) vanishes, while only a small portion of the specific
fluorescence from the label is sacrificed. Enough of the specific signal remains during the
decay period, with the added benefit of reduced background.

In Time-Resolved Fluorescence read mode, the instrument detects the extremely long
emission half-lives of rare earth elements called lanthanides, such as europium (lifetime of
about 700 ps), samarium (lifetime of about 70 ps), or terbium (lifetime of about 1000 ps).

Applications of Time-Resolved Fluorescence

Time-Resolved Fluorescence is widely used in high throughput screening applications such as
kinase assays, and is useful in some fluorescence immunoassays, such as DELFIA (dissociation-
enhanced enzyme linked fluorescence immunoassay). TRF is also useful in some assay
variants of TR-FRET (Time-Resolved Fluorescence Resonance Energy Transfer) in which the
FRET acceptorlabel acts as a quencher only and does not emit fluorescence. The proximity
between donor label and acceptor (quencher) is then quantified by the intensity decrease of
the donor label.

DELFIA requires washing steps as in an ELISA, but the TR-FRET assay involving quenching is a
homogeneous plate assay technique and requires only mixing and measuring—no wash steps
are required. It can also be miniaturized, which makes it useful for high-throughput screening
applications.

The Cisbio Bioassays HTRF® (Homogeneous Time-Resolved Fluorescence) technology is a
proprietary Time-Resolved Fluorescence technology that overcomes many of the drawbacks
of standard Fluorescence Resonance Energy Transfer (FRET) techniques, such as the
requirements to correct for autofluorescence and the fluorescent contributions of unbound
fluorophores. See HTRF Read Mode on page 290.

For information about how to set up Time-Resolved Fluorescence mode protocols, see
Creating Time-Resolved Fluorescence Mode Protocols on page 167.
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Time-Resolved Fluorescence Instruments
The following instruments have time-resolved fluorescence read mode capability:

e FilterMax F5 Multi-Mode Microplate Reader, see page 311

e FlexStation 3 Multi-Mode Microplate Reader, see page 312

e Gemini EM Dual Scanning Microplate Spectrofluorometer, see page 313

e Gemini XPS Dual Scanning Microplate Spectrofluorometer, see page 313

e SpectraMax i3x Multi-Mode Detection Platform, see page 318 Requires Time Resolved
Fluorescence Detection Cartridges, see page 350.

e SpectraMaxiD5 Multi-Mode Microplate Reader, see page 323 Supports the Enhanced TRF
module.

e SpectraMax M2 Multi-Mode Microplate Reader, see page 328

e SpectraMax M2e Multi-Mode Microplate Reader, see page 328

e SpectraMax M4 Multi-Mode Microplate Reader, see page 329

e SpectraMax M5 Multi-Mode Microplate Reader, see page 330

e SpectraMax M5e Multi-Mode Microplate Reader, see page 330

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 331 Requires Time
Resolved Fluorescence Detection Cartridges, see page 350.

Analyzing Time-Resolved Fluorescence Data

A time-resolved fluorescence (TRF) measurement includes a number of pulses. Each pulse
consists of turning the light source on, then off (Excitation Time), pausing for a specified length
of time (Measurement Delay), and measuring the fluorescence intensity of the sample fora
specified length of time (Integration Time). The pulses are repeated several times, as specified
in the protocol parameters.

Blank Correction

Although background is significantly lower than with fluorescence intensity measurements, you
should use blanks or assay controls. A blank well contains everything used with the sample
wells except the label and sample-specific compounds. Do not use an empty well for a blank.

The blank sample reveals the offset underlying each data sample. This offset does not carry
information on the label and is generally subtracted before data reduction is done. For optimal
results, you should run replicates for all blanks, controls, and samples. In this case, the blank
value that will be subtracted is the average value of all blanks.

Data Normalization

TRF raw data changes in magnitude when the timing parameters are changed. However, TRF
data are normalized for a number of 1000 pulses. This means that the sample raw data does
not change when only the number of pulses is changed.

Data Optimization

There are two timing parameters you can optimize to adjust the performance of the
measurement: time per well and integration time per cycle.

Measurement noise is dependent on the read time per sample (time per plate ortime per
well). The detection limit improves when you increase the read time. It is important to enter the
read time when you compare measurements. For TRF, the read time per well increases with
the selected number of pulses. The time between pulses and the intensity of each pulse can
be different on various systems.
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All low-light-level detection devices have some measurement noise in common. To average
out the measurement noise, optimization of the time per well involves accumulating as many
counts as possible. Within some range, you can reduce noise (CVs, detection limit) by
increasing the read time per well, as far as is acceptable from throughput and sample stability
considerations.

To further optimize measurement results, optimize the timing parameters. Use the following
table and figure as guidelines for the timing parameters.

Time-Resolved Fluorescence Timing Parameters Example
Parameter Value Comment

Pulse length 0.100 ms Period for excitation of sample, t; in the following figure.
Suggested value for TUNE, MULTI, and TRF detection cartridges.

Measurement 0.010 ms Delay to ensure excitation pulse is no longer detectable, t, in the
delay following figure.
Suggested value for TUNE, MULTI and TRF detection cartridges.

Integration time 0.890 ms [ Period to accumulate signal, t3 in the following figure.

per cycle (pulse) Suggested value for TUNE and MULTI detection cartridges.
Integration time 1.890 ms Period to accumulate signal, t3 in the following figure.
per cycle (pulse) Suggested value for TRF detection cartridge.
Total cycle time Total cycle time is t4 in the following figure.
t 4
— | t
ty 2

Timing Parameters For Time-Resolved Fluorescence

When you neglect the time delay t, compared to the integration time window t3, you can
approximate the accumulated signal A with the following equation:

A/ Amax =(1-exp(-M)) x100%

In this equation, M is the size of the time window (or integration time) divided by the
exponential decay time constant (or the fluorescence lifetime of the label).

M = (integration time) / (fluorescence lifetime)
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For example, using Europium, which has a fluorescence lifetime of 700 ps, and the suggested
integration time per cycle of 1.890 ms (or 1890 ps), M =1890 /700 = 2.7. Insert this value of M
into the first equation to yield A/ A, = 93%.

To optimize the integration time per cycle (pulse), you should set the integration time such that
the value of M produces the desired signal. For example, to get more than 86% signal, select
an integration time such that M is greater than 2.0. Using the previous Europium example and
solving for the integration time, you can set the integration time to M (2.0) times the
fluorescence lifetime (700 ps), or 1400 ps (1.4 ms).

Achievable Accumulated Signal Percentage Compared to M

M 0.25 0.50 0.75 1.00 1.25 1.50 2.00 3.00

A/ Anal%] 22 39 53 63 71 78 86 95

M can be technically limited by the time between pulses. Further gain in signal above some
value of M can be negligible to improve results.

When you do a dual-label Europium-Samarium measurement, there are more timing
parameters. There is some residual cross-talk of the Samarium signal captured in the Europium
emission channel. Samarium has a much shorter fluorescence lifetime. To reduce the cross-talk
of Samarium in the Europium channel, Europium is measured in a time window shifted away
from the time window for Samarium. This lets the Europium be quantified without cross
contamination from the Samarium. You can use the known Europium concentration to remove
the Europium cross-contamination in the Samarium channel.

TRF Suggested Timing Parameters: Dual Label Europium-Samarium
Parameter Value Comment

Pulse length 0.100 ms | Time interval for flash monitoring.
Suggested value for TRF detection cartridge.

Measurement delay (first | 0.010 ms | Delay to ensure excitation pulse is no longer detectable.

window) Suggested value for TRF detection cartridge.
Integration time (first 0.100 ms | Period to accumulate Samarium signal.
window) Suggested value for TRF detection cartridge.
Measurement delay 0.140 ms | Read out of Samarium signal.

(second window) Suggested value for TRF detection cartridge.

Integration time (second | 0.750 ms | Period to accumulate Europium signal.
window) Suggested value for TRF detection cartridge.
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FRET Read Mode

5049092 F

Fluorescence resonance energy transfer (FRET) is a distance-dependent interaction between
the electronic excited states of two dye molecules in which excitation is transferred from a
donor molecule to an acceptor molecule without emission of a photon.

FRET relies on the distance-dependent transfer of energy from a donor molecule to an
acceptor molecule. Due to its sensitivity to distance, you can use FRET to investigate
molecularinteractions. FRET is the radiationless transmission of energy from a donor molecule
to an acceptor molecule. The donor molecule is the dye or chromophore that initially absorbs
the energy and the acceptoris the chromophore to which the energy is subsequently
transferred. This resonance interaction occurs over greater than interatomic distances, without
conversion to thermal energy, and without a molecular collision. The transfer of energy leads
to a reduction in the fluorescence intensity and excited state lifetime of the donor, and an
increase in the emission intensity of the acceptor. A pair of molecules that interact in such a
manner that FRET occurs is often referred to as a donor/acceptor pair.

While there are many factors that influence FRET, the primary conditions that need to be met
for FRET to occur are relatively few:

e The donorand acceptor molecules must be in close proximity to each other.

e The absorption or excitation spectrum of the acceptor must overlap the fluorescence
emission spectrum of the donor.
The degree to which they overlap is referred to as the spectral overlap integral (J).

e The donor and acceptor transition must be approximately parallel.

For information about how to set up FRET mode protocols, see Creating FRET Mode Protocols
on page 169.

FRET Instruments
The following instruments have FRET read mode capability:

e FilterMax F3 Multi-Mode Microplate Reader, see page 308

e FilterMax F5 Multi-Mode Microplate Reader, see page 311

e SpectraMax i3x Multi-Mode Detection Platform, see page 318 Requires the Cisbio HTRF
detection cartridge. See Time Resolved Fluorescence Detection Cartridges on page 350.

e SpectraMaxiD5 Multi-Mode Microplate Reader, see page 323 Requires the Enhanced TRF
module.

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 331 Requires the Cisbio
HTRF detection cartridge. See Time Resolved Fluorescence Detection Cartridges on
page 350.
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BRET Luminescence

Bioluminescence Resonance Energy Transfer (BRET) is a measurement technique that shares
the key feature of Fluorescence Resonance Energy Transfer (FRET) while using the
advantages of luminescence reads.

BRET employs a luminescence substrate that can undergo cleavage due to an enzymatic
group (donor label) resulting in luminescence emission (channel 1). Unlike other generic
luminescence assays, the BRET luminescence can be quenched by a radiationless Energy
Transfer to an acceptor label (a fluorophore) resulting in fluorescence emission at a longer
wavelength (red shifted, channel 2). The acceptor must be chosen such that its excitation
spectrum overlaps the emission spectrum of the luminescence (Resonance condition). In the
presence of substrate the energy transfer can occur only when the enzymatic group and the
acceptor are in close proximity. Because of this fact, when labels are applied to study protein-
protein interactions for example, signal measured at the emission wavelength of the acceptor
fluorophore indicates binding.

The SpectraMax i3x and SpectraMax Paradigm use the Dual Color Luminescence (LUM)
(BRET2) detection cartridge to measure the light intensity from BRET? reagents. Since the light
is emitted as a result of a chemical reaction, no excitation light and no excitation filters are
required to measure luminescence, and the detection of the acceptor fluorophore (channel 2)
can be regarded as a luminescence also. Emission filters differentiate emissions from the
primary luminescence and the acceptor fluorophore. So, a dual color luminescence read
mode is applied.

Use BRET? to study various kinds of protein-protein interactions. It employs a luciferase label
(where “label” generally means fused by the use of expression vectors) for the one protein and
a Green Fluorescent Protein (GFP) variant label for the other. The type of luciferase (Renilla)
metabolizes the luminescent substrate (a coelenterazine derivative) resulting in blue
luminescence (emission filter 1). Given the substrate, when the other protein with the GFP label
is in close proximity to the luciferase, it quenches the blue luminescence and emits a green
luminescence (emission filter 2). A high green to blue ratio indicates binding. The energy
transferis possible by the selection of the labels, that is, the overlap of the blue luminescence
spectrum with the excitation spectrum of the GFP (resonance condition). As a result, BRET?
combines the advantage of being a homogeneous (no wash steps required) assay with the
generic sensitivity of luminescence detection.

Energy Transfer data are generally normalized by taking the red shifted emission and dividing
it by the blue shifted emission. In terms of the BRET? reagents, the normalization of the green
signal with the blue signal mainly compensates for the decay of the signal due to the digestion
of the substrate. The software supports data reduction in taking ratios of the two emission
channels.

Because of the signal decay, you must measure the assay immediately after you add the
luminescence substrate. The spectral separation of the green from the blue signal eliminates
the need to pre-process the raw data.

When you do a binding assay, controls are involved that represent a maximum (high) and a
minimum (low) G:B (green to blue) ratio, and you can apply the Z". More than merely taking the
ratio of high and low G:B values, the Z" includes replicate variability to validate the actual data
quality.

Z is the standard statistical parameter in the high-throughput screening community to measure
the quality of a screening assay independent of test compounds. Use this as a measure of the
signal separation between the positive controls and the negative controls in an assay.
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Use the following formula to determine the value of Z":
3(SD,, ) +3(SD__)

- | Mean —Mean |
ct [ond

where SD is the standard deviation, c+ is the positive control, and c—is the negative control.

A Z value greater than or equal to 0.4 is the generally acceptable minimum for an assay. You
can use higher values when results are more critical.

Z is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z" value, increase the quantity of label in the
sample, if acceptable for the assay, or increase the read time per well.

You can apply the BRET? reagents in various ways to study other types of molecular
interactions in cell based assays. For a list of applications, go to www.perkinelmer.com.
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Time-resolved fluorescence is a measurement technique based on fluorescence resonance
energy transfer (FRET) using the advantages of time-resolved fluorescence (TRF) read. TR-
FRET read mode requires the installation of the Enhanced TRF module in the instrument and a
computer running the SoftMax Pro Software.

TR-FRET uses a donor fluorophore with a long fluorescence lifetime, such as Europium. The
acceptor fluorophore acts as if it also has a long fluorescence lifetime. This lets the time-gating
principle of time-resolved fluorescence be applied to the acceptor emission to separate
specific signal from background and signal caused by compound interference.

Time-gating electronics introduce a delay between the flashes and the start of signal
collection. During the delay, the unspecific fluorescence caused by test compounds, assay
reagents, and the plate vanishes while only a small portion of the specific fluorescence from
the acceptor fluorophore is sacrificed. Enough of the specific signal remains, with the benefit
of reduced background.

Applications of TR-FRET

TR-FRET is used in competitive assays to quantify the binding between two labeled
molecules, or the disintegration of a bound complex. Binding partners can have similar
molecular weights as opposed to fluorescence polarization read modes. TR-FRET is an assay
that requires only mixing and measuring—no wash steps are required. It can also be
miniaturized, which makes it useful for high-throughput screening applications.

TR-FRET Instruments
The following instruments have TR-FRET read mode capability:

e SpectraMaxi3x Multi-Mode Detection Platform, see page 318 Requires the Cisbio HTRF
detection cartridge. See Time Resolved Fluorescence Detection Cartridges on page 350.

e SpectraMax iD5 Multi-Mode Microplate Reader, see page 323 Requires the Enhanced TRF
module.

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 331 Requires the Cisbio
HTRF detection cartridge. See Time Resolved Fluorescence Detection Cartridges on
page 350.

HTRF Read Mode

Homogeneous time-resolved fluorescence (HTRF) is a measurement technique based on
fluorescence resonance energy transfer (FRET) using the advantages of time-resolved
fluorescence (TRF) read.

HTRF uses a donor fluorophore with a long fluorescence lifetime, such as Europium. The
acceptor fluorophore acts as if it also has a long fluorescence lifetime. This lets the time-gating
principle of time-resolved fluorescence be applied to the acceptor emission to separate
specific signal from background and signal caused by compound interference.

Time-gating electronics introduce a delay between the flashes and the start of signal
collection. During the delay, the unspecific fluorescence caused by test compounds, assay
reagents, and the plate vanishes while only a small portion of the specific fluorescence from
the acceptor fluorophore is sacrificed. Enough of the specific signal remains, with the benefit
of reduced background.
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Applications of Homogeneous Time-Resolved Fluorescence

Homogeneous time-resolved fluorescence (HTRF) is used in competitive assays to quantify
the binding between two labeled molecules, or the disintegration of a bound complex. Binding
partners can have similar molecular weights as opposed to fluorescence polarization read
modes. HTRF is a homogeneous assay that requires only mixing and measuring—no wash
steps are required. It can also be miniaturized, which makes it useful for high-throughput
screening applications.

The fluorescence ratio related to the HTRF readout is a correction method developed by
Cisbio, for which Cisbio has granted a license to Molecular Devices. Its application is strictly
limited to the use of HTRF reagents and technology, excluding other TR-FRET technologies
such as IMAP TR-FRET calculations of acceptorto donor ratios.

HTRF is a registered trademark of Cisbio Bioassays.

Analyzing HTRF Data

A Homogeneous Time-Resolved Fluorescence (HTRF) measurement includes a number of
flash intervals. Each flash interval consists of flashing the lamp, pausing for a specified length of
time, and measuring the fluorescence intensity of the sample. These flash intervals are
repeated several times, as specified in the protocol parameters.

Data Reduction
Data reduction for HTRF reads consists of two steps.

First, a ratio of the signal measured by the emission from the acceptor label at 665 nm to the
signal measured by the emission of the donor label at 616 nm is calculated and multiplied by a
factor of 10,000. This generates what is called the HTRF ratio.

In the second step, ratios are calculated that represent the relative change in the HTRF signal
compared to that of the assay background, represented by assay controls potentially named
negative or Standard O. This relative response ratio is called the Delta F and is formatted as a
percentage, although values greater than 100 can be generated.

Data Optimization

Measurement noise is dependent on the read time per sample (time per plate ortime per
well). The detection limit improves when you increase the read time. It is important to enter the
read time when you compare measurements. For TRF, the read time per well increases with
the number of pulses you enter. The time between pulses can be different on various systems.

HTRF Timing Parameters Example

Parameter Value Comment

Number of pulses 30 Number of flashes per read.

Measurement delay 30 ps Delay to ensure excitation pulse is no longer
detectable.

Integration time per cycle (pulse) | 400 ps Period to accumulate the signal.

Defining the number of flashes (pulses) cannot be used for comparative purposes because the
flash and intensity rate varies from system to system.

You can optimize two timing parameters to adjust the performance of the measurement: time
per plate ortime perwell and integration time per cycle.
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All low-light-level detection devices have some measurement noise in common. To average
out the measurement noise, optimization of the time per well involves accumulating as many
counts as possible. Within some range, you can reduce noise (CVs, detection limit) by
increasing the read time perwell, as far as is acceptable from throughput and sample stability
considerations.

As the number of flashes (read time per well) is increased, several aspects of the data improve:

e Delta F values show less variability (better CVs).
e Small Delta F values are better distinguished from noise.
e Noise of background is reduced.

The second timing parameter you can optimize is the Integration time per cycle. Take care
when you optimize the integration time to consider noise. Delta F is higher at low integration
times, but noise is also high at low integration times. The optimal integration time is where
noise is minimized while maximizing Delta F.

In the following example, the optimal integration time (read time per cycle) displays to be in

the 500 ps to 1000 ps range, as noise is minimized and Delta F is still relatively high. Going
greater than 1000 ps shows a sharp decline in Delta F without apparent improvement in noise.
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Relationship Between Integration Time, Noise, and Delta F

Z is the standard statistical parameter in the high-throughput screening community to measure
the quality of a screening assay independent of test compounds. Use this as a measure of the
signal separation between the positive controls and the negative controls in an assay.

Use the following formula to determine the value of Z":
3(sD_, ) +3(SD, )

Z=1-
| Mean_ —Mean_ |

where SD is the standard deviation, ¢+ is the positive control, and c— is the negative control.

A Z  value greater than or equal to 0.4 is the generally acceptable minimum for an assay. You
can use higher values when results are more critical.

Z is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z" value, increase the quantity of label in the
sample, if acceptable for the assay, orincrease the read time perwell.
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Fluorescence Polarization Read Mode

The Fluorescence Polarization (FP) read mode measures the relative change of polarization of
emitted fluorescence compared to excitation light.

Fluorescence Polarization detection is based on Fluorescence Intensity, with the important
difference that it uses plane-polarized light, rather than non-polarized light. Microplate readers
measure the Fluorescence Polarization of the sample by detecting light emitted both parallel
and perpendicular to the plane of excitation.

By using a fluorescent dye to label a small molecule, the binding of a small molecule to an
interaction partner of equal or greater size can be monitored through its speed of rotation.

When molecules are excited with polarized light, the change in the polarization of the emitted
light depends on the size of the molecule to which the fluorophore is bound (the emitted light
quickly depolarizes if the fluorescent molecule is unbound). Larger molecules yield a stronger
polarization of the emitted light, while smaller molecules cause less polarization because of
their rapid molecular movement. Use Fluorescence Polarization for molecular binding assays in
high-throughput screening (HTS).

Applications of Fluorescence Polarization

Fluorescence Polarization measurements provide information on molecular mobility and are
generally used to quantify the success of a binding reaction between a smaller labeled ligand
and a binding site at a much larger orimmobilized molecule. Use Fluorescence Polarization to
quantify the dissociation or cleavage of the labeled ligand from a binding site.

Fluorescence Polarization is a homogeneous plate assay technique and requires only mixing
and measuring—no wash steps are required as in an ELISA. It can also be miniaturized, which
makes it useful for high-throughput screening applications.

For information about how to set up Fluorescence Polarization mode protocols, see Creating
Fluorescence Polarization Mode Protocols on page 170.

Fluorescence Polarization Instruments
The following instruments have Fluorescence Polarization read mode capability:

e FilterMax F5 Multi-Mode Microplate Reader, see page 311

e FlexStation 3 Multi-Mode Microplate Reader, see page 312

e SpectraMaxi3x Multi-Mode Detection Platform, see page 318 Requires Fluorescence
Polarization Detection Cartridges, see page 346.

e SpectraMaxiD5 Multi-Mode Microplate Reader, see page 323

e SpectraMax M5 Multi-Mode Microplate Reader, see page 330

e SpectraMax M5e Multi-Mode Microplate Reader, see page 330

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 331 Requires
Fluorescence Polarization Detection Cartridges, see page 346.
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Analyzing Fluorescence Polarization Data

The Fluorescence Polarization read mode returns two sets of data: one for fluorescence
intensity parallel (P) to the excitation plane, and the other for fluorescence intensity
perpendicular (S) to the excitation plane. The software uses the S and P values to calculate the
Polarization (mP) and Anisotropy (r) values.

Fluorescence Polarization assays in plates are generally designed with two control samples:
e | OW control sample: minimal polarization value resulting from unbound labeled ligand
only
e HIGH control sample: maximum polarization value resulting from bound labeled ligand only
The Fluorescence Polarization data for a sample is evaluated based on its relative position

between the low and high control values. Total intensity can also be determined from the raw
data and is proportional to the quantity of label in a sample.

Blank Correction

Many Fluorescence Polarization assays use small fluorescent label concentrations in the lower
nm range. In this range, blank controls become significant when compared to samples.

A blank well contains everything used with the sample wells except the label and sample-
specific compounds. Do not use an empty well for a blank.

Background wells, which contain all assay components minus the fluorophore, should be
tested. If the signal in the background wells is more than 1/10 the signal in the wells that contain
fluorophore, then background wells should be run on each assay plate. The average raw signal
from the background's parallel and perpendicular reads must be subtracted from the raw
parallel and perpendicular reads of each sample well before the mP calculation is done.

For optimal results, you should run replicates for all blanks, controls, and samples. In this case,
the blank value that will be subtracted is the average value of all blanks.

Data Reduction

Although the raw S and P values are the true actual values returned from the instrument, the
calculated Polarization (mP) and Anisotropy (r) values are treated as the raw data and become
the basis for further reduction calculations.

Polarization (mP) is calculated as follows:

arallel - (G % perpendicular
P = 1000 (p (G * perpendicular))

(parallel + (G * perpendicular))

Anisotropy (1) is calculated as follows:

(parallel - (G * perpendicular))

r=
(parallel + (2G * perpendicular))

Use the G factor, or grating factor, in Fluorescence Polarization to correct polarization data for
optical artifacts which converts relative mP data to theoretical mP data. Optical systems,
particularly with reflective components, pass light of different polarization with different
efficiency. G factor corrects for this instrument-based bias.
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Data Qualification and Validation

When you validate the data of a Fluorescence Polarization measurement and the assay, the
two factors to look at are the precision value and the Z" factor.

The FP precision value is a measure of replicate uniformity determined by the standard
deviation of replicates at a label concentration of 1 nM. Since the precision of a measured
signal also depends on the read time, the read time must also be specified. A longer read time
leads to a lower (better) precision value.

Z is the standard statistical parameter in the high-throughput screening community to measure
the quality of a screening assay independent of test compounds. Use this as a measure of the
signal separation between the positive controls and the negative controls in an assay.

Use the following formula to determine the value of Z":
3(SD,, ) +3(SD_)

- | Mean —Mean |
c+ C

where SD is the standard deviation, c+ is the positive control, and c— is the negative control.

A Z value greaterthan or equal to 0.4 is the generally acceptable minimum for an assay. You
can use higher values when results are more critical.

Z is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z" value, increase the quantity of label in the
sample, if acceptable for the assay, or increase the read time per well.

The assay window is dependent on the fluorophore lifetime and relative size of the receptor to

the ligand. Precision values are better (lower) at higher signals, which normally come from
higher label concentrations.

For a given assay window, Z" is a downward sloping linear function. That is, as precision values
get higher (worse), the Z” value gets lower (worse).

Precision is dependent upon assay characteristics (sample volume, label concentration) and
read time. In many assays, the characteristics are defined and cannot be changed. In this case,
the only way to improve precision is to increase the read time per well.
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ALPHA stands for Amplified Luminescent Proximity Homogeneous Assay. AlphaScreen® is a
bead-based chemistry used to study molecular interactions between moieties A and B, for
example. When a biological interaction between A and B moves beads (coated with A and B,
respectively) together, a cascade of chemical reactions produce a greatly amplified signal.
The cascade result signal is triggered by laser excitation (680 nm), that makes a
photosensitizer on the A-beads convert oxygen to an excited (singlet) state. The energized
oxygen diffuses away from the A-bead. When reaching the B-bead in close proximity, it reacts
with a thioxene derivative on the B-bead to generate chemiluminescence at 370 nm. Energy
transfer to a fluorescent dye on the same bead shifts the emission wavelength into the 520 nm
to 620 nm range. The limited lifetime of singlet oxygen in solvent (Y4 microseconds) lets
diffusion reach up to only around 200 nm distance. Thus, only B-beads in the proximity of A-
beads yield signal, which indicates binding between moieties A and B.

An AlphaScreen measurement includes a light pulse, by turning on the laser diode for a
specified time, turning off the laser diode, followed by the measurement of the AlphaScreen
signal, as specified in the measurement protocol timing parameters.

AlphaScreen beads are light sensitive. Beads are best handled under subdued (<100 lux) or
green filtered (Roscolux filters #389 from Rosco, or equivalent) light conditions. Do incubation
stepsinthe dark.

You can normalize the raw data to counts per second.

Applications of AlphaScreen

Examples of AlphaScreen assays include:
e G-protein coupled receptor (GPCR) assay kits, for cAMP quantification or IP3 quantification.
e Tyrosine Kinase assays.
e Cytokine detection kits, such as TNF-alpha detection (immunoassay).

AlphaScreen read mode can capture the Europium emission line of AlphaLISA®.

For information about how to set up AlphaScreen mode protocols, see Creating AlphaScreen
Mode Protocols on page 172.

AlphaScreen Instruments
The following instruments have AlphaScreen read mode capability:
e SpectraMaxi3x Multi-Mode Detection Platform, see page 318 Requires AlphaScreen
Detection Cartridges, see page 344.
e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 331 Requires
AlphaScreen Detection Cartridges, see page 344.
For more information, go to www.perkinelmer.com.

ALPHASCREEN and ALPHALISA are registered trademarks of PerkinElmer, Inc.

Analyzing AlphaScreen Data

The conversion rate of photons to counts and relative fluorescence units (RFU) is individual for
each reader. Therefore, raw data from the same plate can seem to be different from one
instrument to the next. Also, the data format used by instrument manufacturers might be counts
normalized per second or not normalized counts, and therefore the raw data can be different
by several orders of magnitude. It is important to know that the number of counts and the size
of figures are not indicators of sensitivity.
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The raw data can be normalized to counts per second by selecting the Normalization optionin
the Settings dialog. See Acquisition Settings on page 110.

Background Correction

Although background is significantly lower than with fluorescence intensity measurements, you
should use blanks or assay controls for background correction. The background can be
effectively measured using blank replicates. When you read a sample with small signal, an
interference can occur from the afterglow of a very strong emitting adjacent sample that was
measured just before. Such cross talk can occur through the wall of a white 384-well plate. To
prevent such interference, you can select the Interlaced Read option in the Settings dialog.
This option reads only every other well in a checkerboard pattern, and then reads the plate
again to read the previously omitted wells.

A blank well contains everything used with the sample wells except the label and sample-
specific compounds. Do not use an empty well for a blank.

For optimal results, you should run replicates for all blanks, controls, and samples. In this case,
the blank value that will be subtracted is the average value of all blanks.
Data Qualification and Validation

Z’is the standard statistical parameter in the high-throughput screening community to measure
the quality of a screening assay independent of test compounds. Use this as a measure of the
signal separation between the positive controls and the negative controls in an assay.

Use the following formula to determine the value of Z":
3(sD_, ) +3(SD, )

- | Mean  —Mean |
c+ -

where SD is the standard deviation, c+ is the positive control, and c—is the negative control.

A Z  value greater than or equal to 0.4 is the generally acceptable minimum for an assay. You
can use higher values when results are more critical.

Z is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z" value, increase the quantity of label in the
sample, if acceptable for the assay, or increase the read time perwell.

% Note: The assay plate and the instrument should be kept at room temperature, since
temperature variations cause fluctuations in signal.
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Western Blots (WB), or protein immunoblots, are one of the most common methods for protein
detection in pharmaceutical and clinical research. You can use various techniques to detect
proteins on Western Blot membranes including fluorescence, silver staining, and
chemiluminescence. Each technique has its limitations. There is a continuous need to improve
quantitation, accuracy, and dynamic range of Western Blots.

The Molecular Devices ScanLater™ Western Blot Assay Kit is a novel system for protein
analysis that you can use with the SpectraMax i3x, SpectraMax iD5, and SpectraMax Paradigm.
Membranes are incubated with Eu-chelate labeled secondary antibodies or streptavidin that
bind specifically to the target protein-specific primary antibody. Europium has a long
fluorescence lifetime, on the order of 1 msec, and detection is done in Time Resolved
Fluorescence (TRF) mode which significantly reduces background from auto-fluorescence or
other sources of short lifetime emissions. The membranes are placed into the instrument
where the membranes are scanned with the ScanLater Western Blot (WB) detection cartridge
(SpectraMax iD5 uses the Enhanced TRF module).

The method does not involve enzyme detection, and the Eu-chelates are resistant to photo-
bleaching, so the signal remains stable for long periods of time (weeks to months). This allows
you repeat the read of membranes and the potential for comparison of band intensities to
known standards for more accurate quantitation. There is also no camera blooming, as can
occur with chemiluminescence or fluorescence detection, so the system gives sharp bands
and excellent image quality.

The TRF detection employs photon counting, so the theoretical dynamic range is >10°. In
practice, however, dynamic range is limited by saturation of binding sites on high-abundant
bands and non-specific binding to background membrane.

The SpectraMax Western Blot system is a simple, sensitive, and stable platform that provides

excellent Western Blot capability for the SpectraMax i3x, SpectraMax iD5, and SpectraMax
Paradigm to extend the uses of these essential laboratory instruments.

Applications
e |dentify the nature of the protein or epitope effectively. Also, it can be used as a tool for
quantitative analysis of protein.
e Use for chromatography components analysis, sucrose gradient analysis.
e Testthe endogenous or exogenous expression of phosphoprotein to detect the
phosphorylation signal.
e Protein resilience in the function experiment.
e Structure domain analysis.
e Analysis of the protein expression level.
e Analysis of protein content in the serum.
e Analysis of regulatory proteins expressed in the cell cycle.
For information about how to set up Western Blot TRF mode protocols, see Creating Western
Blot TRF Mode Protocols on page 173.
If you use the SoftMax Pro Software - GxP edition, you must have the following permissions to
complete a Western Blot membrane read:

e Read Empty Plates/Cuvettes to start a read.
e Create/Save Data Documents to save the data document before the read.
e Overwrite Plate/Cuvette Data to do a high-resolution ROI read.

See SoftMax Pro Software - GxP Edition on page 243.
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Western Blot TRF Instruments
The following instruments have Western Blot TRF read mode capability:

e SpectraMaxi3x Multi-Mode Detection Platform, see page 318 Requires the ScanLater
Western Blot Detection Cartridge, see page 348.

e SpectraMaxiD5 Multi-Mode Microplate Reader, see page 323 Requires the Enhanced TRF
module.

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 331 Requires the
ScanLater Western Blot Detection Cartridge, see page 348.

The ScanLater Western Blot (WB) detection cartridge can be used for top reads only.

Analyzing Western Blot TRF Data

After you scan a membrane for Western Blot data, the data displays in the software as an
image. Use the image tools in the Plate section to zoom, crop, colorize, and adjust the intensity
of the image. You can select a region of interest (ROI) and rescan the membrane at a higher
resolution. See Viewing Western Blot Membrane Data on page 236.

Western Blot membrane data is saved as a TIFF image to allow you to use the image analysis
tool of your choice for analysis. The SoftMax Pro Software includes a version of the ImageJ
software from U.S. National Institute of Health (NIH). See Analyzing Western Blot Images on
page 241.

For best results, use the Molecular Devices ScanLater” Western Blot Assay Kit that matches
your application.

Blocking Nonspecific Binding

To reduce noise, use blocking buffer to reduce non-specific protein from binding with the
membrane.

No single-blocking reagent is optimal for every antigen-antibody pair. Some primary
antibodies can exhibit greatly reduced signal or different nonspecific binding in different
blocking solutions. If you have difficulty detecting your target protein, changing the blocking
solution can dramatically improve the performance. If the primary antibody has worked well in
the past using chemiluminescent detection, try that same blocking solution for detection.
Other commonly used blocking buffers other than BSA are 3% casein and 5% non-fat milk.

Milk-based blockers can contain IgG that can cross react with anti-goat antibodies. This can
significantly increase background and reduce antibody titer. Milk-based blockers can also
contain endogenous biotin or phosphoepitopes that can cause higher background.

To prevent background speckles on blots, use high-quality, ultra-pure water for buffers.

Do not over-block. Extended blocking times can cause loss of target protein from the
membrane.
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Handling Membranes

You must place the membrane in a Molecular Devices ScanLater” membrane holderto scan a
membrane . See Loading the Membrane Holder on page 174.

% Note: Use clean forceps to handle membranes by their edges only. Do not touch the
membrane with gloved or bare hands.

The maximum size of a membrane that fits in the membrane holderis 109 mm x 77 mm.

Use standard blotting procedures for the membrane to prepare for the Western Blot. For
optimal results, use Millipore Immobilon FL (IPFLOOO10). If using PVDF, pre-wet the membrane
in 100% methanol.

Use enough antibody volume so that the entire membrane surface is sufficiently covered with
liquid at all times. Use heat-seal bags if the volume is limiting. Do not let an area of the
membrane dry out. Use agitation for all antibody incubations.

Small proteins can pass through the membrane during transfer (“blow-through”). To prevent
this, use a membrane with a smaller pore size or reduce the transfer time.

Allow the blot to dry for a minimum of 1 hour before detection.

Do not wrap the membrane in plastic for the scan.
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Imaging Read Mode
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To use the Imaging read mode, you must install the SpectraMax i3x with the SpectraMax
MiniMax 300 Imaging Cytometer. Imaging read mode does whole-cell imaging assays. You
can obtain imaging data through visual inspection of the image or use the analysis tools in the
SoftMax Pro Software.

Whole-cell imaging assays are cell-based, or object-based, rather than the single-point
measurements found in other types of plate reads. These types of assays can yield more
biologically meaningful results that can discriminate the fluorescence related to objects, such
as cells or beads, from the bulk solution within a plate well.

The measurement is primarily fluorescent with quantification of cell size, shape, area, and
intensity. Brightfield, transmitted light imaging supports label-free quantification. The camera
resolution in the SpectraMax MiniMax 300 Imaging Cytometer is sufficient to determine the
approximate shape of small 8 micron objects, such as blood cells.

These assays include the direct interrogation of individual cells instead of whole well or cell
lysates which allows you to control cell numbers and heterogeneity in cell-based assays.
Imaging provides increased sensitivity by detecting a few fluorescent cells per well and
detecting cells that are, on average, less fluorescent.

The SpectraMax MiniMax 300 Imaging Cytometer can use transmitted light and two
fluorescent channels during the same plate read to acquire image data. Use the Settings
dialog to select the channels for the acquisition. The StainFree Cell Detection Algorithm uses
proprietary transmitted light analysis technology to eliminate cell staining for cell counting and
confluency measurements.

Applications of Whole-Cell Imaging

Whole-cell imaging assays measure a diverse set of cellular responses, such as fluorescent
protein expression (phosphorylated and total), cell viability (cell toxicity), cell apoptosis, and
cell cycle analysis.

The following dyes are supported:

e EarlyTox™ Cell Integrity Kit

e Fluorescein isothiocyanate (FITC)

e Calcein AM

e Alexa Fluor 488 or Alexa Fluor 647

e Cy5

e DRAQS5
For information about how to set up Imaging read mode protocols, see Creating Imaging
Mode Protocols on page 175.

Imaging Instruments

You install the SpectraMax i3x Multi-Mode Detection Platform, see page 318 with the
SpectraMax MiniMax 300 Imaging Cytometer to add imaging capability to the SpectraMax i3x
so that you can visually inspect a sample and run cell-based assays at cellular or whole-cell
resolution.

Install the SpectraMaxTransmitted Light (TL) detection cartridge in the detection cartridge
drawer to do brightfield, transmitted-light imaging. See Imaging - Transmitted Light Detection
Cartridge on page 347.
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Analyzing Imaging Data

You can obtain imaging data through visual inspection of the image or you can use the analysis
tools in the SoftMax Pro Software.

In fluorescent imaging, the fluorescence in the sample is excited with light of a specified
wavelength. The fluorophore emits at a longer wavelength that is captured in the image.

The software measures the intensity of the emitted fluorescence and estimates the intensity of
the background in the image.

You can select one of the following image analysis types.

Discrete Object Analysis

Discrete Object Analysis uses proprietary algorithms to analyze separate objects, or cells,
based on multiple parameters including the signal intensity over the background and the size
of the objects.

Click Discrete Object Analysis to display the Wavelength for Finding Objects list below the
analysis types. Select the wavelength to use to identify the objects in the well images. You can
use transmitted light or a fluorescent wavelength to find nuclei or easily separable objects in
the image. The StainFree™ Cell Detection Algorithm eliminates cell staining for cell counting
and confluency measurements using proprietary transmitted light analysis technology.

Select the Image Analysis Settings category to display the following:

e Click Find Objects to enter size and intensity values or to use proprietary algorithms with
the drawing tools to graphically define the objects and the background areas for the
analysis. See Finding Discrete Objects or Confluent Areas on page 129.

e Click Classify Objects to define separate measurements for different types of found
objects, or cells. See Classifying Discrete Objects on page 133.

e Click Select Measurements to view the results of the analysis for the wells you select. See
Viewing and Selecting Measurement Statistics on page 134.

Field Analysis

Field Analysis uses proprietary algorithms to analyze confluent areas based on parameters
including the signal intensity over the background and the size of the areas.

Click Field Analysis to display the Wavelength for Finding Confluent Areas list below the
analysis types. Select the wavelength to use to identify the confluent areas in the well images.
The StainFree Cell Detection Algorithm uses proprietary transmitted light analysis technology
to eliminate cell staining for cell counting and confluency measurements.

The Image Analysis Settings category expands to display the following:

e Click Find Confluent Areas to use proprietary algorithms with the provided drawing tools
to graphically define the confluent areas and the background areas for the analysis. See
Finding Discrete Objects or Confluent Areas on page 129.

e Click Select Measurements to view the results of the analysis for the wells you select. See
Viewing and Selecting Measurement Statistics on page 134.

The SoftMax Pro Software proprietary algorithms with the provided drawing tools help the
software learn the patterns of the objects that you want to find. Depending on the complexity
of the object patterns, this teaching process can take several iterations before you get the
expected results. See Resolving Issues with Object Drawing and Finding on page 135.
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Analysis Measurement Parameters

Depending on the needs of your application, you can use one or more of the following analysis
measurement parameters for the region of interest (ROIl) in your experiment:

Object Count: The total number of objects detected in the image. Do not use for field
analysis of confluent areas.

Field Count: The total number of confluent areas detected in the image. Do not use for
discrete object analysis.

Object Percentage: The percentage the objects detected in the image by classification.
Do not use for field analysis of confluent areas.

Covered Area: The combined area of all the objects or confluent areas detected in the
image as a percentage of the entire image area.

Object Area: The average area of the objects detected in the image expressed in um?2. Do
not use for field analysis of confluent areas.

Field Area: The average area of the confluent areas detected in the image expressed in
um?. Do not use for discrete object analysis.

Object Roundness: The average roundness of each object detected in the image. A shape
factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all. Do not use
for field analysis of confluent areas.

Field Roundness: The average roundness of each confluent area detected in the image. A
shape factor of 1.00 is perfectly round, while a shape factor of 0.00 is not round at all. Do
not use for discrete object analysis.

Object Average Intensity: The average fluorescent signal intensity of the objects detected
in the image. Do not use for field analysis of confluent areas or for transmitted light.

Field Average Intensity: The average fluorescent signal intensity of the confluent areas
detected in the image. This is not used for discrete object analysis or for transmitted light.
Object Intensity: The average total fluorescent signal intensity of the objects detected in
the image. Do not use for field analysis of confluent areas or for transmitted light.

Field Intensity: The average total fluorescent signal intensity of the confluent areas
detected in the image. Do not use for discrete object analysis and do not use for
transmitted light.

Total Intensity: The combined total fluorescent signal intensity of the objects or confluent
areas detected in the image expressed in million intensity counts. Do not use for
transmitted light.
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Chapter 7: Supported Instruments

SoftMax Pro Software controls Molecular Devices spectrophotometers and absorbance,
luminescence, and fluorescence microplate readers and detection platforms.

User guides for each of the supported instruments are installed during the SoftMax Pro
Software installation. You can view these user guides from the Windows Start menu at Start >
All Programs > Molecular Devices > SoftMax Pro n.n.n > Hardware User Guides.

SoftMax Pro Software supports the following instruments:

e EMax Endpoint Microplate Reader, see page 306

e EMax Plus Microplate Reader, see page 307

e FilterMax F3 Multi-Mode Microplate Reader, see page 308 (DTX 800)

e FilterMax F5 Multi-Mode Microplate Reader, see page 311 (DTX 880)

e FlexStation 3 Multi-Mode Microplate Reader, see page 312

e Gemini EM Dual Scanning Microplate Spectrofluorometer, see page 313

e Gemini XPS Dual Scanning Microplate Spectrofluorometer, see page 313

e SpectraMax 190 Microplate Spectrophotometer, see page 314

e SpectraMax 340PC384 Microplate Spectrophotometer, see page 314

e SpectraMax ABS Microplate Spectrophotometer, see page 315

e SpectraMax ABS Plus Microplate Spectrophotometer, see page 315

e SpectraMaxi3x Multi-Mode Detection Platform, see page 318

e SpectraMax i3 Multi-Mode Platform, see page 316

e SpectraMax MiniMax 300 Imaging Cytometer, see page 319

e SpectraMaxiD3 Multi-Mode Microplate Reader, see page 320

e SpectraMaxiD5 Multi-Mode Microplate Reader, see page 323

e SpectraMaxL Luminescence Microplate Reader, see page 325

e SpectraMax M2 Multi-Mode Microplate Reader, see page 328

e SpectraMax M2e Multi-Mode Microplate Reader, see page 328

e SpectraMax M3 Multi-Mode Microplate Reader, see page 329

e SpectraMax M4 Multi-Mode Microplate Reader, see page 329

e SpectraMax M5 Multi-Mode Microplate Reader, see page 330

e SpectraMax M5e Multi-Mode Microplate Reader, see page 330

e SpectraMax Paradigm Multi-Mode Microplate Reader, see page 331

e SpectraMax Plus 384 Microplate Spectrophotometer, see page 334

e VersaMax Microplate Spectrophotometer, see page 334

¢ VMax Kinetic Microplate Reader, see page 335

e StakMax Microplate Handling System, see page 336
The SpectraMax i3x supports user-installable detection cartridges for top reads and the
SpectraMax Paradigm requires detection cartridges to do reads. Each detection cartridge
contains the light source, optics, and electrical components needed to do specific read
modes for some applications.

See Supported Detection Cartridges on page 343.
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The EMax Endpoint Microplate Reader measures optical density (OD). The optical array is
designed to analyze the absorbance of multiple sample sites with 9 mm centers. Read one
sample or up to 96 at a time. Use standard 96-well plates.

EMax features include:

e Filterrange: 400 nm to 750 nm
e Filter capacity: 6
e Optical density: single wavelength and dual wavelength

Read Mode Read Type

Endpoint

Absorbance | \/

See Read Modes and Read Types on page 267
Adjusting the Lamp

To adjust the halogen lamp, select the Operations tab and click ° Configure to display the
Configuration dialog. You can adjust the intensity of the lamp for each of the installed filters in
the instrument. You can view the positions and wavelengths of the installed filters. This dialog
lists other instrument information including the serial number and firmware version.

You select the filters you install from the Settings dialog. See Creating Absorbance Mode
Protocols on page 157.

To adjust the intensity of the lamp for each of the filters, click Adjust Lamp. The software and
instrument step through each filter one at a time to adjust the lamp intensity for the best
implementation of the filter wavelength. The Configuration dialog must remain open until the
lamp adjustment completes.
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EMax Plus Microplate Reader
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The EMax Plus Microplate Reader is a filter-based visible absorbance microplate reader with
eight standard filters for a range of applications. The instrument can read standard 96-well
plates.

Read Mode Read Type

Endpoint Kinetic

Absorbance \/ \/

See Read Modes and Read Types on page 267

Configuring Filters for the EMax, EMax Plus, and VMax Microplate Readers

EMax Endpoint Microplate Reader, EMax Plus Microplate Reader, and VMax Kinetic Microplate
Reader have configurable filters. If you change the order of the filters, or add or remove filters,
you need to use the Filter Configuration dialog to define the positions of the filters. If the filter
settings in the Filter Configuration dialog are incorrect, the microplate reader generates
incorrect data. For information about how to change the filters, see the EMax Plus Microplate
Reader User Guide.

To define the filter positions:

1. Select the Operations tab and click e Filters to display the Filter Configuration dialog.

2. Enterthe wavelength values in the correct positions for each filter you install. You can
define up to sixfilters. The permitted wavelength range is 400 nm to 750 nm.

3. Click OK.

The filters you define are available for selection in the Settings dialog. See Creating
Absorbance Mode Protocols on page 157.
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FilterMax F3 Multi-Mode Microplate Reader
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The FilterMax F3 Multi-Mode Microplate Reader is ideal for a broad range of applications,
including drug discovery, genomics, proteomics, and cell-based research. The unique
patented design ensures precise performance and sensitivity across all detection modes. The
DTX 800 Multi-Mode Microplate Reader is an earlier model of the FilterMax F3.

FilterMax F3 features include:

e Visible absorbance at wavelengths between 340 nm and 650 nm.

e Fluorescence intensity for top reads at wavelengths between 340 nm and 650 nm.
® Glow-type luminescence at wavelengths between 400 nm and 650 nm.

e Measurements on samples in 96-well and 384-well plates.

e |inearand orbital plate shake.

e Compliance validation package see SpectraTest Validation Plates on page 338.

The filters are mounted on two types of interchangeable slides. The excitation slide filters are
for absorbance and fluorescence measurements, the emission slide filters are for fluorescence
and some luminescence measurements. Each slide can hold up to sixfilters. See Configuring
Filter Slides on page 308.

Read Mode Read Type
Endpoint Kinetic Well Scan
Absorbance v v v
Dual Wavelength Luminescence v
Fluorescence Intensity \/ \/ \/
FRET v
Luminescence v v

See Read Modes and Read Types on page 267

Configuring Filter Slides

Use the Filter Settings dialog define a filter slide for the FilterMax F3 and FilterMax F5 in the
software. When you add or remove filter slides or change the order of the filters in a slide, you
need to use the Filter Settings dialog to define the filters in the slide. If you do not define the
filter settings, the microplate reader generates incorrect data. See FilterMax F3 Multi-Mode
Microplate Reader on page 308 and FilterMax F3 Multi-Mode Microplate Reader on page 308.
o

Note: You should not reconfigure standard filter slides.

The filters are mounted on two types of interchangeable slides. The excitation slide filters are
for absorbance and fluorescence measurements, the emission slide filters are for fluorescence
and some luminescence measurements. Each slide can hold up to six filters.

Note: Excitation and emission filter slides are different sizes to prevent installation in the
incorrect position.
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Each slide has a built in identification code that allows the software to recognize the slide and
filter configuration. The software can store the definition for up to 31 excitation filter slides and
31 emission filter slides.
e For quantitation experiments, you must use a genomic filter slide that contains narrow
bandwidth 260 nm and 280 nm filters.
e For experiments that use PathCheck technology, you must use a filter slide designed for
PathCheck technology.

Access the Filter Settings dialog
Each of the following procedures is done in the Filter Settings dialog.
To access the Filter Slides dialog:

1. Inthe Ribbon, select the Operations tab and click Info to display the Instrument Information
dialog.
2. Click Edit Slide Configuration to display the Filter Settings dialog.
3. Select one of the following:
e Select Excitation to display the list of excitation slides.
e Select Emission to display the list of emission slides.

Adding Filter Slides
To add and define filter slides:
1. Click Add Slide to add a new slide to the list.
2. Inthe Filter Slide Properties area on the right, in the Slide ID field, enter the identification
number thatis printed on the slide.
3. If needed, click + to display the list of filters installed on the slide and select a filter to
display the filter properties on the right.
4. Inthe Wavelength field, enter the filter wavelength.
5. Click the Techniques drop-down and select the check box for each read mode for which
the filter applies. The filter can be used only for experiments of the read modes you select.
For the FilterMax F5, select Polarization for filter positions that have a polarization filter
installed. If you do not select a read mode, the Installed field displays No, and you cannot
use the filter position for experiments.
6. Afteryouselectthe read modes, the Installed field displays Yes and the Position field
displays the slide position. You cannot edit these fields.
7. Inthe Bandwidth field, enter the filter bandwidth.
8. Inthe Order# field, enter the manufacturer's part number for the filter for your reference.
9. Repeatto configure the rest of filters on the slide.

Exporting Filter Slides
You can export filter slide definitions to an .xml format and then import back into the software.
To export filter slide definitions:

1. Either:

e To export the definition for a single slide, select the slide to export and click Export
Selected Slide.
e To export all slide definitions, click Export Slides.

2. Inthe Save As dialog, navigate to the folder where you want to save the .xml file and enter
the file name in the File Name field. The default location for filter slide definitions is:
C:\ProgramData\Molecular Devices\SMP<n.n.n>\MultiMode\Detection Software\Filters

3. Click Save.
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Removing Filter Slides

You cannot recover a filter slide definition after you remove it from the list. If you plan to use a
filter slide definition in the future, export the definition before you remove it from the list.

To remove afilter slide definition:

1. Inthe slide list, select the slide to remove.
2. Click Remove Slide.

Importing Filter Slides

Follow the previous steps to import a filter slide definition from the .xml format file the software
creates. Each filter slide definition must have a unique slide ID. If the filter slide ID to import
exists in the list, rename the slide ID or remove the slide from the list before you import.

To import filter slide definitions:

1. Click Import Slides.
2. Inthe Open dialog, navigate to the folder where .xml file is saved and select the file.
The default location for filter slide definitions is:
C:\ProgramData\Molecular Devices\SMP<n.n.n>\MultiMode\Detection Software\Filters
3. Click Open.

Loading Slides (Replacing Slide Definitions)

When you use the Load Slides feature, the software deletes all current filter slide definitions
and replaces the slide definitions with the definitions you import. If you plan to use one or more
of the current filter slide definitions in the future, export the current slide definitions before you
load the new definition and replace the current list.

You can load filter slide definitions from the .xml format file the software creates when you
follow the steps above to export a slide definition. Slide definition files can contain definitions
of one or more filter slides for excitation and emission filters.

To replace the current filter slide definitions:

1. Click Load Slides.
2. Inthe message that displays, click Yes.
3. Inthe Opendialog, navigate to the .xml file and select it.
The default location for filter slide definitions is:
C:\ProgramData\Molecular Devices\SMP<n.n.n>\MultiMode\Detection Software\Filters
4. Click Open.
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FilterMax F5 Multi-Mode Microplate Reader
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The FilterMax F5 Multi-Mode Microplate Reader is ideal for a broad range of applications,
including drug discovery, genomics, proteomics, and cell-based research. The unique
patented design ensures precise performance and sensitivity across all detection modes.

The DTX 880 Multi-Mode Microplate Reader is the earlier model of the FilterMax F5.

The filters are mounted on two types of interchangeable slides. The excitation slide filters are
for absorbance and fluorescence measurements, the emission slide filters are for fluorescence
and some luminescence measurements. Each slide can hold up to sixfilters. See Configuring
Filter Slides on page 308.

FilterMax F5 features include:

e UV and visible absorbance at wavelengths between 230 nm and 650 nm.

e Fluorescence intensity at wavelengths between 230 nm and 700 nm for top reads, or
between 300 nm and 650 nm for bottom reads.

e Glow-type luminescence at wavelengths between 400 nm and 700 nm.

e Time-Resolved Fluorescence at wavelengths between 340 nm and 700 nm.

e Fluorescence polarization at wavelengths between 300 nm and 700 nm.

e Measurements on samplesin 6,12, 24, 48, 96, 384, and 1536-well plates.

e A deuterium light source that extends sensitivity into the deep UV band.

e PathCheck technology.

e Automatic read height (Z-height) optimization for top read.

e Temperature control in the plate chamber during measurements.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan

Absorbance \/ v/ \/
Dual Wavelength Luminescence v

Fluorescence Intensity \/ 1/ \/
Fluorescence Polarization v v

FRET v

Luminescence v v

Time Resolved Fluorescence v

See Read Modes and Read Types on page 267
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FlexStation 3 Multi-Mode Microplate Reader
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The FlexStation 3 Multi-Mode Microplate Reader combines the performance of a dual-
monochromator, multi-mode microplate reader and an integrated 8-channel or 16-channel
pipettorinto one compact bench top reader. This integrated system provides a multi-
detection platform capable of increasing liquid-handling throughput and flexibility for
biochemical-based and cell-based assays. The system is equally amenable to agonist and
antagonist assay formats. The instrument combines fluid transfer with multi-detection optics to
provide a microplate reader capable of doing a broad span of applications for the drug
discovery and research environments.

The instrument's dual monochromators allow you to target the optimal assay excitation and
emission wavelengths and eliminate the need to change expensive band pass filters between
experiments.

FlexStation 3 features include:

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan Spectrum Flex
Absorbance v v v v v
Fluorescence Intensity \/ v"’ \/ v’/ \/
Fluorescence Polarization v v
Luminescence v v v v v
Time Resolved Fluorescence v v v v

See Read Modes and Read Types on page 267
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Gemini EM Dual Scanning Microplate Spectrofluorometer

The Gemini EM Dual Scanning Microplate Spectrofluorometer can do a variety of fluorescent
applications. The extreme flexibility and high sensitivity make the Gemini EM useful for
applications within the fields of biochemistry, cell biology, immunology, molecular biology,
and microbiology. The top-read and bottom-read optical design permits measurements for
solution and cell-based assays.

Gemini EM features include:

e Dual monochromators let you select wavelengths in 1 nm increments.

e Cutoff filters reduce stray light and minimize background interference.

e Wavelength scanning ensures that the most sensitive assay conditions are used.
e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan Spectrum
Fluorescence Intensity v/ \/ \/ \/
Luminescence (secondary) v v v v
Time-Resolved Fluorescence (secondary) v/ \/ \/ \/

See Read Modes and Read Types on page 267

Gemini XPS Dual Scanning Microplate Spectrofluorometer

The Gemini XPS Dual Scanning Microplate Spectrofluorometers can do a variety of
fluorescent applications. The extreme flexibility and high sensitivity make the Gemini XPS
useful for applications within the fields of biochemistry, cell biology, immunology, molecular
biology, and microbiology.

Gemini XPS features include:

e Dual monochromators let you select wavelengths in 1 nm increments.

e Cutoff filters reduce stray light and minimize background interference.

e Wavelength scanning ensures that the most sensitive assay conditions are used.
e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan Spectrum
Fluorescence Intensity v/ \/ \/ \/
Luminescence (secondary) v v v v
Time-Resolved Fluorescence (secondary) »/ \/ \/ \/

See Read Modes and Read Types on page 267
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SpectraMax 190 Microplate Spectrophotometer

The SpectraMax® 190 Microplate Spectrophotometer provides rapid and sensitive
measurements of a variety of analytes across a wide range of concentrations. Read one
sample or up to 96 at a time. Use standard 96-well plates.

SpectraMax 190 features include:

e Full spectral range: 190 nm to 850 nm, tunable in 1 nm increments.

e Superior performance: 2 nm bandwidth provides exceptional accuracy and linearity for the
widest range of assays.

e PathCheck technology reports the plate data as standard 1 cm cuvette values.

e Newer models compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type

Endpoint Kinetic Spectrum

Absorbance (UV and Visible) v v v

See Read Modes and Read Types on page 267

SpectraMax 340PC384 Microplate Spectrophotometer

314

The SpectraMax® 340PC384 Microplate Spectrophotometer provides rapid and sensitive
measurements of a variety of analytes across a wide range of concentrations. You can run both
standard spectrophotometer and microplate reader applications on the same instrument. Read
one sample or up to 384 at a time. Use standard 96-well or 384-well plates.

SpectraMax 340PC384 features include:

e Full spectral range: 340 nm to 850 nm, tunable in 1 nm increments.

e Superior performance: 2 nm bandwidth provides exceptional accuracy and linearity for the
widest range of assays.

e PathCheck technology reports the plate data as standard 1 cm cuvette values.

e Newer models compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type

Endpoint Kinetic Spectrum

Absorbance \/ v’/ \/

See Read Modes and Read Types on page 267
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SpectraMax ABS Microplate Spectrophotometer

The SpectraMax® ABS Microplate Spectrophotometer allows you to run both standard
spectrophotometer and microplate reader applications on the same instrument. Read one
sample or up to 384 at a time. The SpectraMax ABS supports 96-well or 384-well plates.
SpectraMax ABS features include:

e Full spectral range: 190 nm to 1000 nm, tunable in 1 nm increments.

e Superior performance: 2 nm bandwidth provides exceptional accuracy and linearity for the
widest range of assays.

e Speed read mode: Reads 96-well plates in just 5 seconds and 384-well plates in 16
seconds for ultra-fast sample throughput.

e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type

Endpoint Kinetic Spectrum

Absorbance (UV and Visible) v v v

See Read Modes and Read Types on page 267

SpectraMax ABS Plus Microplate Spectrophotometer
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The SpectraMax® ABS Plus Microplate Spectrophotometer has a built-in cuvette port and plate
drawer that allow you to run both standard spectrophotometer and microplate reader
applications on the same instrument. Read one sample or up to 384 at a time. The SpectraMax
ABS Plus supports standard cuvettes or 96-well or 384-well plates.

SpectraMax ABS Plus features include:

e Full spectral range: 190 nm to 1000 nm, tunable in 1 nm increments.

e Superior performance: 2 nm bandwidth provides exceptional accuracy and linearity for the
widest range of assays.

e Speed read mode: Reads 96-well plates in just 5 seconds and 384-well plates in 16
seconds for ultra-fast sample throughput.

e PathCheck technology reports the plate data as standard 1 cm cuvette values.

e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type

Endpoint Kinetic Spectrum

Absorbance (UV and Visible) v v v

See Read Modes and Read Types on page 267
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SpectraMax i3 Multi-Mode Platform

The SpectraMax i3 Multi-Mode Platform is a monochromator-based, multi-mode detection
platform that supports user-installable detection cartridges to expand its read capabilities.
Each detection cartridge contains the light source, optics, and electrical components needed
to do specific read modes. Up to four detection cartridges can be installed in the detection
cartridge drawer.

Depending on the application, the instrument can read 6, 12, 24, 48, 96, and 384-well plates.
For micro-volume measurements, the instrument supports the SpectraDrop 24-well Low
Volume Microplate and the SpectraDrop 64-well Low Volume Microplate. With some
detection cartridges, the instrument can read 1536-well microplates.

SpectraMax i3 features include:

e Built-in, 2x2 monochromators for absorbance, fluorescence, and luminescence reads
e Top and bottom read capability

e More capabilities with detection cartridges

e Adjustable read height (Z-height) for top reads

e Up to 1536-well format with some detection cartridges

e Temperature control

e PathCheck technology

e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type ‘

Endpoint Kinetic Well Scan Spectrum Membrane ‘

Instrument Monochromator

Absorbance v v v v

Fluorescence Intensity v v v v

Luminescence v v v v

AlphaScreen 384 HTS, AlphaScreen 384 Std, and AlphaScreen 1536 HTS Detection Cartridges

Screen v v v’

Cisbio HTRF Detection Cartridge

TR-FRET v v v

Dual Color Luminescence (LUM) (BRET2) and Dual Color Luminescence (LUM) (Chroma-Glo) Detection Cartridge
Dual Wavelength Luminescence v/ \/ \/

Luminescence v v v

Fluorescence Intensity (FL) (coum-fluor), Fluorescence Intensity (FL) (fluor-rhod), Fluorescence Intensity (FL) (Cy3-
Cyb), Fluorescence Intensity (FL) (Cfp-Yfp), and Fluorescence Intensity GeneBLAzer Detection Cartridges

Fluorescence Intensity v v v

FRET v v v
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Read Mode Read Type ‘

Endpoint Kinetic Well Scan Spectrum Membrane ‘

Fluorescence Polarization (FP) (Fluorescein) and Fluorescence Polarization (FP) (Rhodamine) Detection Cartridges

Fluorescence Polarization 1/ \/

Glow Luminescence (LUM), Glow Luminescence (LUM) (96), and Glow Luminescence (LUM) (384) Detection Cartridges

Luminescence v/ v/ v"/

ScanLater Western Blot (WB) Detection Cartridge

Time-Resolved Fluorescence 1./

Time Resolved Fluorescence (TRF-EUSA) Detection Cartridge

Dual Wavelength Time-Resolved v v
Fluorescence

Time-Resolved Fluorescence \/ \o"’ \/

See Read Modes and Read Types on page 267 and Supported Detection Cartridges on page
343.
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SpectraMax i3x Multi-Mode Detection Platform

The SpectraMax i3x Multi-Mode Detection Platform is a monochromator-based, multi-mode
detection platform. The monochromator supports top reads for absorbance and luminescence
reads in addition to top or bottom reads for fluorescence intensity reads. You can install
detection cartridges in a detection cartridge drawer to expand the SpectraMax i3x read
capabilities. Each detection cartridge contains the light source, optics, and electrical
components needed to do specific read modes. You can install up to four detection cartridges
fortop reads.

The SpectraMax MiniMax 300 Imaging Cytometer adds imaging capability to the SpectraMax
i3x to visually inspect samples and to run cell-based assays at cellular or whole-cell resolution.
Depending on the application, the instrument can read 6, 12, 24, 48, 96, and 384-well plates.
For micro-volume measurements, the instrument supports the SpectraDrop 24-well Low
Volume Microplate and the SpectraDrop 64-well Low Volume Microplate. With some
detection cartridges, the instrument can read 1536-well microplates.

SpectraMax i3x features include:

e Built-in, 2x2 monochromators for absorbance, fluorescence, and luminescence reads
e Top and bottom read capability

e Adjustable read height (Z-height) for top reads

e Up to 1536-well format with some detection cartridges

e Temperature control

e PathCheck technology

e Compliance validation package see SpectraTest Validation Plates on page 338.

See Read Modes and Read Types on page 267 and Supported Detection Cartridges on page
343.

Read Mode Read Type ‘

Endpoint Kinetic Well Scan Spectrum Membrane ‘

Instrument Monochromator

Absorbance v v v v

Fluorescence Intensity v/ \/ \/ v/

Luminescence v v v v

AlphaScreen 384 HTS, AlphaScreen 384 Std, and AlphaScreen 1536 HTS Detection Cartridges

Screen v v v

Cisbio HTRF Detection Cartridge

TR-FRET v v v

Dual Color Luminescence (LUM) (BRET2) and Dual Color Luminescence (LUM) (Chroma-Glo) Detection Cartridge
Dual Wavelength Luminescence v v v

Luminescence v v v
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Read Mode Read Type

Endpoint Kinetic Well Scan Spectrum Membrane

Fluorescence Intensity (FL) (coum-fluor), Fluorescence Intensity (FL) (fluor-rhod), Fluorescence Intensity (FL) (Cy3-
Cyb), Fluorescence Intensity (FL) (Cfp-Yfp), and Fluorescence Intensity GeneBLAzer Detection Cartridges

Fluorescence Intensity \/ \/ \/

FRET v v v

Fluorescence Polarization (FP) (Fluorescein) and Fluorescence Polarization (FP) (Rhodamine) Detection Cartridges

Fluorescence Polarization v/ \/

Glow Luminescence (LUM), Glow Luminescence (LUM) (96), and Glow Luminescence (LUM) (384) Detection Cartridges
Luminescence \/ \/ \/

ScanlLater Western Blot (WB) Detection Cartridge

Time-Resolved Fluorescence \/

SpectraMax Injector Cartridge

Luminescence \/ \/’

Time Resolved Fluorescence (TRF-EUSA) Detection Cartridge

Dual Wavelength Time-Resolved v v
Fluorescence

Time-Resolved Fluorescence 1/ \/ \/

Transmitted Light (TL) Detection Cartridge with the SpectraMax MiniMax 300 Imaging Cytometer

Imaging

SpectraMax MiniMax 300 Imaging Cytometer

You can attach the SpectraMax MiniMax 300 Imaging Cytometer to the bottom of the
SpectraMax i3x to add imaging capability to visually inspect your sample and to run cell-based
assays at cellular or whole-cell resolution. The cytometer uses solid-state illumination, a digital
camera, a 4x objective lens, laser auto-focus, and auto-exposure to capture fluorescent or
label-free images of a sample at the bottom of the plate wells. The cytometer supports 96-
well and 384-well, flat-bottom, clear-bottom plates.

The measurement is primarily fluorescent with quantification of cell size, shape, area, and
intensity. Brightfield, transmitted light imaging supports label-free quantification. The camera
resolution in the SpectraMax MiniMax 300 Imaging Cytometer is sufficient to determine the
approximate shape of small 8 micron objects, such as blood cells.

The cytometer can use transmitted light and two fluorescent channels during the same plate
read to acquire image data. You can select the channels for the acquisition. The StainFree Cell
Detection Algorithm uses proprietary transmitted light analysis technology to eliminate cell
staining for cell counting and confluency measurements.

The SpectraMax Transmitted Light (TL) detection cartridge enables you to do brightfield
transmitted-light imaging. See Imaging - Transmitted Light Detection Cartridge on page 347.
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SpectraMax iD3 Multi-Mode Microplate Reader

The SpectraMax iD3 Multi-Mode Microplate Readeris a monochromator-based detection
platform. Use the instrument touchscreen interface to run protocols without a connected
computer. The SpectraMax iD3 can export results over your company intranet orto a computer
that is directly connected to the instrument for statistical data analysis. You must use the
SoftMax Pro Software to operate the instrument for protocols that use the injectors.

SpectraMax iD3 features include:

e Compatible with the StakMax Microplate Handling System
e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan Spectrum
Absorbance v v v v
Fluorescence Intensity v"’ \/ \/ \/
Luminescence v v v v

See Read Modes and Read Types on page 267

You can operate the instrument via the SoftMax Pro Software and the QuickSync Tool. See
Installing the QuickSync Tool on page 321.

% Note: When you operate the instrument via a computer running the SoftMax Pro
Software, the instrument touchscreen is disabled.

SpectraMax iD3 Considerations

When you use the SoftMax Pro Software to operate the SpectraMaxiD3, your company
network configuration could prevent the connection between the computer and the
instrument.
You can use the Ethernet cable to connect the computer directly to the instrument or you can
connect the SpectraMaxiD3 to your company intranet. You may have to perform the following
steps to select the instrument.

1. Onthe SpectraMaxiD3 instrument touchscreen, navigate to the Maintenance page System

Information tab and note the instrument IP address.

2. Inthe SoftMax Pro Software, click ﬂ to openthe Application menu.

3. Atthe bottom of the Application menu, click the Options button to display the SoftMax Pro
Options dialog.

4. Inthe list onthe left, click SpectraMax iDx Control.

5. Select the Enables Control of SpectraMax iDx Instruments check box.

6. Enterthe IP address of the instrument in one of the fields. There are five fields to enter up
to five IP addresses.

7. Click OK.

8. Selectthe Home tab and click Instrument to display the Instrument Connection dialog.
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9. Click Refresh if needed and the SpectraMax iD3 Instrument should appear. If the
instrument does not appear, you may have to work with your company network
administrator to confirm that your company network configuration permits the
communication between the computer and the instrument.

For users that use the SoftMax Pro Software - GxP edition the user must have the Lock/Unlock

Instrument permission to lock and unlock the instrument touchscreen. In the Ribbon on the GxP

tab, the following icons lock and unlock the instrument touchscreen:

e Click 'LQGXP Mode On to lock the instrument touchscreen and operate the instrument
from the computer running the SoftMax Pro Software in GxP mode. This locks the
instrument touchscreen for all users and you must operate the instrument from a computer
running the SoftMax Pro Software - GxP edition.

e Click ! GxP Mode Off to release the lock from the instrument touchscreen and allow
users to use the instrument touchscreen to run experiments.

% Note: The instrument remains locked until the user with the appropriate permission

clicks f"JGXP Mode Off to stop the GxP mode. You cannot use the Instrument
Connection dialog to disconnect from an instrument that is locked in GxP mode.

Installing the QuickSync Tool

When you use the SpectraMax iD3 and SpectraMax iD5, use the QuickSync tool to use the raw
data the instrument collects in the SoftMax Pro Software for further analysis.

The QuickSync Tool is a separate software application that you install and run on the computer

running the SoftMax Pro Software.

To install the QuickSync Tool:

1. Insert the SoftMax Pro Software installation medium into the computer slot or use
alternative media.

2. Locate and double-click QuickSynclinstaller.exe file to start the install.

3. Whenthe Do you want to allow this app to make changes to your computer? message
displays, click Yes. The installation starts.

4. Onthe Completing the Setup page, click Finish.

The QuickSync Toolicon appears on the computer desktop.

Using the QuickSync Tool

Use the QuickSync tool to use the raw data the SpectraMax iD3 and SpectraMax iD5 export for
further analysis. The QuickSync Tool software is a separate installation. See Installing the
QuickSync Tool on page 321.

The instrument acquires an IP address when you connect the instrument to your intranet. After
you synchronize the computer with the instrument, the instrument exports result data to the
computer for further analysis.

% Note: The microplate reader cannot have a USB flash drive in the USB slot below the
touchscreen.
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To use the QuickSync tool:

1.
2.

Use the instrument to run the read and leave the results displayed on the touchscreen.

On the computer running the SoftMax Pro Software, double-click the on the desktop or
in the task bar. A message appears that states QuickSync Ready!

Click A by the computer clock (Show Hidden Icons) to display a smaller version of the in
the computer tray.

Right-click in the tray to display a menu and select Available Services to display the list
of SpectraMax iD3 and SpectraMax iD5 instruments on your intranet and/or the instrument
to which you connect the computer through an Ethernet cable.

Close

Add Service by IP

Available Services

Open Last Result

Received Documents
Click the name of instruments to which to synchronize the computer. A check mark
appears next to each instrument name to which the computer is synchronized.

If the name of the instrument does not appear in the list of available services, right-click
and select Add Service by IP and enter the IP address of the instrument to which to
connect.

On the upper left of the instrument touchscreen, touch Export. The computer running the
SoftMax Pro Software displays a confirmation message.

On the computer running the SoftMax Pro Software, right-click and select Open Last
Result.

5049092 F



Chapter 7: Supported Instruments

SpectraMax iD5 Multi-Mode Microplate Reader
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The SpectraMax iD5 Multi-Mode Microplate Reader has a touchscreen interface that provides
integrated instrument control, data display, and the ability to export results over your network
for statistical data analysis.

There are several instrument configurations.

e Base includes filters for tunable fluorescence polarization read mode using the
monochromator and filters to measure europium and terbium using the time-resolved
fluorescence read mode.

e SpectraMax Injector System with Smartlnject (factory installed or by a Molecular Devices
field representative)

e Enhanced TRF Extension Module (you can install)

e Bottom Luminescence (factory installed)

% Note: The SpectraMax iD5 is certified for use with Cisbio Bioassays’ HTRF®
(Homogeneous Time-Resolved Fluorescence) technology. HTRF is a proprietary TR-
FRET technology.

SpectraMax iD5 features include:

e Compatible with the StakMax Microplate Handling System
e Compliance validation package see SpectraTest Validation Plates on page 338.

You can operate the instrument via the SoftMax Pro Software and the QuickSync Tool. See
Installing the QuickSync Tool on page 321.

Read Mode Read Type
Endpoint Kinetic Well Spectrum Membrane
Scan
Absorbance v v v v
Dual Wavelength Luminescence v v v
Fluorescence Intensity \/ 1/ \/ v/
Fluorescence Polarization v v
FRET v v v
Luminescence v v v
Time Resolved Fluorescence v v v’ v v
TR-FRET (Requires Enhanced v v v
TRF Module)

You must use a computer running the SoftMax Pro Software to operate the instrument for
injector protocols and the following read modes: FRET, TR-FRET, and Western Blot.

% Note: When you operate the instrument via a computer running the SoftMax Pro
Software, the instrument touchscreen is disabled.
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SpectraMax iD5 Considerations

When you use SoftMax Pro Software to operate the SpectraMaxiD5, your company network
configuration could prevent direct communication between the computer and the instrument.

You can use the Ethernet cable to connect the computer directly to the instrument or you can
connect the SpectraMax iD5 to your company intranet. You may have to perform the following
steps to select the instrument.

1.

On the SpectraMax iD5 instrument touchscreen, navigate to the Maintenance page
System Information tab and note the instrument IP address.

g

In the SoftMax Pro Software, click to openthe Application menu.

At the bottom of the Application menu, click the Options button to display the SoftMax Pro
Options dialog.

In the list on the left, click SpectraMax iDx Control.

Select the Enables Control of SpectraMax iDx Instruments check box.

Enter the IP address of the instrument in one of the fields. There are five fields to enter up
to five IP addresses.

Click OK.

Select the Home tab and click Instrument to display the Instrument Connection dialog.
Click Refresh if needed and the SpectraMax iD5 Instrument should appear. If the
instrument does not appear, you may have to work with your company network
administrator to confirm that your company network configuration permits the
communication between the computer and the instrument.

For users that use the SoftMax Pro Software - GxP edition the user must have the Lock/Unlock
Instrument permission to lock and unlock the instrument touchscreen. In the Ribbon on the GxP
tab, the following icons lock and unlock the instrument touchscreen:

e Click @GXP Mode On to lock the instrument touchscreen and operate the instrument

from the computer running the SoftMax Pro Software in GxP mode. This locks the
instrument touchscreen for all users and you must operate the instrument from a computer
running the SoftMax Pro Software - GxP edition.

Click ngP Mode Off to release the lock from the instrument touchscreen and allow
users to use the instrument touchscreen to run experiments.

% Note: The instrument remains locked until the user with the appropriate permission

clicks QGXP Mode Off to stop the GxP mode. You cannot use the Instrument
Connection dialog to disconnect from an instrument that is locked in GxP mode.

5049092 F



Chapter 7: Supported Instruments

SpectraMax L Luminescence Microplate Reader

The SpectraMax L Luminescence Microplate Reader is a high-performance microplate reader
that measures luminescence in 96 and 384-well plates. When the instrument is equipped with
the variable-volume injectors option, it can measure both flash and glow luminescence.

e 96-well Standard plates - 10 pL to 200 pL

e 384-well and 96-well half area plates - 10 pL to 80 pL
High-precision peristaltic pumps ensure precise injection volumes and rapid sample mixing.
Continuous monitoring between injection and measurement provides for extremely fast
reactions and reduced delay time.
Optional multiple photomultiplier tubes (PMTs) and multiple injector configurations allow
increased throughput and wavelength-dependent assays such as BRET1 and BRET2.
The extreme flexibility and high sensitivity of the instrument makes it ideal for applications
within the fields of biochemistry, cell biology, immunology, molecular biology, and
microbiology. Typical applications include luciferase reporter gene, ATP, Ca2+, aequorin, and
ELISAs.
The instrument can accommodate SBS-standard 96 and 384-well plates with dimensions of
128.2 mm long, 86.0 mm wide, and heights from 14 mm to 15 mm.
In the SoftMax Pro Software, the SpectraMax L has a unique set of icons on the Ribbon and a
unique set of settings in the Settings dialog.

SpectraMax L features include:

e Greaterthan nine orders of dynamic range

e Reads both 96 and 384-well plates

e Dual injection into both 96 and 384-well plates

e Programmable injection speeds

e AutoWash flush of tubing and tips when the instrument is turned off

e | andscape and portrait plate orientation

e Optional dual PMT configuration with filter positions for instrument wavelength dependent
assays such as BRET

e Optional dual PMT configuration for higher throughput

e Optional injectors up to four injectors

e |sothermal temperature control in the plate chamber

e Optional barcode readerto read labels on plates

e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Dual Read Endpoint Kinetic Fast Kinetic
Dual Wavelength Luminescence \/ »/ v/ \/
Luminescence v v v v

See Read Modes and Read Types on page 267
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SpectraMax L Ribbon

The SpectraMaxL has a unique set of icons on the Ribbon. For a description of each setting,
see the SoftMax Pro Software application help.

Home Tab

Simulator Configuration - When you operate a SpectraMax L in Offline or Simulator mode,
use the Simulator Configuration dialog o define the instrument configuration for simulated
protocols. You can use offline and simulator mode to define protocols that you save for
use later. The settings for the protocols you save must be compatible with the instrument
configuration of the instrument on which you intend to run the protocol.

Instrument Configuration - When you connect the computer to the instrument, use the
Instrument Configuration dialog o view the instrument components that are available for
protocol settings.

Operations Tab

Click Calibration to display the Calibration dialog. Use the Calibration dialog o calibrate the
internal light emitting diodes and do custom multi-PMT normalization plate calibration.
Click Wash Injectors to display the Wash Injectors dialog. Use the Wash Injectors dialog to
wash the injectors.

Click Prime Injectors to display the Prime Injectors dialog. Use the Prime Injectors dialog
to prime the injectors.

Click Reverse Injectors to display the Reverse Injectors dialog. Use the Reverse Injectors
dialog to recover the reagent from the injector tubing.

Click Injector Tubing to display the Injectors Pump Tubing dialog where you to determine
when to replace injector tubing. Use the Injectors Pump Tubing dialog to view whenit is
time to replace the injector tubing.

Click Change Aperture to change the plate drawer aperture from 96-well plates to 384-
well plates or vice-versa. The instrument configuration has either a manual aperture oran
automatic aperture. For the manual configuration you must use the Change Aperture
command when you switch plate formats. The command instructs the reader to check
whether a plate is in the drawer. If no plate is present, the plate carriage moves away from
the read head to allow you to manually change the aperture. See the SpectraMax L User
Guide for instructions to manually change the aperture.

Click Shake Settings to display the Shake Plate Settings dialog. Use the Shake Plate
Settings dialog to custom define how to shake a plate. This shake processisindependent
of a protocol. When you create a protocol, use the Settings dialog to define how to shake
the plate as part of the protocol.

SpectraMax L Protocols

The SpectraMax L instrument has multiple hardware configurations and the instrument
configuration determines which read modes and read types are available.

When you operate the instrument Offline or Simulator mode, you define the instrument
configuration from the Simulator Configuration icon on the Home tab.

When you connect the computer to the instrument, you can view the instrument hardware
components from the Instrument Configuration icon on the Home tab.
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Read Modes
The instrument hardware configuration determines which read modes are available.
e Lumi(Luminescence): For all instrument configurations you can select the Lumi read mode.

When the instrument has two PMTs and no filters, the instrument runs Lumi protocols that
use both PMTs to read 2 wells simultaneously and it assumes the reads of the PMTs are
comparable.

Lumi2W (Luminescence Dual Wavelength): When the instrument has two PMTs and the
PMTs are equipped with filters you can select the Lumi2W read mode to use the PMTs
one at a time to detect the two different wavelengths.

Read Types
For all instrument configurations, the following read types are available:

e Endpoint: A read of each well is taken in the center of each well, either at all wavelengths if

filters are not used, or at specific wavelengths if filters are used. Raw data values are
reported as relative light units (RLU). Each well can receive up to two injections, and then is
read once. You can set a delay time after each injection, from O to 3,600 seconds for the
M-injection, and from 0.1 to 3,600 seconds for the P-injection.

Dual Read: Each well receives two injections, each followed by a read. The first injection is
the P-injection with a subsequent read. The second injection is the M-injection with a
subsequent read. You can set a delay time between injection and read, from 0.1 to 3,600
seconds for the P-injection, and from O to 3,600 seconds for the M-injection.

Kinetic: The instrument collects data over time with multiple reads taken in the center of
each well at regular intervals. Each well can receive multiple injections and reads. You can
specify single injections, followed by single reads, for multiple time points. The minimum
integration interval is dependent on the number of wells you select, the integration time
you select, and the number of injections you select.

Fast Kinetic: The instrument performs repeated reads of one or more wells up to a 200
point maximum integration. All reads of a single well are made before the next well is read.
You cannot pre-read a plate with the Fast Kinetic read type. You can specify multiple
injections and multiple reads, for multiple times. Integration time can be set from 0.01to
3600 seconds.

For a description of each setting, see the SoftMax Pro Software application help.
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SpectraMax M2 Multi-Mode Microplate Reader

The SpectraMax M2 Multi-Mode Microplate Reader contains two monochromators and dual-
mode cuvette ports. Area-well scanning read types and the PathCheck technology let
homogeneous and heterogeneous plate assays be done in one flexible system.

SpectraMax M2 features include:

e Dual-mode cuvette port

e Two monochromators

e PathCheck technology and well volume sensors

e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan Spectrum
Absorbance (UV and Visible) v v v v
Fluorescence Intensity v v v v
Luminescence v v’ v v
Time-Resolved Fluorescence v v v v

See Read Modes and Read Types on page 267

SpectraMax M2e Multi-Mode Microplate Reader

The SpectraMax M2e Multi-Mode Microplate Reader contains two monochromators, dual-
mode cuvette ports, and top-plate and bottom-plate read capability. Area-well scanning read
types and the PathCheck technology let homogeneous and heterogeneous plate assays be
done in one flexible system.

SpectraMax M2e features include:

e Top-read and bottom-read

e Dual-mode cuvette port

e Two monochromators

e PathCheck technology and well volume sensors

e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan Spectrum
Absorbance (UV and Visible) v v v v
Fluorescence Intensity 1/ \/ 1/ t/
Luminescence v v v v
Time-Resolved Fluorescence v v v v

See Read Modes and Read Types on page 267
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SpectraMax M3 Multi-Mode Microplate Reader

The SpectraMax M3 Multi-Mode Microplate Reader is a modular, dual-monochromator
microplate reader platform that offers a wide range of high performance multi-mode
capabilities ideal for life science research and drug discovery screening.

SpectraMax M3 features include:

e Three-mode cuvette port for assay development

e Dual monochromator tunability

e Temperature control

e PathCheck technology

e Compliance validation package see SpectraTest Validation Plates on page 338.
e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan Spectrum
Absorbance (UV and Visible) v v v v
Fluorescence Intensity \/ v’/ \/ \/
Luminescence v v v v

See Read Modes and Read Types on page 267

SpectraMax M4 Multi-Mode Microplate Reader

5049092 F

The SpectraMax M4 Multi-Mode Microplate Reader is a modular, dual-monochromator
microplate reader platform that offers a wide range of high performance multi-mode
capabilities ideal for life science research and drug discovery screening.

SpectraMax M4 features include:

e Three-mode cuvette port for assay development

e Dual monochromator tunability

e Temperature control

e Plate shake

e PathCheck technology

e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan Spectrum
Absorbance (UV and Visible) v v v v
Fluorescence Intensity v/ \/ v/ v/
Luminescence v v v v
Time-Resolved Fluorescence v v v v

See Read Modes and Read Types on page 267

329



SoftMax Pro Software User Guide

SpectraMax M5 Multi-Mode Microplate Reader

The SpectraMax M5 Multi-Mode Microplate Reader is a dual-monochromator microplate
reader platform that offer a wide range of high performance multi-mode capabilities ideal for
life science research and drug discovery screens.

SpectraMax M5 features include:

e Three-mode cuvette port for assay development

e Dual monochromator tunability

e PathCheck technology

e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan Spectrum
Absorbance (UV and Visible) v v v v
Fluorescence Intensity v v v v
Fluorescence Polarization v v
Luminescence v v v v
Time-Resolved Fluorescence v v v v

See Read Modes and Read Types on page 267

SpectraMax M5e Multi-Mode Microplate Reader
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The SpectraMax M5e Multi-Mode Microplate Reader is a dual-monochromator microplate
reader platform that offer a wide range of high performance multi-mode capabilities ideal for
life science research and drug discovery screens.

SpectraMax M5e features include:

e Three-mode cuvette port for assay development

e Dual monochromator tunability

e PathCheck technology

e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type
Endpoint Kinetic Well Scan Spectrum
Absorbance (UV and Visible) v v v v
Fluorescence Intensity v/ \/ v/ v/
Fluorescence Polarization v v
Luminescence v v v v
Time-Resolved Fluorescence v v v v

See Read Modes and Read Types on page 267
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SpectraMax Paradigm Multi-Mode Microplate Reader

Read Mode

The SpectraMax Paradigm Multi-Mode Microplate Reader is a modular multi-mode microplate
reader. User-installable detection cartridges let you configure the microplate reader for
specific applications, and the cartridges expand the capabilities of the microplate reader. The
detection cartridges you install define the measurement capabilities of the microplate reader.
You can install up to six detection cartridges in each of the two detection cartridge drawers of
the SpectraMax Paradigm.

Most detection cartridges start with an excitation energy source either in the form of long-life,
high-powered LED, a xenon flash lamp, or a laser diode. By concentrating the excitation
energy on the sample through label-specific optics, high levels of sensitivity and performance
are reached.

SpectraMax Paradigm features include:

e Array of detection cartridge capabilities
e Automatic read height (Z-height) optimization for both top and bottom read

e |ED intensity adjustment

e Up to 1536-well format

e Temperature control

e Monochromator and filter based options available

e PathCheck technology

e AlphaScreen

e Compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.
Read Type
Well Scan

Kinetic Membrane

Endpoint

Absorbance Detection Cartridge

Spectrum

Absorbance

v v v v

AlphaScreen 384 HTS, AlphaScreen 384 Std, and AlphaScreen 1536 HTS Detection Cartridges

Screen v v v
Cisbio HTRF Detection Cartridge
TR-FRET v v v

Dual Color Luminescence (LUM) (BRET2) and Dual Color Luminescence (LUM) (Chroma-Glo) Detection Cartridge

Dual Wavelength Luminescence

v v v

Luminescence

v v v

Fluorescence Intensity (FL) (coum-fluor), Fluorescence Intensity (FL) (fluor-rhod), Fluorescence Intensity (FL) (Cy3-
Cyb), Fluorescence Intensity (FL) (Cfp-Yfp), and Fluorescence Intensity GeneBLAzer Detection Cartridges

Fluorescence Intensity \/ \/ \/
FRET v v v
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Read Mode

Endpoint

Kinetic

Read Type
Well Scan

Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection Cartridge

Membrane ‘

Spectrum

Dual Wavelength Fluorescence v v v

Intensity

Fluorescence Intensity »/ \/ \/

FRET v v v

Fluorescence Polarization (FP) (Fluorescein) and Fluorescence Polarization (FP) (Rhodamine) Detection Cartridges
Fluorescence Polarization v v

Glow Luminescence (LUM), Glow Luminescence (LUM) (96), and Glow Luminescence (LUM) (384) Detection Cartridges
Luminescence v v v

Multi-Mode (MULTI) Detection Cartridge

Fluorescence Intensity v v v

Luminescence v v v

Time-Resolved Fluorescence v v v

ScanLater Western Blot (WB) Detection Cartridge

Time-Resolved Fluorescence v
Time Resolved Fluorescence (TRF-EUSA) Detection Cartridge

Dual Wavelength Time-Resolved v v

Fluorescence

Time-Resolved Fluorescence v v v

Tunable Wavelength (TUNE) Detection Cartridge

Fluorescence Intensity v v v v

Luminescence v v v v

Time-Resolved Fluorescence v v v v

See Read Modes and Read Types on page 267 and Supported Detection Cartridges on page

343.

Removing Software Locks

At this point you have removed the physical transport locks, installed the SoftMax Pro
Software, connected the cables, and powered on the instrument. As a safety precaution, the
SoftMax Pro Software controls internal locks to prevent the drawers from opening until the
software detects and initializes the instrument.

CAUTION! The instrument can be damaged if you do not remove all physical transport
locks before you use the software to unlock the drawers and initialize the instrument.
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% Note: Do not install detection cartridges into the instrument until after you complete the
following instructions to unlock the drawers and initialize the instrument.

To remove the software locks and initialize the instrument:

1. If the Standby button on the front lower-right corner of the instrument is illuminated, press
the Standby button to take the instrument out of standby mode.
The LEDs on the status panel flash and turn off, and then the amber LED turns on to
indicate that the instrument drawers are locked.

2. Start the SoftMax Pro Software. See Starting the Software on page 9.
The amber LED on the status panel turns off and the green LED turns on to indicate a
successful connection between the instrument and the computer.

3. Afterthe computer and the instrument successfully connect, the Instrument Unlocking
Procedure wizard displays.

4. If the Instrument Unlocking Procedure wizard does not display, use the Instrument
Connection dialog to select and connect to the instrument. See Selecting an Instrument on
page 63.

% Note: If the instrument does not appear in the Available Instruments list in the
Instrument Connections dialog, click Refresh above the list.

5. Follow the prompts in the Instrument Unlocking Procedure wizard to unlock the drawers
and initialize the instrument.

After you complete the Instrument Unlocking Procedure wizard, the instrument does an
initialization procedure that moves the optics and plate drawers to home positions. The green
LED on the status panel turns on, the amber LED flashes and turns off, and then the green LED
remains on. You can now install detection cartridges in the instrument. See "Installing Detection
Cartridges" inthe SpectraMax Paradigm Multi-Mode Microplate Reader User Guide.

To lock the drawers for shipment, use the Instrument Information dialog. See Instrument
Information on page 341.

333



SoftMax Pro Software User Guide

SpectraMax Plus 384 Microplate Spectrophotometer

The SpectraMax Plus 384 Microplate Spectrophotometer has a built-in cuvette port and plate
drawer. You can run both standard spectrophotometer and microplate reader applications on
the same instrument. Read one sample or up to 384 at a time. Use a standard cuvette,

12 x 75 mm test tube, or 96-well or 384-well plates. For more sample throughput, the you can
integrate the SpectraMax Plus 384 into a full robotic system.

SpectraMax Plus 384 features include:

e Full spectral range: 190 nm to 1000 nm, tunable in 1 nm increments.

e Superior performance: 2 nm bandwidth provides exceptional accuracy and linearity for the
widest range of assays.

e Speed read mode: Reads 96-well plates in just 5 seconds and 384-well plates in 16
seconds for ultra-fast sample throughput.

e PathCheck technology.

e Newer models compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type

Endpoint Kinetic Spectrum

Absorbance (UV and Visible) v v v

See Read Modes and Read Types on page 267

VersaMax Microplate Spectrophotometer

334

The VersaMax Microplate Spectrophotometer provides rapid and sensitive measurements of
a variety of analytes across a wide range of concentrations. You can run both standard
spectrophotometer and microplate reader applications on the same instrument. Read one
sample or up to 96 at a time. Use standard 96-well plates.

VersaMax features include:

e Full spectral range: 340 nm to 850 nm, tunable in 1 nm increments.

e Superior performance: 2 nm bandwidth provides exceptional accuracy and linearity for the
widest range of assays.

* Newer models compatible with the StakMax Microplate Handling System.

e Compliance validation package see SpectraTest Validation Plates on page 338.

Read Mode Read Type

Endpoint Kinetic

Absorbance 1/ \/

See Read Modes and Read Types on page 267
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VMax Kinetic Microplate Reader
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The VMax Kinetic Microplate Reader measures optical density (OD) and can do a kinetic
analysis, the rate of optical density change per minute (milliOD/min). The optical array is
designed to analyze the absorbance of multiple sample sites with 9 mm centers. Read one
sample or up to 96 at a time. Use standard 96-well plates.

VMax features include:

e Filterrange: 400 nm to 750 nm
e Filter capacity: 6
e Optical density: single wavelength and dual wavelength

Read Mode Read Type

Endpoint Kinetic
Absorbance \/ \/

See Read Modes and Read Types on page 267
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StakMax Microplate Handling System
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The StakMax Microplate Handling System is an integrated microplate handler for use with
Molecular Devices® microplate readers to provide simple, powerful, walk-away benchtop
automation.

Access the SoftMax Pro Software from the Operations tab in the SoftMax Pro Software. When
you click Plate Stacker, the SoftMax Pro Software enters automation mode. The StakMax
Software starts and connects to the StakMax Microplate Handler. The microplate handler
status displays in the Status line in the StakMax Software dialog.

f;# Stakhax = = I.Ealﬂ
Molecular

Devices StakMax
’ Load Plate ] [ Restack, .. ] [ Fesek ] _

’Eeturn F'Iate] ’ DiErma. .. ] ¢ Scripting.., 4 Stop Read

Ernergency Stop

[ always on Top

Status: StakMax connected

Eﬁl [.ﬁ.liggment... ] [ Help ] ’ Status Wwindoo ]

To exit the SoftMax Pro Software, click Done and then click Terminate in the SoftMax Pro
Software Automation dialog.

% Note: When you use the SoftMax Pro Software - GxP edition, StakMax specific
commands and scripts are not tracked in the audit trail and do not have user permission
settings. Please implement standard work as required by your organization.

Compatible Instruments
The StakMax Microplate Handling System is compatible with the following instruments:

e Gemini™ EM Dual Scanning Microplate Spectrofluorometer
e Gemini™ XPS Dual Scanning Microplate Spectrofluorometer
e SpectraMax® ABS Microplate Spectrophotometer

e SpectraMax® ABS Plus Microplate Spectrophotometer

e SpectraMax® i3x Multi-Mode Detection Platform

e SpectraMax® iD3 Multi-Mode Microplate Reader

e SpectraMax® iD5 Multi-Mode Microplate Reader

e SpectraMax® L Luminescence Microplate Reader

e SpectraMax® M2 Multi-Mode Microplate Reader

e SpectraMax® M2e Multi-Mode Microplate Reader

e SpectraMax® M3 Multi-Mode Microplate Reader

e SpectraMax® M4 Multi-Mode Microplate Reader

e SpectraMax® M5 Multi-Mode Microplate Reader
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e SpectraMax® M5e Multi-Mode Microplate Reader

e SpectraMax® Paradigm® Multi-Mode Microplate Reader
Newer models of the following instruments are compatible with the StakMax Microplate
Handling System:

e SpectraMax® 190 Microplate Spectrophotometer (Serial number begins with NNR)
SpectraMax® 340PC384 Microplate Spectrophotometer (Serial number begins with LNR)
SpectraMax® Plus 384 Microplate Spectrophotometer (Serial number begins with MNR)
e VersaMax" Microplate Spectrophotometer (Serial number begins with BNR)

For more information, see the StakMax Microplate Handling System User Guide or the help
available in the StakMax Software.
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SpectraTest Validation Plates

Molecular Devices microplate readers are designed to provide consistent performance for
many years. Use the SpectraTest Validation Plates from Molecular Devices to validate the
optical performance your instrument.

Each SpectraTest Validation Plate is a comprehensive optical validation package. The
American Association for Laboratory Accreditation (A2LA) has granted accreditation to the
Laboratory Quality System underISO/IEC 17025 for validation plate calibration and re-
calibration processes.

The SoftMax Pro Software Protocol Library includes instrument specific protocols that
automatically read the validation plate, perform the required test measurements, and make the
required calculations. The software also enables you to customize the test report format.

Validation Packages Part Numbers

Part
Number

0200-6117

Item Name

SpectraTest ABS1
Absorbance
Validation Plate

Compatible Instruments

FlexStation 3, SpectraMax 190, SpectraMax 340PC384, SpectraMax ABS,
SpectraMax ABS Plus, SpectraMax i3, SpectraMax i3x, SpectraMax iD3, SpectraMax
iD5, SpectraMax M2, SpectraMax M2e, SpectraMax M3, SpectraMax M4, SpectraMax
M5, SpectraMax M5e, SpectraMax Plus 384, VersaMax

0200-6191

SpectraTest ABS2
Absorbance
Validation Plate

FlexStation 3, SpectraMax ABS, SpectraMax ABS Plus, SpectraMax i3, SpectraMax
i3x, SpectraMax iD3, SpectraMax iD5, SpectraMax M2, SpectraMax M2e, SpectraMax
M3, SpectraMax M4, SpectraMax M5, SpectraMax M5e, SpectraMax Plus 384

0200- SpectraTest FL1 FlexStation 3, Gemini EM, Gemini XPS, SpectraMax i3, SpectraMax i3x, SpectraMax
5060 Fluorescence iD3, SpectraMax iD5, SpectraMax M2, SpectraMax M2e, SpectraMax M3,
Validation Plate SpectraMax M4, SpectraMax M5, SpectraMax Mb5e
0200- SpectraTest LM1 FlexStation 3, SpectraMax i3, SpectraMax i3x, SpectraMax iD3, SpectraMax iD5,
6186 Luminescence SpectraMax L, SpectraMax M3, SpectraMax M4, SpectraMax M5, SpectraMax M5e
Validation Plate
0200- Cuvette Absorbance | SpectraMax ABS Plus, SpectraMax M2, SpectraMax M2e, SpectraMax M3,
2420 Validation Set SpectraMax M4, SpectraMax M5, SpectraMax M5e, SpectraMax Plus 384
0200- Multi-Mode FilterMax F3, FilterMax F5, SpectraMax i3*, SpectraMax i3x*, SpectraMax iD5*,
7200 Validation Plate SpectraMax Paradigm

* Specific read modes or cartridges.
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Appendix A: Maintaining and Calibrating Instruments

The user guide for each instrument describes instrument maintenance.

Instrument Calibration

Use the Calibration dialog to have the instrument step through all available wavelengths one-

by-one to measure the signal that reaches the detector when there is no sample in the optical
path.

The Operations tab contains a Calibration icon when the instrument supports the air calibration
process.

Note: Air-calibration applies to absorbance reads. You do not need a plate or cuvette
forinstrument calibration. The cuvette chamber must be empty for a cuvette calibration.

The software calculates air-calibration values and stores these values in the firmware. The
instrument uses the stored air-calibration values when you use Speed Read and when the
Calibrate iconis disabled in the Settings dialog. See Speed Read Settings on page 125 and
Calibrate on page 141.

1. Select the Operations tab and click Calibration to display the Calibration dialog.

2. Select Plate to calibrate for plates and/or select Cuvette to calibrate for cuvettes.

3. Click Calibrate Now.

4. When the calibration indicator shows that the calibration is complete, click Close.

Calibrating SpectraMax L Instruments
For the SpectraMax L instrument, do the following for calibration.
Calibrate the instrument once a year for maximum performance. Select the Operations tab and
click Calibration to display the Calibration dialog. There are two calibration methods:
e Select Internal Light Emitting Diodes to calibrate using the instrument’s onboard LEDs. This
method does not require sample preparation.
e Select Custom Multi-PMT Normalization Microplate when the instrument has multiple

PMTs and you want to use the light spectrum from your own assays to calibrate the
instrument, rather than the light spectrum from the factory configured LEDs.

Calibrate with Internal Light Emitting Diodes
To calibrate the internal light emitting diodes:

1. Remove any plate from the plate drawer.

2. Select the Operations tab and click Calibration to display the Calibration dialog.
3. Selectthe Internal Light Emitting Diodes Calibration Method option.

4. Click OK. Calibration is done automatically.
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Custom Multi-PMT Normalization Microplate

Create your own custom calibrations if you prefer to calibrate using the light spectrum from
your assays rather than the light spectrum from the factory configured LEDs. Custom
calibrations are used from the Settings dialog in the Sensitivity category. See SpectraMax L
Protocols on page 326.

There are two different PMT Calibration Factor options:

e Select Auto Calculation to use your own assay materials for calibration, but you want the
software to automatically calculate a PMT calibration factor.

e Select Manual Set to use your own assay materials for calibration, and you want to
manually calculate the PMT calibration factor based on the signal obtained from each
PMT.

Auto Calculation
Use this option to use your own assay materials for calibration and have the software
automatically calculate a PMT calibration factor.

1. Remove any plate from the plate drawer.

2. Select the Operations tab and click Calibration to display the Calibration dialog.

3. Select the Custom Multi-PMT Normalization Microplate Calibration Method option.

4. Click the Custom Calibration # drop-down and select the custom calibration to define. You

can define two different custom calibrations.

Select the Auto-Calculation PMT Calibration Factor option.

6. Inthe Dark Adapt Delay field, enter the number of seconds to enable the sample to adapt
to the dark interior of the plate drawer before the calibration starts. This allows the plate
autophosphorescence to subside.

7. Click OK.

8. A message displays to tell you to insert a 96-well plate into the instrument with material of
greater than 100k RLU in wells B2, G2, B11, and G11. After you insert the plate, click OK.

ol

Manual Set
Use this option to use your own assay materials for calibration and manually calculate the PMT
calibration factor based on the signal obtained from each PMT. You can read all or part of a
plate that contains your assay material (should be greater than 100k RLU) to determine these
values and then determine a factor, or multiplier, for each PMT that equalizes the RLU values
foreach PMT.
1. Select the Operations tab and click Calibration to display the Calibration dialog.
2. Select the Custom Multi-PMT Normalization Microplate Calibration Method option.
3. Click the Custom Calibration # drop-down and select the custom calibration to define. You
can define two different custom calibrations.
4. Selectthe Manual Set PMT Calibration Factor option.
5. Enterthe values for each available PMT from your calculations. Available fields are
dependent the instrument configuration.
6. Click OK.
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Instrument Information
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The Instrument Information dialog lists the PIC firmware version, the instrument firmware
version, the instrument serial number, and the automation device number for the FilterMax F3,
FilterMax F5, SpectraMax i3, SpectraMax i3x, SpectraMax iD3, SpectraMax iD5, and
SpectraMax Paradigm. To update the PIC or instrument firmware, click the Update button. For
more information about how to update firmware, contact Molecular Devices support.

To view the Instrument Information dialog, on the Operations tab in the ribbon click Info.

SpectraMax i3 and SpectraMax i3x
The software discovers the installed detection cartridges and displays them in the Instrument

Information dialog. The name and serial number for the detection cartridge displays under its
position in the drawer.

To open or close the detection cartridge drawer, click |-_‘| to the left of the detection
cartridge definitions for the drawer.

SpectraMax Paradigm

The software discovers the installed detection cartridges and displays them in the Instrument
Information dialog. The name and serial number for the detection cartridge displays under its
position in the drawer.

3 |

To open or close a detection cartridge drawer, click|
definitions for that drawer.

to the left of the detection cartridge

You canlock or unlock the detection cartridge drawers when you use the StakMax Microplate
Handling System:

e When the microplate handler is installed, the detection cartridge drawers must be locked.
To lock the cartridge drawers, click Lock Drawers for StakMax.

e Whenyou need to open a detection cartridge drawer, remove the microplate handler
from the detection platform and then unlock the drawers. To unlock the cartridge drawers,
click Unlock Drawers for StakMax.

For more information, see the user guide for the StakMax Microplate Handling System.

To lock all drawers closed, click Lock Instrument for Shipment and follow the on-screen
instructions. To prepare an instrument for shipment, contact Molecular Devices support.

For information about how to unlock the drawers, see Removing Software Locks on page 332.

To align the transfer position of the StakMax Microplate Handling System with the plate drawer
of the SpectraMax Paradigm, click StakMax Alignment Wizard. For how to use the StakMax
Alignment wizard, see the StakMax Microplate Handling System User Guide.

FilterMax F3, FilterMax F5, and SpectraMax iD5

The software discovers the installed excitation and emission filter slides and displays their
configurations in the Instrument Information dialog. The identification number for the slide
displays on the right. Each filter displays its wavelength, bandwidth, and read mode under its
position in the slide.

3 |

For the FilterMax F3 and FilterMax F5, click| to the left of the slide definition to eject or
retract a filter slide. To edit the filters in a slide, or to define more slides, click Edit Slide
Configuration. See Configuring Filter Slides on page 308.
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Appendix B: Supported Detection Cartridges

The SpectraMax i3x supports user-installable detection cartridges for top reads and the
SpectraMax Paradigm requires detection cartridges to do reads. Each detection cartridge
contains the light source, optics, and electrical components needed to do specific read
modes for some applications.

The SoftMax Pro Software supports the following detection cartridges:

e Absorbance Detection Cartridge, see page 343

e AlphaScreen Detection Cartridges, see page 344

e Fluorescence Intensity Detection Cartridges, see page 344

e Fluorescence Polarization Detection Cartridges, see page 346

e FRET Detection Cartridges, see page 346

e | uminescence Detection Cartridges, see page 347

e ScanlLater Western Blot Detection Cartridge, see page 348

e SpectraMax Injector Cartridge, see page 349

e Time Resolved Fluorescence Detection Cartridges, see page 350

e |maging - Transmitted Light Detection Cartridge, see page 347
For detailed cartridge specifications, see the SpectraMax i3x Multi-Mode Detection Platform
User Guide orthe SpectraMax Paradigm Multi-Mode Microplate Reader User Guide.

Contact Molecular Devices to have custom detection cartridges designed to meet the specific
needs of your application.

Absorbance Detection Cartridge

The Absorbance detection cartridge is for the SpectraMax Paradigm only and combines
wavelength scanning and a broad spectrum wavelength range necessary to address nucleic
acid, protein quantitation, ELISA, immunoassay, and proliferation/viability applications.
The cartridge uses a monochromator and has two components. You must install both
components:
e The detection component (ABS-DET) measures the absorbance. Install this component in
one slot in the top cartridge drawer.
e The excitation component (ABS-MONO) sets the absorbance wavelengths. Install this
component in two slots in the bottom cartridge drawer.
The cartridge supports the following read types:

e Endpoint Read Type, see page 267
e Kinetic Read Type, see page 268

e Well Scan Read Type, see page 269
e Spectrum Read Type, see page 269

5049092 F 343



SoftMax Pro Software User Guide

AlphaScreen Detection Cartridges

There are three AlphaScreen® Detection Cartridges that use a 680 nm laser diode to provide a
sensitive read system for AlphaScreen assays. The design isolates each well and provides the
optimal performance for AlphaScreen assays. These cartridges also capture the Europium
emission line of AlphaLISA®.

The following AlphaScreen detection cartridges are available:

e AlphaScreen 384 Std Detection Cartridge

e AlphaScreen 384 HTS Detection Cartridge

e AlphaScreen 1536 HTS Detection Cartridge
Each cartridge occupies one slot in the cartridge drawer. For the SpectraMax Paradigm you
can install it in either cartridge drawer (top for top reads or bottom for bottom reads) but it
cannot occupy the rear-most slot. For best results, you should install the cartridge in the top
drawer.
These cartridges support the following read types:

e Endpoint Read Type, see page 267
e Kinetic Read Type, see page 268
e Well Scan Read Type, see page 269

ALPHASCREEN and ALPHALISA are registered trademarks of PerkinElmer, Inc.

Fluorescence Intensity Detection Cartridges

The following Fluorescence Intensity (Fl) detection cartridges use an ultra-high power LED for
the excitation of various fluorescent labels for the fluorescence intensity read mode. The
standard dual-emission design provides simple, straightforward fluorescence resonance
energy transfer (FRET) measurement. These cartridges occupy one slot in the cartridge
drawer.

e Fluorescence Intensity (Fl) (coum-fluor) Detection Cartridge

e Fluorescence Intensity (FI) (fluor-rhod) Detection Cartridge

e Fluorescence Intensity (FI) (Cy3-Cy5) Detection Cartridge

e Fluorescence Intensity (FI) (Cfp-Yfp) Detection Cartridge

Fluorescence Intensity (FI) GeneBLAzer Detection Cartridge

The Fluorescence Intensity (FI) GeneBLAzer detection cartridge is designed for use with
GeneBLAzer assays from Invitrogen. The standard dual-emission design provides
Fluorescence Resonance Energy Transfer (FRET) measurement. This cartridge occupies one
slot in the cartridge drawer.

Multi-Mode (MULTI) Detection Cartridge

The Multi-Mode (MULTI) detection cartridge is for the SpectraMax Paradigm only and supports
several read modes including fluorescence intensity. This cartridge is optimized for 96-well
and 384-well plates. It occupies three slots in either cartridge drawer (top drawer for top reads
and bottom drawer for bottom reads).

This cartridge also supports the following read modes:

e Time-Resolved Fluorescence Read Mode, see page 283
e | uminescence Read Mode, see page 280
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Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection Cartridge
The Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) detection cartridge uses ultra
high-powered LEDs for the excitation of a dual set of fluorescent labels. This cartridge is for the
SpectraMax Paradigm only and occupies one slot in either cartridge drawer (top drawer for top
reads and bottom drawer for bottom reads).
This cartridge is optimized for detection of the label set used in the MultiTox-Fluor Multiplex
Cytotoxicity Assay from Promega:

e AFC (amino-fluorocoumarin)

®* R110 (rhodamine 110)

The cartridges listed above support the following read types:

e Endpoint Read Type, see page 267

e Kinetic Read Type, see page 268

e Well Scan Read Type, see page 269
Tunable Wavelength (TUNE) Detection Cartridge
The Tunable Wavelength (TUNE) detection cartridge is for the SpectraMax Paradigm only and
supports several read modes including fluorescence intensity. Spectral optimization helps you
get the maximum signal-to-background ratio for most fluorophores or luminescence labels that
are compatible with the wavelength ranges. This cartridge occupies three slots in either the
top or bottom cartridge drawer (top drawer for top reads and bottom drawer for bottom reads).
In addition to the endpoint, kinetic, and well scan read types, this cartridge also supports the
Spectrum Read Type on page 269.
This cartridge also supports the following read modes:

e Time-Resolved Fluorescence Read Mode, see page 283
e | uminescence Read Mode, see page 280
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Fluorescence Polarization Detection Cartridges

There are two Fluorescence Polarization (FP) detection cartridges that support the
fluorescence polarization read mode for specific labels, depending on the cartridge. For best
results you should use solid black plates.

e Fluorescence Polarization (FP) (Fluorescein) Detection Cartridge

e Fluorescence Polarization (FP) (Rhodamine) Detection Cartridge
Each cartridge occupies one slot in the cartridge drawer. For the SpectraMax Paradigm you
can install it in either cartridge drawer (top for top reads or bottom for bottom reads) but it
cannot occupy the rear-most slot. For best results, you should install the cartridge in the top
drawer.
These cartridges support the following read types:

e Endpoint Read Type, see page 267
e Kinetic Read Type, see page 268

FRET Detection Cartridges

The following detection cartridges use an ultra-high power LED for the excitation of various
fluorescent labels. The standard dual-emission design provides simple, straightforward
fluorescence resonance energy transfer (FRET) measurement. These cartridges occupy one
slot in the cartridge drawer.

e Fluorescence Intensity (Fl) (coum-fluor) Detection Cartridge

e Fluorescence Intensity (FI) (fluor-rhod) Detection Cartridge

e Fluorescence Intensity (FI) (Cy3-Cy5) Detection Cartridge

e Fluorescence Intensity (FI) (Cfp-Yfp) Detection Cartridge

Fluorescence Intensity (FI) GeneBLAzer Detection Cartridge

The Fluorescence Intensity (FI) GeneBLAzer detection cartridge is designed for use with
GeneBLAzer assays from Invitrogen. The standard dual-emission design provides
Fluorescence Resonance Energy Transfer (FRET) measurement. This cartridge occupies one
slot in the cartridge drawer.
Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection Cartridge
The Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) detection cartridge uses ultra
high-powered LEDs for the excitation of a dual set of fluorescent labels.
This cartridge is optimized for detection of the label set used in the MultiTox-Fluor Multiplex
Cytotoxicity Assay from Promega:

e AFC (amino-fluorocoumarin)

® R110 (rhodamine 110)
This cartridge is for the SpectraMax Paradigm only and occupies one slot in either cartridge
drawer (top for top reads and bottom for bottom reads).
These cartridges support the following read types:

e Endpoint Read Type, see page 267

e Kinetic Read Type, see page 268

e Well Scan Read Type, see page 269
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Imaging - Transmitted Light Detection Cartridge

The Transmitted Light (TL) detection cartridge provides white LED illumination to do
brightfield, transmitted-light imaging when you use the SpectraMax MiniMax 300 Imaging
Cytometer. The StainFree Cell Detection Algorithm uses proprietary transmitted light analysis
technology to eliminate cell staining for cell counting and confluency measurements.

This cartridge is for the SpectraMax i3x when instrument is installed with the SpectraMax
MiniMax 300 Imaging Cytometer and cannot be used in the SpectraMax Paradigm.

The cartridge occupies one slot in the cartridge drawer and supports the Imaging read mode.

Luminescence Detection Cartridges

There are three Glow Luminescence (LUM) detection cartridges that support the luminescence
read mode. For best results you should use solid white plates. The Glow Luminescence
detection cartridges are individually optimized for a 1536-well, 384-well, or 96-well plate
format:

e Glow Luminescence (LUM) detection cartridge
e Glow Luminescence (LUM) detection cartridge (384)
e Glow Luminescence (LUM) detection cartridge (96)

Each cartridge occupies one slot in the cartridge drawer. For the SpectraMax Paradigm you
caninstall it in either cartridge drawer (top for top reads or bottom for bottom reads) but it
cannot occupy the rear-most slot. For best results, you should install the cartridge in the top
drawer.

Dual Color Luminescence (LUM) (Chroma-Glo) Detection Cartridge

The Dual Color Luminescence (LUM) (Chroma-Glo™) Detection Cartridge supports the
luminescence read mode and is designed to provide the optimal performance when you use
Promega Chroma-Glo™ reagents. This cartridge supports both luminescence and dual
wavelength luminescence reads.

This cartridge occupies one slot in the cartridge drawer. For the SpectraMax Paradigm you can
install it in either cartridge drawer (top for top reads or bottom for bottom reads) but it cannot
occupy the rear-most slot. For best results, you should install the cartridge in the top drawer for
LUM reads.

Chroma-Glo is a trademark of Promega Corporation.
Dual Color Luminescence (LUM) (BRET2) Detection Cartridge

The Dual Color Luminescence (LUM) (BRET2™) Detection Cartridge is designed to provide the
optimal performance when you use Perkin Elmer BRET? reagents. This cartridge supports both
luminescence and dual wavelength luminescence reads. For best results, you should use solid
white plates.

This cartridge occupies one slot in the cartridge drawer. For the SpectraMax Paradigm you can
install it in either cartridge drawer (top for top reads or bottom for bottom reads) but it cannot
occupy the rear-most slot. For best results, you should install the cartridge in the top drawer for
LUM reads.

BRET?is a trademark of PerkinElmer, Inc.
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Multi-Mode (MULTI) Detection Cartridge

The Multi-Mode (MULTI) detection cartridge is for the SpectraMax Paradigm only and supports
several read modes including luminescence. This cartridge optimized for 96-well and 384-well
plates. It occupies three slots in the cartridge drawerand is .

This cartridge also supports the following read modes:

e Fluorescence Intensity Read Mode, see page 275
e Time-Resolved Fluorescence Read Mode, see page 283

The cartridges listed above support the following read types:

e Endpoint Read Type, see page 267

e Kinetic Read Type, see page 268

e Well Scan Read Type, see page 269
Tunable Wavelength (TUNE) Detection Cartridge
The Tunable Wavelength (TUNE) detection cartridge is for the SpectraMax Paradigm only and
supports several read modes including luminescence. Spectral optimization helps you get the
maximum signal-to-background ratio for most fluorophores or luminescence labels that are
compatible with the wavelength ranges. In addition to the endpoint, kinetic, and well scan read
types, this cartridge also supports the Spectrum Read Type on page 269.

This cartridge occupies three slots in the cartridge drawer and you should install it in the top
cartridge drawer for glow luminescence reads.

This cartridge also supports the following read modes:

e Fluorescence Intensity Read Mode, see page 275
e Time-Resolved Fluorescence Read Mode, see page 283

ScanlLater Western Blot Detection Cartridge

The ScanLater™ Western Blot (WB) Detection Cartridge supports the Time-Resolved
Fluorescence read mode for Western Blot membranes.

The Molecular Devices ScanLater™ Western Blot Assay Kit is a novel system for protein
analysis that you can use with the SpectraMax i3x, SpectraMax iD5, and SpectraMax Paradigm.
Membranes are incubated with Eu-chelate labeled secondary antibodies or streptavidin that
bind specifically to the target protein-specific primary antibody. For more information, contact
your representative or search the knowledge base for ScanLater or Western Blot at
support.moleculardevices.com.

The cartridge occupies two slots in the cartridge drawer.

Western Blot reads use the time-resolved fluorescence read mode with a membrane read
type. See Membrane Read Type on page 268.

If you use the SoftMax Pro Software - GxP edition, you must have the following permissions to
complete a Western Blot membrane read:

e Read Empty Plates/Cuvettes to start a read.
e Create/Save Data Documents to save the data document before the read.
e Overwrite Plate/Cuvette Data to do a high-resolution ROl read.

See SoftMax Pro Software - GxP Edition on page 243.
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SpectraMax Injector Cartridge
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The SpectraMax® Injector Cartridge adds injector capability to the SpectraMaxi3x. You can
use the injectors and optics in this cartridge for luminescence reads from the top of the
sample, or use the injectors in the cartridge along with the instrument's built-in monochromator
for fluorescence intensity reads from the bottom of the sample.

This cartridge is for the SpectraMax i3x only and cannot be used in the SpectraMax Paradigm.
Install the SpectraMax Injector cartridge in the two rear-most slots (3 and 4) in the cartridge
drawer.

When you install the SpectraMax Injector cartridge, you can create protocols that inject and
read well by well to reduce signal loss. Injectors deliver a specified volume of a reagent to the
wells of a plate. Use the injectors to deliver the reagent to initiate a reaction that occurs rapidly
and results in a luminescent or fluorescent signal that the instrument must quickly detect.

Common inject-and-read assays include luciferase reporter assays and calcium flux assays.

The SpectraMax Injector cartridge is DLReady™ certified by Promega for
the Dual-Luciferase Reporter (DLR™) assay system.

D L Recar

To define the settings for a read with injection, you must use the Acquisition View in the
Settings dialog. See Acquisition View and Reads With Injectors on page 152.

DLReady, DLR, and the DLReady logo are trademarks of Promega Corporation.
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Time Resolved Fluorescence (TRF-EUSA) Detection Cartridge

The Time Resolved Fluorescence (TRF-EUSA) detection cartridge supports the time-resolved
fluorescence read mode for Europium and Samarium. It is ideal for protein interaction, GPCR,
and enzyme activity applications. For best results you should use solid black plates.

This cartridge occupies one slot in the cartridge drawer. For the SpectraMax Paradigm you can
install it in either cartridge drawer (top fortop reads or bottom for bottom reads). For best
results, you should install the cartridge in the top drawer.

The cartridge supports the following read types:

e Endpoint Read Type, see page 267

e Kinetic Read Type, see page 268

e Well Scan Read Type, see page 269 (Not available for dual-label assays.
Cisbio HTRF Detection Cartridge
The Cisbio HTRF® Detection Cartridge uses a high-energy Xenon flash lamp for sensitive reads
of HTRF reagents. The standard dual-emission design gives the most accurate results in short
overall read time. This cartridge provides Time-Resolved Fluorescence read mode for
europium cryptate and europium acceptors.
The fluorescence ratio related to the HTRF readout is a correction method developed by
Cisbio, for which Cisbio has granted a license to Molecular Devices. Its application is strictly
limited to the use of HTRF reagents and technology, excluding other TR-FRET technologies
such as IMAP TR-FRET calculations of acceptor to donor ratios.
This is a dual-emission cartridge that occupies two slots in the cartridge drawer.
HTRF is a registered trademark of Cisbio Bioassays.
The cartridge supports the following read types:

e Endpoint Read Type, see page 267

e Kinetic Read Type, see page 268

e Well Scan Read Type, see page 269
Multi-Mode (MULTI) Detection Cartridge
The Multi-Mode (MULTI) detection cartridge is for the SpectraMax Paradigm only and supports
several read modes including Time Resolved Fluorescence. This cartridge is optimized for 96-
well and 384-well plates. It occupies three slots in either cartridge drawer (top drawer for top
reads and bottom drawer for bottom reads).
This cartridge also supports the following read modes:

e Fluorescence Intensity Read Mode, see page 275
e | uminescence Read Mode, see page 280

Tunable Wavelength (TUNE) Detection Cartridge

The Tunable Wavelength (TUNE) detection cartridge is for the SpectraMax Paradigm only and
supports several read modes including Time-Resolved Fluorescence. This cartridge occupies
three slots in either the top or bottom cartridge drawer (top drawer for top reads and bottom
drawer for bottom reads). In addition to the endpoint, kinetic, and well scan read types, this
cartridge also supports the Spectrum Read Type on page 269.

This cartridge also supports the following read modes:

e Fluorescence Intensity Read Mode, see page 275
e | uminescence Read Mode, see page 280
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Appendix C: Exporting File Details

Whether you save the export as a .txt or .xls, the information presents as tab-separated values.
This topic describes the basic information that is included in a .txt or .xIs file export format.

For a copy of the SoftMax Pro .xml schema, contact Molecular Devices.

The first line of an export file defines the number of sections (or "Blocks") that are in the export
with the following format:

o ##BLOCKS=n
where nis the number of sections that are in the export file.

The software exports the sections you select to export in the sequence that the sections
display in the document.

Each section displays the following:

e Headerline
The header line displays the section type: Note, Plate, or Group, and the title of the section
you define in the document. Plate sections header lines contain additional information.

e Datalines
The data lines follow the header line and contain the text or data from the section. The
layout and format of the data lines depend on the section type, export type, read mode,
and read type.

e Endline
The end line of each section displays the text: YEnd

The final line of an export file contains a single field with the original name of the export file,
and the date and time the file was last saved.

Plate Export Formats

The following describes the format of Plate sections you export to a .txt or .xls file. For a copy
of the SoftMax Pro .xml schema, contact Molecular Devices.

e The headerline contains the type of section, such as Plate, and the title of the section as
defined in the SoftMax Pro Software data file. Plate sections contain more information in
the header line. See Plate Header Fields on page 352.

e The data lines follow the header line and contain the data from the exported section. The
layout and format of the data lines are dependent on many factors, such as the section
type, export type, read mode, and read type. See Plate Data Lines on page 360.
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Plate Header Fields

The fields in the header line for a Plate section help define the data that is presented in the
section. The order and content of the fields are different depending on the read mode you use
to collect the data.

Absorbance Read Mode

Position Name Description

1. Section type Contains the type of section such as Plate

2. Section name Contains the title of the section as defined in the
document

3. Export version Contains the version of the export application used for this
export

4. Export format Contains Columns output format or Plate output format as
defined in the Export dialog

5. Read type Contains the read type used for the acquisition, such as
Endpoint, Kinetic, Spectrum, or Well Scan

6. Read mode Contains the read mode used for the acquisition
(Absorbance)

7. Data type Contains Raw or Reduced to define the type of data in the
export file

8. Pre-read Always FALSE
Pre-read is not a function of SoftMax Pro Software version 6
or newer

9. Kinetic points Contains the number of reads done during the acquisition
For Endpoint reads the number is 1

10. Read time Contains the read time in seconds for a Kinetic read

Read pattern Contains the scan pattern for a Well Scan read

Contains no value (blank) for other read types

M. Kinetic interval Contains the interval between reads in seconds for a

Well Scan density Kinetic read

Contains the scan density for a Well Scan read
Contains no value (blank) for other read types

12. Start wavelength Contains the starting wavelength for a Spectrum read
Contains no value (blank) for other read types

13. End wavelength Contains the ending wavelength for a Spectrum read
Contains no value (blank) for other read types

14. Wavelength step Contains the wavelength increment or step for a Spectrum
read
Contains no value (blank) for other read types
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Absorbance Read Mode (continued)

Appendix C: Exporting File Details

Position Name Description

15. Number of wavelengths Contains the number of wavelengths read for the
acquisition
Contains no value (blank) for Spectrum reads

16. Wavelengths Contains the wavelengths used for the acquisition
For multiple-wavelength reads, the values are separated
by a space
Contains no value (blank) for Spectrum reads

17. First column Contains the number of the first column read during the
acquisition

18. Number of columns Contains the number of columns read during the
acquisition

19. Number of wells Contains the total number of wells in the plate, such as 96
or 384

20. First row Contains a number corresponding with the first row read
during the acquisition

21. Number of rows Contains the number of rows read during the acquisition

22. Time tags Contains time-tag information if the exported data has
read-time tags

353



SoftMax Pro Software User Guide

354

Fluorescence Intensity and AlphaScreen Read Mode

Position Name Description

1. Section type Contains the type of section such as Plate

2. Section name Contains the title of the section as defined in the
document

3. Export version Contains the version of the export application used for
this export

4. Export format Contains Columns output format or Plate output format as
defined in the Export dialog

5. Read type Contains the read type used for the acquisition, such as
Endpoint, Kinetic, Spectrum, or Well Scan

6. Read mode Contains the read mode used for the acquisition, such as
Fluorescence or Luminescence

7. Bottom read Contains TRUE if read from the bottom of the plate and
FALSE if read from the top

8. Data type Contains Raw or Reduced to define the type of data in the
export file

9. Pre-read Always FALSE
Pre-read is not a function of SoftMax Pro Software version
6 or newer

10. Kinetic points Contains the number of reads done during the acquisition
For Endpoint reads the number is 1

1. Read time Contains the read time in seconds for a Kinetic read

Read pattern Contains the scan pattern for a Well Scan read

Contains no value (blank) for other read types

12. Kinetic interval Contains the interval between reads in seconds for a

Well Scan density Kinetic read

Contains the scan density for a Well Scan read
Contains no value (blank) for other read types

13. Start wavelength Contains the starting wavelength for a Spectrum read
Contains no value (blank) for other read types

14. End wavelength Contains the ending wavelength for a Spectrum read
Contains no value (blank) for other read types

15. Wavelength step Contains the wavelength increment or step for a Spectrum
read
Contains no value (blank) for other read types

16. Number of wavelengths Contains the number of wavelengths read for the

acquisition
Contains no value (blank) for Spectrum reads
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Fluorescence Intensity and AlphaScreen Read Mode (continued)

Position Name Description

17. Wavelengths Contains the wavelengths used for the acquisition
For multiple-wavelength reads, the values are separated
by a space
For Fluorescence reads, contains the emission
wavelengths
Contains no value (blank) for Spectrum reads or Ex/Em
sweeps

18. First column Contains the number of the first column read during the
acquisition

19. Number of columns Contains the number of columns read during the
acquisition

20. Number of wells Contains the total number of wells in the plate, such as 96
or 384

21. Excitation wavelengths Contains the excitation wavelengths used for a
Fluorescence read
For multiple-wavelength reads, the values are separated
by a space
Contains no value (blank) for Spectrum reads or ExX/Em
sweeps

22. Cutoff Contains Manual or Automatic as defined in the Settings
dialog

23. Cutoff filters Contains the wavelengths of the cutoff filters with the
values separated by a space

24. Sweep wave Contains Excitation Sweep or Emission Sweep as defined
in the Settings dialog

25. Sweep fixed wavelength Contains the fixed wavelength of an ExX’Em sweep

26. Reads per well Contains the number of times a well is read during a
single read

27. PMT gain Contains Automatic, High, Medium, Low, or Manual as
defined in the Settings dialog

28. Start integration time Contains the time to start integration for a TRF read.
Contains no value (blank) for other read modes

29. End integration time Contains the time to end integration for a TRF read.
Contains no value (blank) for other read modes

30. First row Contains a number corresponding with the first row read
during the acquisition

31 Number of rows Contains the number of rows read during the acquisition

32. Time tags Contains time-tag information if the exported data has

read-time tags
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Luminescence, Time-Resolved Fluorescence, and Fluorescence Polarization Read Mode

Position Name Description

1. Section type Contains the type of section such as Plate

2. Section name Contains the title of the section as defined in the
document

3. Export version Contains the version of the export application used for
this export

4. Export format Contains Columns output format or Plate output format as
defined in the Export dialog

5. Read type Contains the read type used for the acquisition, such as
Endpoint, Kinetic, Spectrum, or Well Scan

6. Read mode Contains the read mode used for the acquisition, such as
Luminescence or Time Resolved

7. Data type Contains Raw or Reduced to define the type of data in the
export file

8. Pre-read Always FALSE
Pre-read is not a function of SoftMax Pro Software version
6 or newer

o. Kinetic points Contains the number of reads done during the acquisition
For Endpoint reads the number is 1

10. Read time Contains the read time in seconds for a Kinetic read

Read pattern Contains the scan pattern for a Well Scan read

Contains no value (blank) for other read types

M. Kinetic interval Contains the interval between reads in seconds for a

Well Scan density Kinetic read

Contains the scan density for a Well Scan read
Contains no value (blank) for other read types

12. Start wavelength Contains the starting wavelength for a Spectrum read
Contains no value (blank) for other read types

13. End wavelength Contains the ending wavelength for a Spectrum read
Contains no value (blank) for other read types

14. Wavelength step Contains the wavelength increment or step for a Spectrum
read
Contains no value (blank) for other read types

15. Number of wavelengths Contains the number of wavelengths read for the

acquisition
Contains no value (blank) for Spectrum reads
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Appendix C: Exporting File Details

Luminescence, Time-Resolved Fluorescence, and Fluorescence Polarization Read Mode

(continued)

Position Name Description

16. Wavelengths Contains the wavelengths used for the acquisition
For multiple-wavelength reads, the values are separated
by a space
For Time Resolved reads, contains the emission
wavelengths
Contains no value (blank) for Spectrum reads or Ex/Em
sweeps

17. First column Contains the number of the first column read during the
acquisition

18. Number of columns Contains the number of columns read during the
acquisition

19. Number of wells Contains the total number of wells in the plate, such as 96
or 384

20. Excitation wavelengths Contains the excitation wavelengths used for a Time
Resolved read
For multiple-wavelength reads, the values are separated
by a space
Contains no value (blank) for Spectrum reads or ExX'Em
sweeps

21. Cutoff Contains Manual or Automatic as defined in the Settings
dialog

22. Cutoff filters Contains the wavelengths of the cutoff filters with the
values separated by a space
Contains no value (blank) if no cutoff filter is used

23. Sweep wave Contains Excitation Sweep or Emission Sweep as defined
in the Settings dialog

24. Sweep fixed wavelength Contains the fixed wavelength of an Ex’Em sweep

25. Reads per well Contains the number of times a well is read during a
single read

26. PMT gain Contains Automatic, High, Medium, Low, or Manual as
defined in the Settings dialog

27. Start integration time Contains the time to start integration for a Time Resolved
read.
Contains no value (blank) for other read modes

28. End integration time Contains the time to end integration for a Time Resolved
read.
Contains no value (blank) for other read modes

29. First row Contains a number corresponding with the first row read
during the acquisition
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Luminescence, Time-Resolved Fluorescence, and Fluorescence Polarization Read Mode

(continued)

Position Name Description
30. Number of rows Contains the number of rows read during the acquisition
31 Time tags Contains time-tag information if the exported data has

read-time tags
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Imaging Read Mode

Appendix C: Exporting File Details

Position Name Description

1. Section type Contains the type of section, such as Plate

2. Section name Contains the title of the section as defined in the document

3. Export version Contains the version of the export application used for this
export

4. Export format Contains Time Format for Columns output format or Plate
Format for Plate output format as defined in the Export
dialog

5. Read type Contains the read type used for the acquisition, such as
Endpoint

6. Read mode Contains the read mode used for the acquisition, such as
Imaging

7. Data type Contains Raw or Reduced to define the type of data in the
export file

8. Pre-read Always FALSE
Pre-read is not a function of SoftMax Pro Software version 6
or newer

o. Kinetic points Contains the number of reads done during the acquisition
For Endpoint reads the number is 1

10. Read time Contains no value (blank) for Imaging reads

M. Kinetic interval Contains no value (blank) for Imaging reads

12. Start wavelength Contains no value (blank) for Imaging reads

13. End wavelength Contains no value (blank) for Imaging reads

14. Wavelength step Contains no value (blank) for Imaging reads

15. Number of wavelengths Contains the number of wavelengths, or channels, read for
the acquisition

16. Emission wavelengths Contains the emission wavelengths used for the
acquisition
For multiple-wavelength reads, the values are separated by
a space

17. First column Contains the number of the first column read during the
acquisition

18. Number of columns Contains the number of columns read during the
acquisition

19. Number of wells Contains the total number of wells in the plate, such as 96
or 384

20. First row Contains a number corresponding with the first row read

during the acquisition
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Imaging Read Mode (continued)

Position Name Description

21. Number of rows Contains the number of rows read during the acquisition

22. Excitation wavelength Contains the excitation wavelengths used for the
acquisition
For multiple-wavelength reads, the values are separated by
a space

23. Analysis type Contains the analysis type used, such as Discrete Object
Analysis

24. Classification Contains On if classification is used and Off if it is not used

25. Find on Contains the emission wavelength used for finding objects
or fields

26. Measurement Contains the type of measurement selected in the Display
Options dialog, such as Cell Count

Plate Data Lines
The data lines immediately follow the header line.

e The first column shows the time points for a kinetic read, the data points in a well scan
read, or the wavelengths in a spectrum read. For endpoint reads, this column is blank.

e The second column shows the temperature for the read, if you use the incubator for the
read. If the incubator is off, the value is zero.

The read data starts in the third column. When both raw and reduced data are exported, the
reduced data displays below the raw data.

The format of the data depends on whether the data was exported in column format or plate
format.

For column formats, the data displays in a single row. The data for multiple time points for
kinetic reads, multiple data points for well scan reads, or multiple wavelengths for spectrum
reads is listed in separate rows. For endpoint, kinetic, or well scan reads with multiple
wavelengths, the data for each wavelength displays in subsequent rows below the previous
wavelength. Forimaging reads, the data for each measurement is in a separate row.

Time Temperature |Al A2 A3 B1 B2 B3
0:00:00 i 1.596 2.479 2.95 3.002 3.103 1.39 ..| wavelength 1
0:01:58 i 1.564 3.344 2.378 2.744 0.113 3.872
i
Raw Data
0:00:00 i 3.928 3.645 1.956 3.622 2.195 0.519 ..] wavelength 2
0:01:58 i 2.891 3.824 2.782 3.203 1.105 0.281
i
Al A2 A3 [ [B1 [82 B3 .
203.45455] -18.91525] -28.13251 106.53005] 82.585516

Reduced Data
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Kinetic Data Exported in Column Format

For plate formats, the data displays in a table to indicate the columns and rows of the plate.
The data for multiple time points for kinetic reads, multiple data points for well scan reads, or
multiple wavelengths for spectrum reads is listed in separate tables below the previous table.
For endpoint, kinetic, or well scan reads with multiple wavelengths, the data for each
wavelength displays in separate tables to the right of the previous table. Forimaging reads,
the data for each measurement is in a separate table to the right of the previous table.

wavelength 1 wavelength 2
Temperature 1 2 3 1 2 3
0:00:00 #H 1.596 2.479 2.95 3.103 1.39 1.97
1.024 0.308 3.925 2.381 1.957 3.722
0.195 0.287 2.638 0.967 1.049 1.422
0:01:58 #it 1.564 3.344 2.378 | | 0.113 3.872 0.637
0.82 1.797 1.064 3.58 2.603 0.996
0.421 3.066 3.906 RaW Data 0.915 0.57 2.251
#it 1.169 1.092 3.969 1.126 0.004 1.934
1.105 3.022 2.845 1.933 2.834 0.657
3.602 2.033 3.737 0.437 3.242 1.337
1 2 3 .| | 1 2 3
203.45455| -18.91525] -28.13251 1 ["1na =2005] 82.585516] 121.96918
74.597843| 107.62096| -88.65948 Reduced Data 376] -77.66718] -83.94453
-134.6718] 68.810478] -52.5208 o] | 246.51772| 60.674884| 48.51772

Kinetic Data Exported in Plate Format

Group Section Export Formats
The following is the format of Group sections that you export to a .txt or .xls file. For a copy of
the SoftMax Pro .xml schema, contact Molecular Devices.

The header line contains the type of section, such as Group, and the title of the section as
defined in the document.

The data lines immediately follow the header line and contain the text and data from the
exported section.

e The data from the group table displays in a table that contains the column headings in the
first row followed by the data from the table.
e Group summaries, if present, display in the rows at the end of the section.

Note Section Export Formats
The following describes the format of Note sections that you export to a .txt or .xls file. For a
copy of the SoftMax Pro .xml schema, contact Molecular Devices.
The header line contains the type of section, such as Note.

The data lines follow the header line and contain text and Summary formulas from the
exported section.

Images and section images from the Note section are not included in the export file.
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Appendix D: Curve Fit Functions

Generally, a standard curve refers to the curve fitted to the plot of concentration versus mean
value for the Standard group.

Afteryou select a fit type, SoftMax Pro Software determines the parameter values that best fit
the data. The function with these parameters is drawn on the graph. Ideally, the type of fit used
is determined by the underlying chemistry of the assay and can be set before data is read.

When a fit is done, the parameter values display in the legend at the bottom of the graph. The
correlation coefficient describes how well a change in x values correlates with a change in the
y values. The R? value should be used only for linear curve fits.

A good discussion of curve fitting appears in “Data Analysis and Quality Control of Assays: A
Practical Primer” by R. P. Channing Rogers in Practical Inmuno Assay, edited by Wilfrid R. Butt
(published by Marcel Dekker, Inc., New York, 1984).

When you first create a graph of the data, it does not have a fit related to it. You can fit a plot to
one of the following curve-fit functions.

These selections display in the Fit list in the toolbar at the top of the Graph section. Select a
category from the Category list to filter the list of curve fits.

No Fit

Select No Fit to apply no curve fit and to plot the scatter of the data points.
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2-Parameter Exponential

The 2-Parameter Exponential curve fit is also known as:
e 2P Exponential
e Exponential Growth on page 365
e Exponential Decay on page 366

y = A X eBX

y = Concentration

x=Time

A=Y,

B=k

For exponential growth, B> 0O

For exponential decay, B< O

A 2-parameter exponential curve fitis commonly used for radioactive decay, first order
kinetics, and unimolecular decay. It is also used for exponential growth.
Mathematically, a 2-parameter exponential curve fit is a special case of a 3-parameter
exponential curve fit. See 3-Parameter Exponential on page 367.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a 2-parameter exponential
curve fit algorithm is 2.
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Exponential Growth
The Exponential Growth curve fit is also known as:

e 2-Parameter Exponential on page 364

y = A X eBX

y = Concentration

x=Time

A=Y,

B=k

For exponential growth, B> 0

You can calculate doubling time with the following equation:

Doubling time =B xIn(2) = Bx 0.693
Mathematically, this is a special case of a 3-parameter exponential curve fit. See 3-Parameter
Exponential on page 367.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for an exponential growth curve
fit algorithm is 2.
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Exponential Decay
The Exponential Decay curve fit is also known as:

e 2-Parameter Exponential on page 364

y=Axe

y = Concentration

x=Time

A=Y,

B=k

For exponential decay, B< 0

Mathematically, this is a special case of a 3-parameter exponential curve fit. See 3-Parameter
Exponential on page 367.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a 2-parameter exponential
curve fit algorithm is 2.
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3-Parameter Exponential

The 3-Parameter Exponential curve fit is also known as:

e Exponential (in previous versions of the software)

e 3P Exponential

e One-Phase Exponential Decay, see page 368

e One-Phase Exponential Association, see page 369

y=A+Bx(1-e)

x = Time (usually)
y = Specific + Nonspecific Binding or Response

Note: In previous versions of the software, it was possible to select a linearized version
of this fit. This option is not available in SoftMax Pro Software version 6.
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368

One-Phase Exponential Decay

The One-Phase Exponential Decay curve fit is also known as:

e 3-Parameter Exponential, see page 367
e 3P Exponential

y=A+Bx(1l-e)

x = Time (usually)

y = Specific + Nonspecific Binding or Response
A=Yy =Y.y = Plateau + Span

B=-Span

C=1/k =1/decay constant

The software expresses C as the reciprocal of k, so it has same units as X.

A one-phase exponential decay curve fitis commonly used for drug elimination, dissociation

of ligand from a receptor, and radioisotope decay.

The curve is the same as one-phase exponential association, except B is negative instead of

positive. See One-Phase Exponential Association on page 369.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a one-phase exponential

decay curve fit algorithm is 3.
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One-Phase Exponential Association
The One-Phase Exponential Association curve fit is also known as:

e 3-Parameter Exponential, see page 367
e 3P Exponential

y=A+Bx(1l-e)

x = Time (usually)

y = Specific + Nonspecific Binding or Response

A= YO = Ymin

B=Span="Y,.— Yo

C =1/k = 1/association constant

A one-phase exponential association curve fitis commonly used for pseudo-first order kinetics
of ligand/receptor interaction or substrate/enzyme interaction.

The curve is the same as one-phase exponential decay, except B is positive instead of
negative. See One-Phase Exponential Decay on page 368.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a one-phase exponential
association curve fit algorithm is 3.
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4-Parameter Logistic

370

A 4-Parameter Logistic equation is also known as:
e Sigmoidal Dose-Response (variable slope)
e Four-Parameter Logistic Equation
e Four-Parameter Dose-Response Curve

e Hill Equation
D
A
C
A
D
C
A-D
y=D+ TAIXE
+[g]

A = First Asymptote

B = Slope Factor/Hill Coefficient
C=EC;5¢/ICsp

D = Second Asymptote

% Note: In the software, B is always positive, assuming neither A nor D is fixed. A is always
the first asymptote, and D is always the last asymptote. A and D can swap between top
and bottom according to the shape of the curve, whether rising or falling with increasing
concentration. However, if either A or D has been fixed in the software, the B parameter
is no longer required to be positive. In such cases, A and D might or might not be the
first and last asymptotes respectively.

A 4-parameter curve fit is commonly used in dose-response studies and estimation of
EC5o/IC5q values. It can also be used as standard curves.

A 4-parameter curve fit assumes a sigmoidal data set with clear lower and upper asymptotes. If
either asymptote is not clearly defined oris missing (as in a marginal data set), it is nearly
impossible to estimate where the asymptote lies, or if exists at all. Likewise the ECgy cannot be
estimated.

The 4-parameter curve possesses rotational symmetry about the point:
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{C, (A+D)/2}

This point is sometimes referred to erroneously as an inflection point. In reality, for B> 1, the
inflection point is:

(B-1)

(B+1)

() (A+D)+A-D)/B)
2

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a 4-parameter curve fit
algorithm is 4.

% Note: For 3-parameter sigmoidal dose-response curves, use the 4-parameter curve fit
and fix B or one of the asymptotes to a constant. See 3-Parameter Dose-Response
Curves on page 372.

The minimization method for the 4-parameter equation is based on the Levenberg-Marquardt
Method. Discussion of these methods can be found in The Art of Scientific Computing by
William H. Press, Brian P. Flannery, Saul A Teukolski, and William T. Vetterling, published by
Cambridge University Press, New York, 1988.
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3-Parameter Dose-Response Curves
3-Parameter Dose-Response Curves are special cases of a 4-Parameter Logistic equation with
one parameter fixed. See 4-Parameter Logistic on page 370.
3-Parameter Dose-Response Curves with a fixed slope are also known as:
e Sigmoidal Dose-Response (Fixed Slope)
e One-Site Competition
e Three-Parameter Logistic Equation
e Hill Equation (Hill Slope = —1)
3-Parameter Dose-Response Curves with a fixed asymptote are also known as:
e Sigmoidal Dose-Response (Fixed Asymptote)
e Three-Parameter Logistic Equation
e Hill Equation (Bottom Asymptote is Fixed to O)

D

A
U,
C
A-D
v=D+W
C

3-parameter dose-response curves are commonly used in dose-response studies and
estimation of EC50/IC5q values. They can also be used as standard curves.

3-parameter dose-response curves assume a sigmoidal data set with clear lower and upper
asymptotes. If either asymptote is not clearly defined or is missing (as in a marginal data set), it
is nearly impossible to estimate where the asymptote lies, or if exists at all. Likewise the ECgg
cannot be estimated.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a 4-parameter curve fit
algorithm is 4.

The minimization method for the 3-parameter dose-response curves equation is based on the
Levenberg-Marquardt Method. Discussion of these methods can be found in The Art of
Scientific Computing by William H. Press, Brian P. Flannery, Saul A Teukolski, and William T.
Vetterling, published by Cambridge University Press, New York, 1988.
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5-Parameter Logistic

5049092 F

A 5-Parameter Logistic equation is also known as:

e Five-Parameter Logistic Equation

D
A
A
D
B A-D
y=D+ {1+(é)B}G

A = First Asymptote

B = Slope Factor

C =[no physical meaning]
D = Second Asymptote
G = Asymmetry Factor

% Note: In the software, B is always positive, assuming neither A nor D is fixed. A is always
the first asymptote, and D is always the last asymptote. A and D can swap between top
and bottom according to the shape of the curve, whether rising or falling with increasing
concentration. However, if either A or D has been fixed in the software, the B parameter
is no longer required to be positive. In such cases, A and D might or might not be the
first and last asymptotes respectively.

A 5-parameter curve fitis commonly used in dose-response studies and estimation of
ECs./ICsq values. It can also be used as standard curves.

A 5-parameter curve fit assumes an asymmetric sigmoidal data set with clear lower and upper
asymptotes. If either asymptote is not clearly defined or is missing (as in a marginal data set), it
is nearly impossible to estimate where the asymptote lies, orif exists at all. The ECgq cannot be
estimated.

Unlike the 4-parameter logistic equation, C is not the ICgq value. The IC5 value needs to be
calculated separately. See the SoftMax Pro Data Acquisition and Analysis Software Formula
Reference Guide.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a 5-parameter curve fit
algorithm is 5.

The minimization method for the 5-parameter equation is based on the Levenberg-Marquardt
Method. See The Art of Scientific Computing by William H. Press, Brian P. Flannery, Saul A
Teukolski, and William T. Vetterling, published by Cambridge University Press, New York,
1988.
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5-Parameter Logistic Alternate

374

This is a re-parameterization of the standard five-parameter logistic, such that parameters B
and C have the same interpretation as in the case of the four-parameter logistic. In particular,
the ECgq value is given by C.
A 5-Parameter Logistic Alternate equation is also known as:

e Five-Parameter Alternate Logistic Equation

e 5P Alternate

D

Liyv-G
y=D+(A-D) {1 + (2@1—1)( é)m(l‘zc ]
A = First Asymptote

B = Slope Factor

C=ECs/ICsq

D = Second Asymptote

G = Asymmetry Factor

In the software, B is always positive, assuming neither A nor D is fixed. A is always the first
asymptote, and D is always the last asymptote. A and D can swap between top and bottom
according to the shape of the curve, whether rising or falling with increasing concentration. If
either A or D is fixed in the software, the B parameteris no longer required to be positive. In
such cases, A and D might or might not be the first and last asymptotes respectively.

A 5-parameter logistic alternate equation is commonly used in dose-response studies and
estimation of EC5¢/IC5q values. It can also be used as standard curves.

The 5-parameter logistic alternate equation is identical to the 5-parameter logistic equation,
except that it has been re-parameterized such that the C parameteris the estimated ECg/IC5o
value.

A 5-parameter logistic alternate equation assumes an asymmetric sigmoidal data set with clear
lower and upper asymptotes. If either asymptote is not clearly defined oris missing (as in a
marginal data set), it is nearly impossible to estimate where the asymptote lies, orif exists at all.
Likewise the ECgq cannot be estimated.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a 5-parameter logistic
alternate equation algorithm is 6.
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Bi-Exponential
The Bi-Exponential curve fit is also known as:

e Two-Phase Exponential Decay, see page 376
e Double Exponential Decay

y=Ae¥+Ce™+G

A =Spani

B =kl

C=Span2

D=k2

G = Plateau

When the curve is decaying, B and D are both negative.

The bi-exponential curve fitis commonly used when the decay is the result is the sum of a fast
and a slow exponential decay.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a bi-exponential curve fit
algorithm is 5.
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Two-Phase Exponential Decay

The Two-Phase Exponential Decay curve fit is also known as:

e Bi-Exponential, see page 375
e Double Exponential Decay

y=Ae¥+Ce™+G

A =Spani
B=k1
C=Span2
D=k2

G = Plateau

When the curve is decaying, B and D are both negative.

The two-phase exponential decay curve fitis commonly used when the decay is the result is

the sum of a fast and a slow exponential decay.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a two-phase exponential

decay curve fit algorithm is 5.
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Bi-Rectangular Hyperbola

5049092 F

The Bi-Rectangular Hyperbola curve fit is also known as:
e Two-Site Equilibrium Binding (specific binding), see page 377
e Michaelis-Menten with Two Isozymes, see page 378

Response

Concentration

_ _AX Cx
y_x+B+x+D

A bi-rectangular curve fit is commonly used for estimation of maximum (specific) binding and
Kd values in the presence of two binding sites: high-affinity and low-affinity. It is also used for
evaluation of enzyme activity, as function of [S]when two isozymes are present.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a bi-rectangular hyperbola
curve fit algorithm is 4.

Two-Site Equilibrium Binding (specific binding)
The Two-Site Equilibrium Binding (specific binding) curve fit is also known as:
e Bi-Rectangular Hyperbola on page 377

Response

Concentration

_ _AX Cx
y_x+B+x+D

y = Specific binding
A = Maximum binding (high affinity)

B = Kd(high)
C = Maximum binding (low affinity)
B = Kd(low)

A two-site equilibrium binding (specific binding) curve fitis commonly used for estimation of
maximum (specific) binding and Kd values in the presence of two binding sites: high-affinity
and low-affinity.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a two-site equilibrium
binding (specific binding) curve fit algorithm is 4.
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Michaelis-Menten with Two Isozymes
The Michaelis-Menten with Two Isozymes curve fit is also known as:
e Bi-Rectangular Hyperbola, see page 377

Response

Concentration

_ _AX Cx
Y=3+B 'X+D

Y=V,

A=V max(1)

B=Km (1)

C=Vmax(2)

B=Km (2)

A Michaelis-Menten with two isozymes curve fit is commonly used for evaluation of enzyme
activity, as function of [S]when two isozymes are present.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a Michaelis-Menten with two
isozymes curve fit algorithm is 4.
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Brain Cousens

Cubic
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The Brain Cousens curve fit is also known as:
e Sigmoidal Dose-Response with Hormesis

y= A-D+Gx
2CG X |8
1+'1+—A_D)(€)

A = First Asymptote

B = Slope Factor
C=ECs5/ICsq

D = Second Asymptote
G = Hormesis Factor

A brain cousens curve fit is used for studies of test systems that show hormesis (opposite
responses at low and high doses). An example is when an inhibitor shows an enhanced
response at low doses and an inhibitory response at high doses.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a brain cousens curve fit
algorithm is 4.

A Cubic curve fit is also known as:
e Polynomial Third Order

y=A+Bx+Cx*+ Dx?
A cubic curve fit can be used for standard curves, but there is risk of multiple inflection points,
and ambiguity in InterpX results.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a cubic curve fit algorithm is
4.
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Cubic Spline

A Cubic Spline curve fitis a series of cubic segments joining adjacent pairs in a set of points
such that the first and second derivatives match at the joints. There is no simple formula for the
entire function.

A cubic spline curve fitis commonly used for cosmetic curve smoothing.

Gaussian

The Gaussian function consists of a single peak.

y=A*e_(XéB)+D

A =Height-D

B = Peak Center

Cisrelated to the peak width
D = Baseline

Peak width at half-height = ParmC(Plot@Graph)*2*Sqrt(Ln(2))

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a gaussian curve fit
algorithm is 4.
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Linear

A Linear curve fit is also known as:
e Polynomial First Order

y = A+ Bx
A = Intercept
B = Slope

Use a linear fit when the values seem to lie on or are scattered around a straight line.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a linear curve fit algorithm is
2.
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Log-Log

The Log-Log curve fit fits the best straight line to the set of data that consists of the logarithm
of the reads on the Y-axis (the response) and the logarithm of the dose on the X-axis.

Log(y) = A+ B x Log(x)

A = Intercept

B = Slope

Log in this equation is the common or base-10 logarithm.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a log-log curve fit algorithm
is 2.
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Appendix D: Curve Fit Functions

The Log-Logit curve fit routine uses the same equation as the 4-Parameter curve fit, but uses a
different curve fitting algorithm. It is an older method and might be considered outdated. See

4-Parameter Logistic on page 370.

D
A
C
A
D
C
_ A-D
y=D+ 1+(%)B

A = First Asymptote

B = Slope Factor/Hill Coefficient
C=EC5y/ICs

D = Second Asymptote
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Point-to-Point

The Point-to-Point curve fit uses a linear equation to fit each pair of data points.

This curve fitis composed of multiple linear pieces joining the points. The line segment
defined by each pairis used to interpolate data between those points.

Quadratic

A Quaderatic curve fit is also known as:

e Polynomial Second Order

y=A+Bx+Cx?

A = Intercept

B = Slope of the Curve at the Intercept

C = a measure of the curvature of the parabola

The quadratic fit is useful for standard curves.

For the best results, you should exceed the minimum number of standards required for a curve

fit. The minimum number of standards required mathematically for a quadratic curve fit
algorithm is 3.
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Quartic

A Quartic curve fit is also known as:

e Polynomial Fourth Order

y =A+Bx+Cx*+ Dx® + Gx*
A quartic curve fit can be used for standard curves, but there is risk of multiple inflection points,
and so ambiguity in InterpX results.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a quartic curve fit algorithm
is 5.
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Rectangular Hyperbola

A Rectangular Hyperbola curve fit is also known as:

e Michaelis-Menten, see page 387
e One-Site Equilibrium Binding (specific binding), see page 387

A
b
c
o
Q.
1%
[J]
o
B Concentration
g
c
o
Q.
1%
[J]
o
A
B Concentration
y= Ax
X+ B

A rectangular hyperbola curve fit is commonly used estimation of V;max, Km, maximum
binding, and Kd.

A rectangular hyperbola curve fit is a special case of the 4-parameter curve fit where B=1,
D=0, and x is 1/concentration.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a rectangular hyperbola
curve fit algorithm is 2.
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Michaelis-Menten
A Michaelis-Menten curve fit is also known as:

e Rectangular Hyperbola, see page 386
A

Response

B Concentration

_ AX
y X+ B
y =V,

A =V;max
B=Km

A Michaelis-Menten curve fit is commonly used estimation of V;max and Km.

A Michaelis-Menten curve fit is a special case of the 4-parameter curve fit where B=1,D =0,
and xis 1/concentration.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a Michaelis-Menten curve fit
algorithm is 2.
One-Site Equilibrium Binding (specific binding)
A One-Site Equilibrium Binding (specific binding) curve fit is also known as:

e Rectangular Hyperbola, see page 386

// A
B Concentration

AX
X+ B

Response

y:

y = Specific Binding

A = Maximum Binding

B=Kd

A one-site equilibrium binding (specific binding) curve fitis commonly used estimation of
maximum binding and Kd.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a one-site equilibrium
binding (specific binding) curve fit algorithm is 2.
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Rect. Hyper. Plus Linear

388

A Rect. Hyper. Plus Linear (rectangular hyperbola plus linear) curve fit is also known as:
e RHPIlusLinear (in previous versions of the SoftMax Pro Software)
e One-Site Equilibrium Binding (total and nonspecific), see page 389

Total
........................................................ Specific
wf e
£ =
-g /"/
=
-------------------------------------- Nonspecific

Ligand Concentration

= + Cx
Y X+ B
y = Total binding
A = Specific Binding By«
B = Kd (specific binding)
C = nonspecific binding coefficient
A rectangular hyperbola plus linear curve fitis commonly used for estimation of maximum
binding and Kd (of specific binding) in the presence of nonspecific binding.
For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a rectangular hyperbola plus

linear curve fit algorithm is 3.
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One-Site Equilibrium Binding (total and nonspecific)
A One-Site Equilibrium Binding (total and nonspecific) curve fit is also known as:

e Rectangular Hyperbola Plus Linear
e Rect. Hyper. Plus Linear, see page 388

Total
Specific

ﬁﬁﬁﬁﬁ
-

Binding
\\

Nonspecific

Ligand Concentration

AX

v + Cx

y:

y = Total binding

A = Specific Binding By«

B = Kd (specific binding)

C = nonspecific binding coefficient

A one-site equilibrium binding (total and nonspecific) curve fitis commonly used for estimation
of maximum binding and Kd (of specific binding) in the presence of nonspecific binding.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a one-site equilibrium
binding (total and nonspecific) curve fit algorithm is 3.
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Semi-Log

The Semi-Log curve fit fits the best straight line to a set of data for log(x) plotted against y.

y=A+BxLog(x)

A = y-intercept at x=1

B=Slope

Log in this equation is the common or base-10 logarithm.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a semi-log curve fit
algorithm is 2.
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Two-Site Competition

The Two-Site Competition curve fit is applicable to competition studies involving two receptor
binding sites.

Binding

Competitor Concentration
B N 1-B
y=D+(A-D) X X
e[z 13

A =Y, = First Asymptote

B = Fraction of Sites with Affinity Associated with C
C =EC;g, for One Site

G = ECg for the Other Site

D = Second Asymptote

1— B = Fraction of Sites with Affinity Associated with G
Assumptions include:
e |igand has identical affinity for both receptors
e Competitor had different affinities
Fraction1 = Fraction of Receptors with (1)
e Span=Top — Bottom

% Note: To obtain a one-site competition fit, use the 4-parameter logistic and fix B to —1.
See 3-Parameter Dose-Response Curves on page 372.

For the best results, you should exceed the minimum number of standards required for a curve
fit. The minimum number of standards required mathematically for a two-site competition

curve fit algorithm is 4.
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A

Absorbance

Absorbance is the quantity of light absorbed by a solution. To measure absorbance accurately,
it is necessary to eliminate light scatter. If there is no turbidity, then absorbance = optical
density.

A =logyo(lo /1) = =logqo(l/lp)
where [, is intensity of the incident light before it enters the sample divided by the light after it
passes through the sample, and A is the measured absorbance.

See Absorbance Read Mode on page 270.

AlphaScreen

ALPHA stands for Amplified Luminescent Proximity Homogeneous Assay. AlphaScreen®is a
bead-based chemistry used to study molecular interactions between moieties A and B, for
example. When a biological interaction between A and B moves beads (coated with A and B,
respectively) together, a cascade of chemical reactions produce a greatly amplified signal.

The cascade result signal is triggered by laser excitation (680 nm), that makes a
photosensitizer on the A-beads convert oxygen to an excited (singlet) state. The energized
oxygen diffuses away from the A-bead. When reaching the B-bead in close proximity, it reacts
with a thioxene derivative on the B-bead to generate chemiluminescence at 370 nm. Energy
transfer to a fluorescent dye on the same bead shifts the emission wavelength into the 520 nm
to 620 nm range. The limited lifetime of singlet oxygen in solvent (Y4 microseconds) lets
diffusion reach up to only around 200 nm distance. Thus, only B-beads in the proximity of A-
beads yield signal, which indicates binding between moieties A and B.

An AlphaScreen measurement includes a light pulse, by turning on the laser diode fora
specified time, turning off the laser diode, followed by the measurement of the AlphaScreen
signal, as specified in the measurement protocol timing parameters.

AlphaScreen beads are light sensitive. Beads are best handled under subdued (<100 lux) or
green filtered (Roscolux filters #389 from Rosco, or equivalent) light conditions. Do incubation
stepsin the dark.

See AlphaScreen Read Mode on page 296.

Auto Export

The Auto Save dialog enables you to define how and where the software is to automatically
save data immediately after each plate read completes. Auto Save reduces the likelihood of
lost data, particularly when you choose to save files to corporate network file locations that are
backed up on a regular basis.

You can define multiple Auto Save instances.

= | Note: Auto Save settings are saved with each document.

See Auto Export on page 32.
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Auto Read

Auto Read automatically advances to the next Plate section after a read in the sequence that
the Plate sections display within a single experiment. When you start a read for a Plate section
that uses Auto Read, the feature advances to the next Plate section in the experiment and then
reads that plate. If you define multiple Plate sections to automatically advance with Auto Read,
the Auto Read feature reads all enabled Plate sections until it reads a non-enabled Plate
section or the last Plate section in the experiment.

Example, if you have five Plate sections (Plate 1, Plate 2, Plate 3, Plate 4, and Plate 5)in an
experiment, you can enable Plate 1, Plate 2, and Plate 3 to automatically advance with
Auto Read. If you start a read for Plate 2, then Plate 2, Plate 3, and Plate 4 are read in
sequence. Plate 1is not read, since it comes before Plate 2. Plate 5 is not read since Plate
4 is not enabled to automatically advance with Auto Read.

You can set aninterval, or delay time, between plate reads.

See Using Auto Read on page 178.

B

Baseline
Baseline reads are available for kinetic reads with injection.

The instrument collects baseline data before the injection, so that the baseline data can be
subtracted from the reads that follow the injection.

C
Calibrate

Forthe Absorbance read mode, the instrument makes an air-calibration measurement at each
wavelength before the read. If you turn calibration off, the software uses the air-calibration
values stored in the instrument firmware or the values from the previous calibration.

For Fluorescence and Luminescence read modes, the instrument makes a reference read at
each wavelength before the read. If you turn calibration off, the software uses the default
values stored in the instrument firmware or the values from the previous calibration.

For the Kinetic read type, the instrument makes the calibration measurement between reads
during a run, unless the read interval is too short to allow calibration.

See More Settings on page 141.
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Cutoff

The term cutoff refers to the longpass filters the instrument uses to block unwanted residual
excitation light and minimize background interference.
The Luminescence read mode does not use emission cutoff filters. For other read modes:
e Select the Auto Cutoff check box to have the software choose the longpass emission filter
based on the excitation wavelength you enter.
e Clearthe Auto Cutoff check box, then click the corresponding drop-down and select the
cutoff filter for each wavelength. For the Spectrum read type you must select a cutoff filter
(or None).

See Wavelength Settings on page 113.

Cuvette Set Section

Cuvette Set sections enable you to collect data from the cuvette port of the SpectraMax M2
and SpectraMax M2e, SpectraMax M5, SpectraMax M5e, SpectraMax ABS Plus, and
SpectraMax Plus 384. Use Cuvette Set sections to define instrument settings to read the
cuvette, templates to analyze the data, data reduction settings, and data display settings. The
Template Editor in the Cuvette Set section enables you to define formulas for the data the
instrument collects from each cuvette within the Cuvette Set.

See Cuvette Set Sections on page 83.

D

Default Protocol

When you open a new document, the settings from the default protocol appearin the
Workspace. The default protocol settings help you get started when you create a new
document. When you install the software, the Basic Endpoint protocol is set as the default

protocol with the file name default.spr. The E& Save As Default icon on the Protocols tab
enables you to change the default protocol settings.

See Protocols Tab on page 56.
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E

Emission Spectrum Scan

An emission spectrum scan measures fluorescence or luminescence across a spectrum of
wavelengths. Fluorescent reads use the emitted light from a fixed excitation wavelength. The
default value reported for each well is the wavelength of maximum emission in either RFU for
fluorescence mode or RLU for luminescence mode.

End Time

End Time for the Kinetic read type specifies the time after which data points are excluded from
data reduction. The default setting is the total assay time for the Kinetic read type.

See Data Reduction on page 191.

Endpoint

Forthe endpoint read type, a read of each plate well is taken in the center of each well, at a
single wavelength or at multiple wavelengths. Depending on the read mode, the software
reports raw data values as optical density (OD), % Transmittance (%T), relative fluorescence
units (RFU), or relative luminescence units (RLU).

Excitation Spectrum Scan

An excitation spectrum scan measures fluorescence at a single emission wavelength for the
emitted light across a spectrum of excitation wavelengths. The default value reported for each
well is the wavelength of maximum fluorescence excitation in RFU.

F

Fluorescence

Fluorescence occurs when absorbed light is re-radiated at a longer wavelength. In the
Fluorescence Intensity (FL) read mode, the instrument measures the intensity of the re-radiated
light and expresses the result in Relative Fluorescence Units (RFU).

The governing equation for fluorescence is:
Fluorescence = extinction coefficient x concentration x quantum yield x excitation intensity
x pathlength x emission collection efficiency

See Fluorescence Intensity Read Mode on page 275.

Fluorescence Polarization

Fluorescence Polarization detection is based on Fluorescence Intensity, with the important
difference that it uses plane-polarized light, rather than non-polarized light. Microplate readers
measure the Fluorescence Polarization of the sample by detecting light emitted both parallel
and perpendicular to the plane of excitation.

By using a fluorescent dye to label a small molecule, the binding of a small molecule to an
interaction partner of equal or greater size can be monitored through its speed of rotation.

See Fluorescence Polarization Read Mode on page 293.
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Fluorescence Resonance Energy Transfer (FRET)

Fluorescence resonance energy transfer (FRET) is a distance-dependent interaction between
the electronic excited states of two dye molecules in which excitation is transferred from a
donor molecule to an acceptor molecule without emission of a photon.
FRET relies on the distance-dependent transfer of energy from a donor molecule to an
acceptor molecule. Due to its sensitivity to distance, you can use FRET to investigate
molecular interactions. FRET is the radiationless transmission of energy from a donor molecule
to an acceptor molecule. The donor molecule is the dye or chromophore that initially absorbs
the energy and the acceptoris the chromophore to which the energy is subsequently
transferred. This resonance interaction occurs over greater than interatomic distances, without
conversion to thermal energy, and without a molecular collision. The transfer of energy leads
to a reduction in the fluorescence intensity and excited state lifetime of the donor, and an
increase in the emission intensity of the acceptor. A pair of molecules that interact in such a
manner that FRET occurs is often referred to as a donor/acceptor pair.
While there are many factors that influence FRET, the primary conditions that need to be met
for FRET to occur are relatively few:

e The donor and acceptor molecules must be in close proximity to each other.

e The absorption or excitation spectrum of the acceptor must overlap the fluorescence

emission spectrum of the donor.
The degree to which they overlap is referred to as the spectral overlap integral (J).
e The donor and acceptor transition must be approximately parallel.

See FRET Read Mode on page 287.

Fluorophore

A fluorophore is a material that absorbs light energy of a characteristic wavelength, undergoes
an electronic state change, and emits light of a longer wavelength.

See Fluorescence Intensity Read Mode on page 275.

G
G Factor

Use the G factor, or grating factor, in Fluorescence Polarization to correct polarization data for
optical artifacts which converts relative mP data to theoretical mP data. Optical systems,
particularly with reflective components, pass light of different polarization with different
efficiency. G factor corrects for this instrument-based bias.

Gain

Gain is the quantity of increase in signal power expressed as the ratio of output to input for a
photomultiplier tube (PMT).

See PMT and Optics Settings on page 121.

Group

The Template Editor enables you to assign wells to groups. Some protocols automatically
create groups such as Standard or Unknown.

See Group Settings on page 95.
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Imaging
Imaging read mode does whole-cell imaging assays.

Whole-cell imaging assays are cell-based, or object-based, rather than the single-point
measurements found in other types of plate reads. These types of assays can yield more
biologically meaningful results that can discriminate the fluorescence related to objects, such
as cells or beads, from the bulk solution within a plate well.

See Imaging Read Mode on page 301.

K

Kinetic
For the kinetic read type, the instrument collects data over time with reads taken in the center

of each well at regular intervals. To get the shortest possible interval for multiple-wavelength
kinetic reads, choose wavelengths in ascending order.

The values calculated based on raw kinetic data include VMax, VMax per Sec, Time to VMax,
Onset Time, and more. Kinetic reads can be single-wavelength or multiple-wavelength reads.

L
Lag Time

Lag Time for the Kinetic read type defines the period of time to be excluded from data
reduction. It can be used to ignore the initial lag phase of reactions.

See Data Reduction on page 191.

Luminescence

Luminescence is the emission of light by processes that derive energy from essentially non-
thermal changes, the motion of subatomic particles, or the excitation of an atomic system by
radiation. Luminescence detection relies on the production of light from a chemical reaction in
a sample.

See Luminescence Read Mode on page 280.

LUT

A look-up table (LUT) determines the colors to use for the intensity values when displaying an
image.
See Viewing Western Blot Membrane Data on page 236.
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M
Mask

The Mask feature hides the data you select so that the data is not used for calculations and is
not reported. Masking is commonly used to suppress outliers from data reduction calculations.

Masking can be used as a “what if?” tool. Example: If you include a group blank in a template
and want to see the data both with and without the blank, masking the group blanks
suppresses the blanking function and unmasking the group blanks enables the blanking
function.

See Masking Wells or Cuvettes on page 207.

Membrane

The Membrane read type is used for a Time-Resolved Fluorescence read of a Western Blot
membrane.

See Membrane Read Type on page 268 and Western Blot Read Mode on page 298.

o)

Onset Time

Onset Time reports the time required for a Kinetic reaction to reach a specified OD or RFU/RLU
(onset OD/RFU/RLU).

See Kinetic Data Reduction Options on page 198.

Optical Density (OD)

Optical density (OD) is the quantity of light passing through a sample to a detector relative to
the total quantity of light available. Optical Density includes absorbance of the sample plus
light scatter from turbidity and background. You can compensate for background using blanks.
A blank well contains everything used with the sample wells except the chromophore and
sample-specific compounds. Do not use an empty well for a blank.

Some applications are designed for turbid samples, such as algae or other micro-organisms in
suspension. The reported OD values for turbid samples are likely to be different when read by
different instruments.

See Absorbance Read Mode on page 270.
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P
PathCheck Technology

The temperature-independent PathCheck technology normalizes absorbance valuesto alcm
path length based on the near-infrared absorbance of water.

The Beer—Lambert law states that absorbance is proportional to the distance that light travels
through the sample:

Microplate readers use a vertical light path so the distance of the light through the sample
depends on the volume. This variable pathlength makes it difficult to do extinction-based
assays and makes it confusing to compare results between microplate readers and
spectrophotometers.

The standard pathlength of a 1 cm cuvette is the conventional basis to quantify the unique
absorptivity properties of compounds in solution. Quantitative analysis can be done on the
basis of extinction coefficients, without standard curves (for example, NADH-based enzyme
assays). When you use a cuvette, the pathlength is known and is independent of sample
volume, so absorbance is directly proportional to concentration when there is no background
interference.

See PathCheck Technology on page 272.
Photomultiplier Tube (PMT)

A Photomultiplier Tube (PMT) is a vacuum tube that can detect light from dim sources through
the use of photo emission and successive instances of secondary emission to produce
enough electrons to generate a useful current.

Plate Section

Plate sections enable you to define plate related instrument settings, data reduction settings,
and data display settings. When you want to read the same physical plate twice with different
instrument settings you create two Plate sections in the experiment. You can create as many
Plate sections as you need. Auto Read enables you to read multiple plate sections. See Using
Auto Read on page 178.

See Plate Sections on page 80.

Protocols

Protocols contain plate well layout assignments, reduction parameters, and instrument
settings, but no data. Protocols are useful when you want to repeat experiments because they
save instrument experiment settings and formulas for reuse.

See Managing Documents on page 25.

R

Raw Data

Raw data is the signal reported from the instrument with no changes made. This is reported as
optical density (OD), relative fluorescence units (RFU), or relative luminescence units (RLU),
depending on the read mode.
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Raw Data Mode

In Absorbance (ABS) read mode or Fluorescence Polarization (FP) read mode, you can select
the type of raw data to display and use for reduction calculations.

For Absorbance reads, you can choose whether to display absorbance data as Optical Density
or % Transmittance.

The Fluorescence Polarization read mode returns two sets of data: one for fluorescence
intensity parallel (P) to the excitation plane, and the other for fluorescence intensity
perpendicular (S) to the excitation plane. The software uses the S and P values to calculate the
Polarization (mP) and Anisotropy (r) values.

See Data Reduction on page 191.

Reduced Data

Data reduction causes the raw signal values reported by the instrument to be calculated and
displayed based on user-defined formula settings.

Reference

A reference read can be taken either on air or you can use a cuvette that contains the buffer of
your sample.

See Collecting Data From Cuvettes on page 185.

ROI

A region of interest (ROI) is a small area or region of an image where items of interest can be
found.

e For Western Blot Membrane reads, the region of interest is defined in the Plate section.
See Viewing Western Blot Membrane Data on page 236.

e Forlmaging reads, the region of interest is defined in the Settings dialog. See Region of
Interest Settings on page 140.

S
Series

The Series dialog enables you to define several samples as a series. Use a series to enter
incremental sample descriptors (e.g., dilutions or concentrations) and sample namesto a
template when the increment can be expressed as a mathematical operation. When you to
work with groups of wells in the template, the standard value or dilution factor increases or
decreases in specific steps. The series name can also increment.

See Creating a Series on page 98.

Slope

The slope reduction option determines the slope of the combined plot (for example, the slope
of the line using linear regression after the wavelength combination reduction). This reduction
uses all visible time points in the reduction window.

Slope is the same as Vmax Rate when Vmax Rate is set to the same number of points as the
run but is different if you have modified Vmax Points.

See Kinetic Data Reduction Options on page 198.
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Smartlnject

Smartlnject™ technology is available for reads with injection.
The Smartlnject technology shakes the plate during the injection and continues to shake

through the following delay step, if a Delay node follows the Smartinject node. The plate stops
shaking before the well is read.

Spectrum

Depending on the read mode you select, the spectrum read type measures optical density
(OD), % Transmittance (%T), relative fluorescence units (RFU), or relative luminescence units
(RLU) across a spectrum of wavelengths.

See Spectrum Read Type on page 269, Emission Spectrum Scan on page 396, and Excitation
Spectrum Scan on page 396.

Stokes Shift

The Stokes shift is the difference between the wavelengths of the excitation and emission
maxima, or peaks.

See Emission Spectrum Scan on page 396 and Excitation Spectrum Scan on page 396.

.
Template Editor

A template uses a map of the wells in the plate you assign to a Plate section or the cuvettesin
a Cuvette Set section to describe the location of samples in the plate or the cuvettes.
Templates provide the link between raw data and analysis groups.

The Template Editor displays a representation of the plate type orthe set of cuvettes as a
grid. The grid enables you to designate the location of blanks, standards, controls, unknowns,
empty wells, or to assign wells/cuvettes to groups that become Group sections in an
experiment.

See Template Editor on page 90.

Time-Resolved Fluorescence (TRF)

Time-Resolved Fluorescence is a measurement technique that depends on three
characteristics that lead to better discrimination between the specific signal, proportional to
the quantity of label, and the unspecific fluorescence resulting from background and
compound interference:

e Pulsed excitation light sources

e Time-gated electronics faster than the fluorescence lifetime

e |abels with prolonged fluorescence lifetime
The time-gating electronics introduce a delay between the cutoff of each light pulse and the
start of signal collection. During the delay, the unspecific fluorescence (caused by test
compounds, assay reagents, and the plate) vanishes, while only a small portion of the specific
fluorescence from the label is sacrificed. Enough of the specific signal remains during the
decay period, with the added benefit of reduced background.

See Time-Resolved Fluorescence Read Mode on page 283.

5049092 F



5049092 F

Glossary

%Transmittance

%Transmittance is the ratio of transmitted light to the incident light for absorbance reads.
T=1ly

%T =100T

where /is the intensity of light after it passes through the sample and /, is incident light before it
enters the sample.

\Y

Vmax Points

Vmax is the maximum slope of the Kinetic display of mOD/min or RFU/RLU per second. The
software calculates Vmax by measuring the slopes of a number of straight lines, where Vmax
Points determines the number of contiguous points over which each straight line is defined.

An alternative method to analyze non-linear Kinetic reactions is to report the elapsed time until
the maximum reaction rate is reached, rather than to report the maximum rate itself. When you
use this in conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line
defined by Vmax Points and used to calculate Vmax.

See Kinetic Data Reduction Options on page 198.

Vmax Rate

Vmax Rate is reported as signal/min (milli-OD, RFU, or RLU units per minute) for the Kinetic read
type. ltis calculated using a linear curve fit, y = Ax + B. A creeping iteration is done using Vmax
Points and the slope of the steepest line segment is reported as Vmax Rate. It can also be
reported as units per second (the default for Fluorescence and Luminescence modes).

See Kinetic Data Reduction Options on page 198.

W
Well Scan

The well scan read type takes reads at more than one location within a well. The well scan
read type takes multiple reads of a single well of a plate on an evenly spaced pattern inside of
each well at single or multiple wavelengths.

For applications that involve the detection of cells in large area tissue culture plates, the well
scan read type permits maximum surface area detection in cell-based protocols. Since many
cell lines tend to grow as clumps or in the corners of plate wells, you can choose the well scan
pattern and define the number of points to scan in order achieve the best results.

See Well Scan Read Type on page 269.

403



SoftMax Pro Software User Guide

Z
ZI
Z is the standard statistical parameter in the high-throughput screening community to measure

the quality of a screening assay independent of test compounds. Use this as a measure of the
signal separation between the positive controls and the negative controls in an assay.

Use the following formula to determine the value of Z":
3(SD,, ) +3(SD_)

- | Mean —Mean |
c+ C

where SD is the standard deviation, c+ is the positive control, and c— is the negative control.

A Z value greaterthan or equal to 0.4 is the generally acceptable minimum for an assay. You
can use higher values when results are more critical.

Z is not linear and can be made unrealistically small by outliers that skew the standard
deviations in either population. To improve the Z" value, increase the quantity of label in the
sample, if acceptable for the assay, or increase the read time per well.
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